Copyright © 2005, 2007, 2009 Oracle. All rights reserved.

The Programs (which include both the software and documentation) contain proprietary information; they are provided under a license agreement containing restrictions on use and disclosure and are also protected by copyright, patent, and other intellectual and industrial property laws. Reverse engineering, disassembly, or decompilation of the Programs, except to the extent required to obtain interoperability with other independently created software or as specified by law, is prohibited.

The information contained in this document is subject to change without notice. If you find any problems in the documentation, please report them to us in writing. This document is not warranted to be error-free. Except as may be expressly permitted in your license agreement for these Programs, no part of these Programs may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose.

PRODUCT MODULES AND OPTIONS. This guide contains descriptions of modules that are optional and for which you may not have purchased a license. Siebel’s Sample Database also includes data related to these optional modules. As a result, your software implementation may differ from descriptions in this guide. To find out more about the modules your organization has purchased, see your corporate purchasing agent or your Oracle sales representative.

If the Programs are delivered to the United States Government or anyone licensing or using the Programs on behalf of the United States Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS. Programs, software, databases, and related documentation and technical data delivered to U.S. Government customers are "commercial computer software" or "commercial technical data" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the Programs, including documentation and technical data, shall be subject to the licensing restrictions set forth in the applicable Oracle license agreement, and, to the extent applicable, the additional rights set forth in FAR 52.227-19, Commercial Computer Software--Restricted Rights (June 1987). Oracle USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently dangerous applications. It shall be the licensee's responsibility to take all appropriate fail-safe, backup, redundancy and other measures to ensure the safe use of such applications if the Programs are used for such purposes, and we disclaim liability for any damages caused by such use of the Programs.

Oracle, JD Edwards, PeopleSoft, and Siebel are registered trademarks of Oracle Corporation and/or its affiliates. Other names may be trademarks of their respective owners.

The Programs may provide links to Web sites and access to content, products, and services from third parties. Oracle is not responsible for the availability of, or any content provided on, third-party Web sites. You bear all risks associated with the use of such content. If you choose to purchase any products or services from a third party, the relationship is directly between you and the third party. Oracle is not responsible for: (a) the quality of third-party products or services; or (b) fulfilling any of the terms of the agreement with the third party, including delivery of products or services and warranty obligations related to purchased products or services. Oracle is not responsible for any loss or damage of any sort that you may incur from dealing with any third party.
# Contents

## Chapter 1: What’s New in This Release

## Chapter 2: Getting Started
- Getting Started Prerequisites 23
- Starting the Application for the First Time 24
- Entering License Keys 25
- Selecting a Data Source 29
- About Seed Data 30
- Summary of Applications Administration Tasks 30

## Chapter 3: Initial Setup
- About Initial Setup 33
- Summary of Initial Setup Tasks 34
- Adding Views to the Application 35
- Completing Employee Setup 35
- Assigning Skills 37
- Setting Up Locales 37
- Setting Up Satmetrix Survey Reports 41

## Chapter 4: Ongoing Application Administration Tasks
- Setting System Preferences 46
- Setting Up Predefined Queries 46
- Enabling Cancel Query 48
- Setting Up Currencies 48
- Setting Up Currency Conversion 50
- Setting Up Expense Types 53
- Setting Up Payment Terms 54
- Setting Up Periods 55
Contents

Working with Telephone Formats  56
Setting Up Pager Companies  60
About Date Formats  61
Setting Up ZIP Codes  61
Administering Global Time Zone Support  61
Setting Up Email, Fax, and Mail Accounts (Contact Us)  63
Setting Up Industries  64
Setting Up Languages  64
About Case-Insensitive and Accent-Insensitive Queries and Searches  65
   Forcing Case-Sensitive or CIAI Queries or Searches  66
Adding Web Browser Capabilities  66
Adding Additional Web Browsers  67
Administering Quick Fill Templates  69
Setting Up Default View Links for Screen Home Pages  70

Chapter 5:  Working with Lists of Values
About Lists of Values  71
Adding a New Value to an Existing List of Values  72
Clearing the Cache  73
List-of-Values Fields  74
Modifying a List of Values  76
Inactivating a Value in a List of Values  77
Constrained Lists of Values  78

Chapter 6:  Audit Trail
About Audit Trail  81
   Audit Scope  82
   Audit Trail Content  82
   Audit Trail Constraints  83
   Audit Trail for Siebel Remote and Siebel Replication Users  83
Process of Configuring and Using Audit Trail  84
Enabling and Disabling Audit Trail  84
Specifying Business Components and Business Component Fields for Audit  84
Setting Up Read Auditing  86
Specifying Parent–Child Associations for Audit  86
Specifying Audit Trail Restrictions  87
Verifying Audit Trail Configuration  88
Viewing Audit Trail Records  88
Linking Audit Trail to a Business Component  91

Chapter 7: Creating and Administering iHelp
About iHelp  93
Scenario for Administering iHelp  93
Process of iHelp Administration  94
Creating iHelp Item Records  95
Designing iHelp  97
Clearing the iHelp List Cache  99
Activating, Revising, and Deactivating iHelp Items  100
Translating iHelp Items  101
Importing and Exporting iHelp Items  102

Chapter 8: Message Broadcasting
About Message Broadcasting  103
Scenario for Administrating Message Broadcasting  104
Process of Message Broadcasting  105
Enabling and Disabling Message Broadcasting  105
Creating a Message Broadcast  107
About Automatically Updating Message Broadcasting Text  110
Configuring Message Broadcast Caching  111

Chapter 9: Alerts
About Alerts  113
Scenario for Using Alerts  113
Creating Alerts  114
Chapter 10: Administering and Using Inbox

About the Inbox 117
Scenarios for Administering and Using the Inbox 119
Administering the Inbox 121
Reviewing All Inbox Items 121
Deleting Inbox Items 121
Setting Expiration Dates and Due Dates for Inbox Items 122
Changing the Destination View for an Inbox Type 122
Changing Inbox Downloading to Remote Databases 122
Adding Inbox Translations 123
Using the Inbox 123
Taking Action on Inbox Items 124
Reviewing Completed Items 124
Reviewing Submitted Items 124

Chapter 11: Configuring the Inbox

Process of Setting Up and Configuring Inbox 125
Planning for Inbox Configuration 126
Creating Inbox Items 126
Creating Inbox Types 127
Setting Up Inbox Links to Views and SmartScripts 128
Setting Up Inbox Actions 129
Configuring the Inbox for Use with Remote Databases 132
Setting Up Inbox Approval Translations 133
Configuring the Toggle Applets for Inbox Views 134
Configuring the Category Icon for the Inbox 135
Configuring Action Buttons for Inbox Views 136
Setting the Log File for Troubleshooting 137
Universal Inbox Business Service Methods 137

CreateInboxEx Method 139
CreateInbox Method 140
CreateInboxItem Method 142
CreateInboxOwner Method 143
IsInboxItemExisted Method 145
GetInboxItemInfo Method 145
GetInboxParamInfo Method 146
GetInboxOwnerInfoEx Method 147
GetInboxOwnerInfo Method 148
SetInboxParamInfo Method 149
UpdateInboxItemInfo Method 150
DeactivateInboxItem Method 150
DeactivateInboxOwner Method 152
UpdateInboxOwnerInfo Method 152
DeleteInboxItem Method 153
Initialize Method 154
RouteInboxItem Method 154

Examples of Inbox Triggers 155
Sample Workflow for Assigning Service Requests and Creating Inbox Items 157
Sample Workflow to Synchronize Status for Service Requests and Inbox Items 158
Sample Workflow to Update Inbox Items for Status Changes Made in the Inbox Detail View 159
Inbox Trigger Used in ESS 160
Inbox Trigger Using Server Script 161

Chapter 12: Messages
Scenario for Setting Up Messages 163
Process of Setting Up and Using Messages 164
About Using Messages 164
Setting Up Messages 164
About Email and Screen Alerts 165
Creating a New Message (End User) 165
Setting Up Single and Recurring Alerts (End User) 167
Viewing Messages (End User) 167
Sorting Messages by Intervals (End User) 168
Sending a Message Using Email (End User) 168

Chapter 13: Activities
About Activities 171
Creating Activities (End User) 173
Working with Others’ Activities (End User) 176
Delegating an Activity (End User) 177
Viewing Activities Associated with Another Record Type (End User) 178
About Configuring Owner and Employee Fields for Activities 178

**Chapter 14: Activity Plans and Sales Methods**
About Activity Templates and Activity Plans 179
About Sales Methods 180
Scenarios for Activity Plans 180
Process of Administering and Using Activity Plans 181
Defining a Sales Methodology 181
About Activity Assignment 183
Creating an Activity Template 184
Creating TAS Customer Milestone Templates in a Localized Application 186
Deleting an Activity Template 187
Setting a Default Sales Methodology (End User) 187
Using an Activity Plan (End User) 188

**Chapter 15: Assessments**
About Assessment Templates 189
Scenario for Using and Administering Assessments 189
Process of Administering and Using Assessments 190
Creating an Assessment Template 190
Performing an Assessment (User) 192
Assessing an Opportunity for Target Account Selling (End User) 193

**Chapter 16: Calendar**
About Calendar Resources 197
About Calendar Access 197
Scenarios for Calendar Administration 197
Process of Calendar Administration 198
Setting Up Resources 199
Adding and Modifying Calendar Access 199
Deleting Calendar Access 200
Configuring the Calendar Alarm 200
   Setting Alarm Manager Load Frequency 201
   Setting Retroactive Alarms 201

Configuring the Calendar 201
   Displaying Start and End Times for Calendar 202
   Displaying Fields, Colors, Drilldowns, and ToolTips 202
   Specifying Day Summary ToolTip 203
   Showing and Hiding User Interface Components 205
   Changing User Interface Strings 206
   Changing Date Display Format 207
   Changing the First Day of the Week 208
   Overriding User Preferences 209
   Enabling and Disabling Calendar Editing 209
   Using Special Date Markers 209
   Specifying Extra Business Components 210
   Dragging-and-Dropping Records from Other Applets into the Calendar 210
   Changing Controls in the Calendar Detail View 213
   Showing or Hiding Side Applets on the Life Sciences Calendar 213

Chapter 17: State Models
About State Models 215
Scenario for State Models 216
Process of Setting Up State Models 216
Configuring Business Components for State Models 217
Creating State Models and State Transitions 218
Activating State Models 220
Configuring Child Modification for State Models 221

Chapter 18: Literature
About Literature 223
About Setting Up Literature Files 224
Creating and Modifying Literature Files 224
Creating Literature Records 225
Creating Translation Records 227
Creating Literature Item Kits 228
About Making Literature Visible to Users 229
Sharing Literature Through the Products Screen 230
Sharing Literature Through the Competitors Screen 230
Sharing Literature Through the Decision Issues Screen 231
Sharing Literature Through the Correspondence Screen 232
Sharing Literature Through eBriefings 232
Sharing Literature Through Literature or Infocenter 233

Chapter 19: Global Target List Management
About Global Target List Management 235
Scenario for Global Target List Management 236
Process of Global Target List Management 237
Creating Target Lists by Querying (End User) 237
Editing Target Lists (End User) 238
Creating Target Lists By Combining Lists (End User) 239
Applying Target Lists (End User) 239
Creating Activities From Target Lists (End User) 239
About Configuring Target Lists 240
   Setting Up Data Map Object “Activity Templates” for Target Lists 240
   About Workflows for Global Target List Management 241
   Configuring Global Target List Management to Create Activities Asynchronously 241
   Enabling Application of Target Lists on an Applet 242
   Enabling Saving of Target Lists in an Applet 244

Chapter 20: D&B Integration
About D&B Data 247
Business Scenarios for D&B 248
About the D&B D-U-N-S Number 249
Process of Integrating D&B Data 249
   Obtaining D&B Data 250
   Loading D&B Data 250
   Loading D&B Data Using Sample Scripts 251
   About Siebel Update Server Components 254
   Running the Siebel Update Server Components 258
Setting Up the Symbolic URL for Access to the D&B Database 262
Configuring D&B Integration 263
Field Mappings for Configuration of D&B Integration  267

Chapter 21: D&B Integration (End User)
Accessing Company Data and Reports with D&B  273
Viewing D&B Aggregate Data for a Company  273
Promoting a D&B Account  274
Creating a Prospect List from D&B Data  274
Viewing a D&B Report  275
Using Global Integration to Add New D&B Accounts  275

Chapter 22: Contacts
About Contacts  279
Scenario for Contacts  279
Adding a Contact  280
Promoting a Personal Contact to a Contact  282
Creating a Profile for a Contact  282
Adding a Contact to a Synchronization List  282
Assessing a Contact  283
Synchronizing Contact Information with External Systems  283

Chapter 23: Adobe Forms Integration
About Forms Integration  285
Scenarios for Forms Integration  286
Process of Setting Up Adobe Forms Integration  287
Preparing for Adobe Forms Integration Setup  288
Preparing the Setup for Adobe Forms Integration  288
Creating the Web Service for Adobe Forms Integration  288
Configuring the Web Service for Adobe Forms Integration  289
Enabling Forms Integration for Additional Applets Using Siebel Tools  290
Creating an Integration Object for Adobe Forms Integration  290
Generating an XML Schema for Forms Integration  291
Mapping the XML Schema to the PDF Form Using Adobe Designer  292
Creating the Form Record Referencing the PDF File  292
Generating a Form from a Record (User)  294

Chapter 24: Integration Using ASIs
About ASIs  297
Setting Up Account, Contact, and Household ASIs  297
ASI Workflow Descriptions  299

Chapter 25: Web Services
About Web Services for Microsoft Applications  301
About the Excel Web Service  302
About the Word Web Service  302
Seed Data for Excel and Word Web Services  303
Prerequisites for Connecting Templates to Siebel EAI  303
Process of Configuring Excel Web Service  303
Downloading the Template for the Excel Web Service  304
Connecting the Excel Template to Siebel EAI  304
Using the Excel Web Service  305
Process of Configuring Word Web Service  306
Downloading the Template for the Word Web Service  306
Connecting the Word Template to Siebel EAI  306
Process of Using Word Web Service to Perform a Mail Merge  307
Getting the Data for a Mail Merge From the Siebel Database  308
Refining Recipients for a Mail Merge  308
Refining the Message for a Mail Merge  309
Previewing Messages for a Mail Merge  309
Printing or Sending Mail Merge Messages  310
Logging Messages as a Siebel Activity  310

Chapter 26: Accounts
About Accounts  313
Scenario for Accounts in Siebel Sales  313
Scenario for Accounts in Siebel Call Center  314
Creating an Account  314
Associating a Contact with an Account 317
Associating an Activity with an Account 317
Associating an Opportunity with an Account 318
Assessing an Account 318
Synchronizing Account Information with External Systems 319
Viewing Account Credit Profiles 319

Chapter 27: Global Accounts
About Global Accounts 321
Scenario for Using and Administering Global Accounts 322
Process for Using and Administering Global Accounts 323
Generating a Default Hierarchy 323
   Enabling Users to Add Accounts With No Parent to the Default Hierarchy 324
Creating a Custom Hierarchy 324
Assigning a Custom Hierarchy to an Organization 325
Updating a Custom Hierarchy 325
Restoring a Custom Hierarchy 326
Viewing Global Accounts (User) 327

Chapter 28: Opportunity Workflows
About Opportunity Workflows 329
Setting Up Opportunity Notification Workflows 330
Activating the Opportunity Notification Workflow Processes and Policies 331
Rerouting an Opportunity Using Workflows 333
Modifying Opportunity Workflows 333
Setting Up the Get Manager Email 334

Chapter 29: Opportunities (User)
About Opportunities 335
Scenario for Opportunities 336
Opportunities Processes and Procedures 337
About Opportunities Lead Assignment 338
About Lead Response 338
About Lead Qualification, Sales Methods, and Stages 339
Creating an Opportunity 340
Changing the Primary Sales Team Member 344
Monitoring Significant Opportunity Transactions 344
Assessing an Opportunity 345
Viewing Decision Issues for an Opportunity 345
Associating a Contact with an Opportunity 345
Activities Associated with an Opportunity 346
Associating a Product with an Opportunity 346
Creating a Quote from an Opportunity 347
Creating an Organization Analysis 348
Opportunity Charts 351
Generating Opportunity Reports 353
Setting Up Lead Sources for Opportunities 353

Chapter 30: Households
Household Contact Tracking 355
Scenario for Households 356
End-User Procedures for Households 356
Adding a Household Record 356
Adding Contacts to a Household 357
Adding Activities to Household Records 360
Storing and Viewing Information About Households 360
Synchronizing Household Information with External Systems 361

Chapter 31: References
Scenario for References 363
Managing Accounts and References 364
Designating an Account as a Reference 364
Associating an Activity with a Reference 364
Associating a Contact with a Reference 365
Associating an Attachment with a Reference 365
Adding a Reference Activity to the Calendar 366
Adding a Note to a Reference 366
Adding Profile Information to a Reference 367
Searching for References 367
Viewing Reference Asset and Profile Charts 367

Chapter 32: Real-Time Decisions
About Real-Time Decisions 370
Scenario for Real-Time Decisions 370
Process of Configuring Siebel Business Applications for Siebel RTD 370
Checking Prerequisites 371
Configuring Outbound Web Services 371
Configuring RTD with Siebel Views 372
Setting Siebel Enterprise Server Parameters 372
Configuring Siebel Run-Time Events 373
Importing Communication Configuration Seed Data 374
Creating JDBC Data Sources 374
Creating Views in the SIEBEL_OLTP Database 375
Creating and Populating OLAP Tables with History Data 376
Creating a Project for an Inline Service 377
Deploying an Inline Service 378
Customizing Call Reasons 379
Process of Setting Up Real-Time Offers 380
Defining the Campaign 380
Creating and Modifying Offers 380
Enabling Offers for RTD 380
Opening Decision Center for Editing 381
Specifying Eligibility for Offers 381
  Adding Eligibility Rules 382
Updating Offer Information 383
Activating the Offers 383
Viewing RTD Performance Reports 384
Chapter 33: Categories
Scenario for Categories 387
Adding a Category 388
Searching by Category 388

Chapter 34: Competitors
Scenario for Competitors 389
Associating a Competitor with an Opportunity 389
Viewing Competitor Comparisons 390

Chapter 35: Signature Capture
About Siebel Signature Capture Controls 391
Scenario for Signature Capture 392
Roadmap for Implementing Signature Capture 392
Extending the Database for a Signature Capture Control 392
Registering the OCX File 393
Creating the Object and Class for Signature Capture 394
Process of Creating the Applet for Signature Capture 395
  Creating a Form Applet 395
  Creating a Control on the Applet 396
  Creating a Hidden Control on the Applet 396
  Creating Buttons for Saving and Clearing Signatures 397
  Adding Server Script to the Applet 397
  Adding Browser Script to the Applet 398
  Adding the Applet to an Object 402
Compiling the SRF 403
Testing the Signature Capture Applet 403
Generating Reports That Contain Signatures 404

Chapter 36: Decision Issues
Scenario for Decision Issues 405
Creating Decision Issues 405
Associating Decision Issues with an Opportunity (End User) 406
Adding Decision Issues Details (End User)  406

Chapter 37: Enterprise Selling Process
About Enterprise Selling Process  409
Using ESP Methodology to Manage Accounts  410
Scenario for Enterprise Selling Process  410
Process of Enterprise Selling  411
Adding ESP Business Unit and Service Unit Information  412
Adding ESP Business and Service Unit Offerings  413
Conducting an ESP Organizational Analysis  415
Charting the Organization’s Reporting Structure  416
Adding Partners for ESP Analysis  418
Viewing the BU/SU Offering Summary  419
Adding ESP Objectives  419
Adding ESP Account Plan Highlights  420
Viewing an ESP Manager’s Review  421
Generating ESP Account Plan and Account Map Reports  421

Chapter 38: Target Account Selling
Using Target Account Selling to Manage Opportunities  423
Scenario for Target Account Selling  424
Process of Target Account Selling  425
Completing a TAS Overview  426
Assessing an Opportunity  428
Developing Strategy with TAS Competitive Analysis  431
Conducting an Organizational Analysis  432
Developing a Relationship Strategy  435
Adding Customer Milestones  436
Viewing PRIME Activities  437
Adding Notes  438
Creating TAS Opportunity Plan and Initial Plan Reports  439
Chapter 39: Managing Portfolios

About the Portfolio Management Process 441
Scenario for Managing a Portfolio 442
Roadmap for Managing Portfolios 443
Creating a Portfolio Plan 443
Process of Segmenting Accounts 445
   Assessing Current Revenues 445
   Assessing the Future Potential of Accounts 446
   Viewing the Portfolio Segmentation Map 447
Process of Analyzing the A Accounts 447
Process of Analyzing B, C, and D Accounts 448
   Entering Details of the Account 448
   Assessing Business Units and Service Units 449
   Analyzing Selected Units 450
   Reviewing Opportunities 451
   Reviewing Organizational Analysis 451
   Reviewing Marketing Events 452
   Reviewing Partners 453
   Reviewing Objectives and Action Plans 454
Performing a Manager Review of a Portfolio Plan 455
Adding Solutions to Portfolio Plans 456
Printing a Portfolio Report 456

Appendix A: System Preferences

Index
1 What’s New in This Release


Table 1 lists changes in this version of the documentation to support Release 8.0 of the software.

Table 1. What’s New in Siebel Applications Administration Guide, Version 8.0, Rev. B

<table>
<thead>
<tr>
<th>Topic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changes in this version</td>
<td></td>
</tr>
<tr>
<td>About Web Services for Microsoft Applications on page 301</td>
<td>Added a reference to the Siebel System Requirements and Supported Platforms on Oracle Technology Network for supported Microsoft versions.</td>
</tr>
</tbody>
</table>

What’s New in Siebel Applications Administration Guide, Version 8.0, Rev. A

Table 2 lists changes in this version of the documentation to support Release 8.0, Rev. A of the software.

Table 2. What’s New in Siebel Applications Administration Guide, Version 8.0, Rev. A

<table>
<thead>
<tr>
<th>Topic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changes in this version</td>
<td></td>
</tr>
<tr>
<td>Signature Capture on page 391</td>
<td>Added chapter about the Siebel Signature Capture control feature.</td>
</tr>
</tbody>
</table>

Additional Changes

Additional changes to this guide include the following:

- Reviewed and updated the content in Working with Telephone Formats on page 56, About Case-Insensitive and Accent-Insensitive Queries and Searches on page 65, Administering and Using Inbox on page 117, and Configuring the Inbox on page 125.

- Added information about display of different accounts in the Global Accounts Hierarchy List view, depending on whether you have defined a hierarchy in Accounts Displayed in the Global Accounts Hierarchy List View on page 327.
### Table 3. What’s New in Siebel Applications Administration Guide, Version 8.0

<table>
<thead>
<tr>
<th>Topic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New features described</strong></td>
<td></td>
</tr>
<tr>
<td>Audit Trail on page 81</td>
<td>You can now enable Audit Trail from within Siebel applications. You can also audit, read, and export operations.</td>
</tr>
<tr>
<td>Creating and Administering iHelp on page 93</td>
<td>Added information about how to test iHelp items, integrate task UI items to iHelp items, and how to add additional help topics to an iHelp item.</td>
</tr>
<tr>
<td>Adobe Forms Integration on page 285</td>
<td>Moved this chapter to this guide from Siebel Public Sector Guide.</td>
</tr>
<tr>
<td>Global Accounts on page 321</td>
<td>Added a topic on Restoring a Custom Hierarchy on page 326. Added a topic on how to add hierarchy updates to a batch workflow policy.</td>
</tr>
<tr>
<td>Web Services on page 301</td>
<td>Describes the new Web services that enable users of Siebel applications to integrate the Siebel database with Microsoft Excel and Microsoft Word.</td>
</tr>
<tr>
<td>Real-Time Decisions on page 369</td>
<td>Describes the new Real-Time Decisions (RTD) service. This service provides intelligent offer recommendation and retention management features to call center agents who receive inbound customer communications.</td>
</tr>
<tr>
<td>Managing Portfolios on page 441</td>
<td>Describes how portfolio managers can use the Portfolio Management Process (PMP) methodology in Siebel applications to manage accounts and complex relationships with customers and partners.</td>
</tr>
<tr>
<td><strong>Strategic selling feature removed</strong></td>
<td>All references to this functionality have been removed, because this functionality is no longer available in the product.</td>
</tr>
<tr>
<td><strong>Improvements to the documentation</strong></td>
<td></td>
</tr>
<tr>
<td>Assessing a Contact on page 283, Assessing an Account on page 318, Assessing an Opportunity on page 345</td>
<td>Updated topics on how to perform assessments.</td>
</tr>
<tr>
<td>Synchronizing Contact Information with External Systems on page 283, Synchronizing Account Information with External Systems on page 319, Synchronizing Household Information with External Systems on page 361</td>
<td>Updated topics on how to synchronize with external systems.</td>
</tr>
</tbody>
</table>
### What’s New in Siebel Applications Administration Guide, Version 8.0

<table>
<thead>
<tr>
<th>Topic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts on page 313</td>
<td>Merged <em>Using Accounts in Siebel Sales</em> and <em>Using Accounts in Siebel Call Center</em> chapters.</td>
</tr>
<tr>
<td>Opportunity Workflows on page 329, Opportunities (User) on page 335</td>
<td>Reviewed and updated the content.</td>
</tr>
</tbody>
</table>
This chapter includes the following topics:

- "Getting Started Prerequisites" on page 23
- "Starting the Application for the First Time" on page 24
- "Entering License Keys" on page 25
- "Selecting a Data Source" on page 29
- "About Seed Data" on page 30
- "Summary of Applications Administration Tasks" on page 30

### Getting Started Prerequisites

After you have successfully installed the Siebel system, you need to enter license keys so that you and your organization can access Siebel products that your organization has purchased. After the license keys have been entered, you are ready to set up your Siebel applications.

Before you can begin to use your Siebel applications, the software listed in Table 4 must be correctly installed.

Table 4. Required Software

<table>
<thead>
<tr>
<th>Software</th>
<th>For Information, See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Siebel Gateway Name Server</td>
<td><em>Siebel Installation Guide</em> for the operating system you are using</td>
</tr>
<tr>
<td>Siebel Server</td>
<td></td>
</tr>
<tr>
<td>Siebel Database Server</td>
<td></td>
</tr>
<tr>
<td>Siebel Tools or Siebel Developer Web Client</td>
<td></td>
</tr>
<tr>
<td>Siebel Business Applications</td>
<td>Application-specific administration guide and this guide</td>
</tr>
</tbody>
</table>

Once these Siebel servers and applications are successfully installed, you can proceed to enter license keys for specific Siebel applications.
Starting the Application for the First Time

In order to begin setting up your Siebel application, you must log in with administrative responsibilities. The Siebel database server installation script creates a Siebel administrator account that you can use to perform administrative tasks. The default user ID and password are SADMIN and SADMIN (case-sensitive). Your database administrator may also have created a user ID and password that allows you to access the Siebel Server and perform the required setup. To set up entities in the Group Administration view, you must be connected to the Siebel Server; you do not have full administrative capabilities for this view if you are connected to the local database or working in a mobile Web client.

**NOTE:** The responsibility for the SADMIN ID that comes with Siebel applications cannot be modified. However, you can copy this responsibility and modify the copy. For more information, see *Siebel Security Guide*.

You can start Siebel applications from the Siebel Developer Web Client or from the Siebel Web Client. Instructions for both are described below.

**TIP:** If you have not yet entered any license keys, you must enter the first license key from the Siebel Developer Web Client or from Siebel Tools. For more information, see “Entering License Keys” on page 25.

### To start a Siebel application from the Siebel Developer Web Client for the first time

1. From the Start menu, choose Programs and then choose your Siebel application.
2. Enter SADMIN in the User ID and Password fields.
3. In the Connect to field, choose the server database from the drop-down list and click OK.
   - For information about the other databases available in the Connect to drop-down list, see “Selecting a Data Source” on page 29.
4. If a message tells you that there is no valid license key, click OK.
5. In the License Key dialog box, enter the Siebel Business base application license key, and click OK.
   - For more information about license keys, see “Entering License Keys” on page 25. If you need to enter additional license keys, see “Entering an Additional License Key” on page 27.

### To start a Siebel application from the Siebel Web Client for the first time

1. Open your Web browser.
2. Go to the URL for your Siebel Web Client.
   - The login screen appears.
3. Enter SADMIN in the User ID and Password fields and click OK.

**NOTE:** If a message tells you that you have not been licensed for this feature, you must enter a valid license key, using either Siebel Tools or the Siebel Developer Web Client, before you can access the application. For more information, see "Entering License Keys" on page 25.

### Entering License Keys

The Siebel license key is generated so that your organization's users can access the Siebel products that your organization has purchased. The license key is a series of numbers (up to 54 digits). Your organization's specific license key is included in the Welcome Package. You must enter this license key before you begin to use the Siebel product, products, or optional modules that your organization has purchased. Because the license key resides in the database and not on the client machine, everyone who accesses the Siebel database uses the same license key.

Your license key activates the screens and views associated with the applications and modules that your organization has purchased. If you have been assigned multiple license keys, their effect is cumulative, as you enter them.

Customers upgrading from earlier versions of Siebel software may notice differences between the Siebel product and the products listed in the Welcome Package. These generally reflect changes in naming and bundling of Siebel products. For example, a functionality that was previously sold separately might now be bundled into a single product, or included in a base application, or simply have been renamed. It is recommended that you run the application itself to verify that all of the functionality that you expected is there.

Customers using Siebel products which are upgrades from earlier versions may notice differences between the views in the previous product and the views in the upgraded product. Reasons for this may include the following:

- The view you are looking for is not available from the application that you have launched.
- You logged in as a user who does not have responsibilities for the view. In order to evaluate all of the views available in the product, log in as a Siebel administrator.
- The method of accessing the functionality may have changed, or the functionality may have been replaced by more comprehensive features that work differently. Consult the Siebel Bookshelf for information on functionality changes in the latest release.
- The location or name of the screen or view may have changed. You can review the Site Map or consult the Siebel Bookshelf for information on current view locations.

However, if you do not see views that you expected, or if you see views that you did not expect, and feel that it impacts the functionality you have purchased, create a service request (SR) on OracleMetaLink 3. Alternatively, you can phone Global Customer Support directly to create a service request or get a status update on your current SR. Support phone numbers remain the same and are listed on OracleMetaLink 3. If your license key has expired, create a service request on OracleMetaLink 3.
Entering the First License Key

Before you enter the first license key, the following software must be correctly installed: Gateway Name Server, Siebel Server, Siebel Database Server, Siebel Business Applications, and one of the following: Siebel Developer Web Client or Siebel Tools. After the first Siebel Developer Web Client or Siebel Tools installation, the first user to connect to the Siebel database is required to enter a license key in order to use the product.

To enter the first license key

1. Start either Siebel Developer Web Client or Siebel Tools.
   
   **NOTE:** You have the choice of entering the first license key in either Siebel Developer Web Client or Siebel Tools. You can enter any Siebel license key in either Siebel Developer Web Client or Siebel Tools.

2. Log in as the system administrator and connect to the server database.
   
   Use SADMIN as the login name and SADMIN as the password, and choose Server in the Connect to drop-down list.
   
   **NOTE:** If you are the first to log in to Siebel Developer Web Client after a new Siebel installation, you get the error message “There is no valid license key in the database.” If you are the first to log in to Siebel Tools after a new Siebel installation, you get the error message “No valid license keys were found in the database.”

3. If you are logged in to Siebel Developer Web Client, click OK. If you are logged in to Siebel Tools, click Add Key.

4. In the License Key dialog box, enter the Siebel Business base application license key or the Siebel Tools license key, and then click OK.
   
   **CAUTION:** Enter only a Siebel Business base application license key or the Siebel Tools license key. If you enter an optional-module license key without having a Siebel Business base application license key already entered, an error message appears. The error occurs because the Home Page view is required to start Siebel Business base applications, and Home Page views are not included in optional module license keys.


6. Restart the Siebel Server System Service. (For more information, see *Siebel System Administration Guide.*)

7. Start the Siebel application associated with the license key that you entered.
   
   For example, if your license key is for Siebel Sales, start Siebel Sales; if your license key is for Siebel Tools, start Siebel Tools.

   **NOTE:** After entering the initial license key, if you discover that you made an error when entering the license key, you can correct the license key in the Key Value field in the Application Administration screen, License Key view.
Entering an Additional License Key

After entering the initial key, you can add or delete license keys through Siebel Business Applications as long as your Siebel user responsibility includes the Siebel License Key view. You can do this immediately if your purchase included more than one license key, or you can add license keys as your organization purchases more Siebel applications or optional modules.

To enter an additional license key using a Siebel application

1. Start the Siebel application—for example, Siebel Call Center. You can use Siebel Web Client or Siebel Developer Web Client.
2. Log in as the system administrator and connect to the server database.
   - Use SADMIN as the login name and SADMIN as the password, and choose Server in the Connect to drop-down list. If the system administrator’s password has been changed, use the current password.
3. Navigate to the Administration - Application screen > License Keys view.
4. Add the new license key:
   a. In the License Keys list, create a new record.
   b. In the new record, enter one license key in the Key Value field.
   c. Repeat Step a and Step b for each license key to be entered.
5. Close the application.
6. Restart the Siebel Server System Service. (For more information, see Siebel System Administration Guide.)

Start any Siebel application or module associated with a license key you have entered.

If you have any problems installing your license keys, create a service request (SR) on OracleMetaLink.

To enter an additional license key using Siebel Tools

1. Start Siebel Tools.
   - **NOTE:** To enter additional license keys in Siebel Tools, you must have first entered the Siebel Tools license key.
2. Log in as the system administrator and connect to the server database.
   - Use SADMIN as the login name and SADMIN as the password, and choose Server in the Connect to drop-down list. If the system administrator’s password has been changed, use the current password.
3. Choose Help > Technical Support from the menu bar.
4. In the Technical Support Information dialog box, click License Key.
5. Add a license key:
   a. In the License Keys dialog box, click Add Key.
b In the new record, type in one license key and then click OK.
c Repeat Steps a and b for each license key to be entered.

6 Close Siebel Tools.

7 Restart the Siebel Server System Service. (For more information, see Siebel System Administration Guide.)

Start any Siebel application or module associated with a license key you have entered.

License Key Fields

Table 5 describes the files in the license key record.

Table 5. Fields in the License Key Record

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key Value</td>
<td>The license key from your Welcome Package. Create a new record for each license key.</td>
</tr>
<tr>
<td>Status</td>
<td>Automatically entered based on the license key. OK means the license key has not expired. Expired means the license key has expired.</td>
</tr>
<tr>
<td>MaxUsers</td>
<td>Automatically entered based on the license key. The maximum number of concurrent users allowed in your license agreement with Siebel Systems.</td>
</tr>
<tr>
<td>Expires</td>
<td>Automatically entered based on the license key. The expiration date for the license key in your license agreement with Siebel Systems.</td>
</tr>
</tbody>
</table>

Hiding Access to License Keys

There are two ways that you can hide access to license keys: hiding the License Keys administrative view within Siebel applications and hiding the License Key button within Siebel Tools.

■ **Within Siebel Applications.** You may want to hide the License Keys view in the Application Administration screen, in order to discourage unauthorized users from attempting to change license keys. To hide the License Keys view, remove it from the responsibility associated with the users who should not have access to it. Responsibilities control the views to which users have access. For more information about creating and modifying responsibilities, see Siebel Security Guide.
Within Siebel Tools. You may want to disable the License Key button, found in the Technical Support Information dialog box (available from the Siebel Tools Help menu), in order to discourage unauthorized users from attempting to change license keys. You can disable the License Key button by selecting the Siebel Administrator responsibility and deleting the Edit License Key view.

Selecting a Data Source

When you start a Siebel application from the Siebel Developer Web Client, you specify the data source to which you want to connect.

The following databases are potentially available to administrators and end users:

- **Local.** Resides on your local computer. Can be synchronized with the corporate database. Typically stored on a laptop computer and used by mobile users who are not connected to a server when working.
- **Server.** This is your enterprise server database.
- **Sample.** A database of sample data, stored on your workstation. Using this database, you can experiment with a Siebel application without risk of damaging actual organizational data.

You should always perform system administration tasks against the server database. Although you can perform these tasks against your local database and synchronize, doing so has the potential to cause errors, including data conflicts. In addition, performance problems can result from a large local database, and from routing large numbers of transactions.

About the Sample Database

Siebel Business Applications include a sample database to use in demonstrating, evaluating, or experimenting with the Siebel client and Siebel Tools. (For more information, see Siebel Installation Guide for the operating system you are using.)

The sample database includes a number of demo user accounts (SADMIN is one of these). Each of these has a predefined responsibility that reflects the demo user’s position within the sample organization. If you log in to the sample database as a demo user, you can access certain views within Siebel Business Applications based on the demo user’s responsibility.

You do not need to install server components to run the Siebel sample database. However, you cannot access the Administration - Server Management screen if the server component is not running. The sample database cannot be copied to the server data sources.

To log on as a demo user, double-click the icon for the listed application in the Siebel client program group. Applications listed as “Demo” automatically log the indicated user into the sample database. For the other applications, enter the user ID and password in the logon dialog box and choose Connect to: Sample. For more information about the sample database, including a list of demo users, see Siebel Release Notes on OracleMetaLink 3.

The sample database that ships with the Siebel system has a built-in license key that includes access to all views and modules for a period of a year from the initial ship date of the product.
About Seed Data

The enterprise database of your default Siebel application contains some built-in seed data, such as organization, division, position, responsibility, employee records, and a list of countries for addresses. You can use this seed data for training or testing, or as templates for the real data that you enter. This seed data is only a starting point from which you can add more information as required. For more information on the seed data, including descriptions of seed data records, see Siebel Security Guide.

Summary of Applications Administration Tasks

Table 6 summarizes the additional application administration tasks necessary to set up various Siebel Business applications and optional modules.

Table 6. Application Administration Tasks

<table>
<thead>
<tr>
<th>If You Want to</th>
<th>You (May) Need to Perform</th>
<th>For More Information, See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use any base application (for example, Siebel Sales or Siebel Call Center)</td>
<td>Initial Setup tasks.</td>
<td>Chapter 3, “Initial Setup”</td>
</tr>
<tr>
<td></td>
<td>Ongoing administration tasks.</td>
<td>Chapter 4, “Ongoing Application Administration Tasks”</td>
</tr>
<tr>
<td>Control access to views or data</td>
<td>Establish a strategy for controlling access to views and data:</td>
<td>Siebel Security Guide</td>
</tr>
<tr>
<td></td>
<td>■ Establish the business environment (such as organizations, divisions, territories)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Add employees</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Assign responsibilities to employees</td>
<td></td>
</tr>
<tr>
<td>Launch a global deployment</td>
<td>Locale and language administration tasks.</td>
<td>“Setting Up Locales” on page 37</td>
</tr>
<tr>
<td></td>
<td></td>
<td>“Setting Up Languages” on page 64</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Siebel Global Deployment Guide</td>
</tr>
<tr>
<td>Manage global accounts</td>
<td>Account administration tasks: Set up global account hierarchies.</td>
<td>Chapter 27, “Global Accounts”</td>
</tr>
</tbody>
</table>
Table 6. Application Administration Tasks

<table>
<thead>
<tr>
<th>If You Want to</th>
<th>You (May) Need to Perform</th>
<th>For More Information, See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Application Services Interfaces (ASIs) for accounts, contacts, or households</td>
<td>Set up Web services and activate workflows for the ASIs.</td>
<td>Chapter 24, &quot;Integration Using ASIs&quot;</td>
</tr>
<tr>
<td>Create catalogs for data, including products</td>
<td>Create catalogs for products, literature, solutions and auctions.</td>
<td>Siebel Order Management Guide</td>
</tr>
<tr>
<td>Use Correspondence, Presentations, and Proposals functionality</td>
<td>Set up the Siebel Document Server, and create templates.</td>
<td>Siebel Correspondence, Proposals, and Presentations Guide</td>
</tr>
<tr>
<td>Manage content with Content Center</td>
<td>Set up a staging environment, set up content objects and workflows, and set up content types.</td>
<td>Siebel Content Publishing Guide</td>
</tr>
<tr>
<td>Manage a microsite</td>
<td>Microsite administration tasks.</td>
<td>Siebel Content Publishing Guide</td>
</tr>
<tr>
<td>Use the calendar to set up resources, such as conference rooms, equipment, and projectors</td>
<td>Calendar administration tasks.</td>
<td>Chapter 16, &quot;Calendar&quot;</td>
</tr>
<tr>
<td>Use Assignment Manager to automatically assign tasks to appropriate users</td>
<td>Create skills and other criteria.</td>
<td>Siebel Assignment Manager Administration Guide</td>
</tr>
<tr>
<td>Use Siebel Marketing</td>
<td>Marketing administration tasks.</td>
<td>Siebel Marketing Installation and Administration Guide</td>
</tr>
<tr>
<td>Manage lists of prospects, contacts, accounts, positions, and employees</td>
<td>List Management tasks.</td>
<td>Siebel Marketing User Guide and Chapter 19, &quot;Global Target List Management&quot;</td>
</tr>
<tr>
<td>Use Competency Management System</td>
<td>Skills and competencies administration tasks.</td>
<td>Siebel Performance Management Guide</td>
</tr>
<tr>
<td>Use Time Sheets and Expense Reports</td>
<td>Time Sheet and Expense Report setup tasks, such as creating work types.</td>
<td>Siebel Professional Services Automation Guide</td>
</tr>
</tbody>
</table>

**NOTE:** These are different skills than those used by Assignment Manager.
### Table 6. Application Administration Tasks

<table>
<thead>
<tr>
<th>If You Want to</th>
<th>You (May) Need to Perform</th>
<th>For More Information, See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Service schedules, Service Assets, Warranties</td>
<td>Service administration tasks.</td>
<td><em>Siebel Field Service Guide</em></td>
</tr>
<tr>
<td>Manage orders and the order process</td>
<td>Order administration tasks.</td>
<td><em>Siebel Order Management Guide</em></td>
</tr>
</tbody>
</table>
This chapter is about initial setup tasks. It includes the following topics:

- "About Initial Setup" on page 33
- "Summary of Initial Setup Tasks" on page 34
- "Adding Views to the Application" on page 35
- "Completing Employee Setup" on page 35
- "Assigning Skills" on page 37
- "Setting Up Locales" on page 37
- "Setting Up Satmetrix Survey Reports" on page 41

## About Initial Setup

Once your Siebel products are successfully installed, you need to perform a number of tasks to set up and administer the application.

Initial setup tasks are those which must be completed in order for your Siebel applications to work correctly, and then may be done infrequently, for instance, as your company grows.

Ongoing tasks are done on an occasional or ongoing basis, and are described in Chapter 4, "Ongoing Application Administration Tasks."
## Summary of Initial Setup Tasks

Table 7 summarizes the initial setup tasks and the order in which you should perform them.

<table>
<thead>
<tr>
<th>Task</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add any custom views.</td>
<td>Custom views are created in Siebel Tools and must be added to your Siebel application. Custom views should be added to the Views view before you define responsibilities. For information about adding views, see “Adding Views to the Application” on page 35.</td>
</tr>
<tr>
<td>Determine access control strategy and define business environment structure.</td>
<td>Siebel applications can be set up to support many strategies for your company to control access to views and data. These strategies include methods such as defining your business environment structure (organizations, internal and external divisions, and so on), defining employee positions, and creating access groups so that specific groups of people have access to specific views and data. These decisions should be made early in the deployment process, so that the strategy can be implemented during the initial setup. For more information about controlling access to views and data, and the procedures for implementing access control, see Siebel Security Guide.</td>
</tr>
<tr>
<td>Enter employee records into system (database and application) and determine employee access to views and data.</td>
<td>Enter employee records after you have defined your business environment structure. You need to assign at least one responsibility to each employee, and you may also assign organizations, positions, or other access control parameters. For more information about entering or deactivating employee records, see Siebel Security Guide.</td>
</tr>
<tr>
<td>Complete employee setup.</td>
<td>For information about associating additional information to an employee record, see ”Completing Employee Setup” on page 35.</td>
</tr>
<tr>
<td>Set up locales.</td>
<td>Locale Codes and parameters are necessary for a global deployment. For more information, see ”Setting Up Locales” on page 37.</td>
</tr>
</tbody>
</table>
Adding Views to the Application

Developers create new views through Siebel Tools. In order for the views to become available for administrators to work with, you must add them to the Views screen in the application before you define your business environment.

Example: You want to add an Opportunities view in the Reference screen. In Siebel Tools, you create the view and name it Reference Opportunities. (For details on creating views, see Configuring Siebel Business Applications.) In your Siebel application, you follow the steps below and add the Reference Opportunities view in the View Administration view. After it has been added in both places, the view can be made accessible to the appropriate users. For details about controlling visibility to views, see Siebel Security Guide.

To add customized views to the Siebel application

1. Navigate to the Administration - Application screen > Views view.
2. In the Views list, create a new record, and complete the necessary fields.

You generally do not need to modify or delete views that are already listed. You would only need to modify a view if its name was changed in Siebel Tools. A view would need to be deleted only if it no longer existed in the data model schema, or if you did not want anyone to have access to it. Instead of deleting views, administrators should remove the views from responsibilities and keep them in the database.

**NOTE:** Only visibility-level views can be configured to appear in the Site Map.

Completing Employee Setup

After completing the employee setup procedures described in the Siebel Security Guide, which are required to allow employee access to the Siebel application, views and data, you complete employee setup by providing additional information. This can include the following:

- **Assignment Rules.** Allows you to see and administer the assignment rules for an employee. For more information on assignment rules, see Siebel Assignment Manager Administration Guide.
  
  **NOTE:** You must be logged on to a server database to use the Employee Assignment Rules view.

- **Availability.** Lists the projects for which an employee is on staff, or for which an employee has been requested. For more information, see Siebel Professional Services Automation Guide.
  
  **NOTE:** Employees can also change their availability in the Availability view on the User Preferences screen.

- **Exception Hours.** Specifies what days and hours an employee is not available.

- **Utilization.** Displays a chart with the monthly and quarterly utilization of the currently selected employee. Managers use this chart for monitoring professional services projects and employees. For more information about professional services, see Siebel Professional Services Automation Guide.
To complete the employee setup

1. Navigate to the Administration - User screen > Employees view.
2. In the Employees list, drill down on the employee for whom you want to add additional information.
3. Click the More Info view tab.
4 In the form, complete any necessary fields. Some of the fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>Specifies which Siebel product or group of software components to associate with the currently selected employee. For more information, see Siebel Anywhere Administration Guide.</td>
</tr>
<tr>
<td>Available Until</td>
<td>May be used to indicate the active period of an employee. Used in conjunction with the Availability, Overtime Availability, and Next Available fields.</td>
</tr>
</tbody>
</table>

5 Click any other appropriate view tab.

6 Create a new record, if needed.

7 Enter the appropriate information.

Assigning Skills

At the levels of organizations, positions, and employees, you can add skills. Skills are used for assigning employees to certain projects, service requests, and so on. Skills added to an organization apply to all employees assigned to that organization. Skills assigned to a position apply only to the employee assigned to that position. You create skills with Siebel Tools.

Employees can track and update their own skill profiles in the User Preferences Profile view.

For more information about how your Siebel application uses skills, see Siebel Assignment Manager Administration Guide.

Setting Up Locales

A locale is a set of rules guiding how common data is displayed to the user or received from the user. These rules are used to format data from a database before displaying the resulting information in output fields on the user interface. Siebel applications support language and geographical conventions for the display language of picklists, and formatting of data such as dates, time, numbers, and currency based on locale settings.

The Locale information is stored in the Locale Table (S_LOCALE). The data in this table is maintained by the administrator using the Locale Administration view.

The locale with which the Component Object Manager processes are initialized is determined by the value of the parameter Locale Code. Although this is set during installation, it may be changed to the locale code of any locale that is preconfigured with the Siebel application or added by the administrator. The Locale Code parameter can be set at the Enterprise, Server, or Component level.

A number of locales and their parameters come prebuilt with the standard Siebel application. You can also create and revise locales in the Locale Administration view.
After a locale and its parameters are defined, you can create translations for locale names that display in the locale pick applet, rather than the three letter acronym locale code. For example, instead of showing ENU as locale name, the administrator provides English–United States as a translation for English speakers and Inglese–Stati Uniti d’America for Italian speakers. Only translated locale names are exposed to end-users on locale pick applets.

**NOTE:** Whereas the Siebel Web Clients use the locale settings specified in the Locale Administration view, the Siebel Mobile Web Client and the Siebel Developer Web Client use the locale settings defined in the client operating system’s regional settings.

Setting up a Server Object Manager includes assigning a locale to the Object Manager. Because the locale directs how locale sensitive information, such as date, time, and numbers are different from country to country, customers must complete an Object Manager for each country in which they have users in order to provide the users with correct looking data for their locale. (It is not necessary to complete an Object Manager for each country in Siebel Developer Web Clients, because dedicated clients use the regional settings of the dedicated client machine.)

**To create a locale**

1. Navigate to the Administration - Data screen > Locale view.
2. In the Locale list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date Separator</td>
<td>Designates the symbol used to separate the components of the date. This symbol replaces the forward slash (/) in the date format.</td>
</tr>
</tbody>
</table>
| International Dialing Code| Designates the country codes to display in phone numbers, suppressing the country code for phone numbers that are in the user’s locale. For example, if the phone numbers for two accounts are the following:  
  - +33 1-23 42 34 56, for an account based in France (+33 is the country code for France)  
  - +1 6502955000, for an account based in the U.S. (+1 is the country code for the U.S.)  
  To a user based in the U.S. (locale ENU) the International Dialing Code value is “USA and Canada (1)”, and the above phone numbers display as follows:  
  - +33 1-23 42 34 56  
  - (650) 295-5000 |
### List Separator
Designates the symbol used to separate consecutive numbers in a list.

For example:
- In the U.S., consecutive numbers are separated by a comma: 1.23,3.57,4.01
- In France, consecutive numbers are separated by a semicolon: 1,23;3,57;4,01

### Locale Code
Siebel applications use the three letter acronym (TLA) code conventions of Microsoft for locale name. In most cases, the TLA is created by taking the two-letter language abbreviation from the ISO Standard 639 and adding a third letter as appropriate to form a unique identifier.

For information on Microsoft codes, see your Microsoft documentation.

### Locale Name
The naming convention is generally *Language Name–Territory*, for example, English–United States, English–United Kingdom, or French–France.

### Long Date Format
Specifies the appropriate long date format, using spaces, commas, or periods as separators. Long date formats contain day and month names.

For example: dddd, MMMM dd, yyyy as in Friday, June 21, 2004

A forward slash (/) in the format acts as a placeholder for the Date Separator symbol.

**NOTE:** Long dates are only supported for the calendar, the Gantt chart, salutation text on the home page, and balloon text in some charts.

### Negative Currency Format
Specifies the location of the negative sign (-) with respect to the currency symbols and digits (100).

For example:
- For U.S. format, ($32.45), select $s100
- For British format, -£32.40, select s100

### Number Decimal Separator
Specifies the symbol used to indicate the decimal place.

For example:
- French format: 1 234,34 (comma as decimal symbol)
- U.S. format: 1,234.34 (period as decimal symbol)
Initial Setup ▶ Setting Up Locales

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number Fractional Digits</td>
<td>Designates the number of digits after the decimal separator. For example, the number 12.340 has a number fractional of 3. This applies to data fields of type DTYPE_NUMBER.</td>
</tr>
</tbody>
</table>
| Number Grouping Separator | Designates the symbol used to group numbers. For example:  
  - French format: 1 234 (space as number grouping separator)  
  - German format: 1.234 (period as number grouping separator)  
  - U.S. format: 1,234 (comma as number grouping separator) |
| Number Leading Zero       | Designates whether to display a leading zero in numbers less than one. For example, .7 or 0.7.                                                                                                                |
| Positive Currency Format  | Specifies the location of the currency symbols with respect to the digits (100). For example: for U.S. format, $32.45, select s100.                                                                            |
| Short Date Format         | Specifies the appropriate shortened date format. For example:  
  - International format: yymmdd  
  - U.S. format: mm/dd/yy  
  - German format: dd.mm.yy  
  The forward slash in the string mm/dd/yy is actually a placeholder. It is replaced with the symbol specified in the Date Separator field. For example, if the Date Separator value is a dash, -, then April 10, 2002 displays as 04-10-2002. |
| Time AM Designator        | Specifies the symbol for designating time between 00:00 and 12:00. For example: AM, a.m., am                                                                                                               |
| Time Leading Zero         | Designates whether to display a leading zero in time fields. For example:  
  - 12 hour clock with leading zero: 01:03 AM, 01:03 PM  
  - 12 hour clock without leading zero: 1:03 AM, 1:03 PM  
  - 24 hour clock with leading zero: 01:03, 13:03  
  - 24 hour clock without leading zero: 1:03, 13:03 |
To create a translation for a locale name

1. Navigate to the Administration - Data screen > Locale view.
2. Select the appropriate record.
3. Click the Locale Name Translation view tab.
4. On the Locale Name Translation list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time PM Designator</td>
<td>Specifies the symbol for designating time between 12:00 and 24:00. For example: PM, p.m., or pm</td>
</tr>
<tr>
<td>Time Separator</td>
<td>Specifies the symbol used to separate the hours from the minutes.</td>
</tr>
<tr>
<td>UI Directionality</td>
<td>Designates the direction of the text displayed.</td>
</tr>
</tbody>
</table>

To edit the current locale

1. Edit the locale record. (See “To create a locale” on page 38.)
2. To have the edits take effect, restart the application’s Object Manager.

(For information about shutting down and starting Siebel Server components such as an Object Manager, see the Siebel System Administration Guide.)

Setting Up Satmetrix Survey Reports

NOTE: This section only applies to those who have purchased Siebel Satmetrix Surveys or who have purchased surveys directly from Satmetrix Systems.

In order to view Satmetrix survey reports through your Siebel application, you need to:
Initial Setup  ■ Setting Up Satmetrix Survey Reports

- Add the Account Satmetrix Survey View view to the appropriate user responsibilities. For information about how to add views to responsibilities, see *Siebel Security Guide*.
- Enter the secret key string provided by Satmetrix Systems into the Satmetrix Key Value system preference. For information about how to change system preferences, see "Setting System Preferences" on page 46.
- Extend the List of Values for WI_ARG_TYPE as described in "To extend the List of Values for WI_ARG_TYPE" on page 42.
- Set up the symbolic URL for access to the Satmetrix reports server, as described in "To set up the symbolic URL for access to Satmetrix Reports" on page 42.

**To extend the List of Values for WI_ARG_TYPE**

1. Navigate to Administration - Data > List of Values.
2. Create a new record, and complete the necessary fields.
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>WI_ARG_TYPE</td>
</tr>
<tr>
<td>Display Value</td>
<td>Satmetrix</td>
</tr>
<tr>
<td>Language-Independent Code</td>
<td>Satmetrix</td>
</tr>
<tr>
<td>Active</td>
<td>Yes</td>
</tr>
<tr>
<td>Translate</td>
<td>Yes</td>
</tr>
<tr>
<td>Replication Level</td>
<td>All</td>
</tr>
</tbody>
</table>

For more information about creating List of Values records, see Chapter 5, "Working with Lists of Values."

**To set up the symbolic URL for access to Satmetrix Reports**

1. Navigate to the Administration - Integration screen > WI Symbolic URL List view.
2. From the Show drop-down list, select Symbolic URL Administration.
3. In the Symbolic URL list, select SatmetrixSurvey.
4. Make sure the URL is the URL for the reports server provided by Satmetrix Systems.
In the Symbolic URL Arguments list, complete the fields, using the following table as a guide.

<table>
<thead>
<tr>
<th>Name</th>
<th>Required Argument</th>
<th>Argument Type</th>
<th>Argument Value</th>
<th>Append as Argument</th>
<th>Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>EncodeUrl</td>
<td>Yes</td>
<td>Command</td>
<td>FALSE</td>
<td>Yes</td>
<td>1</td>
</tr>
<tr>
<td>version</td>
<td>Yes</td>
<td>Constant</td>
<td>Obtain from Satmetrix</td>
<td>Yes</td>
<td>2</td>
</tr>
<tr>
<td>windowsize</td>
<td>Yes</td>
<td>Command</td>
<td>WebControl width=1000 height=500 border=1</td>
<td>Yes</td>
<td>3</td>
</tr>
<tr>
<td>type</td>
<td>Yes</td>
<td>Constant</td>
<td>acct</td>
<td>Yes</td>
<td>4</td>
</tr>
<tr>
<td>acctid</td>
<td>Yes</td>
<td>Field</td>
<td>Id</td>
<td>Yes</td>
<td>5</td>
</tr>
<tr>
<td>acctname</td>
<td>Yes</td>
<td>Field</td>
<td>Name</td>
<td>Yes</td>
<td>6</td>
</tr>
<tr>
<td>contactid</td>
<td>Yes</td>
<td>Constant</td>
<td>*</td>
<td>Yes</td>
<td>7</td>
</tr>
<tr>
<td>contactname</td>
<td>Yes</td>
<td>Constant</td>
<td>*</td>
<td>Yes</td>
<td>8</td>
</tr>
<tr>
<td>user</td>
<td>Yes</td>
<td>Profile Attribute</td>
<td>Login Name</td>
<td>Yes</td>
<td>9</td>
</tr>
<tr>
<td>domain</td>
<td>Yes</td>
<td>Constant</td>
<td>Obtain from Satmetrix</td>
<td>Yes</td>
<td>10</td>
</tr>
<tr>
<td>model</td>
<td>Yes</td>
<td>Constant</td>
<td>Obtain from Satmetrix</td>
<td>Yes</td>
<td>11</td>
</tr>
<tr>
<td>created</td>
<td>Yes</td>
<td>Field</td>
<td>Timestamp</td>
<td>Yes</td>
<td>12</td>
</tr>
<tr>
<td>token</td>
<td>No</td>
<td>Satmetrix</td>
<td>Satmetrix Surveys, CalculateToken</td>
<td>Yes</td>
<td>13</td>
</tr>
</tbody>
</table>
This chapter assumes that you have successfully installed your Siebel product and have completed the tasks in Chapter 3, "Initial Setup."

The tasks described in this chapter set up defaults that are used throughout your Siebel application. For some implementations, the default settings provided through the seed data meet a company’s needs without customization. In other cases, administrators find it useful to make adjustments to these defaults.

This chapter includes the following topics:

- "Setting System Preferences” on page 46
- "Setting Up Predefined Queries” on page 46
- "Enabling Cancel Query” on page 48
- "Setting Up Currencies” on page 48
- "Setting Up Currency Conversion” on page 50
- "Setting Up Expense Types” on page 53
- "Setting Up Payment Terms” on page 54
- "Setting Up Periods” on page 55
- "Working with Telephone Formats” on page 56
- "Setting Up Pager Companies” on page 60
- "About Date Formats” on page 61
- "Setting Up ZIP Codes” on page 61
- "Administering Global Time Zone Support” on page 61
- "Setting Up Email, Fax, and Mail Accounts (Contact Us)” on page 63
- "Setting Up Industries” on page 64
- "Setting Up Languages” on page 64
- "About Case-Insensitive and Accent-Insensitive Queries and Searches” on page 65
- "Adding Web Browser Capabilities” on page 66
- "Adding Additional Web Browsers” on page 67
- "Administering Quick Fill Templates” on page 69
- "Setting Up Default View Links for Screen Home Pages” on page 70
Setting System Preferences

System preferences control how Siebel applications operate in your environment. You need to review default settings and modify these as appropriate for your environment.

For a list of the system preferences in Siebel applications, see Appendix A, “System Preferences.”

To set system preferences
1. Navigate to Administration - Application screen > System Preferences view.
2. Check that the default System Preference Values are correct in your environment, or change values for system preferences as needed.

Some system preferences may not take effect until the affected components are restarted. (For information about shutting down and starting Siebel Server components such as an Object Manager, see the Siebel System Administration Guide.)

Setting Up Predefined Queries

This section discusses how to set up predefined queries. It includes the following topics:

- About Setting Up Predefined Queries. Predefined queries (PDQ) automate queries that a user can perform online.
- Things to Remember. A list of things to remember when setting up queries.
- Procedures. How to create a predefined query by saving a query and set up a query in the Predefined Query view.

About Setting Up Predefined Queries

Predefined queries (PDQ) automate queries that a user can perform online. Rather than creating a query, entering criteria, and running the query, the user selects a PDQ from the Queries drop-down list.

Predefined queries can be private (available only to the person who created them) or they can be public (available to all the users of the application).

There are two ways to set up predefined queries:

- Create and execute a query in the usual way, and then save the query.
- Create or modify a predefined query in the Predefined Query screen.

Things to Remember

When setting up queries, remember:

- The Administrator can define a PDQ using both displayed and nondisplayed fields.
- You can reference only fields from the current applet’s business component in your query.
On occasion, using the wildcard * to find all entries in a field may cause a performance problem. If it does, use IS NOT NULL instead. For more information about query operators, see Siebel Fundamentals.

Predefined queries are defined on a business object. All screens based on the same business object display all the predefined queries created for that business object.

Querying on fields of data type DTYPE_NOTE is not supported on some database platforms.

**Procedures**

The following procedures describe how to create a predefined query by saving a query and how to set up a query in the Predefined Query view.

**To create a predefined query by saving a query**

1. Navigate to the screen where you want to run the query.
2. Create and execute a query.
3. From the application-level menu, choose Query > Save Query As.
4. In the Save Query As dialog box, enter a name for the query.
   - The query is added to your list of predefined queries. This query is private, and only you can view it.
5. If you want to make the query public:
   a. Navigate to the Administration - Application screen > Predefined Queries view.
   b. In the Predefined Queries list, deselect the Private field in the record for the query you just created.

**To set up a predefined query in the Predefined Query view**

1. Navigate to the Administration - Application screen > Predefined Queries view.
2. In the Predefined Queries list, create a new record, and complete the necessary fields.
   - Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>This is the name that appears in the predefined query drop-down list.</td>
</tr>
<tr>
<td>Object</td>
<td>The object upon which the query is performed.</td>
</tr>
<tr>
<td>Private</td>
<td>Marked if the query is available only to the person who created it.</td>
</tr>
<tr>
<td></td>
<td>When you unmark a query to make it public, the other users must first exit the application and reenter before they can see the newly public query.</td>
</tr>
</tbody>
</table>
Enabling Cancel Query

The cancel query feature allows users to stop their slow or incorrect queries. If the query does not return records within a given number of seconds (the timeout period), a dialog box appears, which allows the user to cancel the query.

The cancel query feature is enabled through the CancelQueryTimeOut parameter in the [SWE] section of the application configuration file (CFG).

To enable the cancel query feature

1. Open your application's configuration file, for example uagent.cfg.
2. Change the CancelQueryTimeOut parameter to

   ```
   CancelQueryTimeOut = timeout
   ```

   where `timeout` is any integer of zero or greater.

   For example, if `CancelQueryTimeOut = 3`, the cancel query dialog box appears if records are not returned within 3 seconds.

   **NOTE:** A timeout value of less than zero, for example, -1, disables the feature.

Setting Up Currencies

You specify the currencies your company uses by:

- **Making Currencies Active.** If the application includes the currency definitions you need, you make these currencies active.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query</td>
<td>The SQL code for the query.</td>
</tr>
<tr>
<td></td>
<td>When you create a query for a field that is a multi-value group, you can use the EXIST operator to query nonprimary child records.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> You cannot use SQL functions in the query for a predefined query.</td>
</tr>
<tr>
<td></td>
<td>For more information about the syntax, see about operators, expressions, and conditions in <em>Siebel Developer's Reference</em>.</td>
</tr>
<tr>
<td>Cache Result</td>
<td>If this is Y, the query returns all rows up to the value of the DSMaxFetchArraySize parameter set for the data source.</td>
</tr>
<tr>
<td></td>
<td>For information about setting DSMaxFetchArraySize, see about modifying Named Subsystems in the <em>Siebel System Administration Guide</em>.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> Setting DSMaxFetchArraySize to -1 and Cache Result to Y may cause memory problems for queries returning many rows.</td>
</tr>
</tbody>
</table>
Ongoing Application Administration Tasks ■ Setting Up Currencies

■ Defining Currencies. If you need additional currencies whose definitions the application does not include, you must also define these currencies.

NOTE: If you use multiple currencies, you must also set up exchange rates before you import data that contains foreign currencies and before you use any of the Siebel currency features.

Making Currencies Active

The application includes more than 30 currency definitions. If your currency is one of these, you need only mark it as active.

To make currencies active

1. Navigate to Administration - Data screen > Currencies view.
2. For any currency that you want to make active, click the Active column in the Currencies list.
3. (Optional) Enter the Start Date and End Date in the form to specify the date when this currency becomes active and the date when it is no longer active.

Defining Currencies

If your company uses any currencies that the application does not include, you must define them and mark them as active.

If you modify the definition of currencies, you must clear the cache or log out and back in to the application before the modification becomes visible. For more information about clearing the cache, see “Clearing the Cache” on page 73.

You cannot delete a currency once you have defined it. If you no longer use it, you can mark it as inactive.

To define a currency

1. Navigate to Administration - Data screen > Currencies view.
2. Create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>A three-letter code for the currency.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the currency.</td>
</tr>
<tr>
<td>Issuing Country</td>
<td>The country that issues the currency.</td>
</tr>
<tr>
<td>Symbol</td>
<td>The symbol for the currency, such as $.</td>
</tr>
</tbody>
</table>
Setting Up Currency Conversion

This section discusses how to set up exchange rates and includes related background information. It includes the following topics:

- **Setting Up Exchange Rates.** You must set up exchange rates used to convert currencies.
- **Understanding the Euro and Triangulation.** If a currency is part of the European Monetary Union, you convert it to other currencies through the Euro.
- **Currency Conversion Functionality.** The currency conversion rates that you set up are used by a number of features of Siebel applications.

**Setting Up Exchange Rates**

After you have set up your currencies, but before you use any currency features or import data with foreign currencies, you must set up exchange rates that are used to convert currencies.

If you fail to set up an exchange rate, currency is converted on a 1:1 basis. This means that the amount stays the same but the currency symbol changes.

**NOTE:** To calculate exchanges between currencies, you must set up an exchange rate twice—one for each currency. For instance, if you want to calculate exchange rates between U.S. dollars and Japanese yen, you must set up an exchange rate for yen to dollars, and set up another rate for dollars to yen.

### Setting Up Exchange Rates

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scale</td>
<td>The number of places after the decimal used for displaying currency in the interface. For example, U.S. Dollars has a scale of 2 to accommodate the cents, so an amount would be displayed as $10.50. If the scale were 1, this same amount would be displayed as $10.5.</td>
</tr>
<tr>
<td>Smallest Denomination</td>
<td>The smallest unit of currency available. For instance, the smallest unit of currency for the U.S. Dollar is one cent, or .01 dollars. If there were no cents, the scale would still be 2, but the smallest denomination would be $0.05.</td>
</tr>
<tr>
<td>EMU Triangulation</td>
<td>Check to indicate that this currency must be converted to other checked currencies using the EMU Triangulation method.</td>
</tr>
<tr>
<td>Active</td>
<td>Indicates whether or not the currency can be chosen by the end user.</td>
</tr>
<tr>
<td>Start Date</td>
<td>The date when the currency becomes active.</td>
</tr>
<tr>
<td>End Date</td>
<td>The date when the currency is no longer active.</td>
</tr>
<tr>
<td>Extended Scale</td>
<td>The number of places after the decimal used for storing currency data in the database. If the values in the Extended Scale and Scale fields are different, results of currency calculations, for instance conversions or discounts, may be different than expected. This is because the currency values that are stored in the database are used for these calculations, rather than the displayed values.</td>
</tr>
</tbody>
</table>
To set up exchange rates

1. Navigate to Administration - Data screen > Currencies view.
2. In the Currencies list, select the currency for which you want to establish exchange rates.
3. Click the Exchange Rates view tab.
4. In the Exchange Rates list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Currently, Daily is the only type used.</td>
</tr>
<tr>
<td>To Currency</td>
<td>The currency to which you are converting the currency selected in the currencies list.</td>
</tr>
<tr>
<td>Exchange Rate</td>
<td>The conversion rate.</td>
</tr>
<tr>
<td>Exchange Date</td>
<td>The date of this conversion rate. When converting currencies, Siebel applications use the exchange rate whose date is closest to, but not past, the date of the transaction. Depending on the accuracy that you need and on how much currency values are fluctuating, you may want to enter a new exchange rate every week, month, quarter, or year. Siebel applications use the Exchange Date only to convert currencies in transactions in which money has been or will be received. For example, Quote Item Price has an Exchange Date field, because it represents money that your company will receive, and your sales representatives should enter the date when the money will be received.</td>
</tr>
</tbody>
</table>

5. Repeat this process to add additional exchange rates.

You must restart the Siebel client or use the clear cache command before any changes to exchange rates can be seen in your Siebel application. For more information about clearing the cache, see “Clearing the Cache” on page 73.

The Euro and Triangulation

**NOTE:** As of January 2002, the Euro Triangulation method for converting between currencies belonging to EMU members is not needed for present and future currency exchanges. However, the method is still available in Siebel applications, as are the old currencies, so that historical data can be maintained accurately. The following description applies only to historical data needing conversion prior to the 2002 switch to the Euro for the EMU member countries.

If a country is a member of the European Monetary Union (EMU), you should convert its currency to other currencies through the Euro. This is called triangulation, and it is used whenever either currency being converted has EMU Triangulation checked.
For example, if you are converting from USD to DEM and DEM has EMU Triangulation checked, you must set up the conversion rates between US dollars and the Euro and between the Euro and US dollars. You do not have to check the EMU Triangulation field for USD. The DEM is converted to EUR according to the fixed exchange rate set by the European Monetary Union, and then the amount in EUR is converted to USD according the exchange rate you set up.

The EMU Triangulation field is already checked for the following European Monetary Union member nations: Germany (DEM), Belgium (BEF), Spain (ESP), France (FRF), Ireland (IEP), Italy (ITL), Netherlands (NLG), Austria (ATS), Portugal (PTE), Finland (FIM), and Luxembourg (LUF). However, you can check or clear this field. For instance, if the United Kingdom or Sweden joins the EMU, then you can check the field for that currency.

To calculate triangulation conversion, the conversion rate is always expressed to six significant figures. Conversions from one national currency unit into another are made by:

1. Converting the monetary amount from the national currency unit into the Euro.
2. Rounding the result to not less than three decimal places.
3. Converting the result to the target national currency.
4. Rounding the result to the lowest subunit of the target national currency, such as pfennig for the German mark or centime for the French franc.

**NOTE:** The EMU Triangulation field should be checked only for currencies that are subdivisions of the Euro.

### Currency Conversion Functionality

Currency conversions currently occur in your Siebel application in various features. Some examples follow:

- **Price lists.** When you change the currency code of a price list, it prompts you for an exchange date and converts the prices of all of the price list items.

- **Quotes.** When you change the currency code of a quote, it will convert the discount amounts and discount prices.

- **Forecasting.** When you update forecast information from the opportunity, it will do a currency conversion from the opportunity currency to the forecast currency if the currencies are different. When you roll up the forecast lines, it will do a conversion from the forecast line currency to the rollup forecast currency if the currencies are different.

- **Projects.** When you create expenses in a currency different from the project’s currency and submit the expenses to the project, the expense amount will be converted from the expense currency to the project currency in the Project Time Expenses Summary and Project Time Expenses Adjustments views.

- **Rate lists.** When you change the currency code of a rate list, it will prompt you for an exchange date and convert the prices of all of the price list items.

- **Expense reports.** When you prepare expense reports, you can perform currency conversion between the expense currency and your default currency.

- **Reports.** The following reports support currency conversion:
Setting Up Expense Types

When employees create expense reports, they choose an expense type for each line item in the report. For example, when employees travel on business, they might have to enter line items with expense types Food, Airfare, Car Rental, Hotel, and so on.

When you set up expense types, you specify what expense types are available to employees in the drop-down list that they use to choose expense types. You also specify how these expense types are to be categorized and summarized in expense reports.

You can also create establishments that are associated with these expense types. For example, if the expense type is Airfare, you might associate establishments with it such as Air Canada and British Airways. For more information about associating expense types with establishments, see Siebel Professional Services Automation Guide.

**NOTE:** Before you can add expense types and establishments, you must add them in the List of Values Administration screen so that they can be displayed in the drop-down list. Create expense types under EXP_ITEM_TYPE, and create establishments under EXP_ITEM_ESTAB. For more details about List of Values administration, see Chapter 5, “Working with Lists of Values.”

**To set up expense types**

1. Navigate to the Expense Reports screen > Expense Types view.
Setting Up Payment Terms

Payment terms are the different terms that you offer to your customers, such as Net 30 days and Net 60 days. You set up payment terms so that they are available in your Siebel application, for example in the Quotes screen.

To set up a payment term

1. Navigate to the Administration - Data screen > Orders > Payment Terms view.
2. Create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payment Term</td>
<td>Enter a name for the payment term, such as Net 30.</td>
</tr>
<tr>
<td>Net Days</td>
<td>If the payment term requires payment in a specific number of days after the order date, enter the number of days. Optional.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the payment term. Optional.</td>
</tr>
<tr>
<td>Discount</td>
<td>If there is a discount for early payment, enter the amount of the discount. Optional.</td>
</tr>
<tr>
<td>Discount Days</td>
<td>If there is a discount for early payment, enter the number of days within which a customer must pay to qualify for the discount. Optional.</td>
</tr>
<tr>
<td>Due</td>
<td>If there is a specific due date for payment, enter the due date. Optional.</td>
</tr>
<tr>
<td>Integration ID</td>
<td>Users should not modify this system field. It is a cross-reference that links the Siebel application to corresponding payment term information in the back-office application.</td>
</tr>
</tbody>
</table>
Setting Up Periods

Periods are time periods that are used in your business, such as Q1 2002 or Jan. 2001. Periods are used extensively in the Siebel application, such as in forecasting, time sheets, incentive compensation, and expense reports.

Be sure to set up periods far enough into the future that forecasting will work. For example, the default forecast is for seven months ahead. Therefore, if you keep this default, you must create periods defined for at least seven months from the current date for forecasting to work correctly.

After setting up a period, you can associate Period Units with it. Period Units allow you to define one time unit in terms of another. For example, day periods can be associated with week periods for use in Timesheets. When a new timesheet is created, based on a week period, each day in that week is also added to the timesheet. This functionality requires the day periods to be associated as Period Units with the week period.

To set up periods

1. Navigate to the Administration - Data screen > Periods view.
2. In the Period Definition list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Period</td>
<td>Enter a name for the period, such as Q1 2001.</td>
</tr>
<tr>
<td>Closed</td>
<td>Select this to indicate that the period has already closed.</td>
</tr>
<tr>
<td>Start</td>
<td>Enter the start date for the period.</td>
</tr>
<tr>
<td>End</td>
<td>Enter the end date for the period.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of period, such as month, quarter, or year.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the period.</td>
</tr>
</tbody>
</table>

To associate period units with a period

1. Navigate to the Administration - Data screen > Periods view, and select the appropriate period.
2. In the Period Units list, create a new record.
3. In the Period Units dialog box, select all the period units to associate with this period, and then click OK.
Working with Telephone Formats

Telephone formats specify how phone numbers are formatted when users enter the numbers in phone number fields. You can only have one phone format for each country code. The phone format is applied only when users enter numbers without other formatting symbols, such as a slash (/), or dash (-).

Before users enter phone numbers, do the following:

- Set the default locale. See “Setting Up Locales” on page 37. The default phone format is determined by the locale setting.
- Define phone formats for countries that do not have a format already defined. See “Specifying Phone Formats” on page 57.

If a user enters a phone number from a country for which the format has not yet been specified, the phone number might be formatted incorrectly.

NOTE: If you define any new phone formats, coordinate with communications administrators who specify CTI functionality and define dialing filters. For more information, see Siebel Communications Server Administration Guide.

CAUTION: If you modify the phone formats that are provided with your Siebel application, make sure that you test the changes thoroughly.

North American Phone Formats

The default format for North American phone numbers is (000) 000-0000. The phone formatting logic for North American phone numbers works as follows:

- If the user enters 10 digits in a phone number field, it is formatted as (123) 123-1234.
- If the user enters more than 10 digits, the first 10 digits are formatted as (123) 123-1234, and the rest of the digits are formatted as the extension number. The user can enter up to 40 digits.
- If the user enters fewer than 10 digits, an error message is displayed.
- If the user begins the phone number with a zero (0), an error message is displayed.

This formatting logic is followed even when the default locale is not North America.

International Phone Formats

An international phone number is a phone number for a country other than the current default country.

To enter an international phone number in a phone number field, the user must enter a plus sign (+), followed by the country code. For example, the user can enter +44. If the user does not enter a country code, the default country code is assumed.

When a user enters an international phone number in a phone number field, the formatting of the number depends on the following:

- The number of digits that the user enters
- The number of digits specified for the country in the phone format
The formatting logic is described in the following table.

<table>
<thead>
<tr>
<th>Number of Digits</th>
<th>Formatting Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Same as in format</td>
<td>Formatted as specified.</td>
</tr>
<tr>
<td>More than in format</td>
<td>First digits are formatted as specified. The rest of the digits are formatted as an extension number.</td>
</tr>
<tr>
<td>Fewer than in format</td>
<td>Entry is accepted without an error message. This is to accommodate phone numbers of different lengths.</td>
</tr>
</tbody>
</table>

If there is no phone format for the indicated country, the number remains formatted in the same way that the user enters the number. No error message is displayed.

**Maximum Length for International Phone Numbers**

Refer to Table 8 to calculate the safe maximum length for international phone numbers:

Table 8. Maximum Length for International Phone Numbers

<table>
<thead>
<tr>
<th>Is there a phone format for the country?</th>
<th>Then, the safe maximum length for international phone number is</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>C + 2N + E + 2 ≤ 40</td>
</tr>
<tr>
<td>No</td>
<td>2C + 2N + E + 2 ≤ 40</td>
</tr>
</tbody>
</table>

In the formulae in Table 8:
- C is the length of the country code
- N is the length of the city code and the subscriber number, including any formatting, such as spaces or hyphens
- E is the length of the extension number

*Figure 1* shows an example.

![Figure 1. Example Calculation of Maximum Length of International Phone Number](image)

**Specifying Phone Formats**

If your users need to enter phone numbers for countries for which a format has not been entered in your application, you must specify phone formats for those countries.

To specify phone formats

1. Navigate to the Administration - Data screen > List of Values view.

2. Query the Type field for the entry PHONE_FORMAT to see the existing phone formats.

3. Create a new record, and complete the necessary fields.
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Value</td>
<td>Enter the format string.</td>
</tr>
<tr>
<td>Language-Independent Code</td>
<td>Use the number zero (0) to represent required digits, the character # to represent optional digits, and other formatting characters to represent how to format the phone number. Do not include any alphanumeric characters other than zero. For example, to format an Australian phone number, which includes a two-digit area code and a six- or eight-digit number, use (00) 000# 000#. You do not need to include characters to represent the country code in the format. When a user enters a number, the country code is automatically shown if the default country is different from the country code.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter the country code of the new format. When adding new codes, make sure that no country code is a prefix of any other. For example, because India’s country code is 91, you should not add a country code of 9 or of 910 (or any other number beginning with 91).</td>
</tr>
<tr>
<td>Type</td>
<td>Enter PHONE_FORMAT or choose it in the drop-down list.</td>
</tr>
</tbody>
</table>

4. Stop and restart the Siebel Server.

**NOTE:** When you change or add a phone format, the existing phone numbers are not updated automatically.

**CAUTION:** When a user enters phone numbers, the user can enter letters in place of digits, but computer telephony integration (CTI) features, such as outbound dialing, do not work for these numbers. Queries for such numbers must include the letters, not the numeric equivalents. Siebel Business Applications do not detect or warn users if they enter Q or Z (letters that do not appear on all phones).
Examples of Formatting of Phone Numbers

Table 9 shows how phone numbers appear under various circumstances. In this example, the default country is the United States. Therefore the default format is the North American format, (000) 000-0000. Another format has been entered for country code 91: 00-000-0000.

Table 9. Examples of Phone Number Formatting

<table>
<thead>
<tr>
<th>User Enters</th>
<th>Number Is Formatted As</th>
</tr>
</thead>
<tbody>
<tr>
<td>1234567890</td>
<td>(123) 456-7890</td>
</tr>
<tr>
<td>1234567890123</td>
<td>(123) 456-7890 x123</td>
</tr>
<tr>
<td>123456</td>
<td>Error message: “Invalid data has been entered.”</td>
</tr>
<tr>
<td>+91123456789</td>
<td>+9112-345-6789</td>
</tr>
<tr>
<td>+9112345678910</td>
<td>+9112-345-6789 x10</td>
</tr>
<tr>
<td>+9112345</td>
<td>+9112345</td>
</tr>
<tr>
<td>+2512345</td>
<td>+2512345</td>
</tr>
<tr>
<td>?0+9112345678</td>
<td>?0+9112345678 (you see the '?' and the '0')</td>
</tr>
<tr>
<td>?0HelloWorld</td>
<td>?0HelloWorld (you see the '?' and the '0')</td>
</tr>
</tbody>
</table>

Sorting Phone Numbers

Phone numbers are stored in the database without special format characters, so the special format characters have no effect on the sort order.

Querying Phone Numbers

When performing a query on a phone number, do not include any format characters such as commas (,), hyphens (-), periods (.), the letter x, or spaces.

You can query for only country 61 by typing +61* but you cannot query for only North American phone numbers this way, because +1* returns all phone numbers. To query for North American phone numbers, use `not like +*` instead.

When you use a phone number in a query, the country code of the default locale is automatically added to the query, unless the default locale is North America. If the default locale is North America, no code is added. For example, if the default locale is Germany, and the user types 0181 in the phone field of a query, the German country code (+49) is added to the query. That is, the query becomes +490181*.

To find a number for a country other than the default country, the user must specify the country code in the query. To avoid limiting the query to one country, the user must refine the query, and remove the country code portion of the query specification.
To see a demonstration of this behavior, look at the Contacts screen. Every phone number for a
country other than the default contains +n at the beginning, while every phone number for the
default country code appears as local; that is, without a plus sign. Phone numbers that have the +n
require explicit queries; that is, the user must specify the country code and the number. Local
numbers are returned normally.

Table 10 gives examples of how to query phone numbers.

### Table 10. Querying Phone Numbers

<table>
<thead>
<tr>
<th>Query Result</th>
<th>Query Criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td>(123) 456-7890</td>
<td>1234567890</td>
</tr>
<tr>
<td>+61(123) 45.67.89 x0</td>
<td>+611234567890 (if 61 is defined as a country code)</td>
</tr>
<tr>
<td>Country code 61 phone numbers</td>
<td>+61*</td>
</tr>
<tr>
<td>All phone numbers</td>
<td>+1*</td>
</tr>
<tr>
<td>All North American phone numbers</td>
<td>not like +*</td>
</tr>
<tr>
<td>415 area code numbers (North America only)</td>
<td>415*</td>
</tr>
<tr>
<td>Null phone numbers</td>
<td>is null</td>
</tr>
<tr>
<td>415 area code or null (North America only)</td>
<td>415* or is null</td>
</tr>
<tr>
<td>(800) SKY-PAGE</td>
<td>800SKY*</td>
</tr>
</tbody>
</table>

### Importing Information with EIM

Siebel Enterprise Integration Manager (EIM) manages the exchange of data between Siebel database
tables and other corporate databases. When you use EIM to import information that includes
international phone numbers, the numbers are handled as described in the previous sections. For
more information about EIM, see *Siebel Enterprise Integration Manager Administration Guide*.

### Updating the Phone Format with EAI Adapter

When you update the phone format using Siebel EAI Adapter, the plus (+) sign and the country code
are required, but the phone format can be in any form (that is, not just US format).

### Setting Up Pager Companies

Pager companies can be set up so they are available from the Pager Company field in the Send Page
dialog.

**To set up a pager company**

1. Navigate to the Administration - Communications screen > Pager Companies view.
2 In the Pager Companies list, create a new record, and complete the necessary fields.

**NOTE:** The pager companies you use to send pages must support Telocator Alphanumeric Protocol (TAP), which is an industry standard for sending alphanumeric pages.

### About Date Formats

For the Siebel Web Client, the display format for date and time is determined by the locale settings of the application server. For more information, see "Setting Up Locales" on page 37.

For the Siebel Developer Web Client and the Siebel Mobile Web Client, the date format is determined by the specification in the client computer’s operating system.

When a user creates a query using a date field, the user must use the appropriate date format.

### Setting Up ZIP Codes

ZIP Codes are used to look up address attributes (City, State, and so on). They are also used to look up nine-digit postal codes based on the street address. Siebel Business Applications ship with a table of United States Postal Service ZIP Codes, and the table is available for customer use.

**To add a ZIP Code**

1. Navigate to Administration - Data screen > ZIP Code Administration view.
2. In the ZIP Geocodes list, create a new record, and complete the necessary fields.

### Administering Global Time Zone Support

The time zones records that are shipped with Siebel applications as seed data include the 74 world time zones. These are the same time zones used by Microsoft in its operating systems. Use the Time Zone administration view to:

- Edit the text descriptions of time zones and their abbreviations
- Manage the active status of time zones to control which time zones are available to end users for use in the applications
- Manage multilingual translations to control how time zone information is displayed to users in multiple languages

Tasks for administering time zones include:

- "Modifying Time Zones" on page 62
- "Maintaining Translations of Time Zones" on page 62

For more information on global time zone support, see *Siebel Global Deployment Guide*. 
Modifying Time Zones

You rarely need to modify a time zone’s regional settings. However, you may want to modify other time zone settings such as the display name or daylight savings rules, as these occasionally change.

**NOTE:** You cannot add or delete time zones.

To modify time zone settings

1. Navigate to Administration - Data screen > Time Zone Administration view.
2. In the Time Zone list, select the time zone record you want to modify.
3. Modify the fields as necessary.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of time zone.</td>
</tr>
<tr>
<td>Standard Abbreviation</td>
<td>The abbreviation for the time zone.</td>
</tr>
<tr>
<td>UTC Offset</td>
<td>Offset, in minutes, from Coordinated Universal Time (UTC) when daylight savings is not in effect.</td>
</tr>
<tr>
<td>DST Abbreviation</td>
<td>The abbreviations for daylight savings time (DST).</td>
</tr>
<tr>
<td>DST Bias</td>
<td>Incremental DST offset, in minutes, from UTC when DST is not in effect.</td>
</tr>
<tr>
<td>DST Start Ordinal</td>
<td>Part of the rule that determines when DST starts. For example, if the rule is the first Sunday in April, First is defined in this field.</td>
</tr>
<tr>
<td>DST Start Day</td>
<td>Part of the rule that determines when DST starts. For example, if the rule is the first Sunday in April, Sunday is defined in this field.</td>
</tr>
<tr>
<td>DST Start Month</td>
<td>Part of the rule that determines when DST starts. For example, if the rule is the first Sunday in April, April is defined in this field.</td>
</tr>
<tr>
<td>DST Start Time</td>
<td>Minutes after midnight that DST starts. For example, if DST starts at 2:00 A.M., set the start time to 120.</td>
</tr>
</tbody>
</table>

Maintaining Translations of Time Zones

You maintain translations of the text-based fields for each time zone using the Time Zone Administration view.

To maintain translations of time zones

1. Navigate to Administration - Data screen > Time Zone Administration view.
2. In the Time Zone list, select the time zone you want to translate.
3. In the Time Zone Translation list, create a new record, and complete the necessary fields, including the translation of the Name field for the selected language.
4 Repeat Step 3 for each language required for translation.

Date and Timestamps

The date and time used for timestamping records are obtained by the Siebel Server. When a remote user runs the Siebel client in disconnected mode, the Siebel Server runs on the user's machine and takes the date and time from that machine.

If the Global Time Zone feature is enabled, then fields of data type UTCDATETIME are converted to UTC during Object Manager-based operations. For more information, see the Siebel Global Deployment Guide.

Setting Up Email, Fax, and Mail Accounts (Contact Us)

Salespeople use the Contact Us screen to answer questions and provide contact information to customers. If your organization uses Siebel eService, your customers can access this information directly from a Contact Us page on your Web site.

Creating a Contact Us Account

To help your salespeople provide information on a chosen topic, you can create different accounts, such as Technical Support, Shipping, and Sales.

To add a Contact Us account
1 Navigate to Administration - Application screen > Contact Us view.
2 In the Email, Fax and Mail Accounts list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Type</td>
<td>Choose the Contact Us type.</td>
</tr>
<tr>
<td>Access List</td>
<td>Indicates which employees can view the Contact Us account.</td>
</tr>
</tbody>
</table>

About Adding Email Addresses and Subjects

If your organization uses Siebel eService, any email addresses you include in Contact Us accounts appear on a Contact Us page on your Web site. You can create default email subjects that are added to the user's Subject line when the user sends email through your Web site.

For more information, see Siebel eService Administration Guide.
Setting Up Industries

You can set up and maintain industry information used throughout the application. The information in the Industries view populates the Industries drop-down list, which is found in a variety of screens and views, such as in the Accounts and References screens. The Industry list can also be used by Siebel Assignment Manager to assign new leads or service requests to Siebel users. For example, a sales representative who covers the pharmaceutical industry can be assigned automatically to new accounts based on a Pharmaceutical Industry value.

To add an industry

1. Navigate to Administration - Data screen > Industries view.
2. In the Industries list, create a new record.
3. Complete the Industry, SIC Code, and Type fields.

   NOTE: The Industry and SIC Code values must be unique. If you add a value that already exists, you receive an error message.

Setting Up Languages

You can set up and maintain language information used throughout the application. The information in the Languages view populates the Language drop-down list, which is found in a variety of screens and views, such as in the References and SmartScripts screens. The Language field can also be used by Siebel Assignment Manager to give assignments to call center agents who work for international companies and speak a variety of languages with customers.

For example, a sales representative for a German chemical manufacturing company could use a Danish SmartScript to make a sales call to a prospective customer in Copenhagen, and then make the same sales call using an Italian SmartScript when speaking to a prospective customer in Rome. In these cases, the Language field is used to identify the language into which each SmartScript has been translated.

To add a language

1. Navigate to Administration - Data screen > Languages view.
2. In the Languages list, create a new record.
3 Complete the Name and Code fields.

**NOTE:** The Name and Code values must be unique. If you add a value that already exists, you receive an error message.

**NOTE:** Languages cannot be deleted because deleting languages can cause problems with Mobile Web Client synchronization. While the delete language command can be restored using Siebel Tools, this is strongly discouraged. For help with modifying language code, create a service request (SR) on OracleMetaLink 3. Alternatively, you can phone Global Customer Support directly to create a service request or get a status update on your current SR. Support phone numbers are listed on OracleMetaLink 3.

### About Case-Insensitive and Accent-Insensitive Queries and Searches

By default, queries and searches in Siebel applications are sensitive to case and accent. If you perform a query or search, there is a match only if the search criteria you enter are capitalized and accented in the same way that the data is capitalized and accented in the database.

If you do not want queries and searches to be case sensitive and accent sensitive, you can enable case-insensitive and accent-insensitive (CIAI) queries and searches on particular columns and fields in Siebel Tools. If you enable CIAI queries on a column, when you enter the query in the Siebel application, the field for the CIAI column is empty. When you enter the queries for fields that are not CIAI-enabled, the text, `<Case Required>`, is displayed in the field.

Not all types of database support both case-insensitive and accent-insensitive queries and searches on CIAI-enabled columns. Table 11 lists which CIAI features are supported in each type of database.

**Table 11. Database Support for CIAI Queries**

<table>
<thead>
<tr>
<th>Database</th>
<th>Case Insensitive</th>
<th>Accent Insensitive</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>MSSQL</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Oracle</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

For information about how to implement CIAI queries and searches on particular columns or fields, see *Configuring Siebel Business Applications*. For information on how the CIAI feature affects performance, see *Siebel Performance Tuning Guide*.

**NOTE:** Determine your requirements for case-insensitive queries and searches, and set the appropriate parameters for fields before users enter any data.
Forcing Case-Sensitive or CIAI Queries or Searches

Regardless of the setting for case-sensitive and accent-sensitive queries, users can use operators to force case-sensitive or CIAI queries or searches. The following table describes the operators to use to force case-sensitive or CIAI queries or searches:

<table>
<thead>
<tr>
<th>Type of Query</th>
<th>Operator</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case sensitive and accent sensitive</td>
<td>= followed by the criterion in single quotation marks</td>
<td>&quot;Computer’ returns only records that have Computer spelled with a capital C.</td>
</tr>
<tr>
<td>CIAI</td>
<td>~ followed by other operators if required, and the criterion</td>
<td>-LIKE computer returns all records that have computer in the field, regardless of capitalization.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-LIKE francais returns all records that have francais in the field, regardless of capitalization or accent.</td>
</tr>
</tbody>
</table>

In searches with complex criteria, the user must also use the tilde (~) operator to force the CIAI feature, regardless of the setting for case-sensitive and accent-sensitive queries and searches.

Adding Web Browser Capabilities

Siebel applications come with a number of browsers configured for use. Generally, you do not need to make changes to the Web browser settings. However, if you need to add a capability to a browser, you can do so through the Web Browser Administration screen.

Web browser capabilities identify what an end user's browser can and cannot do. They support the Siebel Web Engine's ability to provide different HTML tags and other markup tags to different browsers, based on what each particular browser is capable of rendering. This can also allow an administrator or developer to specify what looks best in a particular browser.

When a user logs into a Siebel Web application, the Siebel Web Engine reads information encapsulated in the requests coming from the user's browser to determine the browser's version and make. It then correlates that information with the data contained in the Web Browser Administration views to determine the browser's capabilities.

One of the primary ways this information is applied is through conditional tags in Web templates. For example, if some of your users use an older browser that does not support frames, your template might include a conditional tag that prevents these users from receiving pages with frames. Conditional Web engine tags that evaluate browser capabilities can be used in all Siebel Web templates and Web applications, but are used most prominently in those that support wireless devices. For example, the SWLSStart.swt template includes the following conditional tag:

```
<swe:switch>
  <swe:case condition="Web Engine User Agent, Test Capability, 'Default Markup: XML'">
  <swe:pageitem id='3' property='FormattedHtml' />
  </swe:case>
</swe:switch>
```
By the time that the Web Engine interprets the swe:case tag, it has already determined what type of browser the user has. The usage of the tag causes the Web Engine to call the TestCapability method on the Web Engine User Agent business service. The TestCapability method returns TRUE if the user’s browser has a Capability called DefaultMarkup with a value of XML. When the condition is met (that is, the method returns TRUE) the tags between <swe:case> and </swe:case> are processed. For more information about the syntax of conditional tags, see Configuring Siebel Business Applications.

Adding Additional Capabilities
Siebel applications come with a number of predefined capabilities. These capabilities can be added to any browser. Some examples include:

- **FrameSupport.** Indicates whether the browser can render frame tags (for example, <swe:frameset>).
- **CookiesAllowed.** Indicates whether the browser supports cookies.
- **HighInteract.** Indicates whether the browser is among those supported for Siebel's High Interactivity Web applications (such as Internet Explorer 5.5).
- **ActiveX.** Indicates whether the browser can support ActiveX controls.

You can also add other capabilities that are not included in the standard Siebel application. For example, you could add a capability named `SupportsWingDingFont`. New capabilities then become available for use in any browser definition.

To add a capability
1. Navigate to Administration - Web Browser screen > Capabilities view.
2. In the Capabilities list, create a new record.
3. Complete a name and description for the new capability.

Adding Additional Web Browsers
If you need to add a Web browser definition that is not included in the standard Siebel application, you can choose between the following two methods.

- **Add a parent browser definition.** This definition includes all of the browser capabilities. Use this method if you need to add a completely new browser (such as Opera), or a major upgrade release of an existing browser (such as future releases of Microsoft Internet Explorer or Netscape). For information about this procedure, see “To add a parent Web browser” on page 69.

- **Add a child browser definition.** Child browser definitions inherit the capabilities of the parent browser, and add additional capabilities as necessary. Use this method for adding interim releases based on a browser that is already defined. For example, a “dot” release, such as 5.7 or 5.8. For information about this procedure, see “To add a child Web browser” on page 69.
Ongoing Application Administration Tasks ■ Adding Additional Web Browsers

Required Browser Capabilities
For a browser to work correctly, it must include two capabilities that allow the browser to be identified at run time. The required capabilities are:

- **User-Agent.** This capability names the browser.
- **Accept.** This capability indicates what types of documents the browser can open.

These capabilities are part of HTTP standard information and appear in HTTP request headers sent from a browser. For example, a request from a Microsoft Internet Explorer 5.5 browser sent to a Web application might include the following lines:

```
Accept: image/gif, image/x-xbitmap, image/jpeg, image/pjpeg, application/vnd.ms-powerpoint, application/vnd.ms-excel, application/msword, */*
User-Agent: Mozilla/4.0 (compatible; MSIE 5.5; Windows NT 4.0)
```

In this example, the value for the User-Agent capability would be Mozilla/4.0 (compatible; MSIE 5.5; Windows NT 4.0).

Both the User-Agent and Accept capabilities must be included. This is because at run time, the User-Agent is checked to identify the browser. If the User-Agent is not recognized, the values for the Accept parameter in the header are compared to the Accept parameters of the browsers listed in the Web Browser Administration screen, to find the browser with the most closely matching Accept parameters.

In addition to the User-Agent and Accept capabilities, if a browser is based on an existing parent browser, it must include the Parent capability.

**NOTE:** Parent browsers frequently do not have the User-Agent and Accept capabilities. This is because parent browsers are intended to serve as containers of other capabilities that can be inherited. If a browser does not have its own User Agent and Accept capabilities, then it is acting as a parent of another browser that has these capabilities.

Adding JumpTab Capability for Internet Explorer 5.0
If you are running your Siebel application on Internet Explorer 5.0, you need to set the JumpTab capability to True.

(If the JumpTab capability is not set, users need to click the back button twice to return to the previous page.)

**To add the JumpTab capability**
1. Navigate to Administration - Web Browser screen > Capabilities view.
2. In the Capabilities list, select the JumpTab capability record.
3. In the form, in the Capability Value field, enter TRUE.
Adding a Web Browser

Whether you are adding a parent browser or a child browser, the process is similar. However, in the case of a parent browser, you add all detailed components, and in the case of a child browser, you base the browser on an existing browser.

**NOTE:** Although a parent browser may contain the User-Agent and Accept capabilities, it does not have to. If you use parent browsers as templates for child browsers, do not include these two capabilities in the parent browser template.

**To add a parent Web browser**

1. Navigate to Administration - Web Browser screen > Browsers view.
2. In the Browser list, create a new record.
3. Complete a name and description for the new browser.
4. Drill down on the record.
5. In the Capabilities list, create records for each of the capabilities for this browser.

**NOTE:** If there is an existing browser that contains most of the appropriate capabilities, you can copy it and then make changes. To do so, in Step 2, click the menu button and choose Copy Record instead of New Record.

**To add a child Web browser**

1. Navigate to Administration - Web Browser screen > Browsers view.
2. Note the name of the parent browser (that is, the one on which you will base the new browser).
3. Create a new record.
4. Complete a name and description for the new browser.
5. Drill down on the record.
6. In the Capabilities list, create these three records:
   - **Parent.** Set the capability value to the parent browser you identified in Step 2.
   - **User-Agent.** Enter the appropriate User-Agent.
   - **Accept.** Enter the types of documents that can be opened by the browser.
7. Add any additional capabilities that are not included in the parent browser or that differ from those inherited from the parent browser.

Administering Quick Fill Templates

For information about creating Quick Fill Templates, see *Siebel Fundamentals*.

Users can create quick fill templates for their personal use. Administrators can make these templates public so that all users have access to them. Administrators can also delete any quick fill template and make simple changes to the template record (such as name, sequence, and public flag).
To make a quick fill template public
1. Navigate to the Administration - Application screen > Quick Fill Templates Administration view.
2. Select the template record.
3. Select the Public Flag option for the template.

To edit a quick fill template
1. Navigate to the Administration - Application screen > Quick Fill Templates Administration view.
2. Select the template record.
3. Edit the fields as necessary.
   The Sequence Number determines the order in which the fields are filled in.

Setting Up Default View Links for Screen Home Pages

For more information about screen home pages and setting up view links, see *Siebel Fundamentals.* Administrators can define links that appear on the quick links area of screen home pages. These default view links are visible to all users.

To add a default view link to a screen home page
1. Navigate to the Administration - Application screen > View Links view.
2. In the Screen Homepages list, select the home page.
3. In the View Links list, create a new record, and complete the necessary fields.
   Make sure that the view you specify is available to all users.
   **TIP:** Use increments of 10 to sequence the links. This gives users space to create their own view links between the default ones that you create.
Working with Lists of Values

This chapter provides guidelines to administrators for working with lists of values within Siebel applications. It includes the following topics:

- “About Lists of Values” on page 71
- “Adding a New Value to an Existing List of Values” on page 72
- “Clearing the Cache” on page 73
- “List-of-Values Fields” on page 74
- “Modifying a List of Values” on page 76
- “Inactivating a Value in a List of Values” on page 77
- “Constrained Lists of Values” on page 78

About Lists of Values

A list of values (LOV) is a set of values that populates a static picklist, which is accessed when a user clicks a drop-down list in the user interface.

Drop-down lists can be based on two types of picklists: static picklists and dynamic picklists.

- A static picklist has a selection list that is a static list of values. An example of a static picklist is a drop-down list containing postal abbreviations for states and countries.
- A dynamic picklist has a selection list that usually contains transactional data. An example of a dynamic picklist is a drop-down list containing account names.

As a rule of thumb, dynamic picklists include all picklists that do not retrieve values stored in the S_LST_OF_VAL table. Dynamic picklists are typically rendered through a pick applet, such as the picklist used to choose an account for a contact. However, they can be configured to appear as a drop-down list.

The remainder of this section focuses on static picklists, whose contents can be administered from the list-of-values views. For information on how to set up a new list of values and configure both static and dynamic picklists, see Configuring Siebel Business Applications.

This section describes how to work with the values that populate static picklists, including how to create or modify values in an existing list of values, and inactivate values when you do not want them to display. In addition, it describes how lists of values can be constrained by selections in other lists.

**NOTE:** If you will be creating multilingual lists of values (MLOV), you should also review Configuring Siebel Business Applications.

There are two views in the Administration - Data screen in which you can view list-of-values data:

- In the List of Values view, a list view
Working with Lists of Values  ■ Adding a New Value to an Existing List of Values

In the LOV Explorer view

The values in these two views are the same. Only the format in which the information is presented is different. The procedures in this section give instructions that specify using the list view. If you prefer to use the explorer view, you may do so.

Your Siebel applications come with numerous lists of values that support the static picklists used throughout Siebel screens. You can use these as they are, or you can modify them through the list-of-values views to support your organization’s requirements.

Adding a New Value to an Existing List of Values

In order to add an item to an existing list of values so that it shows up in a drop-down list, you must know its type. You can find out the type by querying the list-of-values list to determine the type associated with a specific display value. Then you can create a new record with that type. For instance, in the Accounts list you can see the Status drop-down list. Imagine that you use this field to indicate ratings for your accounts’ reliability. Initial settings are Gold and Silver. You might want to add another status of Bronze to this list, to give to customers that have a reliable account rating. The procedure below uses this example.

The maximum number of values allowed for one LOV type is 10,000.

To identify the list-of-values type for a display value

1. Navigate to the screen displaying the drop-down list to which you want to add a value (for example, the Accounts screen).
2. Select the drop-down list and make note of one of the choices.
   For example, in the Accounts screen, select the Status drop-down list and make note of the value Gold.
   
   **TIP:** Be sure to note the capitalization and spacing of the choice.
3. Navigate to Administration - Data screen > List of Values view.
4. In the list-of-values list, perform a query in the Display Value field, using the value you noted in Step 2.
5. In the list of records that is returned, identify the appropriate record by reviewing the entries in the Type field.
   List-of-values types usually have names that relate to the field labels in the screens where they are used. In this example, you would look for a type labeled something like ACCOUNT_STATUS.
   When you create a new value for this list, you will use this type.

To add a new value to an existing list of values

1. Navigate to Administration - Data screen > List of Values view.
Click New to create a new record, and then enter the list-of-values type in the Type field.

Enter a new value in the Display Value field.

For example, if Bronze is the status that your organization gives customers that have a reliable account rating, and you want to make Bronze available as in the Account Status drop-down, you would create a new record with ACCOUNT_STATUS as the type and Bronze as the display value.

Make sure that the length of the Display Value you enter does not exceed the allowed length of the destination column.

Enter a value in the Language Independent Code field. This value is usually the same as the Display Value.

Make sure that the length of the Language Independent Code you enter does not exceed the allowed length of the destination column.

NOTE: The Display Name and Language Independent Code must both be unique within a list-of-values type, except when configuring a multilingual list of values. If you add a value that already exists, you get an error message. For example, there cannot be two ACCOUNT_STATUS records that have a display value of Bronze. For information about how this differs for multilingual lists of values, see the definition of the Language Independent Code field in Table 12 on page 74.

If applicable, in the Order field, you can enter a number to indicate the numerical order in which the value appears in a drop-down list.

For example, if the order numbers for Gold and Silver are 1 and 2, respectively, the order number for Bronze would be 3.

If appropriate, complete the remaining fields in the record.

For a description of these fields, see “List-of-Values Fields” on page 74.

Clear the LOV cache by clicking Clear Cache.

After you have cleared the cache, you can navigate to a screen and select the new value in the related drop-down list. For example, you can navigate to the Accounts screen, select a record from the Accounts list, and then choose Bronze in the record’s Account Status drop-down list.

Clearing the Cache

A particular list of values is cached the first time a user opens a drop-down list that uses the list of values. This improves performance by avoiding the need to retrieve the list from the database upon subsequent usage of the drop-down list. However, this also means that updates to a list of values do not show up in a drop-down list until you clear the cache. Clearing the cache instructs the Siebel application to read the updated values out of the database and display them.

Users who log in after you add or change a list of values can see the addition or change that you made. However, in order for you to see the changes that you made in real time, you must do one of the following:

- For the Dedicated Web Client, log out of the application and log back in.
- For either the Web Client or the Dedicated Web Client, clear the cache.
About LOV Caching on Screen Home Pages

LOV caching behaves slightly differently on screen home pages.

On screen home pages, the LOVs are cached as soon as the page is displayed. It is not necessary for the user to open the drop-down list in order to have the LOVs cached.

Procedure for Clearing the Cache

To clear the cache (using the Clear Cache button)

1. Navigate to Administration - Data screen > List of Values view.
2. In the List of Values list, click Clear Cache.

List-of-Values Fields

List-of-values records have the fields shown in Table 12. Not all fields for list-of-values records are displayed in the standard user interface. You can use the Columns Displayed menu option to see a field that is not displayed.

Some list-of-values fields, such as High, Low, and Weighting Factor, are for use by specialized Siebel C++ code to store additional information about the selected list-of-values record. In addition, pick maps can use list-of-value fields such as High, Low, and Weighting Factor. Pick maps normally use the Display Value field, which causes the list item selected by the user to be stored in the database exactly as it appears in the list. These fields can be used to populate other fields of the business component in which the pick map is defined.

If you need to use the High or Low fields, or other extra fields, use Siebel Tools to extend the PickList Generic BusComp by adding fields mapped to the corresponding columns on the S_LST_OF_VAL table. For example, you could use the High and Low fields to automatically fill in the high and low temperatures when a user picks a Month value in a Date drop-down list. To do so, you would add two pick maps to the Month field by adding the High and Low list of value fields to the Pick List field of Pick Map. For more information about the PickList Generic BusComp, and about configuring static picklists and pick maps, see Configuring Siebel Business Applications.

**NOTE:** The Target High and Target Low fields are used exclusively with Smart Reports. For more information, see Siebel Reports Administration Guide.

Table 12. List-of-Values Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type of list of values (the field name).</td>
</tr>
<tr>
<td>Display Value</td>
<td>Value as displayed in the drop-down list.</td>
</tr>
<tr>
<td>Translate</td>
<td>When checked, indicates that internationalization is needed. (There is no client or server functionality associated with this field.)</td>
</tr>
</tbody>
</table>
### Table 12. List-of-Values Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multilingual</td>
<td>When checked, indicates that the list of values is part of a multilingual list of values (MLOV). (There is no client or server functionality associated with this field.)</td>
</tr>
<tr>
<td>Language Independent Code (LIC)</td>
<td>Along with the Display Value, the Language Independent Code uniquely identifies a value for a particular LOV type. In most cases the Language Independent Code is the same as the Display Value. However, the Language Independent Code and Display Value are different for multilingual lists of values (MLOVs). MLOVs allow a single logical list item to support multiple display values for users who are accessing the Siebel application in different languages. For example if the MR_MS (Personal Title) list of values were multilingual, there might be three list-of-values items with a Language Independent Code of Mr. These might have a display value and language of Mr. (English-American), Senor (Spanish - Modern), and Herr (German), respectively. German users would see Herr in the Personal Title drop-down list, Spanish users would see Senor and English users would see Mr. Although the display values vary across language instances, the value stored in the database when a user selects any one of these is always Mr. because that is the Language Independent Code associated with Herr, Senor, and Mr. Values entered in the Language Independent Code field are sometimes referred to as LIVs (language independent values).</td>
</tr>
<tr>
<td>Parent LIC (Language Independent Code)</td>
<td>The Language Independent Code of a parent list of values. Used in hierarchical lists of values, where the values that will display in a drop-down list are constrained by the value selected in the parent drop-down list of values. For more information, see &quot;Constrained Lists of Values&quot; on page 78. There are only parents and children in this hierarchy. Grandchildren are not allowed. This is enforced by limiting the values in the Pick Parent dialog box to those values which do not themselves have parent display values.</td>
</tr>
<tr>
<td>Replication Level</td>
<td>Specifies whether the translation is intended for use at all levels in the translation hierarchy or only at the regional level.</td>
</tr>
<tr>
<td>High</td>
<td>Extra field available for use by pick maps or for customization.</td>
</tr>
<tr>
<td>Low</td>
<td>Extra field available for use by pick maps or for customization.</td>
</tr>
<tr>
<td>Order</td>
<td>The numerical order in which a value is displayed within a drop-down list.</td>
</tr>
<tr>
<td>Active</td>
<td>When checked, indicates that the value is displayed to the end user. When unchecked, indicates that the value is not displayed to the end user.</td>
</tr>
</tbody>
</table>
Modifying a List of Values

**CAUTION:** Use caution when modifying lists of values that are part of the seed data. Modifying some list-of-values fields that are used programmatically by the Siebel application can adversely impact standard Siebel functionality. However, you can modify the Display Value field without affecting standard Siebel functionality both when the list is a multilingual list of values (MLOV) and when it is a standard list of values.

Modifying some lists of values can adversely impact standard Siebel functionality:

- Do not change the Language Independent Code values for lists of values because the internal Siebel application uses the Language Independent Code field.

- Some lists of values are for use only by the internal Siebel application and should not be modified. For example, the list-of-values SOURCE_TYPE (Internal) and list-of-values types that include REPOSITORY in the Type field name are for internal use only.

- Some list-of-values modifications can have undesired results. For example, changing all lists of values in the application to uppercase or changing the Language Independent Code from the Siebel standard can result in values not being displayed or being displayed improperly.

**NOTE:** Modifying a Display Value field does not automatically update records that have been populated with the old value. For example, if you change Ms. to Miz in the Display Value field, Miz show up in the drop-down list, but all contact records that were previously entered with Ms. in the Personal Title field still have Ms. in the Personal Title field.

For more information about multilingual lists of values (MLOVs), see *Configuring Siebel Business Applications*.

In order to modify a value in a drop-down list, you must know its display value and type. You can find out the type by querying the list-of-values list for a specific display value. For example, if you needed to make a change to the value 1-ASAP in the Priority drop-down list in the Activities screen, you could do so using the following steps.

**To modify an item in a list of values**

1. Navigate to Administration - Data screen > List of Values view.
2 Click the menu button, and then choose New Query.
3 Enter the Display Value for the record you want to change in the Display Value field.
   For example, you might enter the value 1-ASAP.
4 Click the menu button, and then choose Run Query.
   A list of records appears that includes the display value that you entered. More than one record
   may appear, and the records may have different types.
5 In the list of records, select the record that you want to modify, and make the desired change.
6 To see the list-of-values modification in the application, click Clear Cache. For instructions about
   how to clear the cache, see “To clear the cache (using the Clear Cache button)” on page 74.

Inactivating a Value in a List of Values

You can inactivate individual values in a list, but you cannot delete values. Inactive values are values
that the application does not display to end users in a drop-down list, whereas active values are
displayed to end users.

**CAUTION:** Inactivating some lists of values can adversely impact standard Siebel functionality.

Do not inactivate list-of-values types or values used internally by the Siebel application. For example,
do not inactivate list-of-values types that include “Repository” in the Type field name.

Be careful when inactivating a list of values, because the application may depend on the list of values
being present.

Be careful when inactivating individual values as well. For example, if you inactivate the value
Commercial in the Account_Type list of values, but you have existing or old account data that stored
Account Type = Commercial, you may introduce inconsistencies in your data. If you want to
inactivate a display value, you need to clean up the account records in the database first.

**To inactivate a value in a list of values**

1 Navigate to Administration - Data screen > List of Values view.
2 If necessary, perform a query to locate the record you want to make inactive.
3 Select the list of values record you want to make inactive.
4 In the Active field, click the check mark. When a square containing an x appears, click the x.
   The x disappears and the Active field no longer contains a check mark.
5 To see that the value has been inactivated, click Clear Cache.
Constrained Lists of Values

Some drop-down lists are set up to display a subset of values based on a value set in another drop-down list. For example, if you have two fields for Service Request, Area and Subarea, the values shown in the Area drop-down list might include Network and Upgrade. If the user chooses Network, that user might see a drop-down list for Subarea that includes Ethernet Card and 3rd Party Software. If on the other hand the user chooses Upgrade for the Area, that user might see CD-ROM, Disk Drive, Memory, and Operating System in the Subarea. Setting up this type of filtering is referred to as setting up a constrained picklist. In such a case, the lists of values have been configured to be dependent on one another. In this example, the Area drop-down list is considered to be the parent and the Subarea drop-down list is the child.

Figure 2 shows the values available in the Area drop-down list, and the values available in the Subarea list when Network and Upgrade have been selected, respectively.

![Figure 2. Contents of Drop-Down List Constrained by Parent Drop-Down List](image)

Constrained picklists (or lists of values) must first be set up through Siebel Tools. After they are configured through Siebel Tools, specific values in lists can be made hierarchically dependent through the List of Values view. This is accomplished by using the Parent LIC attribute in the list-of-values record to specify which values show up when a value is selected in the parent drop-down list.
For example, the LOV Type SR_AREA is used by both the Area and Subarea drop-down lists in a Service Request. The values that show up in the Area drop-down list are constrained to those that have a Parent LIC value of External. Figure 3 shows how the records for these values appear in the list-of-values list, including the Parent LIC value of External.

<table>
<thead>
<tr>
<th>Type</th>
<th>Display Value</th>
<th>Language-Independent</th>
<th>Language Name</th>
<th>Parent LIC</th>
<th>Order</th>
<th>Active</th>
<th>Translate</th>
</tr>
</thead>
<tbody>
<tr>
<td>SR_AREA</td>
<td>User Interface</td>
<td>User Interface</td>
<td>English-American</td>
<td>External</td>
<td>7</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SR_AREA</td>
<td>Installation</td>
<td>Installation</td>
<td>English-American</td>
<td>External</td>
<td>3</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SR_AREA</td>
<td>Upgrade</td>
<td>Upgrade</td>
<td>English-American</td>
<td>External</td>
<td>5</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SR_AREA</td>
<td>Usage</td>
<td>Usage</td>
<td>English-American</td>
<td>External</td>
<td>6</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SR_AREA</td>
<td>Network</td>
<td>Network</td>
<td>English-American</td>
<td>External</td>
<td>4</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SR_AREA</td>
<td>Internet Registration</td>
<td>Internet Registration</td>
<td>English-American</td>
<td>External</td>
<td>8</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SR_AREA</td>
<td>Configuration</td>
<td>Configuration</td>
<td>English-American</td>
<td>External</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SR_AREA</td>
<td>CIT Hardware</td>
<td>CIT Hardware</td>
<td>English-American</td>
<td>External</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SR_AREA</td>
<td>Solution Search</td>
<td>Solution Search</td>
<td>English-American</td>
<td>External</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SR_AREA</td>
<td>eMail Response</td>
<td>eMail Response</td>
<td>English-American</td>
<td>External</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SR_AREA</td>
<td>Smart Scripts</td>
<td>Smart Scripts</td>
<td>English-American</td>
<td>External</td>
<td>2</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Figure 3. LOV Records with the Same Parent LIC

The values that show up in the Subarea drop-down list are constrained to those that have a Parent LIC value that matches the user’s selection for the Area. For example, if the user selects Network in the Area drop-down, only those values that have the Parent LIC set to Network show up in the Subarea drop-down list, while if the user selects Upgrade in the Area drop-down, only those values that have the Parent LIC set to Upgrade show in the Subarea drop-down list. Figure 4 shows the records for the values that are available for both the Network and Upgrade parent values.

<table>
<thead>
<tr>
<th>Type</th>
<th>Display Value</th>
<th>Language-Independent</th>
<th>Language Name</th>
<th>Parent LIC</th>
<th>Order</th>
<th>Active</th>
<th>Translate</th>
</tr>
</thead>
<tbody>
<tr>
<td>SR_AREA</td>
<td>3rd Party Software</td>
<td>3rd Party Software</td>
<td>English-American</td>
<td>Network</td>
<td>5</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SR_AREA</td>
<td>Ethernet Card</td>
<td>Ethernet Card</td>
<td>English-American</td>
<td>Network</td>
<td>5</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SR_AREA</td>
<td>Memory</td>
<td>Memory</td>
<td>English-American</td>
<td>Upgrade</td>
<td>6</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SR_AREA</td>
<td>Operating System</td>
<td>Operating System</td>
<td>English-American</td>
<td>Upgrade</td>
<td>5</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SP_AREA</td>
<td>CD-ROM</td>
<td>CD-ROM</td>
<td>English-American</td>
<td>Upgrade</td>
<td>6</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SR_AREA</td>
<td>Disk Drive</td>
<td>Disk Drive</td>
<td>English-American</td>
<td>Upgrade</td>
<td>5</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Figure 4. LOV Records Constrained by the Values Upgrade and Network
If you want to change the parent Area of a Subarea list item, you must modify the Parent LIC code of the Subarea list item. Similarly, to add a new Subarea list item, you must create a new record, setting the list-of-values type to SR_AREA and the Display Value, Language Independent Code, and Language as described in “Adding a New Value to an Existing List of Values” on page 72. Then you would set the Parent LIC code to the appropriate parent area. By contrast, to add a new item to the Area drop-down list, you would follow the same steps, but specify that the Parent LIC code have the value External.

**NOTE:** The usage of the value External to identify items in the parent drop-down list is specific to this example. To determine what this value would be for any given pair of constrained picklists, reference the underlying configuration in the Tools Repository.

SR_AREA LOV is used by the SR_TYPE, Area, and Sub Area LOVs in a Parent-Child-Grandchild hierarchy. SR_AREA LOV configuration is different when compared with other LOVs. While creating SR_AREA LOV values ensure that:

- SR Type value has no Parent LIC Code and the order number is 1000 or more.
- SR Area LOV value’s Parent LIC code is the LIC of the parent SR Type.
- Sub Area’s Parent LIC code is a combination of the SR TYPE and SR Area LIC Values. The application concatenates the SR Type and SR Area LIC values to create a new record, which is displayed in the Parent LIC list.

For information about constraining both static picklists (maintained through lists of values) and dynamic picklists, see *Configuring Siebel Business Applications*.

**NOTE:** In the example above using the Area and Subarea drop-down lists, both parent and child lists of values have the same list-of-values type. While this is not required, it has the advantage of avoiding EIM unique key violation errors. These errors can occur when constraining picklists using Siebel Tools, when the parent and child lists of values contain different list-of-values types. If you plan to use Siebel EIM to exchange list-of-values data, you should consider constraining picklists by configuring them so that the parent and child lists of values have the same list-of-values type.
This chapter is about Audit Trail. It includes the following topics:

- “About Audit Trail” on page 81
- “Process of Configuring and Using Audit Trail” on page 84
- “Enabling and Disabling Audit Trail” on page 84
- “Specifying Business Components and Business Component Fields for Audit” on page 84
- “Setting Up Read Auditing” on page 86
- “Specifying Parent–Child Associations for Audit” on page 86
- “Specifying Audit Trail Restrictions” on page 87
- “Verifying Audit Trail Configuration” on page 88
- “Viewing Audit Trail Records” on page 88
- “Linking Audit Trail to a Business Component” on page 91

## About Audit Trail

Audit Trail creates a history of the changes that have been made to data in Siebel applications. An audit trail is a record showing who has accessed an item, which operation was performed, when it was performed, and how the value was changed. Therefore, it is useful for maintaining security, examining the history of a particular record, documenting modifications for future analysis, and record keeping. Audit Trail logs information without requiring any interaction with, or input from, your users.

Audit Trail can be used for a variety of purposes. In a simple example, a call center uses an audit trail to track the status change of a service request, who changed it and when. Audit trail capabilities can also be used to track the time needed to change the state of an item, such as a service request from open to closed. A calculation of the time difference can help the call center manager measure and improve service quality. Audit trail can also be used to reproduce a record at a given point in time to maintain regulatory compliance. To do this, look at the audit trail for the record and compare the audit trail details with the current state of the record.

Audit Trail can also be used to track the viewing and export of data. For example, financial services organizations can use Audit Trail to monitor who has read or exported an account holder’s information. Audit trail can be implemented for the Audit Trail functionality itself. This helps you track any changes made to the Audit Trail settings.

**NOTE:** For any audit trail deployment, the combination of the number of fields audited and the number of audit records created by a given business process has performance implications. If you audit a large number of fields on a business component, or audit fields in a large number of business components, there might be an unacceptable performance impact.
Audit Trail Features
More Audit Trail features are described in the following topics:

- “Audit Scope” on page 82
- “Audit Trail Content” on page 82
- “Audit Trail Constraints” on page 83
- “Audit Trail for Siebel Remote and Siebel Replication Users” on page 83

Audit Scope
System administrators can specify the audit scope by the following means:

- Operations (such as read, update, new, delete, and export) performed on business components
- Operations performed in a specific time period
- Only those operations performed by certain responsibilities, positions, or employees
- Fields, for audits of read operations

Audit Trail Content
For all auditable operations, the following information is stored:

- User ID of the person who performs the operation
- Date and time of the operation
- Record ID and row ID of the audited item

Table 13 lists some of the information that is stored for particular operations.

Table 13. Information Stored for Auditable Operations

<table>
<thead>
<tr>
<th>Operation</th>
<th>Information Stored</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Record</td>
<td>■ Name of the field on which the operation is performed</td>
</tr>
<tr>
<td></td>
<td>■ Value of the field</td>
</tr>
<tr>
<td>Modify</td>
<td>■ Name of the field on which the operation is performed</td>
</tr>
<tr>
<td></td>
<td>■ Old value of the field</td>
</tr>
<tr>
<td></td>
<td>■ New value of the field</td>
</tr>
<tr>
<td>Copy Record</td>
<td>■ Value of the field</td>
</tr>
<tr>
<td>Delete</td>
<td>■ Name of the field on which the operation is performed</td>
</tr>
<tr>
<td></td>
<td>■ Value of the field when the user deleted the record</td>
</tr>
</tbody>
</table>
Audit Trail Constraints

The following cannot be audited:

- Virtual business components. This is because virtual business components do not bind to any underlying tables.
- Calculated fields. This is because, typically, the value for a calculated field is derived from a table-based field. Audit a calculated field by auditing the table-based field that was used to derive the calculated field.
- Export of data through the use of methods other than the following:
  - Export Data Map menu item
  - Enterprise Integration Manager (EIM)

Audit Trail for Siebel Remote and Siebel Replication Users

The following information applies to remote and replication users:

- Audit trails are generated only when the user synchronizes data with the server.
- Audit trails are regenerated when the user synchronizes other data.
- If the transaction is rejected during the conflict resolution, an audit trail record is not generated.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Information Stored</th>
</tr>
</thead>
</table>
| Associate   | ■ Parent business component  
              ■ Child business component  
              ■ Link information          |
| Read        | ■ Name of the field that the user reads   
              ■ Value of the field at the time of the read operation, if the Read Field Value option is selected on the Administration - Audit Trail screen |
| Export      | ■ Business component from which records are exported   
              ■ Row IDs of the exported records  
              ■ Number of records exported     |
Process of Configuring and Using Audit Trail

This example process represents the tasks that are carried out when setting up and monitoring Audit Trail.

1. “Enabling and Disabling Audit Trail” on page 84
2. “Specifying Business Components and Business Component Fields for Audit” on page 84
3. “Setting Up Read Auditing” on page 86
4. “Specifying Parent–Child Associations for Audit” on page 86
5. “Specifying Audit Trail Restrictions” on page 87 (Restricting according to user, position, or responsibility)
6. “Verifying Audit Trail Configuration” on page 88
7. “Viewing Audit Trail Records” on page 88

Enabling and Disabling Audit Trail

By default, the Audit Trail functionality is enabled in Siebel Business Applications.

**NOTE:** Audit Trail creates history records for predefault values.

This task is a step in Process of Configuring and Using Audit Trail on page 84.

To enable or disable Audit Trail

1. Navigate to the Administration - Application screen > System Preferences view.
2. To enable Audit Trail, set the value of the EnableAuditing system preference to TRUE.
   To disable Audit Trail, set the value to FALSE.
3. To enable Audit Trail for EIM, set the value of the EnableEimAuditing system preference to TRUE.
   To disable Audit Trail for EIM, set the value to FALSE.

Specifying Business Components and Business Component Fields for Audit

You administer the business component and the business component fields to be audited from the Administration - Audit Trail screen.

This task is a step in Process of Configuring and Using Audit Trail on page 84.
To configure the business component and business component fields to be audited

1. Navigate to the Administration - Audit Trail screen.

2. In the Audit Trail Buscomp list, create a new record, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assoc</td>
<td>Specifies whether to audit associations with the child business components in the Child Buscomp list. See “Specifying Parent–Child Associations for Audit” on page 86.</td>
</tr>
<tr>
<td>Delete</td>
<td>Select if you want to audit the Delete operation. Clear this check box if you want to make sure that the delete operation is not audited.</td>
</tr>
<tr>
<td>End Date</td>
<td>Date on which the auditing stops. Turn Audit Trail off for an individual business component by setting the End Date to a date that has already passed.</td>
</tr>
<tr>
<td>New</td>
<td>Select if you want to audit the New operation.</td>
</tr>
<tr>
<td>Restriction Type</td>
<td>Specifies whether there is a rule determining who gets audited.</td>
</tr>
<tr>
<td>Start Date</td>
<td>Date on which the auditing starts.</td>
</tr>
<tr>
<td>Update</td>
<td>Select if you want to audit the Update operation.</td>
</tr>
<tr>
<td>Export</td>
<td>Select if you want to audit the Export operation.</td>
</tr>
</tbody>
</table>

3. In the Field list, create a new record for the field you want to audit. Some of the fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Name</td>
<td>Displays the column name of the selected field.</td>
</tr>
<tr>
<td>Field</td>
<td>Select the field name you want to audit. The details of the selected field are displayed in the Table Name, Column Name, and Join columns.</td>
</tr>
<tr>
<td>Join</td>
<td>Displays the join name associated with the column.</td>
</tr>
<tr>
<td>Read Field Value</td>
<td>Select if you want to store the field value during the audits of read operations.</td>
</tr>
<tr>
<td>Reading</td>
<td>Select if you want to audit the read operations.</td>
</tr>
<tr>
<td>Table Name</td>
<td>Displays the table to which the column belongs.</td>
</tr>
</tbody>
</table>
4 Repeat Step 3 until the Field list shows all the fields in that business component that you want to audit.

**NOTE:** In any deployment of Audit Trail, there might be a negative impact on performance, depending on the number of fields audited, and the number of audit records created by a business process. The impact might be greater for audits that include read operations, because this is the most common operation. If you audit a large number of fields on a business component, or audit fields in a large number of business components, there might be an unacceptable performance impact.

**To disable individual business components**
1 Navigate to the Administration - Audit Trail screen.
2 Use one of the following methods to disable Audit Trail:
   - In the Audit Trail Buscomp list, enter an end date prior to today’s date in the End Date field.
   - In the Audit Trail Buscomp list, delete the record for the business component.

### Setting Up Read Auditing

You can configure Audit Trail to audit read operations on records.

This task is a step in **Process of Configuring and Using Audit Trail on page 84**.

**To set up an audit trail of read operations**
1 Navigate to the Administration - Audit Trail screen.
2 In the Audit Trail Buscomp list, create a new record for the business component, and complete the necessary fields.
   - Some fields are described in the table in **Step 2 in Specifying Business Components and Business Component Fields for Audit on page 84**.
3 In the Field tab, perform the following steps:
   a Create a new record to represent the field on which you want read-auditing.
   b Use the Field column to select the name of the field.
   c Select the Reading option for the record.
4 Click the Update Audit Cache button.

### Specifying Parent–Child Associations for Audit

In Siebel Business Applications, parent–child associations are set through:

- MVG (multi-value group) fields
Parent–child applets

Audit Trail can keep track of changes in parent–child associations. For example, you can audit the association (and dissociation) of contacts with accounts.

This task is a step in Process of Configuring and Using Audit Trail on page 84.

To configure business components for auditing of parent–child associations

1. Determine the name of the child business component whose association you want to audit.
2. Navigate to the Administration - Audit Trail screen.
3. In the Audit Trail Buscomp list:
   - Select an existing record for the parent business component.
   - Or
   - Create a new record for the parent business component and complete the necessary fields. Some fields are described in table in Step 2 on page 85.
4. Make sure that the Assoc field is checked.
5. Click the Child Buscomp view tab.
6. In the Child Buscomp list, create a new record for the child business component whose association with the parent business component you want to audit.

Some of the fields are described in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Child Buscomp</td>
<td>Displays the child business component for the link.</td>
</tr>
<tr>
<td>Inter Child Column</td>
<td>Displays the name of the child column.</td>
</tr>
<tr>
<td>Link Name</td>
<td>Select the link between the parent and child business components that you want to audit.</td>
</tr>
<tr>
<td>M/M</td>
<td>Displays whether the link is a many-to-many link.</td>
</tr>
<tr>
<td>Parent Field</td>
<td>Displays the parent field of the child business component.</td>
</tr>
<tr>
<td>Table Name</td>
<td>Displays the name of the table on which the link is based.</td>
</tr>
</tbody>
</table>

Specifying Audit Trail Restrictions

You can restrict who gets audited by user, position, or responsibility.

For example, if you set the Restriction Type to User on the Audit Trail Buscomp Fields view, you then go to the Audit Trail Users View and add the users whom you want to audit. Restriction by responsibility or position works in the same way.

This task is a step in Process of Configuring and Using Audit Trail on page 84.
To specify audit trail restrictions

1. Navigate to the Administration - Audit Trail screen.
2. In the Audit Trail Buscomp list, select a business component entry, and change the Restriction Type field to Position, Responsibility, or User.
3. Click the Position, Responsibility, or User view tab.
4. Create or edit records in the audit trail position, responsibility, or user list.
   - The positions, responsibilities, or users that you specify are audited for the operations on this particular business component.
5. Click the Update Audit Cache button.

Verifying Audit Trail Configuration

The following steps are part of the verification process to make sure that the business component and business component fields were specified correctly.

This task is a step in Process of Configuring and Using Audit Trail on page 84.

To verify audit trail records

1. Navigate to the view for the business component that you want to audit.
2. Make a change to the data in that view.
3. Navigate to Audit Trail screen > Audit Trail Items view, and in the Audit Trail Items list, query the business component and field values to make sure there is a new record showing the changes that you made to the business component.

Viewing Audit Trail Records

After you have set up the fields, operations, responsibilities, positions, and employees to be audited, you can read the results of the audit trails in the Audit Trail view and the Audit Trail Items view.

This task is a step in Process of Configuring and Using Audit Trail on page 84.

Querying Audit Trail Information

After recording or importing Audit Trail records into the database, you can query Audit Trail information in the Audit Trail Items view. For example, you can query Audit Trail items to determine changes made by team members, dates, or operations performed on a business component.

To query audit trail information

1. Navigate to the Audit Trail screen > Audit Trail Items view.
2 Query the list for Audit Trail items of interest.
Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base Table</td>
<td>Displays the name of the primary database table where the database change occurred.</td>
</tr>
<tr>
<td>Business Component</td>
<td>Displays the business component for the record where the database change occurred.</td>
</tr>
<tr>
<td>Child Business Component</td>
<td>Displays the child business component for the record where the database change occurred, if any.</td>
</tr>
<tr>
<td>Child Table Name</td>
<td>Displays the name of the child table for the record where the database change occurred, if any.</td>
</tr>
<tr>
<td>Column</td>
<td>Displays the name of the column in which the change occurred.</td>
</tr>
<tr>
<td>Date</td>
<td>Displays the timestamp of the change.</td>
</tr>
<tr>
<td>Employee ID</td>
<td>Displays the unique identifier of the user who changed the record.</td>
</tr>
<tr>
<td>Employee Login</td>
<td>Displays the username of the user who changed the record.</td>
</tr>
<tr>
<td>Field</td>
<td>Displays the name of the field where the change occurred.</td>
</tr>
<tr>
<td>Group ID</td>
<td>Displays the unique identifier of the group to which the user who changed the record belonged.</td>
</tr>
<tr>
<td>Link</td>
<td>Displays the name of the link that describes the relationship between the child business component and the parent business component. This link is configured in Siebel Tools.</td>
</tr>
<tr>
<td>New Value</td>
<td>Displays the value in the field after the database change occurred.</td>
</tr>
<tr>
<td>Old Value</td>
<td>Displays the value in the field before the database change occurred.</td>
</tr>
<tr>
<td>Operation</td>
<td>Displays the type of operation that was performed, for example, New Record, Delete, and so on.</td>
</tr>
<tr>
<td>Record ID</td>
<td>Displays the unique identifier of the record that was changed.</td>
</tr>
<tr>
<td>Row ID</td>
<td>Displays the unique identifier of the row in which the change occurred.</td>
</tr>
<tr>
<td>Table</td>
<td>Displays the name of table to which the selected field belongs in the Siebel database.</td>
</tr>
</tbody>
</table>

Querying Export Audit Trail Records
You can set up Export Audit Trail for a business component to monitor the export activities for the business component. You can view the results of export audit in the Export Audit Trail view. See Specifying Business Components and Business Component Fields for Audit on page 84 for details on setting up export audit trail.
To query export audit trail information:
1. Navigate to the Audit Trail screen > Export Audit Items view.
2. Select the Audit Trail item required.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Component</td>
<td>Displays the business component on which the export operation was performed.</td>
</tr>
<tr>
<td>Date</td>
<td>Displays the timestamp of the export activity.</td>
</tr>
<tr>
<td>Employee ID</td>
<td>Displays the unique identifier for the user who initiated the export.</td>
</tr>
<tr>
<td>Employee Login</td>
<td>Displays the username of the user who initiated the export.</td>
</tr>
<tr>
<td>Record Count</td>
<td>Displays the number of records that were exported.</td>
</tr>
<tr>
<td>Records IDs</td>
<td>Displays the unique identifier for each record that was exported.</td>
</tr>
</tbody>
</table>

Querying Read Audit Trail Records
You can use the Read Audit feature to monitor the reading of sensitive information.

To query read audit trail information
1. Navigate to the Audit Trail screen > Read Audit Items view.
2. Select the Audit Trail item required.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Component</td>
<td>Displays the business component for the record that was read.</td>
</tr>
<tr>
<td>Date</td>
<td>Displays the timestamp of the read operation.</td>
</tr>
<tr>
<td>Employee ID</td>
<td>Displays the unique identifier of the user who read the record.</td>
</tr>
<tr>
<td>Employee Login</td>
<td>Displays the username of the user who read the record.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Displays the name of the field that was read.</td>
</tr>
<tr>
<td>Field Value</td>
<td>Displays the value that was in the field at the time that the field was read.</td>
</tr>
<tr>
<td>Record ID</td>
<td>Displays the unique identifier of the record that was read.</td>
</tr>
</tbody>
</table>

**NOTE:** To audit record field values, you must select Read Field Value in the Field view of the Administration - Audit Trail screen. For more information, see “Specifying Business Components and Business Component Fields for Audit” on page 84.
Linking Audit Trail to a Business Component

In some circumstances, you might need to link the Audit Trail view to a specific business component view. For example, a Call Center team might want to see the Audit Trail records for individual service requests. Using Siebel Tools, you can create a view that would allow the Call Center team to see these Audit Trail records, if the following conditions are met:

- Audit Trail must be running in database auditing.
- You must be able to audit the business component you are linking to Audit Trail. For information on determining if a business component can be used in Audit Trail, see “Audit Trail Constraints” on page 83.

**NOTE:** Because audit trail item records are not routed to mobile Web clients, data in these linked views can only be displayed in Siebel Web Client and the Siebel Developer Web Client. Make sure that mobile clients do not have access to views displaying audit trail data.

**To link Audit Trail to a business component**

1. Start Siebel Tools.
2. Create a link between the Audit Trail Item 2 business component and the business component to which you are linking Audit Trail. Set the parent business component property of the link to the name of the audited business component.
   
   For example, if you are configuring the view to show the audit trail records for the Product Defect business component, the parent business component should be Product Defect. The Child Business Component for the link should be Audit Trail Item List 2. The Source and Destination Fields for the link should be Id and Record Id respectively.

3. Modify the business object for the business component to which you are linking Audit Trail. You need to create Audit Trail Item 2 as one of the business object components, and specify the Link property as the link you created in Step 2.
4. Create a view which has an applet based on the selected business component as a parent, and the Audit Trail Item List 2 applet as a child.
5. Add this view to a screen.
6. Launch one of the Siebel employee applications.
7. Navigate to the Administration - Application screen > Views view.
8. From the Show drop-down list, choose Responsibilities, and add the new view to applicable responsibilities.
Creating and Administering iHelp

This chapter is about administering iHelp. It includes the following topics:

- “About iHelp” on page 93
- “Scenario for Administering iHelp” on page 93
- “Process of iHelp Administration” on page 94
- “Creating iHelp Item Records” on page 95
- “Designing iHelp” on page 97
- “Clearing the iHelp List Cache” on page 99
- “Activating, Revising, and Deactivating iHelp Items” on page 100
- “Translating iHelp Items” on page 101
- “Importing and Exporting iHelp Items” on page 102

About iHelp

iHelp is real-time step-by-step instruction that helps users complete tasks within the application.

iHelp is best used to provide instruction to first time or occasional users.

**NOTE:** iHelp may not be appropriate for enforcing standards, because users are free to follow or not follow any given step. For information about how to standardize user behavior, see *Siebel Business Process Framework: Task UI Guide*.

For information about how to use iHelp, see *Siebel Fundamentals*. For information about Application Deployment Manager (ADM) and iHelp, see *Siebel Application Deployment Manager Guide*.

About iHelp and Standard Activity Mode

iHelp instructions can be used in both standard and high interactivity mode. However, high interactivity mode is required to create and administer iHelp items.

Scenario for Administering iHelp

This scenario provides an example of a process performed by two iHelp administrators. Your company may follow a different process according to its business requirements.
Introduction
The agents in training in the North American call centers of a multinational company want step-by-step instructions on how to create activities.

The iHelp Administrator in North America
The North American administrator creates an iHelp item to appear in the iHelp pane of the Activities and Accounts screens (screens frequently used by the agents). Because these instructions only pertain to call center agents, this iHelp item is set to be visible only to those users with the Call Center responsibility.

The North American administrator and the call center managers are the only people who need to modify this iHelp item; the call center managers provide the content of the iHelp steps, and the administrator restricts edit access by associating the Call Center access group with the iHelp item.

Various employees test the iHelp item. When the tests are complete, the administrator activates the iHelp item.

At the end of the month, a policy change takes place that effects some steps in the iHelp item. This is handled by creating two versions of the iHelp item. One item is set to expire at the end of the month and the second item (with steps corrected for the new policy) is set to become active at the beginning of the next month.

In North America, the call centers operate in both English and French. The manager of the francophone call center revises the iHelp item, translating the text into French.

The European iHelp Administrator in Europe
The European call centers use a different database, but they also want their call center agents to see this iHelp item. The North American administrator exports the iHelp item to a file and sends it to the European administrator. Then, the European administrator imports the item into the European database, adds responsibilities and access groups, and activates the iHelp item.

Process of iHelp Administration
This example process represents the tasks that are carried out in the “Scenario for Administering iHelp” on page 93.

1  "Creating iHelp Item Records” on page 95
2  “Designing iHelp” on page 97
3  “Clearing the iHelp List Cache” on page 99
4  “Activating, Revising, and Deactivating iHelp Items” on page 100
5  “Translating iHelp Items” on page 101
6  ”Importing and Exporting iHelp Items” on page 102
Creating iHelp Item Records

Creating iHelp Item Records

The first task in creating iHelp items is to create the iHelp item record.

In this task, you determine the following for the iHelp item:

- In which applications the iHelp item is displayed
- In which screens the iHelp item is displayed
- Which users can see the iHelp item
- Which administrators can modify the iHelp item
- (Optional) Activation and expiration dates for the iHelp item
- If the iHelp item is downloaded to remote and local databases

You can create iHelp items in several ways. You can import and export the items, or you can create the items manually. If you create the items manually, make sure that you test your iHelp items in either of the following ways:

- Create and test your iHelp item in the intended production environment. While you test, restrict the responsibilities associated with the iHelp item to restrict visibility of the item. For more information, about how to restrict responsibilities, see the following task about how to create an iHelp item record.

- Create and test your iHelp item in your development environment, then use ADM to deploy the item to production. For information about ADM and iHelp, see Siebel Application Deployment Manager Guide.

This task is a step in Process of iHelp Administration on page 94.

To create an iHelp item record

1. Navigate to the Administration - iHelp screen > All iHelp Items view.
2. Create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>This is the name that appears in the iHelp pane. Make sure that the name clearly identifies the iHelp item. Do not include any special characters such as colons or quotation marks in the Name.</td>
</tr>
<tr>
<td>Remote Support</td>
<td>iHelp items can be downloaded to regional and local databases. Use this field to determine if items are downloaded:</td>
</tr>
<tr>
<td></td>
<td>- All. Items are downloaded to both regional and local databases</td>
</tr>
<tr>
<td></td>
<td>- Regional. Items are downloaded to regional databases only</td>
</tr>
<tr>
<td></td>
<td>- None. Items are not downloaded to databases</td>
</tr>
</tbody>
</table>
Creating and Administering iHelp

Creating iHelp Item Records

3 Set which users can see the iHelp items (in the iHelp pane or Map):

a Click the Responsibilities view tab.

b Associate the responsibilities of those users who you want to see the iHelp item.

c Make sure the Active flag is selected for each responsibility.

NOTE: Users also must have the Task Assistant Player View associated with at least one of their responsibilities. For more information about how to associate views and responsibilities with users, see Siebel Security Guide.
4 Specify the locations in the application where you want the iHelp item to appear. When you specify a location, you specify a combination of screens, business objects, and view tabs.

iHelp items are mapped to business objects. Business objects are often uniquely associated with a particular screen, but there are some exceptions to this. For example, business object home pages do not have this unique relationship. If you want an iHelp item to appear on both the Activities Home Page and other views under the Activities screen, you must associate both of the following business objects with the iHelp item:

- Action Home
- Action

To specify the locations in the UI where you want the iHelp item to appear, perform the following steps:

a Click the Screens view tab.

b Click New, then select a combination of screens, business objects, and view tabs where you want the iHelp item to appear.

You can select only a combination of screens, business objects, and view tabs, which is common to all the applications specified in the Application field.

5 If you want to restrict edit access for the item, set the access groups to determine who can modify the iHelp item:

a Click the Access Groups view tab.

b Associate access groups with the iHelp item. Make sure that you belong to one of the access groups.

c Click the More Info view and select Private check box in the form view.

For more information about access groups, see *Siebel Security Guide*.

**To add additional help topics to an iHelp item**

1 Navigate to the Administration - iHelp screen > All iHelp Items view.

2 Select the iHelp item you want to work with, and then click the Related iHelp tab.

3 Click New on the Related iHelp form, and then select an iHelp item from the iHelp Item dialog.

You can use the numerals in the Order field for each help topic to specify the order in which the help topics are displayed in the iHelp item.

**Designing iHelp**

Assemble step-by-step iHelp instructions in the iHelp Designer by creating steps and connecting them with branches.

**To access the iHelp Designer**

1 Navigate to the Administration - iHelp screen > All iHelp Items view.
2 Drill down on the name of the iHelp item.

**To create an iHelp step**

1. In the iHelp Designer, drag the Step or Start icon onto the grid.

   The first step in any iHelp must be Start. The start step should navigate the user to the correct view for the iHelp item. Only one Start step is allowed per iHelp item.

2. In the Step form, complete the fields.

   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>This name appears on the step’s icon in the iHelp Designer. The user does not see this name.</td>
</tr>
<tr>
<td>View</td>
<td>Enter a view name if you want the step to:</td>
</tr>
<tr>
<td></td>
<td>- Provide a hyperlink to a view.</td>
</tr>
<tr>
<td></td>
<td>- Highlight buttons or fields on the view.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> If you provide a hyperlink to a screen which is different from the main screen for the iHelp, you may lose record context as you navigate to the other screen. For example, a user in the Contact Activities view of the Contacts screen, highlights an activity record and clicks an iHelp link to the Activities screen. In going to the Activities screen, the record context is broken. The highlighted activity is no longer selected, and the user must query for it again. If you remain in the same screen, context is generally maintained.</td>
</tr>
<tr>
<td></td>
<td>Only views that are common to all the applications specified in the Application field are available for selection.</td>
</tr>
<tr>
<td>Caption</td>
<td>This is the text that appears in the step. Use the following tags to format step captions:</td>
</tr>
<tr>
<td></td>
<td>- <code>&lt;b&gt;</code> and <code>&lt;/b&gt;</code>: Bold.</td>
</tr>
<tr>
<td></td>
<td>- <code>&lt;i&gt;</code> and <code>&lt;/i&gt;</code>: Italic.</td>
</tr>
<tr>
<td></td>
<td>- <code>&lt;u&gt;</code> and <code>&lt;/u&gt;</code>: Underline.</td>
</tr>
<tr>
<td></td>
<td>- <code>&lt;v&gt;</code> and <code>&lt;/v&gt;</code>: View navigation links. If you add these tags to text, the text is displayed in bold and blue, and has an underline when you point to the text.</td>
</tr>
<tr>
<td></td>
<td>- <code>&lt;a&gt;</code> and <code>&lt;/a&gt;</code>: External hypertext links. For example, <code>&lt;a href=&quot;http://www.oracle.com&quot; target=&quot;_blank&quot;&gt;Oracle&lt;/a&gt;</code>. If you add these tags to text, the text is displayed in bold and blue, and has an underline when you point to the text.</td>
</tr>
</tbody>
</table>
Creating and Administering iHelp

Clearing the iHelp List Cache

iHelp loads all iHelp items to the iHelp Map and iHelp pane when the application is initialized. When you modify iHelp items, you may need to clear the iHelp List Cache before you can see changes to the iHelp item (in the iHelp pane).

To clear the iHelp List Cache
1. Navigate to the Administration - iHelp screen > All iHelp Items view.
2. From the menu button, choose Clear iHelp List Cache.

To connect steps with branches
1. Drag the Branches icon onto the grid.
2. Move the end points of the branch to connect two steps.
3. If multiple branches leave one step, set conditions on the branches:
   a. Click the Branches folder for the step.
   b. In the Branches list, complete the fields.

   No Condition Expression is required for the last branch in the sequence.

   For information on the Branch Condition Expression Designer, see Developing and Deploying Siebel Business Applications.

Clearing the iHelp List Cache

(Optional) Highlight a button or field:
- Click the Field and Button Highlights folder.
- In the Field and Button Highlights list, create new records and complete the fields.

(Optional) Create substeps:
- Click the SubSteps folder.
- In the SubSteps list, create new records, and complete the Caption field.

If you add substeps to a step, an arrow is displayed at the end of the step caption. Click this arrow to show the substeps. Click the arrow again to hide the substeps.

NOTE: You cannot add view navigation links to substeps.
Activating, Revising, and Deactivating iHelp Items

The Activate, Revise, and Deactivate buttons control:

- The status of the iHelp items.
- Whether the items are visible in the iHelp pane and iHelp Map.
- Whether the items can be edited.

The behavior of these buttons is described in Table 14.

Table 14. About the Activate, Revise, and Deactivate Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>When to Use</th>
<th>Effect</th>
<th>Changes Status From...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate</td>
<td>The iHelp item is complete and ready for general use.</td>
<td>Cannot be modified (although it can be deleted).</td>
<td>In Progress</td>
<td>Active 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The status and version no longer appear with the item name in the iHelp pane.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Revise</td>
<td>You want to make changes to an active iHelp item.</td>
<td>Copies the iHelp item to a new record that can be edited.</td>
<td>Active</td>
<td>In Progress</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For the new record, deselects Active flag on Responsibilities view.</td>
<td>Inactive</td>
<td></td>
</tr>
<tr>
<td>Deactivate</td>
<td>You no longer want the item to display in the iHelp pane.</td>
<td>The iHelp item is no longer displayed in the iHelp pane or the iHelp Map.</td>
<td>Active</td>
<td>Inactive</td>
</tr>
</tbody>
</table>

1. Any active version of the item becomes Outdated

To activate an iHelp item

1. Navigate to the Administration - iHelp screen > All iHelp Items view.
2. Select an in-progress iHelp item.
3. Click Activate.

To revise an active iHelp item

1. Navigate to the Administration - iHelp screen > All iHelp Items view.
2 Select an active iHelp item.
3 Click Revise.

**TIP:** Reset the responsibilities for the in-progress iHelp item so that you can see and test the item that you are revising.

---

**To deactivate an iHelp item**
1 Navigate to the Administration - iHelp screen > All iHelp Items view.
2 Select an active iHelp item.
3 Click Deactivate.

---

**Translating iHelp Items**

When translating an iHelp Item, only the text strings that the user sees are translated. These text strings are:

- Item name
- Section labels
- Step captions
- Substep captions

If translation is not defined for a language, the text from the base record is displayed.

---

**To translate an iHelp item**
1 Navigate to the Administration - iHelp screen > Translations view.
2 In the iHelp Items list, select an iHelp item.
3 In the Translations list, create a new record, and complete the necessary fields.
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>Translation of the iHelp item name</td>
</tr>
</tbody>
</table>

4 Click the Designer view tab.
5 For each step:
   a Open the Translations folder.
   b Create a record to the Translations list and complete the fields.
6 For each substep:
   a Open the Translations folder for the substep.
Importing and Exporting iHelp Items

iHelp items can be exported and imported as XML files.

Export and import iHelp items to:

■ Move iHelp items from one database to another, for example when upgrading
■ Create backups of iHelp items

You cannot move iHelp items between different types of Siebel repositories. For example, you cannot export from a Siebel Call Center application to a Siebel Automotive application. In general, you need to make sure that all the applications, screens, and views referenced in the exported item are available in the repository where the item is imported.

To export an iHelp item as an XML file

1. Navigate to the Administration - iHelp screen > All iHelp Items view.
2. In the iHelp Items list, select an iHelp item.
   
   **CAUTION:** Make sure that the name of the item does not contain any special characters such as colons or quotation marks.
3. From the menu button, choose Export iHelp Item Definition.

To import an iHelp item

1. Navigate to the Administration - iHelp screen > All iHelp Items view.
2. From the menu button in the iHelp Items list, choose Import iHelp Item Definition.
3. Browse for the iHelp item XML file and click Import.
   
   If an iHelp item of the same name already exists, the imported iHelp item is imported as a new version of the item.
   
   After import, the iHelp Items list is filtered to show only the newly imported item.

   **CAUTION:** The following types of information are not exported or imported: responsibility information and access group information.
This chapter explains the procedures necessary to administer message broadcasting for Siebel applications. It includes the following topics:

- “About Message Broadcasting” on page 103
- “Scenario for Administrating Message Broadcasting” on page 104
- “Process of Message Broadcasting” on page 105
- “Enabling and Disabling Message Broadcasting” on page 105
- “Creating a Message Broadcast” on page 107
- “About Automatically Updating Message Broadcasting Text” on page 110
- “Configuring Message Broadcast Caching” on page 111

About Message Broadcasting

Message broadcasting provides a platform for administrators and other users with access to the Message Broadcasts view to send important information directly to users’ screens. Typically, this information is time-critical such as a due date, or it is updated frequently such as a call queue’s status.

NOTE: Message Broadcasting is available for employee applications. (It is not available for customer or partner applications.)

The messages can be displayed by one of the following two methods:

- Scroll messages in the message bar across the bottom of a user’s screen, visible at all times.
- Display messages in a dialog box in the middle of the screen in addition to scrolling across the bottom of the screen.

Messages have severity levels (indicated by color) and activation and expiration dates.

Message Broadcasts can be created through the administration view, automatically from Siebel Business Process Designer, or remotely from a third-party application through Siebel EAI.

In What Order Are Messages Displayed?

Message Broadcast messages are retrieved from the Message table through the Siebel application server and sent to the message bars of the targeted Siebel Web Client sessions. There is no set order for the messages to appear on the message bar, that is, the order cannot be controlled by the administrator or the end user.
About Disabling Messages
Users can disable their scrolling message bar, but the administrator can override this setting for broadcast messages.

About Message Broadcast Caching Versus Directly Polling the Database
There are two methods for ways for the application to obtain the messages for display:

- The default behavior is to have the messages read from the database each time the message bar is refreshed. This method can adversely affect performance if the message bar is set to refresh frequently.
- Message Broadcast Caching stores messages in each application’s object manager. The messages are then broadcast through the Service Request Broker (SRBroker).

Scenario for Administrating Message Broadcasting
This scenario is an example of process flows performed by an administrator working with call center agents to create and send broadcast messages. Your company may follow a different process flow according to its business requirements.

The contact center administrator wants to inform customer-care representatives of the current total number of outbound calls relative to their day’s goal. In addition, the administrator wants the customer-care representatives to be aware of the current customer service levels and whether there are customers waiting for service.

After working with the telecommunications and application teams to define the appropriate real-time contact center statistics for his customer-care representatives and contact center, the contact center administrator creates broadcast messages, using statistics that come from a variety of sources and third party solutions. The real-time data feed into the Message Broadcasting tables are accomplished through Siebel EAI, UAN, or both after the appropriate statistics and their sources have been identified. The customer-care representatives then receive their individualized and group statistics on their message bar in real time.

In addition to providing his customer-care representatives with this real-time status information, the contact center administrator also wants to send informative messages to individuals and teams in real time. Throughout the shifts and work day, he sends these messages to individuals and teams using the Message Broadcasts view within the Siebel application. The contact center administrator can send a message to an individual employee, a set of employees with the same responsibility, a division of employees, or to all employees.

The customer-care representatives service customers using multiple communications channels with the Siebel application. The customer-care representative can receives contact center statistics calculated for an individual, group, or in summary on the message bar within their Siebel application. This real-time information updates the customer-care representatives as to whether they and the call center are meeting their service objectives.
Process of Message Broadcasting

To set up message broadcasting, the administrator typically performs the following tasks:


Enabling and Disabling Message Broadcasting

By default, message broadcasting is enabled. As an administrator, you can enable or disable message broadcasting. You can set message broadcasting to operate in any of the following modes:

- Always enabled
- Always disabled
- User enabled (default)

You can also enable or disable message broadcasting in Mobile and Dedicated Web Clients.

The message bar is also supported for standard interactivity application clients, and you can display the message bar in standard interactivity client applications.

To enable or disable message broadcasting for an application

1. Navigate to the Administration - Server Configuration screen > Enterprises view.
2. From the Enterprise Servers list, select the enterprise server that runs the application whose message broadcasting settings you want to modify.
3. Click the Component Definitions tab, then select a component whose Component Type value is Application Object Manager.
4 Select the Application Message Bar Flag parameter in the Component Parameters subview, and type the value you require in the Value field. For information about the values you can specify, see Table 15.

Table 15. Application Object Manager Parameter Values

<table>
<thead>
<tr>
<th>Parameter Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE</td>
<td>Specify this value if you want message broadcasting to be always enabled. If this value is set to TRUE, users cannot disable message broadcasting. For a Siebel Web Client deployment, the Siebel application server pushes messages to users. For Mobile Web Client users, messages are synchronized. If you set the Application Message Bar Flag parameter to TRUE, you can specify the update interval for the message bar. To specify the update interval, select the Application Message Bar Update parameter, and modify the Value field. The default value is 120 seconds. If the update interval is less than the SessionTimeout set in the CFG file of the application, sessions never time out.</td>
</tr>
<tr>
<td>FALSE</td>
<td>Specify this value if you want message broadcasting to be always disabled. If this value is set to FALSE, the message bar and message broadcast alerts do not appear on the screens of users. For a Siebel Web Client deployment, the Siebel application server does not push messages to users. For Mobile Web Client users, messages are not synchronized.</td>
</tr>
<tr>
<td>User Enabled</td>
<td>Specify this value if you want users to be able to enable or disable message broadcasting in their user preferences. If a Web client user disables message broadcasting, the Siebel application server does not push messages to the user. If a Mobile Web Client user disables message broadcasting, messages are not synchronized. If this value is set to User Enable, the update interval is a user preference. For more information, see Siebel Fundamentals. If the update interval is less than the SessionTimeout set in the CFG file of the application, sessions never time out.</td>
</tr>
</tbody>
</table>

For details on how to configure the server component, or Siebel Application Object Manager, parameters, see Siebel System Administration Guide.

To enable or disable message broadcasting on Mobile and Dedicated Web Clients

1 Use a text editor to open the CFG file for your Siebel application.
2 Find the ShowMessageBar parameter in the CFG file.
   For example:
ShowMessageBar = TRUE

3 Set the parameter value to TRUE, FALSE, or User Enabled.
See Table 15 on page 106 for more descriptions of each parameter value.

4 If you set the ShowMessageBar parameter to true, specify the update interval for the message bar by adding the following line to the CFG file:

   MessageBarUpdateInterval = seconds

   where seconds is the interval in seconds between message bar updates (refreshes). The default value is 120 seconds.

5 Save and close the CFG file.

**To display the message bar in standard interactivity client applications**

1 Identify the .swt file that specifies the Web template on which the container page for the application is based.

2 Before each of the </swe:frameset> tags in the .swt file, add the following lines:

   <swe:frame type="Toolbar" htmlAttr="marginheight='0' marginwidth='0' noresize scrolling='No'">
     <swe:include file="CCFrameMsgbar.swt"/>
   </swe:frame>

3 Locate each line that contains a htmlAttr attribute in the .swt file.
   The following is a sample line that contains a htmlAttr attribute:

   <swe:frameset htmlAttr="rows='number,number,number,*' border='0' frameborder='No'">

4 In each htmlAttr attribute, enter 15 as the height of the message bar after the asterisk (*).
   The following is a sample htmlAttr attribute, with the height specified:

   <swe:frameset htmlAttr="rows='44,24,25,*,15' border='0' frameborder='No'">

5 Save the changes to the .swt file.

6 Restart your standard interactivity client application.

**Creating a Message Broadcast**

When you create a message broadcast, all connected users that you specify receive the message immediately upon the date and time you have specified that the message be activated. Mobile users, such as field representatives, receive the activated messages when they synchronize.

**NOTE:** To send a message broadcast, you must have responsibilities that include access to the Message Broadcasts view.
Typically, the appearance of a message broadcast is designated by a single severity level, as specified in the Severity field. Each severity level is associated with a different color. The severity level that you choose determines the color of the message broadcast and how it is delivered.

In addition to using the Severity field to determine the appearance of a message, you can also combine multiple severity levels to create a message broadcast with unique formatting. By adding special tags to the text of a message broadcast, you can change the color of different sections of the message. The following tags are used to combine severity levels in a message:

- [N] for Normal
- [H] for High
- [U] for Urgent

For example, if your message has a severity of normal, but you want specific text to be highlighted, you can tag parts of the text with the code for High or Urgent. Here is an example:

```
The trunk line from [H]Chicago, Illinois [N]is [U]DOWN!
```

The beginning of the message appears in the color for the severity of the message, Normal; the words **Chicago, Illinois** appears in the color for High; and the word *DOWN!* appears in the color for Urgent.

**To create a message broadcast**

1. Navigate to the Administration - Communications screen > Message Broadcasts view.
2. In the Message Broadcasts list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abstract</td>
<td>A brief description of the message.</td>
</tr>
<tr>
<td>Activation Date/Time</td>
<td>Date and time at which you want to start broadcasting the message. If the Activation field is left blank, the message is broadcast immediately. However, broadcasts are controlled by the application message interval and login. <strong>NOTE:</strong> The date and time are taken from the Siebel Server (not from the machine where the client browser is running). Make sure that the date and time are set correctly on the Siebel Server.</td>
</tr>
<tr>
<td>All</td>
<td>Check this option to broadcast the message to all users.</td>
</tr>
<tr>
<td>Briefing Bulletin</td>
<td>Check this option to distribute the message as a bulletin on the My Briefing page. For more information, see <em>Siebel Briefings Administration Guide</em>.</td>
</tr>
<tr>
<td>Broadcast</td>
<td>Required to send the message broadcast to recipient’s message bar. Check this option to broadcast and display the message. If not checked, the message is not broadcast in the message bar at the bottom of the screen.</td>
</tr>
</tbody>
</table>
### Message Broadcasting ■ Creating a Message Broadcast

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expiration Date/Time</td>
<td>Date and time at which you want to stop broadcasting the message. If the Expiration field is left blank, the message does not expire and the message continues to be broadcast.</td>
</tr>
<tr>
<td><strong>NOTE:</strong> The date and time are taken from the Siebel Server (not from the machine where the client browser is running). Make sure that the date and time are set correctly on the Siebel Server.</td>
<td></td>
</tr>
<tr>
<td>Message</td>
<td>Required to create the message broadcast record. The text you want to send as the message broadcast. This field accepts up to 2,000 characters.</td>
</tr>
<tr>
<td></td>
<td>To use severity levels within the message text, see &quot;About Automatically Updating Message Broadcasting Text&quot; on page 110.</td>
</tr>
<tr>
<td>Recipient Division</td>
<td>The broadcast message is sent to all users associated with the divisions selected in the Divisions dialog box.</td>
</tr>
<tr>
<td></td>
<td>This field can be used in combination with the Recipient Position field.</td>
</tr>
<tr>
<td>Recipient Position</td>
<td>The broadcast message is sent to all users specified in the Recipients dialog box.</td>
</tr>
<tr>
<td></td>
<td>This field can be used in combination with the Recipient Division field.</td>
</tr>
<tr>
<td></td>
<td>For an employee name to show up in the Recipients dialog box, the employee must have a position defined and be marked active for that position. If multiple employees occupy the same position, the message is sent to all of them, even though you only see the active employee on the list.</td>
</tr>
<tr>
<td></td>
<td>Employees with multiple positions see messages sent to any of their positions, regardless of what position they log in as.</td>
</tr>
<tr>
<td>Severity</td>
<td>Required to create the message broadcast record. Choose the severity level to indicate the importance and appearance of the message.</td>
</tr>
<tr>
<td></td>
<td>To force the message broadcast to appear in an alert box in the middle of the screen, in addition to its appearance on the message bar, select Urgent with Alert.</td>
</tr>
</tbody>
</table>

3. In the Message field, enter the message broadcast text you want to send.

4. (Optional) In the Message field, insert severity level tags as necessary to set the appearance of the message broadcast text.
About Automatically Updating Message Broadcasting Text

As an administrator, you can customize message broadcasting to automatically update message text that changes frequently. For example, a call center’s queue statistics frequently change. Every few minutes, an administrator has to update the statistics to make sure agents have the most accurate information. This manual approach is very time consuming and inefficient when dealing with frequently changing data.

You can use Siebel EAI to automatically update message broadcasting text. Your CTI middleware or ACD switch can provide the data for the Siebel application to distribute.

The Broadcast Message business component manages the messages. The fields of this business component are listed and described in Table 16. These field names are necessary for developing the integration object.

Table 16. Field Names for the Broadcast Message Business Component

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abstract</td>
<td>Short summary for identifying the purpose of a message, such as “Calls In Queue”</td>
</tr>
<tr>
<td>Activation Date/Time</td>
<td>When the message broadcasting should begin</td>
</tr>
<tr>
<td>All</td>
<td>To broadcast the message to all employees with positions defined</td>
</tr>
<tr>
<td>Body</td>
<td>The text of the message displayed in the message bar</td>
</tr>
<tr>
<td>Division</td>
<td>Used to set recipients using division</td>
</tr>
<tr>
<td>Division Id</td>
<td>The internal identification value for Division</td>
</tr>
<tr>
<td>Expiration Date/Time</td>
<td>When the message broadcasting should end</td>
</tr>
<tr>
<td>Position</td>
<td>Used to set recipients using position</td>
</tr>
<tr>
<td>Position Id</td>
<td>The internal identification value for Position</td>
</tr>
<tr>
<td>Recipient</td>
<td>Used to set recipients using employee</td>
</tr>
<tr>
<td>Recipient Id</td>
<td>The internal identification value for Recipient</td>
</tr>
<tr>
<td>Type</td>
<td>Severity of the message as defined in the List of Values type BRDCST_MSG_TYPE</td>
</tr>
<tr>
<td>Via Broadcasting</td>
<td>To send the message using message broadcasting</td>
</tr>
<tr>
<td>Via Interactive</td>
<td>To send the message via Siebel eBriefings</td>
</tr>
</tbody>
</table>

A sample Visual Basic (VB) script follows, which demonstrates how to create and update a broadcast message with information, using the call center queue as an example. The sample Visual Basic script is generic; your CTI middleware’s API determines the structure of syntax like the Msg command.
Sample Message Broadcasting Script

The script can be created through a button, an Excel macro, or another VB application. Because it is a script and not an application, it does not need the VB Set command. All the commands are standard to VB coding.

This script is designed to update a message without an expiration date, not to create a new message every time. For more information on how to get or create a Siebel Application Object, see Configuring Siebel Business Applications.

CAUTION: The code in this example updates single value fields. For information on how to update multi-value fields, see Configuring Siebel Business Applications.

```
' Get "Broadcast Message" BusComp

' Find "Calls Waiting" message
  BusComp.SetSearchSpec "Abstract", "Calls In Queue", errCode
  BusComp.ExecuteQuery 0, errCode
  If BusComp.FirstRecord(errCode) <> True Then

' We need to create a new message
  BusComp.NewRecord 0, errCode
  BusComp.SetFieldValue "Abstract", "Calls In Queue", errCode
  End If

' Prepare message using middleware API info.
  Set Msg = "[N]Calls Waiting: [U]10"

' Update the record
  BusComp.SetFieldValue "Body", Msg, errCode
  BusComp.SetFieldValue "All", "Y", errCode

' Write the record
  BusComp.WriteRecord errCode
```

In addition to writing a script, you can use Siebel Business Process Designer to create or update a broadcast message. For more information, see Siebel Business Process Designer Administration Guide.

Configuring Message Broadcast Caching

The following task describes how to configure your applications to take advantage of message broadcast caching.

NOTE: Message Broadcast administration is not supported on Mobile Web Clients when message broadcasting caching is on. Make additions, edits, and deletions to the Message Broadcasts list only when connected to the server.
To configure message broadcast caching

1. Navigate to the Administration - Server Configuration screen > Enterprises view.

2. From the Enterprise Servers list, select the enterprise server that runs the application whose message broadcasting settings you want to modify.

3. Click the Component Definitions tab, then select a component whose Component Type value is Application Object Manager.

4. Select the Application Enable Message Broadcast Cache parameter in the Component Parameters subview, and type TRUE in the Value field.

   For details on how to configure the server component, or Siebel Application Object Manager, parameters, see Siebel System Administration Guide.

   NOTE: The default value for the Application Message Broadcast Cache Size parameter is 100. It is unlikely that you need to increase this value. The minimum cache size is the ratio \([\text{message bar refresh rate}] / [\text{message update interval}]\). For example, if the message bar updates every 120 seconds and the message updates every 10 seconds, set the cache size parameter to at least 12.

5. Enable message broadcast caching for Dedicated Web Clients (if any). Add or edit the EnableMsgbroadcastCache parameter in the [Siebel] section in your application’s CFG file:

   EnableMsgbroadcastCache = TRUE

6. If you use any workflow policy that contains a workflow policy program of Type = Send Broadcast Message, then activate the Check New Broadcasted Message workflow policy, which belongs to the Siebel Messaging policy group.

   For information about how to activate workflow policies, see Siebel Business Process Framework: Workflow Guide.

   The Check New Broadcasted Message policy monitors the S_BRDCST_MSG table and invokes the Notify Broadcasted Message workflow process to broadcast any new message added to the table.
This chapter explains the procedures necessary to create alerts for Siebel applications. It includes:

- "About Alerts" on page 113
- "Scenario for Using Alerts" on page 113
- "Creating Alerts" on page 114

### About Alerts

Alerts provide a platform for administrators and other users with access to the Alert Administration view to send long, complex, and customized messages directly to selected groups of recipients. Typically, these messages are time-critical, but also need to have associations with data in the company database (for instance, literature or products) and to be customized for the recipient.

For example, to communicate product pricing changes to a sales team with members around the world, a sales manager would want to be able to distribute new pricing structures and product information as soon as they are approved. Traditionally, this would be done with email messages, phone calls, or mailed literature. This approach presents some challenges:

- To provide the necessary details, a large quantity of information may need to be distributed, with file attachments or links provided by the manager.
- Different team members may require different price list or product information, depending on their organization, division, or position.
- Distributing information to remote team members may produce a communication lag time.

Features of alerts include the following:

- The abstract of alert messages are displayed in an applet on the recipients’ home page, listed in order of the priority specified by the sender. Recipients can click on the abstract to read the entire message.
- Literature items, products, systems, and subsystems can be associated with alerts.
- Access to price list and product information available to different team members may be controlled by organization, division, or position.

### Scenario for Using Alerts

This scenario provides an example of a process flow performed by an administrator, a sales manager, and a Human Resources director. Your company may follow a different process flow according to its business requirements.
A multinational software development corporation uses the Siebel Sales application to automate their sales workforce. The company is organized geographically by division for the purpose of access control, and alerts are enabled.

An international sales manager has just been given the go-ahead for a new set of software product bundles, which include one new product. He needs to communicate these price changes to his company’s sales force as soon as possible. Because pricing varies by geography, each of the four major geographical regions represented by his company’s four sales divisions need to receive a customized message about the new product bundles. He tells the Siebel administrator the details of the alert message that needs to be sent.

The Siebel administrator creates the alert message, and associates a price list and the new product with the message. She creates keywords that users will be able to search on to find the message at a later date, if necessary.

When the Siebel administrator sends the alert, a customized message is sent to all international sales representatives, with the appropriate price list for their division associated. The sales representatives see the alert message on their home pages upon login to the Web client or downloads alerts during synchronization. These users can navigate through the home page or Site Map to read the text and any associated literature items or products.

After sending the alert to the sales force, the Siebel administrator continues with other work. The Human Resources director has requested that employees be sent a weekly alert for the next month, reminding them to attend a benefits information session. The Siebel administrator creates this Human Resources alert, using the same process she used to create the sales force alert, but, instead of sending it as a single-message alert, she designates it to recur at weekly intervals.

Creating Alerts

When you create an alert, all designated connected users receive the alert at the date and time the alert is activated. Mobile users, such as sales field representatives, receive an activated alert after synchronization.

To create an alert

1. Navigate to the Administration - Alert screen > Alerts view.
2. In the Alerts list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority</td>
<td>The priority of the message determines where the message appears in the list of alerts on the users’ home pages. Messages with the highest priority are at the top of the list.</td>
</tr>
<tr>
<td>Keyword</td>
<td>Enter keywords that the user searches on to find this message.</td>
</tr>
</tbody>
</table>
### Alerts

#### Creating Alerts

**Step 3:** Drill down on the new record in the Abstract column.

**Step 4:** If you want to add literature as an attachment:

- **a.** Click the Literature view tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>The type chosen from the drop-down list helps determine who receives the alert, as follows:</td>
</tr>
<tr>
<td></td>
<td>- Employee Home Page Alert: Displays the alert on all employees' home pages.</td>
</tr>
<tr>
<td></td>
<td>- Partner Alert: Displays alerts to employees of registered partner companies.</td>
</tr>
<tr>
<td></td>
<td>- Program Information: Displays the alert to self-registered, individual partners.</td>
</tr>
<tr>
<td></td>
<td>- Public Information: Displays the alert to unregistered, anonymous users.</td>
</tr>
<tr>
<td><strong>Abstract</strong></td>
<td>Enter a brief abstract that summarizes the message. This appears as a hyperlink on the appropriate users’ home pages.</td>
</tr>
<tr>
<td><strong>Activation</strong></td>
<td>Enter the date when the message will first appear to users.</td>
</tr>
<tr>
<td><strong>Expiration</strong></td>
<td>Enter the date when the message will no longer appear to users.</td>
</tr>
<tr>
<td><strong>Partner Alert</strong></td>
<td>Indicates that the alert is intended for partner companies. Make sure that this field is selected so that your alert will be seen.</td>
</tr>
<tr>
<td><strong>Employee Alert</strong></td>
<td>Indicates that the alert is intended for employee users. Make sure that this field is selected so that your alert will be seen.</td>
</tr>
<tr>
<td><strong>All Users</strong></td>
<td>Select this box if you want the alert to appear to all users, as indicated by the Employee Alert or Partner Alert check boxes.</td>
</tr>
<tr>
<td></td>
<td>For example, if the Employee Alert check box is checked, and the All Users check box is checked, all employees receive the alert.</td>
</tr>
<tr>
<td><strong>Message Body</strong></td>
<td>Type in the text of the message, including HTML formatting code if desired.</td>
</tr>
<tr>
<td></td>
<td>Alerts can be enhanced by using the following HTML formatting codes:</td>
</tr>
<tr>
<td></td>
<td>- <code>&lt;b&gt;text&lt;/b&gt;</code> = bold</td>
</tr>
<tr>
<td></td>
<td>- <code>&lt;u&gt;text&lt;/u&gt;</code> = underline</td>
</tr>
<tr>
<td></td>
<td>- <code>&lt;i&gt;text&lt;/i&gt;</code> = italics</td>
</tr>
<tr>
<td></td>
<td>- <code>&lt;h4&gt;text&lt;/h4&gt;</code> = font size</td>
</tr>
<tr>
<td></td>
<td>- <code>&lt;a href=&quot;http:text&quot;&gt;text&lt;/a&gt;</code> = hyperlink to Web page or site</td>
</tr>
<tr>
<td><strong>Preview</strong></td>
<td>Displays the message as it appears to users.</td>
</tr>
</tbody>
</table>
b In the Literature list, create a new record for the literature item.

**NOTE:** Only literature of type Sales Tool can be added.

5 If you want to add a product as an attachment:
   a Click the Product view tab.
   b In the Product list, create a new record for the product.

6 If you want to specify the recipients:
   a Click the Recipients view tab.
   b From the Show drop-down list, select Recipient Divisions or Recipient Positions.
   c Create new records to the Recipient List.

Remember, if you selected the All Users check box in **Step 2 on page 114**, the message will automatically be sent to all recipients.
10 Administering and Using Inbox

This chapter contains information about the Inbox, how users use the Inbox, and how administrators can make changes to the Inbox types that are already configured. It includes the following topics:

- “About the Inbox” on page 117
- “Scenarios for Administering and Using the Inbox” on page 119
- “Administering the Inbox” on page 121
- “Reviewing All Inbox Items” on page 121
- “Deleting Inbox Items” on page 121
- “Setting Expiration Dates and Due Dates for Inbox Items” on page 122
- “Changing the Destination View for an Inbox Type” on page 122
- “Changing Inbox Downloading to Remote Databases” on page 122
- “Adding Inbox Translations” on page 123
- “Using the Inbox” on page 123
- “Taking Action on Inbox Items” on page 124
- “Reviewing Completed Items” on page 124
- “Reviewing Submitted Items” on page 124

If you want to create and configure new Inbox types, or make changes to Inbox functionality that require Siebel Tools, see Chapter 11, “Configuring the Inbox.”

About the Inbox

The goals of the Inbox are to provide users with:

- A single screen that shows all approval and notification items assigned to them regardless of the screen where the item originated.

- Enough detailed information about the item so that they can act on the item from the Inbox and not need to navigate to other screens for more information.
Table 17 lists some terminology used in this chapter.

Table 17. Inbox Terminology

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inbox item</td>
<td>Requests for approval and notification that are delivered to inboxes of users. Inbox items point to other records, or to feature objects in the database, which require review or approval. The term <em>Inbox item</em> is shortened to <em>item</em> in some text in this document.</td>
</tr>
<tr>
<td>Deactivated Inbox item</td>
<td>An Inbox item that has been processed or has expired. The item no longer appears in the Inbox Items List view.</td>
</tr>
<tr>
<td>Inbox screen</td>
<td>This is the screen where users can perform the following tasks:</td>
</tr>
<tr>
<td></td>
<td>■ Take action on their current Inbox items.</td>
</tr>
<tr>
<td></td>
<td>■ View their completed items.</td>
</tr>
<tr>
<td></td>
<td>■ View their submitted items.</td>
</tr>
<tr>
<td>Inbox Items List</td>
<td>A view that displays Inbox items on which the user needs to act.</td>
</tr>
<tr>
<td>Submitted Items List</td>
<td>A view that displays deactivated Inbox items that have been submitted by the user.</td>
</tr>
<tr>
<td>Completed Items List</td>
<td>A view that displays deactivated Inbox items. Typically, these are the items for which the approval process is complete.</td>
</tr>
<tr>
<td>Inbox action</td>
<td>The action that the user takes on the Inbox item. Typically, this is approval, rejection, or acknowledgement.</td>
</tr>
<tr>
<td>Inbox type</td>
<td>Determines some characteristics of the Inbox item, such as which actions can be taken on the item, and the expiration date for the item.</td>
</tr>
<tr>
<td>Destination view</td>
<td>A view that displays data from the feature object, and which is linked to by the Name hyperlink.</td>
</tr>
<tr>
<td>Feature object</td>
<td>The underlying entity that the Inbox record points to; for example, a service request record or, for ESS, a row in the SmartScript session table. When you drill down on an item in the Inbox, you see the feature object.</td>
</tr>
<tr>
<td>ESS</td>
<td>Siebel Employee Self-Service application. The Inbox is an important feature for this application. When this document provides ESS-specific information, the information is noted as ESS-specific.</td>
</tr>
<tr>
<td>Universal Inbox</td>
<td>This is an alternative name for the Inbox.</td>
</tr>
</tbody>
</table>

**How the Inbox Interacts with the Feature Objects**

Inbox items contain references to the feature objects.
Feature objects interact with Inbox items through the methods of the Universal Inbox business service. These methods can be invoked using various mechanisms, for example, run-time events can monitor the business component operations of the feature object.

The Inbox interacts with feature objects through Inbox actions, which are defined as part of the Inbox type. Integration business service methods are invoked when the users take action on Inbox items.

Figure 5 illustrates interaction between feature objects and the Inbox.

![Figure 5. How Inbox Interacts with Feature Objects](image)

**About the Universal Inbox Business Service**

The Universal Inbox business service is the interface between the underlying feature object and the Inbox items. Universal Inbox business service methods handle creation, update, deactivation, and deletion of Inbox items.

**CAUTION:** Do not interact with the Inbox through any channel other than the Universal Inbox Business Service.

For information about the methods in Universal Inbox business service, see "Universal Inbox Business Service Methods" on page 137.

**Scenarios for Administering and Using the Inbox**

These two scenarios provide examples of processes performed by administrators and users. You might use the Inbox differently, depending on your business model. The examples provided in this topic are for an approval process. However, similar logic applies for other items such as notification.

- “Scenario for Service Request Management” on page 120
Scenario for Service Request Management

An organization has implemented an automated Inbox assignment and escalation policy for service requests. According to this policy, service requests are assigned based on the area, and an Inbox item is created to notify the service request owner of each assignment. An Inbox item is also created for the manager of the service request owner. The item is created based on the priority of the service request. The Inbox was configured when the Siebel application was initially rolled out, but this recent change in policy requires the administrator to perform some tasks.

The administrator changes the replication-level feature, which is currently set to Regional. The administrator changes the setting so that the Inbox items are downloaded to both regional and local databases.

In addition, the policy has to be implemented in Japanese installations, so the administrator adds the appropriate language translation.

Previous Inbox items have remained in the Inbox for too long, so the administrator reduces the item expiration period.

Finally, the administrator adds a new drill-down destination view for certain users who do not have access to the standard Service Request views.

Scenario for Approving Personnel Action Forms Requests Captured Using ESS

The Human Resources (HR) manager at a company has outlined new personnel action policies for employees. Management has mandated that personnel change requests be filed electronically. Approvals are required in the following sequence:

1. A HR representative for the department in which the employee works
2. The immediate supervisor of the employee
3. The departmental vice president

This new policy is assigned to a Siebel administrator for implementation.

After using the Employee Self-Service feature to set up and activate the integrated Personnel Action Form (PAF), the administrator designs the approval flows for the business object using Siebel Business Process (Workflow) Administration. Using the Inbox, the administrator creates the required approval type. When a user submits this particular item, the approval type created by the administrator invokes the approval workflow process.

A manager at the company submits a PAF. The form is routed to the human resources representative, then the manager, and finally the vice president. Each approver can reject the form and send it back to the requestor. If approved, the process flow results in an update of data fields.
Administering the Inbox

The following list includes some of the straightforward changes that the administrator can make to the Inbox types that have already been configured. For detailed information about how to set up and configure Inbox, see Chapter 11, “Configuring the Inbox.”

- "Reviewing All Inbox Items” on page 121
- "Deleting Inbox Items” on page 121
- "Setting Expiration Dates and Due Dates for Inbox Items” on page 122
- "Changing the Destination View for an Inbox Type” on page 122
- "Changing Inbox Downloading to Remote Databases” on page 122
- "Adding Inbox Translations” on page 123

Reviewing All Inbox Items

Administrators can view all the Inbox items. They can also take action on any Inbox item.

To review all items
1. Navigate to the Administration - Inbox screen and one of the following views:
   - All Inbox Items. All items that are in users’ Inbox Items Lists. The administrator sees one record for each owner.
   - All Completed Items. All items that are in users’ Completed Items Lists. The administrator sees one record for each owner.
   - AllSubmitted Items view. All items that are in users’ Submitted Items Lists. The administrator sees one record for each originator.
2. Click the Detail view tab to see information about the feature object.
3. Click the History view tab to see who owns the item and which owners have taken action on the item.

Deleting Inbox Items

The administrator can delete Inbox items in the All Submitted Items view. When an item is deleted, the item is deleted for all owners and for the user who submitted the item.

To delete Inbox items
1. Navigate to the Administration - Inbox screen > All Submitted Items view.
2. Delete Inbox records as required.
Setting Expiration Dates and Due Dates for Inbox Items

Each Inbox item that is created is associated with an Inbox type. Fields in the Inbox type record determine the expiration and due dates for items of that type.

To change how item expiration and due dates are set for Inbox items of a given type

1. Navigate to Administration - Inbox screen > All Inbox Types view.
2. In the Inbox Types list, select a record and edit the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Queue Duration (Days)</td>
<td>Determines the due date for the item. When the item has been in the Inbox of the owner for more than this number of days, the Past Due check box appears selected.</td>
</tr>
<tr>
<td>Item Expiration Duration (Days)</td>
<td>Determines the expiration date for the item. This field appears in the Submitted Items List view. By default, no action is taken when an item expires.</td>
</tr>
</tbody>
</table>

Changing the Destination View for an Inbox Type

If the Inbox item is set up to link to a particular view through the Name hyperlink, you can change this destination view or add a new destination view. For example, if some users do not have responsibilities to see the current destination view, you can add a destination view that they can see.

Multiple views can be associated with one Item type. Each view is assigned a sequence number. When users drill down on the Item hyperlink in the Inbox, the view that is displayed is the first view in the sequence that they have access to, based on their responsibilities.

Changing Inbox Downloading to Remote Databases

Inbox items can be set to download to regional and local databases. If your Inbox type is currently configured to download to remote databases, you can change this setting.

**NOTE:** If your Inbox type is not currently set to download to remote databases, see “Configuring the Inbox for Use with Remote Databases” on page 132.

To change remote downloading for an Inbox type

1. Navigate to Administration - Inbox screen > All Inbox Types view.
2 Select the Inbox type.

3 In the More Info form, edit the Replication Level:
   - **All.** Downloads the Inbox items to the regional and local databases.
   - **Regional.** Downloads the Inbox items to the regional databases only.
   - **None.** Does not download items to the remote databases.

   **CAUTION:** If the Replication Level is currently set to None, see “Configuring the Inbox for Use with Remote Databases” on page 132 before you change the Replication Level.

### Adding Inbox Translations

If you have a multilingual Siebel application, and the Inbox is not currently supporting all languages, you can use the Translations view to extend language support.

Create a translation record for each language supported in your multilingual application.

#### To set up an Inbox translation

1 Navigate to the Administration - Inbox screen > All Inbox Types view.
2 Select the Inbox item, and click the Translations view tab.
3 In the Translations list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>Translation of the Inbox type Name.</td>
</tr>
</tbody>
</table>

### Using the Inbox

The following list shows the procedures that a user, an employee, manager, or approver, typically perform.

The user (an employee, manager, or approver) uses the Inbox to perform the following tasks:

- “Taking Action on Inbox Items” on page 124
- “Reviewing Completed Items” on page 124
- “Reviewing Submitted Items” on page 124
Taking Action on Inbox Items

Users can take action on items that are sent to them for approval. The most typical actions are to approve, reject, and acknowledge items. The actions available to the user are determined by the Inbox type of the item.

To approve or reject an Inbox item

1. Navigate to the Inbox screen > Inbox Items List view.
2. From the Show drop-down list, select My Inbox Items or My Team’s Inbox Items.
3. In the Inbox Items list, select the item that you want to approve or reject.
   - **NOTE:** You can click the Name hyperlink to review the feature object.
4. In the Action field, select the desired action, for example, Approved.
5. (Optional) In the Comments field, enter a brief explanation.

When the record is saved, the business service and method defined in the Inbox type for the action are triggered.

Reviewing Completed Items

The History view lets users track the progress of the items through each stage of the approval process. For example, managers can review the approval decision and comments made by each approver.

To review items that have been previously approved

1. Navigate to the Inbox screen > Completed Items List view.
2. From the Show drop-down list, select My Completed Items or My Team’s Completed Items.
3. In the Completed Items List, select the item that you want to review.
4. Drill down on the Name hyperlink to review the feature object.

Reviewing Submitted Items

Users can review the Inbox items that they have submitted. They can check the progress of an item, for example, to see who has approved the item and who has not.

To review submitted items

1. Navigate to the Inbox screen > Submitted Items List view.
2. From the Show drop-down list, select My Submitted Items or My Team’s Submitted Items.
3. Review the Inbox items that you, or your team, have submitted.
11 Configuring the Inbox

This chapter contains information about configuring the Inbox.

For administration and user information about the Inbox, see Chapter 10, “Administering and Using Inbox.”

This chapter includes the following topics:

- “Process of Setting Up and Configuring Inbox” on page 125
- “Planning for Inbox Configuration” on page 126
- “Creating Inbox Items” on page 126
- “Creating Inbox Types” on page 127
- “Setting Up Inbox Links to Views and SmartScripts” on page 128
- “Setting Up Inbox Actions” on page 129
- “Configuring the Inbox for Use with Remote Databases” on page 132
- “Setting Up Inbox Approval Translations” on page 133
- “Configuring the Toggle Applets for Inbox Views” on page 134
- “Configuring the Category Icon for the Inbox” on page 135
- “Configuring Action Buttons for Inbox Views” on page 136
- “Setting the Log File for Troubleshooting” on page 137
- “Universal Inbox Business Service Methods” on page 137
- “Examples of Inbox Triggers” on page 155

Process of Setting Up and Configuring Inbox

The following section describes the processes an administrator might follow to set up and configure the Inbox.

1. “Planning for Inbox Configuration” on page 126
2. “Creating Inbox Items” on page 126
3. “Creating Inbox Types” on page 127
4. “Setting Up Inbox Links to Views and SmartScripts” on page 128
5. “Setting Up Inbox Actions” on page 129
6. “Configuring the Inbox for Use with Remote Databases” on page 132
Planning for Inbox Configuration

Before you start configuring the Inbox, you need to do some research and planning.

This task is a step in Process of Setting Up and Configuring Inbox on page 125.

To plan an Inbox Configuration

1. Choose the feature object you want to integrate with the Inbox.
   For example, Employee Self-Service forms, Service Requests, Opportunities.

2. Analyze how the object is currently accessed. Consider the following questions:
   a. Is the object accessed from the UI or from workflow processes? Is the object accessed from one place or many?
   b. How is the object related to other objects? Are other objects dependent on the object?
   c. What operations do users perform on the object?

3. Determine the integration mechanism by considering what needs to happen to the object after it enters the Inbox.

   There are two kinds of integration with the Inbox:
   - **Inbound.** It is typically triggered through workflows, eScripts, run-time events, or Workflow Monitor agents.
   - **Outbound.** It is typically triggered through workflows and eScripts.

   For example, if users access the feature object in other ways besides using the Inbox, you need to synchronize (inbound) the Inbox with the object’s current data. (See also Figure 5 on page 119.)

4. Consider the following best practices:
   - Interact with the Inbox only through the methods in the Universal Inbox business service. Do not edit the Inbox fields directly.
   - Do not customize the fields in the Inbox.
   - You cannot reactivate an Inbox item after the item has been deactivated for the owner. Instead, you must create a new Inbox item for that owner.

Creating Inbox Items

Inbox items are created by the Universal Inbox business service. Methods for this business service can be called using various mechanisms, for example:

- Workflows
Configuring the Inbox

Creating Inbox Types

Workflow Monitor Agent

eScripting

Run-time events

If you want to configure the application to have Inbox items created in a certain screen or for a business component, the following procedure outlines how to do this.

This task is a step in Process of Setting Up and Configuring Inbox on page 125.

To configure the application to create Inbox items

1. Review the information about the Inbox business service, methods and workflows at the end of this chapter.
2. Review the procedures for setting up Inbox types.
3. Use one of the ways given in the preceding list to call the Inbox business service and create Inbox items.

Creating Inbox Types

Each Inbox item that is created is assigned an Inbox type. The Inbox type sets the following characteristics for the Inbox item:

■ Action Type

The action type is the LOV type that determines the actions the user can choose to take on an Inbox.

For example, there is an action type called UINBOX_STATUS_TYPE. There are three LOV records of type UINBOX_STATUS_TYPE: Approved, Received, and Rejected. These records represent the actions that the user can take on an Inbox item of this type.

**NOTE:** Because the effect of the action is set for each Item type, this LOV type can be used for many Item types, but the effect of approving or rejecting can be different for each Item type.

■ Category

The category determines the icon that appears in the Category field for the item in the Inbox. The category field can be useful for querying and sorting Inbox item and Inbox type records. For information about editing the Category icon, see “Configuring the Category Icon for the Inbox” on page 135.

■ Replication Level

■ Integration Object Name

■ Business Object Name

■ Item Expiration Duration (Days)

■ Default Queue Duration (Days)

■ Views and SmartScripts that link to the Inbox item
Configuring the Inbox  ■ Setting Up Inbox Links to Views and SmartScripts

Effects of the actions that the user can choose
This task is a step in Process of Setting Up and Configuring Inbox on page 125.

To create an Inbox type
1 Navigate to the Administration - Inbox screen > All Inbox Types view.
2 In the Inbox Types list, create a new record, and complete the necessary fields in the More Info form.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replication Level</td>
<td>If you do not want to download Inbox items to remote databases, select None. Otherwise, see “Configuring the Inbox for Use with Remote Databases” on page 132.</td>
</tr>
<tr>
<td>Integration Object Name</td>
<td>If there is an integration object associated with the Inbox type, you can specify it here. This is no special logic associated with this field.</td>
</tr>
<tr>
<td>Business Object Name</td>
<td>Enter the feature object that the destination view belongs to.</td>
</tr>
<tr>
<td>Default Queue Duration (Days)</td>
<td>Enter the number of days that the item can stay in the Inbox before the Past Due check box appears selected. This field determines the due date for the item.</td>
</tr>
<tr>
<td>Item Expiration Duration (Days)</td>
<td>Enter the number of days that the item can stay in the Inbox before the item expires. By default, no action is taken when the item expires. The Expiration field appears in the Submitted Items List view.</td>
</tr>
</tbody>
</table>

Setting Up Inbox Links to Views and SmartScripts

Administrators can specify that the Name hyperlink of Inbox items links to a particular view. Administrators can change the destination view or add a new destination view. For example, if some users do not have responsibilities to see the current destination view, you can add a destination view that they can see.

You can associate multiple views with an Item type. You assign a sequence number to each view. When users drill down on the Item hyperlink in the Inbox, the view that is displayed is the first view in the sequence that they have access to, based on their responsibilities.

You can also specify a SmartScript to run when users click the Name hyperlink. SmartScripts are primarily used for ESS integration with Inbox, for example, an ESS Summary Form SmartScript.
This task is a step in Process of Setting Up and Configuring Inbox on page 125.

NOTE: If you have set a Name Drilldown action, then view records you set up are ignored.

**To set up views and SmartScripts for an Inbox type**

1. Navigate to the Administration - Inbox screen > All Inbox Types view.
2. In the Inbox Types list, select a record, and then click the Views view tab.
3. In the Views list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>Select the view to display when users drill down on an Inbox item. Make sure that the view that you enter belongs to the Business Object specified for the Inbox type. For ESS, use the EmpSS Form Player view.</td>
</tr>
<tr>
<td>Sequence #</td>
<td>Enter the sequence in which to make views available to the user.</td>
</tr>
<tr>
<td>SmartScript</td>
<td>Select the SmartScript to run in the view.</td>
</tr>
</tbody>
</table>

**Setting Up Inbox Actions**

**About Actions**

There are several circumstances where a business service method can be invoked to act on an Inbox item. A different action type is used for each. These actions are summarized in Table 18.

Table 18.  Actions for Inbox Types

<table>
<thead>
<tr>
<th>Action</th>
<th>Invokes the Specified Business Service Method When ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Field Dropdown</td>
<td>The user takes action, that is, edits the Action field on the Inbox item.</td>
</tr>
<tr>
<td>Name Drilldown</td>
<td>The user drills down on the Name hyperlink of the item. You can also use the Views view to configure this hyperlink.</td>
</tr>
<tr>
<td></td>
<td>For more information about how to use the Views view to configure the hyperlink, see &quot;Setting Up Inbox Links to Views and SmartScripts&quot; on page 128.</td>
</tr>
<tr>
<td>Local Validation</td>
<td>The user, in a remote database, drills down on the Name hyperlink of the item. For more information, see &quot;Configuring the Inbox for Use with Remote Databases&quot; on page 132.</td>
</tr>
</tbody>
</table>
Configuring the Inbox ■ Setting Up Inbox Actions

Table 18.  Actions for Inbox Types

<table>
<thead>
<tr>
<th>Action</th>
<th>Invokes the Specified Business Service Method When ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initialize</td>
<td>This action is provided for backward compatibility. Do not use this action unless you are upgrading. For more information, see the Siebel Database Upgrade Guide. This action invokes the Initialize method of the Universal Business Service. It creates an Inbox item and starts the defined method.</td>
</tr>
<tr>
<td>Transfer</td>
<td>The user transfers the Inbox item to another user.</td>
</tr>
<tr>
<td>Transfer Validation</td>
<td>The user transfers the Inbox item to another user, and the Transferable field for the Inbox Type is selected.</td>
</tr>
</tbody>
</table>

About Deactivate Item Upon Finish and Deactivate Owners Upon Finish Fields

There are two ways that an Inbox item can be deactivated:

■ Deactivation can be done through one of the Universal Inbox Business Service methods.

■ The Inbox type can be set up so that if the business method in the Actions record finishes without error, the item is deactivated. The item can be deactivated for all the owners or only for owner who takes the action:
  ■ If Deactivate Item Upon Finish is set, when one owner takes action on the item, the item is deactivated for all owners and all owners see the item in their Completed Items List.
  ■ If Deactivate Owners Upon Finish is set, when one owner takes action, the item is deactivated (and moved to the Submitted Items List) for that owner alone. The item remains in the other owners’ Inbox List.

This task is a step in Process of Setting Up and Configuring Inbox on page 125.

For an example of an Inbox action setup, see “Examples of Inbox Triggers” on page 155.

To set up an Inbox action

1. Navigate to the Administration - Inbox screen > All Inbox Types view.

2. In the Inbox Types list, select the Inbox Type, and click the Actions view tab.
In the Actions list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>See Table 18 on page 129.</td>
</tr>
<tr>
<td>Business Service</td>
<td>Specifies the business service to use, for example, Workflow Process Manager.</td>
</tr>
<tr>
<td>Business Service Method</td>
<td>Specifies the method to invoke for the selected business service.</td>
</tr>
<tr>
<td>Business Service Method Arguments</td>
<td>Specifies the arguments required to invoke the business service method. For example, if you use the Workflow Process Manager business service, your workflow must contain the properties with the same argument names.</td>
</tr>
<tr>
<td>Deactivate Item Upon Finish</td>
<td>Select this option to deactivate the Inbox item for all owners, after the method has successfully completed.</td>
</tr>
<tr>
<td>Deactivate Owners Upon Finish</td>
<td>Select this option to deactivate the Inbox item for one owner, after the method has successfully completed.</td>
</tr>
</tbody>
</table>

In addition to the arguments passed in the Business Service Method Arguments field, the following arguments are always passed to your custom business service or workflow:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>ActionLIC</td>
<td>The value the user selected from the Action field. For example, if the Inbox Type has an Action Type of UINBOX_STATUS_TYPE, the value of this argument is one of the following: Accepted, Received, or Rejected.</td>
</tr>
<tr>
<td>BusinessObjectName</td>
<td>The value of the business object name field for the Inbox type.</td>
</tr>
<tr>
<td>Employee Login</td>
<td>The login ID of the user who uses the Inbox type.</td>
</tr>
<tr>
<td>InboxItemId</td>
<td>The row ID of the Inbox item. This argument refers to the UInbox Item business component, which is used by the Submitted Items List view.</td>
</tr>
<tr>
<td>InboxTypeId</td>
<td>The row ID of the Inbox type.</td>
</tr>
<tr>
<td>InboxTypeName</td>
<td>The name of the Inbox type.</td>
</tr>
<tr>
<td>IntegrationObjectName</td>
<td>If the Inbox type has an integration object name, the value of this field is passed in this argument.</td>
</tr>
<tr>
<td>ObjectId</td>
<td>The row ID of the business object name that is managed by the Inbox type.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> This row ID is not the standard Object Id property that is available on every workflow.</td>
</tr>
<tr>
<td>OwnerInfoId</td>
<td>The row ID of the Inbox Item Task. This argument refers to the UInbox Item Task business component, which is used by the Inbox Items List and Completed Items List view.</td>
</tr>
</tbody>
</table>
NOTE: The Inbox Action passes the row ID of the feature object in ObjectId. Within a workflow process, the ID of the primary business component on which the process is based must be stored in the process properties Object Id. Note the space character in the Object Id process property name. Therefore, the workflow process first copies the content of ObjectId to Object Id, if necessary.

Configuring the Inbox for Use with Remote Databases

Inbox items can be downloaded to regional and local databases. The Inbox functionality downloads Inbox item records but does not download the underlying feature object.

CAUTION: The person who configures the Inbox must make sure that the feature object is downloaded. For example, you must make sure that the service request records that the Inbox item points to are downloaded to the local database.

If your business processes require your users to download Inbox items to remote databases, set up a Local Validation action. This action invokes a business service method that you define when a remote user attempts to view the underlying feature object.

The method that you define must return an argument to the Inbox, to tell the Inbox that the feature object is not present. The Inbox then displays an error message to the user and prevents the drill down.

To configure the Inbox for remote use

1. Define a business service with a business service method that does the following:
   a. Accepts the following arguments from the Inbox:
      - InboxItemId
      - OwnerInfoId
      - ObjectId
      - InboxTypeName
      - BusinessObjectName
      - IntegrationObjectName
      - Name-value pairs from the Inbox Parameters tables
   b. Looks for the feature object, and, if the feature object is found, sets the output argument LocalValidationError to N.

2. Navigate to the Administration - Inbox screen > All Inbox Types view.

3. In the Inbox Types list, select the type record.

4. In the More Info form, set the Replication Level:
   - All. To download Inbox items to regional and local databases.
Regional. To download Inbox items to regional databases only.

5 Click the Actions view tab.

In the Actions list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Local Validation</td>
</tr>
<tr>
<td>Business Service</td>
<td>The business service that you defined in Step 1</td>
</tr>
<tr>
<td>Business Service Method</td>
<td>The business service method that you defined in Step 1</td>
</tr>
<tr>
<td>Business Service Method Arguments</td>
<td>Arguments for the business service method.</td>
</tr>
</tbody>
</table>

Setting Up Inbox Approval Translations

If your Siebel application is multilingual, you need to create a translation record for each language.

Use the Translations view to specify Inbox type names in other languages.

This task is a step in Process of Setting Up and Configuring Inbox on page 125.

To set up an Inbox translation

1 Navigate to the Administration - Inbox screen > All Inbox Types view.

2 In the Inbox Types list, select the approval record and click the Translations view tab.

3 In the Translations list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>Translation of the Inbox type Name.</td>
</tr>
</tbody>
</table>
Configuring the Toggle Applets for Inbox Views

The Inbox supports dynamic toggle applets in three types of views, as shown in Table 19.

Table 19. Dynamic Toggle Applets for Inbox

<table>
<thead>
<tr>
<th>Views Supporting Dynamic Toggle Applet</th>
<th>Toggle Applet Name</th>
<th>Corresponding Business Component for Views</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inbox items detail views</td>
<td>UInbox Item Task Toggle List Applet</td>
<td>UInbox Item Task</td>
</tr>
<tr>
<td>Completed items detail views</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Submitted items detail views</td>
<td>UInbox Item Toggle List Applet</td>
<td>UInbox Item</td>
</tr>
</tbody>
</table>

When you set up a dynamic toggle applet, you determine which type of form applet appears in the lower portion of the Inbox Detail views. Typically, the applet that is based on the business object of the underlying feature object is the most suitable applet.

For example, if you want to set up the Inbox for service request approvals, you can create a dynamic toggle applet that displays the Service Request Detail Applet form applet when the business object for the Inbox type is Service Requests. Then you can create a link between the Inbox business components and the Service Request business component, so that the service request information can display in the Inbox detail views.

To configure dynamic toggle applets for the Inbox

1. In Siebel Tools, create an applet child object for the appropriate toggle applet, as follows:
   a. Create a form applet. Make sure that an Applet Web Template is defined for the Edit mode of this applet.
   b. Set the value of the Auto Toggle Field to Item Type BusObj Name.
   c. Set the value of the Auto Toggle Value field to the business object of the Inbox type. For example, set the value to Service Request.

   For information about which toggle applet to create a child object for, see Table 19. For more information about how to configure toggle applets, see Configuring Siebel Business Applications.

2. Create links between the business component of the feature object and the two Inbox business components, that is, UInbox Item and UInbox Item Task. Create the links as follows:
   a. Create a link record.
b Complete the fields as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Automatically populated after the Parent Business Component and Child Business Component fields are completed.</td>
</tr>
<tr>
<td>Parent Business Component</td>
<td>Select UInbox Item Task or UInbox Item.</td>
</tr>
<tr>
<td>Child Business Component</td>
<td>Enter the business component for the dynamic toggle applet, for example, Service Request.</td>
</tr>
<tr>
<td>Source Field</td>
<td>Enter the Item Object ID.</td>
</tr>
<tr>
<td>Destination Field</td>
<td>Enter the ID of the feature object to display in the dynamic toggle applet; usually this is ID.</td>
</tr>
</tbody>
</table>

For more information about creating links, see Configuring Siebel Business Applications.

3 Associate the business component for the dynamic toggle applet with the two Inbox business objects UInbox ItemTask and UInbox Item History. For each link, perform the following actions:

a Create a business object component record.

b Complete the fields as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the business component for the dynamic toggle applet, for example, Service Request.</td>
</tr>
<tr>
<td>Link</td>
<td>Enter the name of the link from Step 2.</td>
</tr>
</tbody>
</table>

**Configuring the Category Icon for the Inbox**

You can change and add to the icons that appear in the Category field by editing the Bitmap Category called Inbox Category.

For more information about bitmap categories and working with images, see Configuring Siebel Business Applications.

**To add Category icon for a Category field value**

1 Add the icon image file, in Graphic Interchange Format (GIF), to the images directory.

   Base the size of your image on the existing Category icons in this directory, for example, icon_approval.gif.
In Siebel Tools, create a bitmap record for the Bitmap Category object called Inbox Category and complete the fields as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the language-independent code for the value, from the UINBOX_INBOX_TYPE LOV, for example, CAMPAIGNS.</td>
</tr>
<tr>
<td>Bitmap</td>
<td>The name of the file from Step 1.</td>
</tr>
</tbody>
</table>

**Configuring Action Buttons for Inbox Views**

In the preconfigured Siebel application, users take action on an Inbox item by choosing from the Action drop-down list. You can configure the Inbox so that the first five values in the Action drop-down list display as buttons on the UIInbox Item Task List Applet applet.

**Activating the Inbox Action Buttons**

Which controls you activate depends on whether your application runs in standard or in high interactivity mode.

For more information about working with controls in applets, see the section about editing applet layout in *Configuring Siebel Business Applications*.

**To configure action buttons for standard interactivity**

1. In Siebel Tools, navigate to the UIInbox Item Task List Applet.
2. Select the Edit List Applet Web Template and then activate the following Applet Web Template Items:
   - ActionControl0
   - ActionControl1
   - ActionControl2
   - ActionControl3
   - ActionControl4

**To configure action buttons for high interactivity**

1. In Siebel Tools, for the Applet Siebel Object called UIInbox Item Task List Applet, select the Edit List Applet Web Template item.
2. Activate the UIInboxCustomCtrl.

   The first five entries in the Action drop-down list display as buttons on the applet.
Configuring Background Colors for the Inbox Action Buttons

If you edited the cascading style sheet for the list applet and changed the background colors, you need to edit the background colors for the action buttons so that they match the applet.

To change the background colors for the action buttons

In Siebel Tools, for the UIInboxCustomCtrl Applet Control, edit these user properties, shown in the following table.

<table>
<thead>
<tr>
<th>User Property</th>
<th>Comment</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ActiveBackgroundColor</td>
<td>Color code for the active background color</td>
<td>#333399</td>
</tr>
<tr>
<td>InActiveBackgroundColor</td>
<td>Color code for the inactive background color</td>
<td>#ffffff</td>
</tr>
</tbody>
</table>

Setting the Log File for Troubleshooting

For troubleshooting problems with the Inbox, set the Inbox log file to a verbose level.

To set the level of the Inbox log file for troubleshooting

In Siebel Tools, set the Log Level for the Inbox log file (Alias = InboxLog) to 5.

For information about log files, see Siebel System Monitoring and Diagnostics Guide.

Universal Inbox Business Service Methods

This section discusses the Universal Inbox business service and lists its methods.

Definitions needed to understand the Universal Inbox Business Service (see also Figure 6):

- **Inbox item and Inbox item owner.** For most of this chapter, the term *Inbox item* has been used synonymously with *Inbox item owner*. But to understand how the methods for the Universal Inbox business service work, it is necessary to distinguish between the two:
  - **The Inbox item.** This is the record that appears in the Submitted Items views.
  - **The Inbox item owner.** This is the record that appears in Inbox Items and Completed Items views. Owner information contained in this record. Typically there are one or more Inbox item owner records associated with one Inbox item record.
**Name-value pairs.** In addition to the predefined fields that belong to the Inbox item records (such as, type name, expiration date), there is provision to store additional data with the Inbox item in the form of name-value pairs. The name-value pairs are typically used to record data specific to the underlying feature object. The name-value pairs are stored in the Inbox Parameters table associated with the Inbox item.

![Diagram](image)

**Figure 6. Relationship Between Inbox Items and Inbox Item Owners**

<table>
<thead>
<tr>
<th>Method Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 CreateInboxEx</td>
<td>This method creates an Inbox item and an Inbox item owner.</td>
</tr>
<tr>
<td>2 CreateInbox</td>
<td>This method creates multiple Inbox items and multiple Inbox item owners.</td>
</tr>
<tr>
<td>3 CreateInboxItem</td>
<td>Creates multiple Inbox items.</td>
</tr>
<tr>
<td>4 CreateInboxOwner</td>
<td>Creates multiple Inbox item owners for an Inbox item.</td>
</tr>
<tr>
<td>5 IsInboxItemExisted</td>
<td>Checks if an Inbox item exists.</td>
</tr>
<tr>
<td>6 GetInboxItemInfo</td>
<td>Returns field values from an Inbox item and, if GetParams is true, returns the name-value pairs for the Inbox item.</td>
</tr>
<tr>
<td>7 GetInboxParamInfo</td>
<td>Returns the name-value pairs for an Inbox item.</td>
</tr>
<tr>
<td>8 GetInboxOwnerInfoEx</td>
<td>Returns field values for an Inbox item owner.</td>
</tr>
<tr>
<td>9 GetInboxOwnerInfo</td>
<td>Returns field values for multiple Inbox item owners for a given Inbox item, and returns information about the action status of the items.</td>
</tr>
<tr>
<td>10 SetInboxParamInfo</td>
<td>Inputs name-value pairs for an Inbox item.</td>
</tr>
<tr>
<td>11 UpdateInboxItemInfo</td>
<td>Updates field values for an Inbox item.</td>
</tr>
<tr>
<td>12 DeactivateInboxItem</td>
<td>Deactivates all Inbox item owners for an Inbox item and updates field values for that Inbox item.</td>
</tr>
<tr>
<td>13 DeactivateInboxOwner</td>
<td>Deactivates an Inbox item owner, and updates the field values for that Inbox item owner.</td>
</tr>
<tr>
<td>14 UpdateInboxOwnerInfo</td>
<td>Updates field values for an Inbox item owner.</td>
</tr>
</tbody>
</table>
CreateInboxEx Method

This method creates an Inbox item and an Inbox item owner.

**Input Arguments**

Table 21. CreateInboxEx Method, Property Set, Type = InboxInfo

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Required</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>InboxName</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>InboxTypeName</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>InboxPartyId</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Comments</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ObjectId</td>
<td></td>
<td></td>
</tr>
<tr>
<td>InboxExpirationDuration</td>
<td></td>
<td>In seconds.</td>
</tr>
<tr>
<td>InboxUTCExpirationTS</td>
<td></td>
<td>UTC timestamp.</td>
</tr>
<tr>
<td>ReplicationLevel</td>
<td></td>
<td>Indicate whether this Inbox item needs to be routed when using remote databases. Choose one of the following options:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ All. Indicates HQ, Regional, Local.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Regional. Indicates HQ, Regional.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ None. Indicates HQ.</td>
</tr>
<tr>
<td>OwnerPartyId</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>OwnerPriority</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Output Arguments

Table 22. CreateInboxEx Method, Property Set

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>InboxItemId</td>
<td></td>
</tr>
<tr>
<td>OwnerInfoId</td>
<td></td>
</tr>
</tbody>
</table>

CreateInbox Method

This method creates multiple Inbox items and multiple Inbox item owners.
Input Arguments

Table 23. CreateInbox Method, Property Set, Type = InboxInfo

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Required</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Child properties</td>
<td></td>
<td>Multiple children are allowed. See Table 24.</td>
</tr>
</tbody>
</table>

Table 24. CreateInbox Method, Child Property Set, Type = InboxItemInfo

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Required</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>InboxName</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>InboxTypeName</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>InboxPartyId</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>ObjectId</td>
<td></td>
<td></td>
</tr>
<tr>
<td>InboxExpirationDuration</td>
<td></td>
<td>In seconds.</td>
</tr>
<tr>
<td>InboxUTCExpirationTS</td>
<td></td>
<td>UTC timestamp.</td>
</tr>
<tr>
<td>Comments</td>
<td></td>
<td>The name-value pairs are put into the Inbox Parameters table.</td>
</tr>
<tr>
<td>Child properties</td>
<td></td>
<td>Multiple children are allowed. See Table 25.</td>
</tr>
</tbody>
</table>

Table 25. CreateInbox Method, Grandchild Property Set, Type = InboxOwnerInfo

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Required</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>OwnerPartyId</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>OwnerPriority</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OwnerQueueDuration</td>
<td></td>
<td>In seconds.</td>
</tr>
<tr>
<td>OwnerUTCDueTS</td>
<td></td>
<td>UTC timestamp.</td>
</tr>
<tr>
<td>OwnerUTCStartWorkingTS</td>
<td></td>
<td>UTC timestamp.</td>
</tr>
<tr>
<td>OwnerActionLIC</td>
<td></td>
<td>Language-independent code.</td>
</tr>
</tbody>
</table>
Configuring the Inbox ■ Universal Inbox Business Service Methods

Output Arguments

Table 26. CreateInbox Method, Property Set

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Child properties</td>
<td>Multiple children can be returned. See Table 27.</td>
</tr>
</tbody>
</table>

Table 27. CreateInbox Method, Child Property Set, Type = ItemOutput

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>InboxItemId</td>
<td>The row ID of the newly created Inbox item.</td>
</tr>
<tr>
<td>Child properties</td>
<td>Multiple children can be returned. See Table 28.</td>
</tr>
</tbody>
</table>

Table 28. CreateInbox Method, Grandchild Property Set, Type = OwnerInfoOutput

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>OwnerPartyId</td>
<td></td>
</tr>
<tr>
<td>OwnerInfoId</td>
<td></td>
</tr>
</tbody>
</table>

CreateInboxItem Method

This method creates multiple Inbox items.

Input Arguments

Table 29. CreateInboxItem Method, Property Set, Type = InboxItemInfo

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Required</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>InboxName</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>InboxTypeName</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>InboxPartyId</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>ObjectId</td>
<td></td>
<td></td>
</tr>
<tr>
<td>InboxExpirationDuration</td>
<td></td>
<td>In seconds.</td>
</tr>
<tr>
<td>InboxUTCExpirationTS</td>
<td></td>
<td>UTC timestamp.</td>
</tr>
<tr>
<td>Comments</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Output Arguments

Table 29. CreateInboxItem Method, Property Set, Type = InboxItemInfo

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Required</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReplicationLevel</td>
<td></td>
<td>Indicate whether this Inbox item needs to be routed when using remote databases. Choose one of the following options:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ All. Indicates HQ, Regional, Local.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Regional. Indicates HQ, Regional.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ None. Indicates HQ.</td>
</tr>
</tbody>
</table>

The name-value pairs are put into the Inbox Parameters table.

CreateInboxOwner Method

This method creates multiple Inbox item owners for an Inbox item. If DeactivateOthers is true, the method deactivates the current active Inbox item owners before creating new ones.

The method searches as follows:

1. InboxItemId
2. ObjectId + InboxTypeName
**Configuring the Inbox**  ■ Universal Inbox Business Service Methods

---

**Input Arguments**

Table 31. CreateInboxOwner Method, Property Set

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Required</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>InboxItemId</td>
<td></td>
<td>The row ID of the newly-created Inbox item.</td>
</tr>
<tr>
<td>ObjectId</td>
<td></td>
<td>The object ID of the inbox item.</td>
</tr>
<tr>
<td>InboxTypeName</td>
<td></td>
<td>The name of Inbox type.</td>
</tr>
<tr>
<td>DeactivateOthers</td>
<td></td>
<td>Default is yes, that is, deactivate others.</td>
</tr>
<tr>
<td>Child properties</td>
<td></td>
<td>Multiple children are allowed. See Table 32.</td>
</tr>
</tbody>
</table>

Table 32. CreateInboxOwner Method, Child Property Set, Type = InboxOwnerInfo

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Required</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>OwnerPartyId</td>
<td>Yes</td>
<td>The party ID of the Inbox owner.</td>
</tr>
<tr>
<td>OwnerPriority</td>
<td></td>
<td>Language-independent code.</td>
</tr>
<tr>
<td>OwnerQueueDuration</td>
<td></td>
<td>In seconds.</td>
</tr>
<tr>
<td>OwnerUTCDueTS</td>
<td></td>
<td>UTC timestamp.</td>
</tr>
<tr>
<td>OwnerUTCStartWorkingTS</td>
<td></td>
<td>UTC timestamp.</td>
</tr>
<tr>
<td>OwnerActionLIC</td>
<td></td>
<td>Language-independent code.</td>
</tr>
</tbody>
</table>

**Output Arguments**

Table 33. CreateInboxOwner Method, Property Set, Type = ItemOutput

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>InboxItemId</td>
<td>The row ID of the newly-created Inbox item.</td>
</tr>
<tr>
<td>DeactivateOthers</td>
<td>Indicates whether or not the other owners have been deactivated.</td>
</tr>
<tr>
<td>Child properties</td>
<td>Multiple children can be returned. See Table 34.</td>
</tr>
</tbody>
</table>

Table 34. CreateInboxOwner Method, Child Property Set, Type = OwnerInfoOutput

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>OwnerPartyId</td>
<td>The party ID of the Inbox owner.</td>
</tr>
<tr>
<td>OwnerInfoId</td>
<td>The information ID of the Inbox owner.</td>
</tr>
</tbody>
</table>
IsInboxItemExisted Method

This method checks if an Inbox item exists.

The method searches as follows:

1. InboxItemId
2. ObjectId + InboxTypeName

Input Arguments

Table 35. IsInboxItemExisted Method, Property Set

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Required</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>InboxItemId</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ObjectId</td>
<td></td>
<td></td>
</tr>
<tr>
<td>InboxTypeName</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Output Arguments

Table 36. IsInboxItemExisted Method, Property Set

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>IsInboxItemExisted</td>
<td>1 or 0</td>
</tr>
<tr>
<td>InboxItemId</td>
<td></td>
</tr>
<tr>
<td>HasActiveOwners</td>
<td>Indicates if the Inbox item has active owners with a 1 or a 0.</td>
</tr>
</tbody>
</table>

GetInboxItemInfo Method

This method returns field values from an Inbox item and, if GetParams is true, returns the name-value pairs for the Inbox item.

The method searches as follows:

1. InboxItemId
2. ObjectId + InboxTypeName
Configuring the Inbox ■ Universal Inbox Business Service Methods

Input Arguments

Table 37. GetInboxItemInfo Method, Property Set

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Required</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>InboxItemId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>ObjectId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>InboxTypeName</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>GetParams</td>
<td></td>
<td>If Y, returns all name-value pairs.</td>
</tr>
</tbody>
</table>

Output Arguments

Table 38. GetInboxItemInfo Method, Property Set

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>ObjectId</td>
<td></td>
</tr>
<tr>
<td>InboxTypeId</td>
<td></td>
</tr>
<tr>
<td>InboxTypeName</td>
<td></td>
</tr>
<tr>
<td>InboxName</td>
<td></td>
</tr>
<tr>
<td>InboxPartyId</td>
<td></td>
</tr>
<tr>
<td>Comments</td>
<td></td>
</tr>
<tr>
<td>InboxUTCExpirationTS</td>
<td>UTC timestamp.</td>
</tr>
<tr>
<td>Name - value pairs</td>
<td></td>
</tr>
</tbody>
</table>

GetInboxParamInfo Method

This method returns the name-value pairs for an Inbox item.

The method searches as follows:

1. InboxItemId
2. ObjectId + InboxTypeName
Configuring the Inbox  ■ Universal Inbox Business Service Methods

Input Arguments

Table 39.  GetInboxParamInfo Method, Property Set

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Required</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>InboxItemId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>ObjectId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>InboxTypeName</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
</tbody>
</table>

Output Arguments

Table 40.  GetInboxParamInfo Method, Property Set

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name - value pairs</td>
<td></td>
</tr>
</tbody>
</table>

GetInboxOwnerInfoEx Method

This method returns field values for an Inbox item owner. If the Inbox item owner is in the screen-active business component record, the method returns the values from the screen-active business component.

The method searches as follows:

1. OwnerInfoId
2. InboxItemId, OwnerPartyId
3. ObjectId, InboxTypeName, OwnerPartyId

Input Arguments

Table 41.  GetInboxOwnerInfoEx Method, Property Set

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Required</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>ObjectId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>InboxTypeName</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>OwnerPartyId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>InboxItemId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>OwnerInfoId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
</tbody>
</table>
Configuring the Inbox ■ Universal Inbox Business Service Methods

Output Arguments

Table 42. GetInboxOwnerInfoEx Method, Property Set

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>OwnerInfoId</td>
<td></td>
</tr>
<tr>
<td>OwnerPriority</td>
<td></td>
</tr>
<tr>
<td>OwnerActionLIC</td>
<td></td>
</tr>
<tr>
<td>OwnerUTCDueTS</td>
<td></td>
</tr>
<tr>
<td>OwnerComments</td>
<td></td>
</tr>
<tr>
<td>OwnerStartWorkingTime</td>
<td></td>
</tr>
<tr>
<td>OwnerEndWorkingTime</td>
<td></td>
</tr>
</tbody>
</table>

GetInboxOwnerInfo Method

This method returns field values for multiple Inbox item owners for a given Inbox item, and returns information about the action status of the items.

The method searches as follows:

1. InboxItemId
2. ObjectId + InboxTypeName

Input Arguments

Table 43. GetInboxOwnerInfo Method, Property Set

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Required</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>InboxItemId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>ObjectId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>InboxTypeName</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>ActiveOwnerOnly</td>
<td>Default is TRUE.</td>
<td>Indicates that information is returned only for active owners.</td>
</tr>
<tr>
<td>EvaluateOR</td>
<td></td>
<td>Evaluate the OR condition on all owners’ actions based on the Action which is passed in from the caller.</td>
</tr>
<tr>
<td>EvaluateAND</td>
<td></td>
<td>Evaluate the AND condition on all owners’ actions based on the Action which is passed in from the caller.</td>
</tr>
</tbody>
</table>
Output Arguments

Table 44. GetInboxOwnerInfo Method, Property Set

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>OREvalResult</td>
<td>1 or 0.</td>
</tr>
<tr>
<td>ANDEvalResult</td>
<td>1 or 0.</td>
</tr>
<tr>
<td>Child Properties</td>
<td>Multiple children can be returned. See Table 45.</td>
</tr>
</tbody>
</table>

Table 45. GetInboxOwnerInfo Method, Child Property Set, Type = InboxOwnerInfo

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>OwnerInfoId</td>
<td></td>
</tr>
<tr>
<td>OwnerPriority</td>
<td></td>
</tr>
<tr>
<td>OwnerActionLIC</td>
<td>Language-independent code.</td>
</tr>
<tr>
<td>OwnerUTCDueTS</td>
<td>UTC timestamp.</td>
</tr>
<tr>
<td>OwnerComments</td>
<td></td>
</tr>
<tr>
<td>OwnerStartWorkingTime</td>
<td>UTC timestamp.</td>
</tr>
<tr>
<td>OwnerEndWorkingTime</td>
<td>UTC timestamp.</td>
</tr>
</tbody>
</table>

SetInboxParamInfo Method

This method inputs name-value pairs for an Inbox item.

The method searches as follows:

1. InboxItemId
2. ObjectId + InboxTypeName

Input Arguments

Table 46. SetInboxParamInfo Method, Property Set

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Required</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>InboxItemId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>ObjectId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>InboxTypeName</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
</tbody>
</table>

The name-value pairs are put into the Inbox Parameters table.
**UpdateInboxItemInfo Method**

This method updates field values for an Inbox item.

The method searches as follows:

1. InboxItemId
2. ObjectId + InboxTypeName

**Input Arguments**

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Required</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>InboxItemId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>ObjectId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>InboxTypeName</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>InboxName</td>
<td></td>
<td>Value passed cannot be empty.</td>
</tr>
<tr>
<td>InboxPartyId</td>
<td></td>
<td>Value passed cannot be empty.</td>
</tr>
<tr>
<td>ReplicationLevel</td>
<td></td>
<td>Indicate whether this Inbox item needs to be routed when using remote mobile client. Choose one of the following options:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- All. Indicates HQ, Regional, Local.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Regional. Indicates HQ, Regional.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- None. Indicates HQ.</td>
</tr>
<tr>
<td>InboxExpirationDuration</td>
<td></td>
<td>In seconds. Value passed cannot be empty.</td>
</tr>
<tr>
<td>InboxUTCExpirationTS</td>
<td></td>
<td>UTC timestamp. Value passed cannot be empty.</td>
</tr>
</tbody>
</table>

The name-value pairs are put into the Inbox Parameters table.

**DeactivateInboxItem Method**

This method deactivates all Inbox item owners for an Inbox item and updates field values for that Inbox item.

The method searches as follows:

1. InboxItemId
2. ObjectId + InboxTypeName
### Input Arguments

Table 48. DeactivateInboxItem Method, Property Set

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Required</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>InboxItemId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>ObjectId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>InboxTypeName</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>InboxName</td>
<td></td>
<td>Value passed cannot be empty.</td>
</tr>
<tr>
<td>InboxPartyId</td>
<td></td>
<td>Value passed cannot be empty.</td>
</tr>
</tbody>
</table>
| ReplicationLevel      |          | Indicates whether this Inbox item needs to be routed when using remote mobile client. Choose from one of the following options:  
- All. Indicates HQ, Regional, Local.  
- Regional. Indicates HQ, Regional.  
- None. Indicates HQ.  |
| InboxExpirationDuration|         | In seconds. Value passed cannot be empty.  |
| InboxUTCExpirationTS  |          | UTC timestamp. Value passed cannot be empty.  |

The name-value pairs are put into the Inbox Parameters table.

Child Properties  

Multiple children are allowed. See Table 49.

Table 49. DeactivateInboxItem Method, Child Property Set, Type = InboxOwnerInfo

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Required</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>OwnerPartyId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>OwnerInfoId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>OwnerPriority</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OwnerActionLIC</td>
<td></td>
<td>Language-independent code.</td>
</tr>
<tr>
<td>OwnerComments</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OwnerStartWorkingTime</td>
<td></td>
<td>UTC timestamp, or Y, T, or TRUE to set to the current time.</td>
</tr>
<tr>
<td>OwnerEndWorkingTime</td>
<td></td>
<td>UTC timestamp, or Y, T, or TRUE to set to the current time.</td>
</tr>
</tbody>
</table>
**DeactivateInboxOwner Method**

This method deactivates an Inbox item owner and updates field values for that Inbox item owner.

The method searches as follows:

1. OwnerInfoId
2. InboxItemId, OwnerPartyId
3. ObjectId, InboxTypeName, OwnerPartyId

If there is SSASqlErrWriteConflict conflict, clear the error message to show the error message on UI.

**Input Arguments**

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Required</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>ObjectId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>InboxTypeName</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>OwnerPartyId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>InboxItemId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>OwnerInfoId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>OwnerPriority</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OwnerActionLIC</td>
<td></td>
<td>Language-independent code.</td>
</tr>
<tr>
<td>OwnerComments</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OwnerStartWorkingTime</td>
<td></td>
<td>UTC timestamp, or Y, T, or TRUE to set to the current time.</td>
</tr>
<tr>
<td>OwnerEndWorkingTime</td>
<td></td>
<td>UTC timestamp, or Y, T, or TRUE to set to the current time.</td>
</tr>
</tbody>
</table>

**UpdateInboxOwnerInfo Method**

This method updates field values for an Inbox item owner.

The method searches as follows:

1. OwnerInfoId
2. InboxItemId, OwnerPartyId
3. ObjectId, InboxTypeName, OwnerPartyId
Input Arguments

Table 51. UpdateInboxOwnerInfo Method, Property Set

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Required</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>ObjectId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>InboxTypeName</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>OwnerPartyId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>InboxItemId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>OwnerInfoId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>OwnerPriority</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OwnerActionLIC</td>
<td></td>
<td>Language-independent code.</td>
</tr>
<tr>
<td>OwnerQueueDuration</td>
<td></td>
<td>In seconds.</td>
</tr>
<tr>
<td>OwnerUTCDueTS</td>
<td></td>
<td>UTC timestamp.</td>
</tr>
<tr>
<td>OwnerComments</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OwnerStartWorkingTime</td>
<td></td>
<td>UTC timestamp, or Y, T, or TRUE to set to the current time.</td>
</tr>
<tr>
<td>OwnerEndWorkingTime</td>
<td></td>
<td>UTC timestamp, or Y, T, or TRUE to set to the current time.</td>
</tr>
</tbody>
</table>

DeleteInboxItem Method

This method deletes an Inbox item and all associated Inbox item owners.

The method searches as follows:

1. InboxItemId
2. ObjectId + InboxTypeName

Usage Example
Call this method when the underlying feature object for the Inbox item has been deleted.

Input Arguments

Table 52. DeleteInboxItem Method, Property Set

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Required</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>InboxItemId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
</tbody>
</table>
Initialize Method

This method is intended for use only by those upgrading from the 7.5.3 version of the application. This method creates an Inbox item and starts the business service method defined in the Initialize action.

**CAUTION:** Priority is no longer an input argument for the Initialize method. (Task) Priority is an input argument for the RouteInboxItem Method.

## Input Arguments

Table 52.  DeleteInboxItem Method, Property Set

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Required</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>ObjectId</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
<tr>
<td>InboxTypeName</td>
<td></td>
<td>For searching, not updated.</td>
</tr>
</tbody>
</table>

Table 53.  Initialize Method, Property Set

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Required</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>ItemType</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>ItemDescription</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>ItemObjectId</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>ItemSubmittedBy</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>ItemPriority</td>
<td></td>
<td>Not supported in version 7.7.</td>
</tr>
<tr>
<td>ItemQueueDuration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ItemComments</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

RouteInboxItem Method

This method is intended for use only by those upgrading from the 7.5.3 version of the application. For more information about this method, see *Siebel Database Upgrade Guide*.

This method deactivates existing Inbox item owners and creates new Inbox item owners for an Inbox item.
Input Arguments

Table 54. RouteInboxItem Method, Property Set

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Required</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>ItemWorkflowInstanceId</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Child Properties</td>
<td>Yes</td>
<td>Multiple children are allowed. See Table 55.</td>
</tr>
</tbody>
</table>

Table 55. RouteInboxItem Method, Child Property Set, Type = TaskOwnerInfo

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Required</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>TaskOwnerId</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>TaskStatus</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TaskPriority</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Output Arguments

Table 56. RouteInboxItem Method, Property Set, Type = ItemOutput

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>InboxItemId</td>
<td>The row ID of the newly-created Inbox item.</td>
</tr>
<tr>
<td>Child properties</td>
<td>Multiple children can be returned. See Table 57.</td>
</tr>
</tbody>
</table>

Table 57. RouteInboxItem Method, Child Property Set, Type = OwnerInfoOutput

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>OwnerPartyId</td>
<td></td>
</tr>
<tr>
<td>OwnerInfoId</td>
<td></td>
</tr>
</tbody>
</table>

Examples of Inbox Triggers

This section presents samples of Inbox triggers.

- "Sample Workflow for Assigning Service Requests and Creating Inbox Items" on page 157
- "Sample Workflow to Synchronize Status for Service Requests and Inbox Items" on page 158
- “Sample Workflow to Update Inbox Items for Status Changes Made in the Inbox Detail View” on page 159
- “Inbox Trigger Used in ESS” on page 160
About the Sample Workflows

The following pages describe three sample workflows that apply to service requests and that illustrate the use of the Inbox. You can use Siebel Tools to import the workflow files into the Siebel Sample Database, and try out the workflows. Additionally, you can import them into your own implementation and modify them for your business needs.

Where to Find the Sample Workflow Files

These sample workflows are provided as part of the sample database installation. You can find these workflow files in the \SIEBEL_CLIENT_HOME\SAMPLE\WORKFLOWS directory. (For example, C:\Program Files\Siebel\7.8\web client\SAMPLE\WORKFLOWS)

The names of the files that contain the sample workflows are:
- Inbox - Service Demo Creation.xml
- Inbox - Service Action.xml
- Inbox - Service Detail Action.xml

Creating Inbox Types for Use with the Sample Workflows

If you want to try out the sample workflows in the Sample Database, you must create two Inbox types: SRManager and SROwner.

To create two Inbox types for use with the sample workflows

1. Create two Inbox types that use the field values given in the following table.

   The procedure is in “Creating Inbox Types” on page 127.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value for First Inbox Type</th>
<th>Value for Second Inbox Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>SROwner</td>
<td>SRManager</td>
</tr>
<tr>
<td>Business Object Name</td>
<td>Service Request</td>
<td>Service Request</td>
</tr>
<tr>
<td>Category</td>
<td>APPROVALS</td>
<td>APPROVALS</td>
</tr>
<tr>
<td>Default Queue Duration (Days)</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Item Expiration Duration (Days)</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Action Type</td>
<td>SR_STATUS</td>
<td></td>
</tr>
</tbody>
</table>

2. Set up a link to the Service Request Detail View for the SROwner and the SRManager Inbox types.

   The procedure is in “Setting Up Inbox Links to Views and SmartScripts” on page 128.
3 Create an Inbox Actions record for the SROwner Inbox type that uses the field values given in the following table.

The procedure is in “Setting Up Inbox Actions” on page 129.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Action Field Dropdown</td>
</tr>
<tr>
<td>Business Service</td>
<td>Workflow Process Manager</td>
</tr>
<tr>
<td>Business Service Method</td>
<td>RunProcess</td>
</tr>
<tr>
<td>Business Service Method Arguments</td>
<td>&quot;ProcessName&quot;, &quot;Inbox - Service Action&quot;</td>
</tr>
</tbody>
</table>

Sample Workflow for Assigning Service Requests and Creating Inbox Items

This topic describes the Inbox - Service Demo Creation workflow.

What This Workflow Does
This workflow is triggered whenever a new service request is created. The workflow acts only on service requests where Area = Network; service requests in all other areas are ignored.

If the service request does not have an owner, it is assigned to APARKER. Inbox items and Inbox item owners are created for the service request’s owner and the service request owner’s manager. Both users are then sent email to notify them that there are new items in their Inboxes.

Diagram of the Workflow

Figure 7. Inbox - Service Demo Creation Workflow
Configuring the Inbox ▪ Examples of Inbox Triggers

Detailed Information About the Steps in the Workflow

The workflow performs the following steps:

1. **Start.** The workflow is triggered when a service request is created.

2. **Retrieve SRInfo.** Retrieves data about the service request, for example, its Area, Status, and SR #.

3. **SRArea, isSR Assigned, HR Policies SR Type, and Default.** If the service request is unassigned and value of the Area field is Network, then assigns the service request to APARKER.

4. Checks if an Inbox item for this service request already exists.

5. **CreateInbox For Owner.** If an Inbox item does not already exist, this step calls the CreateInboxEx method which creates an Inbox item of Inbox type SROwner, and an Inbox item owner.

6. **Get SREmployee Info.** Retrieves the email address of the service request’s owner.

7. **Manager Exist.** Determines if the owner of the service request has a manager.

8. **Get Manager Info, Create InboxMngr, IsEmailAddrExisted, and Send Email to Manager and to Owner.** If the owner of the service request has a manager:
   - Retrieves information about the manager.
   - Calls the CreateInboxEx method to create an Inbox item of Inbox type SRManager, and an Inbox item owner.
   - Sends email to both the manager and the owner of the service request.

9. **IsSROwnerEmail and Send Email to SR Owner.** If the owner does not have a manager, sends email to the owner of the service request.

Sample Workflow to Synchronize Status for Service Requests and Inbox Items

This topic describes the Inbox - Service Action workflow.

What This Workflow Does

This workflow makes sure that changes to the service request records, where the value of the Area field is Network, and the Inbox item based on those service requests are synchronized:

- When a user takes action on a service request Inbox item, the status of the service request record is updated accordingly. For example, when the Inbox item is closed by its owner, the workflow changes the status of the underlying service request to closed.

- When a user changes the Status of a service request, the actions available for the corresponding Inbox item are appropriately updated. In this case, the Inbox items for both the owner and the manager are deactivated and removed from the Inbox.
Configuring the Inbox

Examples of Inbox Triggers

Diagram of the Workflow

![Workflow Diagram](image)

Figure 8. Inbox - Service Action Workflow

Detailed Information About the Steps in the Workflow

The workflow performs the following steps:

1. **Start.** The workflow starts when:
   - The user takes action on a service request Inbox item.
   - The run-time event attached to the WriteRecordUpdate event on the Service Request business component is triggered.

2. **GetInboxInfo.** Retrieves a set of parameters about the Inbox item. One of the parameters is ObjectId, which is the ServiceRequestId. This step positions the Service Request business component on the ObjectId that has been passed in.

3. **GetSRUIStatus.** Retrieves the action taken by the user on the service request Inbox item.

4. **Set SR Status.** Updates the Status of the service request according to the action taken by the user on the Inbox item.

5. **GetSRStatus.** Retrieves the status and area information about the service request.

6. **Network Area?.** Determines if the value of the Area field is Network. If not, the workflow ends.

7. **Is SR Closed?, Deactivate Inbox Owners and Deactivate SRManagers.** If the service request is closed, calls the DeactivateInboxItem method to deactivate Inbox item owners for the owner of the service request and their manager.

Sample Workflow to Update Inbox Items for Status Changes Made in the Inbox Detail View

This topic describes the Inbox - Service Detail Action workflow.

What This Workflow Does

This workflow is triggered when a user changes the status of a service request from within the Inbox screen > Inbox Items List > Detail view. This workflow updates the Inbox item of the service request according to the change made to the service request.
Configuring the Inbox ■ Examples of Inbox Triggers

Diagram of the Workflow

![Workflow Diagram]

Figure 9. Inbox - Service Detail Action Workflow

Detailed Information About the Steps in the Workflow

The workflow does the following steps:

1. **Start.** The run-time event attached to the WriteRecordUpdate event on the Service Request business component of the UInbox Item Task business object is triggered.
2. **GetSRId.** Gets the service request row ID and the Inbox item ID.
3. **GetSRInfo.** Gets the updated information from the service request record.
4. **UpdateInboxOwnerActionInfo.** Calls the UpdateInboxOwnerInfo method to update the Inbox item owner.
5. **IsSRClosed, DeactivateInboxOwner, and DeactivateInboxOwnerManager.** If the service request is closed, calls the DeactivateInboxItem method to deactivate Inbox item owners for the owner of the service request and their manager.

Inbox Trigger Used in ESS

This section presents a sample of SmartScript code.

This code is entered in the Script_Finish statement of the ESS Form (SmartScript). It can be accessed from the Administration - SmartScript screen > Scripts view in the HelpDesk application. For more information about Employee Self Service, see *Siebel HelpDesk Guide*.

The purpose of the script is to take data from the ESS Form (SmartScript) as well as some required arguments to invoke the Universal Inbox business service under the Initialize method. When the user submits the ESS Form (SmartScript), this eScript code is launched, invoking the Universal Inbox business service, and creating an Inbox item based on the parameters specified in the eScript and the Inbox type.

```javascript
function Script_Finish ()
{
    var szScriptSessionId;
    var szRequester;
    var svc;
    var indata;
    var outdata;
    var ssPage;
    var ssQuestion;
    var EmployeeLastName;
    var EmployeeFirstName;
```
var RequestedChange;
var PAFComments;
var PAFPriority;
var szSSLanguageCode;
var szSSCurrencyCode;

ssPage = GetPage("PAF Which Change");
sQuestion = ssPage.GetQuestion("Display Employee Last Name");
EmployeeLastName = ssQuestion.GetCurrentValue();

ssPage = GetPage("PAF Change Requested");
RequestedChange = ssPage.GetQuestion("PAF Change Requested");

ssQuestion = ssPage.GetQuestion("PAF Comments");
PAFComments = ssQuestion.GetCurrentValue();

ssQuestion = ssPage.GetQuestion("PAF Priority");
PAFPriority = ssQuestion.GetCurrentValue();

inData = TheApplication ().NewPropertySet ();
outData = TheApplication ().NewPropertySet ();

// Cancel saving everything to the database
Cancel ();

// Get the login name of the user
szRequester = TheApplication ().LoginName ();

// Get SmartScript Save Session table ID.
ssScriptSessionId = GetSessionId ();

szSSLanguageCode = GetParameter("Language");
szSSCurrencyCode = GetParameter("Currency");

inData.SetProperty ("SmartScriptLanguageCode", szSSLanguageCode);

// ItemObjectld, ItemType, ItemSubmittedBy, and ItemDescription are the required input arguments for the "Universal Inbox.Initialize" inData.SetProperty("ItemObjectld", szScriptSessionId);

// Item Type is the Approvals Inbox type defined in the Approvals Inbox Administration screen
inData.SetProperty("ItemType", "Personnel Action Form");

// Short Description of the inbox item
inData.SetProperty("ItemDescription", RequestedChange + " PAF " + EmployeeFirstName + " " + EmployeeLastName);

inData.SetProperty("ItemSubmittedBy", szRequester);

// ItemQueueDuration, ItemPriority, and ItemComments are the optional input arguments for the "Universal Inbox.Initialize"
inData.SetProperty("ItemQueueDuration", "129600");
inData.SetProperty("ItemPriority", PAFPriority);
inData.SetProperty("ItemComments", PAFComments);

svc = TheApplication ().GetService ("Universal Inbox");
svc.InvokeMethod("Initialize", inData, outData);
}

### Inbox Trigger Using Server Script

This section presents a sample Server Script that calls Inbox methods.

This code is entered in the PreWriteRecord statement for the Project business component in Siebel Tools. The purpose of this code is to take data from the project record as well as some required arguments to invoke the Universal Inbox business service under the Initialize method. When the user changes the value of the Status field to For Approval, this eScript code is launched, invoking the Universal Inbox business service and creating an Inbox item based on the parameters specified in the eScript and the Inbox type.
```javascript
function BusComp_PreWriteRecord ()
{
    var FldProjectStatus = this.GetFieldValue("Status");
    if (FldProjectStatus == "For Approval")
    {
        var szScriptSessionId;
        var szRequester;
        var svc;
        var indata;
        var outdata;

        indata = TheApplication ().NewPropertySet ();
        outdata = TheApplication ().NewPropertySet ();

        // Get the login name of the user
        szRequester = TheApplication ().LoginName ();

        // ItemObjectId, ItemType, ItemSubmittedBy, and ItemDescription are the
        // required input arguments for the "Universal Inbox.Initialize" function
        var FldProjectNum = this.GetFieldValue("Project Num");
        indata.SetProperty ("ItemObjectId", FldProjectNum);
        // ItemType is the Approvals Inbox type defined in the
        // Approvals Inbox Administration screen
        indata.SetProperty ("ItemType", "ChangeManagement");
        // Short Description of the inbox item
        indata.SetProperty ("ItemDescription", FldProjectNum);
        indata.SetProperty ("ItemSubmittedBy", szRequester);

        // ItemQueueDuration, ItemPriority, and ItemComments are the
        // optional input arguments for the "Universal Inbox.Initialize" function
        indata.SetProperty ("ItemQueueDuration", "129600");
        indata.SetProperty ("ItemPriority", "High");
        indata.SetProperty ("ItemComments", "Change Management Project");

        svc = TheApplication ().GetService ("Universal Inbox");
        svc.InvokeMethod ("Initialize", indata, outdata);
    }

    return (ContinueOperation);
}
```
This chapter describes the administrative setup tasks that need to be performed before the Messages screen and views are used. It also explains how end users create, view, sort, and send messages.

**NOTE:** The Messages functionality is unrelated to the message broadcasting and alerts discussed in Chapter 8, "Message Broadcasting" and Chapter 9, "Alerts."

This chapter includes the following topics:

- "Scenario for Setting Up Messages" on page 163
- "Process of Setting Up and Using Messages" on page 164
- "About Using Messages" on page 164
- "Setting Up Messages" on page 164
- "About Email and Screen Alerts" on page 165
- "Creating a New Message (End User)" on page 165
- "Setting Up Single and Recurring Alerts (End User)" on page 167
- "Viewing Messages (End User)" on page 167
- "Sorting Messages by Intervals (End User)" on page 168
- "Sending a Message Using Email (End User)" on page 168

**Scenario for Setting Up Messages**

This scenario provides an example of a business process performed by an administrator and a sales representative to set up and manage messages. Your company may follow a different process according to its business requirements.

A corporation has hired four new sales representatives. The Siebel administrator must set up message functionality for these new employees. The administrator sets up accounts for each new sales representative and checks to make sure that the Communications Management and the Workflow Management component groups are enabled.

Next, the administrator activates the Messages workflow policies and the Siebel Message send email and Siebel Message send email for activity owner workflow processes.

The administrative assistant for the sales representatives receives a message for a sales representative, either by phone or by voice mail. Instead of writing the message out by hand, the administrative assistant enters the message in the Messages screen and assigns the message to the sales representative.
The administrative assistant associates the message with an existing account, adds information in the Comments field, and attaches a spreadsheet file to the message. The administrative assistant then prioritizes the message and send it either as an email or a screen alert.

By default, a message is marked private, which means that only the administrative assistant and sales representative can review the message. The administrative assistant can alternately choose not to mark the message private, and then any individual with access to the account, activity, contact, opportunity, or service request associated with the message can view it.

**Process of Setting Up and Using Messages**

To set up and use messages, the administrator and the end user typically perform the following tasks:

- “Setting Up Messages” on page 164
- “Creating a New Message (End User)” on page 165
- “Setting Up Single and Recurring Alerts (End User)” on page 167
- “Sorting Messages by Intervals (End User)” on page 168
- “Sending a Message Using Email (End User)” on page 168

**About Using Messages**

End users, such as sales representatives and call center agents, can use messages to communicate with others who also use Siebel applications. They can create messages, view and sort messages, and associate activities and other items with messages. Using messages allows end users to maintain a history of the communication associated with a contact, account, opportunity, or information request.

**Setting Up Messages**

Administrators need to set up workflows for the Messages screen and views before a new employee can have email access.

**NOTE:** Make sure that users have the Message User responsibility so that they can access Messages views. For more information about setting responsibilities for users, read about defining responsibilities in *Siebel Security Guide*.

**To set up workflows for the Messages screen and views**

1. Make sure that the Communications Management and the Workflow Management component groups are enabled.
2 Activate the Messages workflow policies. All Messages workflow policies are in the Siebel Messaging policy group.

3 Activate Siebel Message send email and Siebel Message send email for activity owner workflow processes.

For detailed information about how to set up workflows, see Siebel Business Process Designer Administration Guide.

About Email and Screen Alerts

There are two types of message alerts you can establish to send screen or email and screen alerts. You can set up email and screen alerts for messages and individuals to whom you delegate message-related activities, and perform the following tasks:

- Set up an alert for an individual to whom you routinely send messages
  For instance, you routinely send messages to the same individuals, and you want to set up a standard alert method to let them know you have sent a message.

- Set up an alert for a single message so the recipient receives an alert
  For instance, you send a message to an individual for whom you have not set up a message alert, but you can also set up an alert for the individual message.

You can opt to receive both email alerts and screen alerts simultaneously.

**Email Alerts.** A message generates an email alert when the following events occur:

- A message is created and the Alert Type field has a value of Email or Email and Screen Alert.

- A message is assigned to you, and you have set up an alert to receive email when messages or activities are assigned to you by a contact or employee.

- An activity is assigned to you, and you have set up an alert to receive email when messages or activities are assigned to you.

- You send an email from your Siebel application.

**Screen Alerts.** A message generates a screen alert when the following events occur:

- A message is created and the Alert Type field of the Messages form has a value of Screen Alert or Email and Screen Alert.

- A message is assigned to you, and you have set up an alert to receive a screen alert when messages or activities are assigned to you by a contact or employee.

- An activity is assigned to you, and you have set up an alert to receive a screen alert when messages or activities are assigned to you.

Creating a New Message (End User)

You can create a message using the Message screen.
To create a new message

1. Navigate to the Messages screen > Messaging List view.
2. In the Messaging List, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>Shows the Account name associated with the message, if applicable.</td>
</tr>
<tr>
<td>Alert Type</td>
<td>Allows you to select a value from the drop-down list to indicate the alert type for the message. Default values include None, Email, Screen Alert, and Email and Screen Alert.</td>
</tr>
<tr>
<td>Assigned To</td>
<td>A required field that displays the name of the individual to whom you are assigning the message. You can select a default value in the Default Assigned To field in the User Preferences screen. See Siebel Fundamentals for more information on user preferences.</td>
</tr>
<tr>
<td>Comment</td>
<td>An optional text field that displays additional information.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>An editable field that displays the month, day, year and the hour, minute, second that the message was created.</td>
</tr>
<tr>
<td>Email</td>
<td>Automatically populates the email address when you select the contact record.</td>
</tr>
<tr>
<td>First Name</td>
<td>Automatically populates the first name of the contact when you select the contact record.</td>
</tr>
<tr>
<td>Home Phone #</td>
<td>Automatically populates the home telephone number when you select the contact record.</td>
</tr>
<tr>
<td>Last Name</td>
<td>A required field that displays the last name of the contact you selected as the message recipient. After a record is saved, you can drill down on the hyperlink to navigate to Contacts and More Info.</td>
</tr>
<tr>
<td>Message</td>
<td>A text field that displays the content of the message.</td>
</tr>
<tr>
<td>Mobile Phone #</td>
<td>Automatically populates the mobile telephone number when you select the contact record.</td>
</tr>
<tr>
<td>Opportunity</td>
<td>Displays the Opportunity associated with the message, if applicable. Click the select button to choose an opportunity.</td>
</tr>
<tr>
<td>Priority</td>
<td>Allows you to select a value from the drop-down list to indicate the message priority. Default values include 1-ASAP, 2-High, 3-Medium, and 4-Low.</td>
</tr>
<tr>
<td>Private</td>
<td>A check box which, when selected, allows only the message creator and recipient to view the message. When the check box is cleared, team members associated with the opportunity, account, contact, and service request can view the message.</td>
</tr>
<tr>
<td>SR #</td>
<td>The Service Request number associated with the message, if applicable.</td>
</tr>
</tbody>
</table>
Setting Up Single and Recurring Alerts (End User)

You can set up an ongoing alert type for an individual. This individual always receives an alert when you assign a message to him.

You also can assign an alert to a single message to notify the recipient of a message. You can do this either while you are creating the message or after you have saved the message.

**To set up a recurring message alert**

1. Navigate to the Messages screen > Messaging List > Message Alert Setup view.
2. In the Message Alerts Setup list, click New.
3. In the new Message Alert record, click the select button in the Last Name field.
4. In the Pick Contact dialog box, select the name, and then click OK.
5. In the Alert Type drop-down list, select the type of alert.
   - The default value in the Alert Type field is None. Other values are Email Alert, Screen Alert, and Email and Screen Alert.

**To send a single message alert**

1. Navigate to the Messages screen > Messaging List > Daily Messages view.
2. In the Daily Messages list, click New.
3. In the form at the bottom of the window, click the drop down list in the Alert Type field, and then choose the type of alert to assign to the message.

Viewing Messages (End User)

You can view messages assigned to you, or created by you, using your Siebel application.

**To view messages assigned to you**

1. Navigate to the Messages screen > Messaging List view.

### Table

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Allows you to select a value from the drop-down list to indicate the message status. Default values include New, Read, Delegated, Return Call, and Completed.</td>
</tr>
<tr>
<td>Work Phone #</td>
<td>Automatically populates the business telephone number when you select the contact record.</td>
</tr>
</tbody>
</table>
2 In the Messaging list, select the message to read.

3 In the Message Details form, review the text in the Message field.

**To view messages created by you**

1 Navigate to the Messages screen > Messaging List > All Messages view.

2 In the All Messages list, select Columns Displayed from the Menu drop-down list.

3 In the Columns Displayed dialog box, move Created By from the Available Columns list to the Selected Columns list, and then click Save.

4 In the All Messages list, click Query, complete the Created By field, and then click Go.

5 In the All Messages list, sort the messages by the Date/Time field.

---

**Sorting Messages by Intervals (End User)**

Use the appropriate view tab to sort messages into Daily, Weekly, or Monthly lists. You also can use queries to achieve the same result. The default query for the Messaging list displays all messages, but you can select predefined Daily, Weekly, or Monthly queries to refine your lists.

**To sort messages by intervals**

1 Navigate to the Messages screen.

   A list of messages you received today appears in the Messaging list.

2 Click Query and, in the Messages dialog box that appears, enter the date for which you want to find messages, and click Go.

   A list of messages for the specified date appears.

3 Click Today to reset the date to the current date.

4 Click the Weekly Messages view tab to view messages you received in the previous seven-day interval.

5 Click the Monthly Messages view tab to view messages you received in the last 30 days.

---

**Sending a Message Using Email (End User)**

You can send email messages to the recipient from within Siebel application. The recipient either can be inside or outside your corporate firewall because the Siebel application uses the email address associated with the contact information for the recipient. After you create a message and complete the necessary fields, you can send the message as an email. For information on standard email functionality within Siebel Business Applications, see *Siebel Fundamentals*. 

---
To send an email message

1. Navigate to the Messages screen.
2. In the Messaging list, select the message to send as an email message.
3. From File menu, select Send Email.
4. In the Send Email dialog box, complete the fields for the email, and then click Send.
   In the email form, click To to display the Address Book dialog box.
13 Activities

This chapter contains information about activities. It includes the following topics:

- "About Activities” on page 171
- “Creating Activities (End User)” on page 173
- "Working with Others’ Activities (End User)” on page 176
- “Delegating an Activity (End User)” on page 177
- “Viewing Activities Associated with Another Record Type (End User)” on page 178
- "About Configuring Owner and Employee Fields for Activities” on page 178

About Activities

Siebel applications use activities to organize, track, and resolve a variety of tasks, from finding and pursuing opportunities to closing service requests. If a task requires multiple steps that one or more people may carry out, activities greatly simplify the job. Activities can help:

- Define and assign the task
- Provide information to complete the task
- Track the progress of the task
- Track costs and bill for the task

These are the major advantages of breaking down a task into one or more activities:

- The ownership of the problem can remain at the management level, when required.
- The employee looking at assigned activities can identify only the required information.
- Reporting is simplified.
- Activities can be assigned to more than one person.

Activities are used to represent tasks in many situations such as scheduling and recording meetings, appointments, and interactions with customers and prospects. If one task leads to follow-up tasks, it is possible to associate follow-up activity records with a parent activity record.

Activities can be viewed in several different locations, including the following:

- **My To Do List in the Activities screen.** This list shows all the user’s activities, regardless of status. Access this list by navigating to the Activities screen and choosing My To Do List from the Show drop-down list.

- **My To Do’s in the Calendar screen.** This list displays a subset of the data displayed in the My To Do List in the Activities screen, activities that have not been completed. For general information about using the Calendar screen, see *Siebel Fundamentals*. 
Assignments Methods
Activities are assigned to employees. Activity assignment can take place in a number of ways:

- Manual assignment
- Automatic assignment to the creator of the activity (by predefaulting the Owner field to the activity’s creator)
- Automatic assignment using Assignment Manager (see Siebel Assignment Manager Administration Guide).

Business Objects Associated with Activities
Siebel activity objects may be associated with other Siebel business objects. Some common associations are listed in Table 58. In most cases, this association is with a set of activities defined by an activity plan and individual (or stand-alone) activities. In a few cases, an object is associated either with an activity template or with stand-alone activities (not both).

Table 58. Association of Activity Object with Other Siebel Objects

<table>
<thead>
<tr>
<th>Screen Name</th>
<th>Business Object</th>
<th>Stand-Alone Activities</th>
<th>Activities from Templates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts</td>
<td>Account</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Agreements</td>
<td>Service Agreement</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Assets</td>
<td>Asset Management</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Campaigns</td>
<td>Campaign</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Contacts</td>
<td>Contact</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Messages</td>
<td>Messaging</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Opportunities</td>
<td>Opportunity</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Orders (Order Line Items view)</td>
<td>Order Entry</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Preventive Maintenance</td>
<td>FS PM Plan Item</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Programs</td>
<td>Program (DBM)</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Projects</td>
<td>Project</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Quality</td>
<td>Product Defect</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Repairs</td>
<td>FS Repair</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>References</td>
<td>Reference</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Service</td>
<td>Service Request</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Creating Activities (End User)

Using activities, you can assess the investment in time and resources to maintain and grow account relationships. Sales managers also have a record of the activities of their sales representatives as they manage account relationships. Sales teams can use activities to avoid duplicating efforts across the team, and to share information about pending and completed activities.

**NOTE:** Activities that are assigned specific dates and times appear on both the Activities and the Calendar screens. For more information, see *Siebel Fundamentals*.

**To create an activity**

1. Navigate to the Activities screen > Activity List view.
2. In the Activity List, create a new record, and complete the necessary fields.
3 Drill down on the record, and click the view tabs to complete more fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>The account associated with the activity.</td>
</tr>
<tr>
<td>Activity #</td>
<td>A default, application-generated number.</td>
</tr>
<tr>
<td>Alarm</td>
<td>The Alarm check box sets the activity reminder. A reminder dialog box appears when the activity is due. You can either set an alarm for an individual activity, or you can set a default alarm for all your activities. For more information, see <em>Siebel Fundamentals</em>.</td>
</tr>
<tr>
<td>Attachments</td>
<td>Indicates whether there are attachments associated with this activity. This field does not appear by default in the Service Activities view, but can be displayed through the use of the Columns Displayed command.</td>
</tr>
<tr>
<td>Audience</td>
<td>A list of values established by your company that allows you to specify which audiences can view the activity. Examples of values are employees, partners, and customers.</td>
</tr>
<tr>
<td>Billable</td>
<td>A check box which when selected, indicates the activity is a revenue-generating event.</td>
</tr>
<tr>
<td>Category</td>
<td>A list of values established by your company that allows you to specify a category for the activity. Service related activities are often created by one individual (such as a call center agent) and completed by another (such as a service repair representative). Consequently, when a service related category value is selected (such as Diagnostic, Field Engineer Activity, Preventative Maintenance or Other), the owner of the activity is deleted so that the activity is unassigned. The user can then reassign the activity by adding a new value to the owner field. If the customer is using Siebel Assignment Manager, the activity is automatically reassigned.</td>
</tr>
<tr>
<td>Comments</td>
<td>A text field for activity notes and information to be shared by the team.</td>
</tr>
<tr>
<td>Created</td>
<td>The date and time the activity was created.</td>
</tr>
<tr>
<td>Created By</td>
<td>The user ID of the activity creator.</td>
</tr>
<tr>
<td>Description</td>
<td>A text entry field that can be used for additional information about the activity.</td>
</tr>
</tbody>
</table>
### Field | Comments
--- | ---
Display In | A field that determines where an activity appears. The field has three values—Calendar and Activities, To Do and Activities, Activities Only. If, for example, you want an activity to appear in your calendar, you must set the Display In field to Calendar and Activities and make sure that the activity has a start time. If you set the Type field to To Do, the Display In field automatically changes to To Do and Activities. On the home page, To Do activities appear in the My Activities list and do not appear in the My Calendar list.
Due | An editable date field that displays a date and time by which the activity must be completed.
Duration | A list of values established by your company that allows you to choose the duration of an activity. Default values are in minute segments, for example 5, 10, 15, and 20.
Employees | The User ID of the activity creator. You can select multiple employees for an activity, but only one employee can be designated as primary.
End | The proposed date and time for the activity completion.
Estimate | The monetary value associated with the activity estimate.
Global Owner | The employee who is responsible for the activity.
Meeting Location | A text field that can be used for location information that is shared by the sales team. Examples of meeting locations are Conference Room B and Main Campus Facility.
New | Automatically selected when ownership is changed from the activity creator to another user. Automatically cleared when the new owner views activity details by clicking the hyperlink in the Type field.
Opportunity | A dialog box that allows you to associate an opportunity with an activity.
Owner | The primary employee associated with the activity. The default owner is the creator of the activity. Enter a new value into the field by typing the User ID directly into the field, or click the select button and choose the primary employee from the Pick Employee dialog box. The new Owner value that you enter also replaces the primary employee that appears in the Employee field. Conversely, if you add a new primary to the Employee field, this new primary also appears in the owner field.
Price List | A list of values established by your company that allows you to specify which price list is associated with a billable activity.
NOTE: The My To Do filter allows you to view each activity that has been designated as a To Do item using the Display In field. Choose My To Do List from the Show drop-down list to access this feature. You can further refine the To Do List from the Show drop-down list to access this feature. You can also view uncompleted To Do items in the To Do list that appears on the calendar screen. This list, by default, only shows To Do items that are not yet complete.

**Working with Others’ Activities (End User)**

The following procedure describes how to work with another user’s activity records, if that user has granted you permission to do so.

For information about how to grant permission for another user to work with your activity records, see about granting access to your calendar in *Siebel Fundamentals*.
To work with another user’s activity records
1. Navigate to the Activities screen > Others’ Activities List view.
2. In the drop-down list in the header, select the user whose activities you want to work with, and click Go.
   If you have add-and-modify access to the records, the New button in the Activities list is available, and you can work with these records as your own. If you have not been granted permission to make changes, the New button is inactive.

Delegating an Activity (End User)
If you work as part of a sales team or you are a sales manager, you may manage other people’s activities. You can delegate an activity to another member of the sales team, an employee, or a partner.

To delegate an activity
1. Navigate to the Activities screen > Activity List view.
2. Select the activity that you want to delegate.
3. Edit the Owner field, selecting the individual to whom you want the activity assigned.

To reassign or remove ownership of an activity using the Employee field
1. Navigate to the Activities screen > Activity List view.
2. Select the activity that you want to reassign.
3. Edit the Employees field, adding or removing employees as required.
4. Designate one of the employees as the Primary.

To assign an activity using Assignment Manager
1. Navigate to the Activities screen > Activity List view.
2. Select the activity that you want to reassign.
3. In the form, click the menu button and choose Assign.
4. Use the Employees dialog box to select an employee to assign the activity to.

NOTE: If the delegator uses Siebel Assignment Manager to reassign an activity, the delegator is automatically removed from the employee list.
Viewing Activities Associated with Another Record Type (End User)

For example, users researching service requests can review the activities related to the selected service request in the Service Request Detail view. This view lists the completed and scheduled activities for the service request.

The procedure below uses the Service Request screen as an example, but many other screens also have activity views.

To view activities for a service request

1. Navigate to the Service Requests screen > Service Request List view.
2. Drill down on a service request record.
3. Click the Activities view tab.
   - The Activities list represents every scheduled task for the selected service request as well as the service request history.
4. (Optional) Create a new activity and complete the fields.
5. To see more information about an activity, drill down Type field.

About Configuring Owner and Employee Fields for Activities

Depending on your business process, you may want to configure the Siebel application so that the Employees and Owner fields for activities are always left blank when the activity is created. (The Owner field displays the primary from the Employee field.)

To achieve this, use Siebel Tools to set the predefault value of the Primary Owned By field (which maps to the Owner field that appears in the UI) in the Action business component to blank.
This chapter contains information about activity plans, activity templates, sales methods, and sales stages. It includes the following topics:

- "About Activity Templates and Activity Plans” on page 179
- "About Sales Methods” on page 180
- "Scenarios for Activity Plans” on page 180
- "Process of Administering and Using Activity Plans” on page 181
- "Defining a Sales Methodology” on page 181
- "About Activity Assignment” on page 183
- "Creating an Activity Template” on page 184
- "Creating TAS Customer Milestone Templates in a Localized Application” on page 186
- "Deleting an Activity Template” on page 187
- "Setting a Default Sales Methodology (End User)” on page 187
- "Using an Activity Plan (End User)” on page 188

For information about creating activity templates for field service activities, see Siebel Field Service Guide.

**About Activity Templates and Activity Plans**

*Activity templates* are created by an administrator and are blueprints for sets of activities. Activity templates can be invoked by end users to create activity plans.

You can select an appropriate activity template for the goal you want to achieve, which generates a list of activities associated with the activity template. This generated list of activities is an *activity plan*. An activity plan saves you from creating a new list of activities for each sales call, corporate visit, and special event. Typically, activity plans incorporate a company’s best practices. Using activity plans, you can locate, assign, schedule, and track the progress of related activities.

For instance, the following list of activities can serve as an activity template for a corporate visit with clients for product demonstrations:

- Book a conference room
- Set an agenda
- Confirm the date and time with the customer
- Make arrangements for presenters
This set of tasks, when defined as a template and applied to create the activity plan, helps sales team members follow the steps your company recommends to prepare for a corporate visit. The list drives critical tasks and defines the recommended lead time for each activity within the template.

Each activity template is associated (through its Type value) with a certain business object. See Table 58 on page 172 for a list of business object and screens that use activity templates. In activity plans views, only activity templates that have been associated with the active business object can be invoked. For example, on the Opportunity screen, only templates for opportunity activities are visible. Selecting a template creates all the activities defined by that template.

### About Sales Methods

A sales method is an approach used in the sales process. The administrator sets up sales methods and sales stages that represent the organization’s desired sales process. A method may encompass every stage associated with the sales process, from prospecting to forecasting to closing deals. You can set up as many methods and sales stages as your organization needs. Sales representatives can then use the method most appropriate for their opportunities.

Sales methods can differ even within one organization. For instance, a sales method for dealing with complex multimillion dollar opportunities may include as many as fifteen stages, while a sales method of a low dollar opportunity may require only four.

Sales methods and stages are only associated with activity templates and assessment templates of type Opportunity.

### Scenarios for Activity Plans

This scenario provides an example of a process performed by the administrator and the end users in a sales situation. Your company may follow a different process flow according to its business requirements.

#### Scenario for Sales

A sales organization has adopted a new sales methodology in order to improve the effectiveness of its salespeople. The business analyst has provided the administrator with a detailed document describing the sales method, the stages of the method, and the activities that each salesperson should perform at each stage of the deal. The outline of the document looks like this:

**Our New Sales Method**

- Stage 1, Prospecting, the lead discovery phase. (Status = Open)
- Stage 2, Qualification of the lead and working up the deal. (Status = Open)
- Stage 3, Closing the deal and entering the order. (Status = Won)
  - Activity 1, Prepare the quote within 2 days
  - Activity 2, Email the quote to manager for approval within 3 days
The administrator creates a new sales method record (New Sales Method) and four associated sales stage records (Prospecting, Qualification, Closing, and Lost).

Next, she creates four new activity templates, one for each stage. The activity template describes the activities and milestones that the salespeople should perform at that stage.

Because the salespeople enter their own opportunity records, the administrator sets up the activity template details so that the salesperson who enters the opportunity is automatically assigned ownership of the activities.

Salespeople set their user preferences to specify that their default sales methodology is the New Sales Method, so that this methodology is automatically filled in when they create their opportunities.

When salespeople enter their opportunity records and specify a sales stage, the activity template for that stage automatically generates and assigns the activities appropriate for the stage. And, because lead times were set up in the activity template details, the due dates for the activities are calculated automatically, based on the date that the opportunity entered the sales stage.

Process of Administering and Using Activity Plans

This example process represents the tasks that are carried out in the course of administering and using activity plans and sales methods.

- “Defining a Sales Methodology” on page 181
- “Creating an Activity Template” on page 184
- “Creating TAS Customer Milestone Templates in a Localized Application” on page 186
- “Deleting an Activity Template” on page 187
- “Setting a Default Sales Methodology (End User)” on page 187
- “Using an Activity Plan (End User)” on page 188

Defining a Sales Methodology

There are two parts to creating a sales methodology:

- Creating the sales method record
- Creating a sales stage record for each stage in the methodology

**NOTE:** Sales methods and stages are associated with activity templates and assessment templates of type Opportunity. If you are not intending to create a template of this type, you do not need to define a sales methodology.
You use the Sales Methods view of the Applications Administration screen to define sales methods and to create and associate sales stages with each of those methods.

**To create a sales method and associated sales stages**

1. Navigate to the Administration - Data screen > Sales Methods view.
2. In the Sales Methods list, create a new record, and complete the necessary fields.
3. In the Sales Stages list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phase</td>
<td>This value is used for rolling up many different stages into phases. Phases simplify management and reporting of the sales cycle. Select the one that best matches the stage you are currently adding. For example, a stage called Prospecting would best match the lead discovery phase. The choices in this drop-down list are configured by using the SALES_STAGE_PHASE_TYPE type in the List of Values. For more information, see Chapter 5, “Working with Lists of Values.” The default choices are: ■ A - Lead Discovery ■ B - Working the Deal ■ C - Closing ■ D - Lost Deal</td>
</tr>
<tr>
<td>Status</td>
<td>The choices in this drop-down list are configured by using the SALES_STAGE_STATUS type in the List of Values. For more information, see Chapter 5, “Working with Lists of Values.” The default choices are Open, Won, and Lost.</td>
</tr>
<tr>
<td>Quota Factor</td>
<td>The amount by which a sales representative’s quota is multiplied by for that sales stage. As you move deals from one stage to another, some deals fall out of the pipeline. In order to eventually close $1,000,000 in revenues, you might need $10,000,000 worth of stage 01 deals, or $5,000,000 worth of stage 04 deals, or $1,500,000 of stage 08 deals. This means your quota factors in this case is 10 for stage 01, 5 for stage 04, and 1.5 for stage 08. In your Siebel application, a sales representative’s quota is the sum total of his or her revenue quota objectives on all of his or her active quota plans. The default value is 1.</td>
</tr>
<tr>
<td>Order</td>
<td>The sales stage’s position in the list of values in the Opportunities screen.</td>
</tr>
</tbody>
</table>
Before the Sales Method and Sales Stage can be used, the cache may need to be refreshed. For more information, see “Clearing the Cache” on page 73.

### About Activity Assignment

Activities created using activity templates can be assigned automatically to:

- The employee who is specified in the template.
- The employee who creates the activity, using activity templates (this is usual in a sales situation).
- No employee (this is recommended when Assignment Manager is used to assign the activity).
The assignment is determined by the values in the Employee and Category fields of the activity record in the Activity Template Details list, according to Table 59.

Table 59. Employee and Category Values Determine Activity Assignment

<table>
<thead>
<tr>
<th>If Employee Is...</th>
<th>and Category Is...</th>
<th>Then the Activity Is...</th>
</tr>
</thead>
<tbody>
<tr>
<td>NOT NULL</td>
<td>Any value (NULL or NOT NULL)</td>
<td>Assigned to the employee who is specified in the Employee field of the template.</td>
</tr>
<tr>
<td>NULL</td>
<td>Field Engineer Activity, Repair Activity, Preventive Maintenance, or Other</td>
<td>Not assigned. The Employee and Owner fields are blank in the created activity.</td>
</tr>
<tr>
<td>NULL</td>
<td>Not Field Engineer Activity, Repair Activity, Preventative Maintenance, or Other</td>
<td>Assigned to the employee who creates the activity (by applying the activity template).</td>
</tr>
</tbody>
</table>

NOTE: Activities created directly in the Activities screen are similarly affected by the Category value. If the Category value is changed to Field Engineer Activity, Repair Activity, Preventive Maintenance, or Other, the values of Owner and Category fields are deleted and set to NULL when the record is saved.

Creating an Activity Template

You use the Activity Templates view of the Administration - Data screen to create activity templates.

NOTE: For information about creating service activity templates using the Service Details view, see Siebel Field Service Guide.

To create an activity template without grandchild records

1. Navigate to the Administration - Data screen > Activity Templates view.
2 In the Activity Templates list, create a new record, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales Stage</td>
<td>If you are creating a template of type Opportunity, select the sales stage with which you would like to associate the activity template. When the sales stage is selected, the Sales Method field is automatically filled in. When this sales stage (and sales method) are specified for an opportunity and Auto Trigger is selected, the activity template is used to automatically populate the Activity Plan view for that opportunity. For information about creating sales stages and methods, see “Defining a Sales Methodology” on page 181.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type that specifies where you would like the template to be available. For example, select Account if you want to use this template to create activity plans for accounts, or Milestone for TAS customer milestones. The choices in this drop-down list are configured by using the TEMPLATE_OBJECT_TYPE type in the List of Values. For more information, see Chapter 5, “Working with Lists of Values.”</td>
</tr>
<tr>
<td>Sales Method</td>
<td>When the sales stage is selected, the Sales Method field is automatically filled in.</td>
</tr>
<tr>
<td>Public</td>
<td>There is no logic associated with this field. You may choose to use it in conjunction with workflows and search specifications.</td>
</tr>
<tr>
<td>Auto Trigger</td>
<td>If you are creating a template of type Opportunity, select this field to have the activity plan automatically generated for opportunities with this sales stage.</td>
</tr>
</tbody>
</table>

3 Click the Activity Template Details view tab.

4 In the Activity Templates Details list, create a new record, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The choices in this drop-down list are configured by using the TODO_TYPE type in the List of Values. For more information, see Chapter 5, “Working with Lists of Values.”</td>
</tr>
<tr>
<td>Duration</td>
<td>The time needed to complete the activity. This field determines the end time for the activity.</td>
</tr>
<tr>
<td>Lead Time</td>
<td>The lead time for the activity.</td>
</tr>
<tr>
<td>Lead Units</td>
<td>Units of time to measure the lead time of the activity.</td>
</tr>
<tr>
<td>Employees</td>
<td>User names of the people who are to perform the activity. See “About Activity Assignment” on page 183.</td>
</tr>
</tbody>
</table>
Creating TAS Customer Milestone Templates in a Localized Application

The sample TAS Customer Milestone activity template is available only in English. If you are running a localized version of the Siebel Sales application (that is, a version in a language other than English) and are using the Target Account Selling (TAS) module, you need to create an activity template of type Milestone, as outlined in the following procedure.

To translate a TAS Customer Milestone template for a localized application

1. Navigate to Application - Data screen > Activity Templates view.
2. In the Activity Templates list, query for records of type Milestone where Milestone is the translation of the English word in the localization language.

   **NOTE:** For the translation, see the Interface Terminology Look-up manual for your language, or, in the List of Values, look for the Display Value that corresponds to the Language-Independent Code for Milestone. For more information about List of Values, see Chapter 5, "Working with Lists of Values."

   Six records should be found by the query:
   - 1-Request Offering(s)
Activity Plans and Sales Methods

■ Deleting an Activity Template

3 For each of the six templates:
   a Click the Activity Templates Detail view tab.
   b Make sure that for each detail record, the Type is Recommended Activity where Recommended Activity is the translation of the English phrase in the localized language. (See note in Step 2.)
   c Optional: Translate the Description of each detail record into the localized language.

4 Follow the procedure for adding a milestone in "Adding Customer Milestones" on page 436, and make sure that the six Activity Templates (Step 2 of this procedure) appear in the Event field drop-down list.

Deleting an Activity Template

NOTE: If you delete an activity template, the activities associated with activity plans that reference the template are not deleted. However, the reference to the activity template from the activity is deleted.

To delete an activity template
1 Navigate to the Administration - Data screen > Activity Templates view.
2 In the Activity Templates list, select and delete the activity template record.

Setting a Default Sales Methodology (End User)

End users can set a default sales methodology in their preferences so that each time they create a new opportunity, their default sales methodology is filled in for the opportunity record.

To set a default sales methodology
1 From the application-level menu, choose Tools > User Preferences.
2 On the link bar, click Price List & Sales Methodology.
3 In the Sales Methodology field, select the methodology that you want to have as the default.
Using an Activity Plan (End User)

An activity plan defines the activities needed to implement a project or goal, or to resolve issues that frequently occur. For example, if a service-oriented activity plan is associated with a service request, the plan might include standard set of activities required to resolve the SR.

Activity plans use activity templates that establish the list of activities to be completed. Activity templates, created by administrators, may have various levels of details pertinent to each member of a team, such as requisitioning parts and tools, steps involved in the service activities, or special directions or instructions.

After an agent chooses an activity plan, the steps are in place to help diagnose and resolve the customer’s issues, and the agent can move to the next customer call. Either Assignment Manager or an administrator can assign the activities to the appropriate users.

To create activities associated with an activity plan

1. Navigate to the Service Requests screen > Service Request List view.
2. In the Service Request list, select the service request, and drill down on the SR #.
3. Click the Activity Plans view tab.
4. In the Activity Plans list, create a record, and in the Template field, select the appropriate activity template for the service request.
5. In the Planned Start field, enter the start date and time for activities related to the service request.
6. Save the Activity Plan.

Activities associated with the plan are automatically generated and appear in the Activities subview.
This chapter contains information about assessments. It includes the following topics:

- "About Assessment Templates" on page 189
- "Scenario for Using and Administering Assessments" on page 189
- "Process of Administering and Using Assessments" on page 190
- "Creating an Assessment Template" on page 190
- "Performing an Assessment (User)" on page 192
- "Assessing an Opportunity for Target Account Selling (End User)" on page 193

### About Assessment Templates

An assessment template is a model used to generate an assessment. Assessment templates can be created to assess opportunities, contacts, and accounts, as well as other areas of the Siebel applications.

Assessments ask questions (in the form of attributes) and score the answers in order to determine a single total score or percentage, which measures or ranks a given opportunity, contact, account, or so on.

Assessments are made up of one or more attributes. Each attribute has a name, a weight, a set of allowable values and a description field. For example, a common attribute for an account might be Credit History. The values for this attribute might include Excellent, Good, Average, and Poor. Each of these values carries a numerical score and, optionally, instructions for the end user on how to choose the correct value.

Typically, the administrator creates assessment templates, and end users apply the templates and carry out the assessments.

### Scenario for Using and Administering Assessments

This scenario provides an example of a process performed by the administrator and the end users in a sales situation. Your company may follow a different process according to its business requirements.

A sales organization has adopted a new sales methodology in order to improve the effectiveness of its salespeople. The business analyst has provided the administrator with a detailed document describing the sales method.
Because the salespeople have too many opportunities to deal with at once, they need to prioritize their opportunities. To help them to this, the business analyst has created a standardized assessment document that he recommends all salespeople use to rank their opportunities. The outline of assessment document looks like this:

Assessing a Lead at the Qualification Stage

> Attribute 1: Adaptability to New Technology, weight = 5

> Attribute 2: Number of potential users, weight = 7

  0 to 50, score = 0, Too small
  51 to 100, score = 1, Route to telesales
  101 to 500, score = 2, Route to middle market
  more than 500, score = 6, Pursue aggressively

> Attribute 3: Sponsor's stance, weight = 10

  Adversarial, score = -5, Strongly against us
  Weak, score = 0, Neutral or slight favor another vendor
  Moderate, score = 5, Willing to recommend our product
  Strong, score = 10, Believes we are the best choice

> Attribute 4: Lead's purchase profile and history, weight = 5

The administrator uses the information in this document to create an assessment template associated with the qualification stage. When a salesperson reaches the qualification stage of the deal, the Assessments view for that opportunity is automatically populated with the questions that need to be answered in order to assess and prioritize the opportunity.

Process of Administering and Using Assessments

This example process represents the tasks that are carried out in the course of administering and using assessments.

- "Creating an Assessment Template" on page 190
- "Performing an Assessment (User)" on page 192
- "Assessing an Opportunity for Target Account Selling (End User)" on page 193

Creating an Assessment Template

You use the Sales Assessment Templates view of the Administration - Data screen to create assessment templates.
**To create an assessment template**

1. Navigate to the Administration - Data screen > Sales Assessment Templates view.

2. In the Assessment Templates list, create a new record, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment</td>
<td>The name of the template.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type that specifies where you would like the template to be available. For example, select Contact if you want to use this template to create an assessment plan for contacts. The choices in this drop-down list are configured by using the TEMPLATE_OBJECT_TYPE type in the List of Values. For more information, see Chapter 5, “Working with Lists of Values.”</td>
</tr>
<tr>
<td>Sales Stages</td>
<td>If you are creating a template of type Opportunity, select sales stages with which you would like to associate the assessment template. When one of these sales stages (and matching sales method) is specified for an opportunity, the assessment template is used to automatically populate the Assessments view for that opportunity.</td>
</tr>
<tr>
<td>Sales Method</td>
<td>This field is filled when a sales stage is selected.</td>
</tr>
</tbody>
</table>

3. In the Assessment Attributes list, create a new record for each attribute you want to assess. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>The attribute’s position in the Assessment Attributes list.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the attribute.</td>
</tr>
<tr>
<td>Weight</td>
<td>The relative importance of the attribute.</td>
</tr>
<tr>
<td>Max Child</td>
<td>This field contains the maximum score from the Attribute Values list.</td>
</tr>
<tr>
<td>Weight Times Score</td>
<td>This is the product of the Weight and the Max Child values.</td>
</tr>
</tbody>
</table>
For each assessment attribute, create a record for each possible value of the attribute in the Attribute Values list.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Indicates the value’s position in the Attribute Values list.</td>
</tr>
<tr>
<td>Value</td>
<td>The name of the value, for example, Excellent, Good, or Average.</td>
</tr>
<tr>
<td>Score</td>
<td>The number of points that the value represents.</td>
</tr>
<tr>
<td>Description</td>
<td>Additional information about the value to help the assessor.</td>
</tr>
</tbody>
</table>

These values appear in the Pick Attribute Value dialog box when the end user applies the template. For information about using an assessment template, see "Assessing an Opportunity" on page 345.

How Assessment Scores Are Calculated

The total score for the assessment is determined by summing weighted scores for each assessment attribute:

\[
\text{Total Score} = \sum_{i=1}^{n} (\text{Weight}_i \times \text{Score}_i)
\]

where \(n\) is the number of assessment attributes in the template.

The score is also calculated as a percentage of the maximum score possible:

\[
\text{Max Total Score} = \sum_{i=1}^{n} (\text{Weight}_i \times \text{Max Score}_i)
\]

where \(\text{Max Score}_i\) is the largest score for any value in the Attribute Values list for the \(i\)th attribute. This is the Max Child value shown in the Assessment Attributes applet. For example, in the assessment example in the "Scenario for Using and Administering Assessments" on page 189, the largest score for Attribute 2 is 6 and the largest score for Attribute 3 is 10.

Performing an Assessment (User)

You can perform assessments of accounts, contacts, and opportunities.
You can use account assessments to compare accounts, to compare accounts with a model, or to determine what information is present or not for an account. You complete the assessment by selecting the appropriate values for the different accounts.

The following procedure shows how to assess an opportunity, but the procedure is essentially the same for any screen where assessments can be performed.

An opportunity assessment helps you qualify opportunities and verify resource allocation. Using an assessment template, you can select values and attributes to assign a composite value to the opportunity.

**NOTE:** In some companies, your Siebel application automatically generates assessments, but if this process has not been automated, you can create assessments manually.

**To perform an assessment**

1. Navigate to the appropriate Assessments view. For example, to assess an opportunity, navigate to Opportunities > List > Assessments.
2. Query for the first item that you want to assess, then click the Assessments view tab.
3. In the Assessments list, create a new record, and complete the necessary fields:
   - In the Template Name field, click the select button.
     - The Select Assessment Template dialog box appears.
   - Select the template, and then click OK.
   - Alternatively, select a record from the list of assessment templates.
4. Click the Assessment Attributes subview tab.
5. For each assessment attribute, select the appropriate value for the attribute from the drop-down list in the Value field.

   A composite assessment value for the item appears as a percentage value in the Percent field in the Assessments view. This percentage compares the value you entered with the maximum possible value for the item.

---

**Assessing an Opportunity for Target Account Selling (End User)**

Sales professionals can use the Assessments view to evaluate the opportunity using criteria developed by Siebel MultiChannel Services. Assessments must be completed before determining the best strategy. An assessment focuses on the following four key questions:

1. Is there an opportunity?
2. Can we compete?
3. Can we win?
4. Is it worth winning?
Sales professionals assess their organization's position and the position of their top competitors against these criteria. As the sales campaign progresses, sales professionals repeat this assessment and then compare the results to past assessments to evaluate and monitor their position at each sales stage.

The first few times an assessment is performed, use the TAS Coach to help evaluate and answer each set of assessment questions. After a number of assessments are performed and you are familiar with the criteria and methodology, use the Assessment form to rate the criteria.

**To begin an assessment**

1. Navigate to the Opportunities screen > List view.
2. In the Opportunities list, drill down on the opportunity which you want to assess.
3. Click the Target Account Selling view tab.
4. In the lower link bar, click Assessments.
   - The Assessments list includes all the assessments you and your sales team have performed to date. Use the Assessments list to compare opportunity assessments for your company and your competitors.
5. In the Assessments form, click New.
6. In the new record, the Assessment For field defaults to Our Company for self assessments. If you are assessing a competitor's position, enter the competitor in this field.
7. In the Assessment form, click TAS Coach, and then complete the assessment criteria questions.
   - For more information, see "Using the TAS Coach" on page 194.

**Using the TAS Coach**

The Assessment TAS Coach uses Siebel SmartScripts technology to help sales professionals evaluate opportunities. The explorer pane expands to show the individual questions in each question set, and the form at right provides information on assessment considerations and rating selection.

**To perform an assessment using TAS Coach**

1. Assess the position of each of the criteria in the Assessments list by selecting a plus (+), a minus (-), or a question mark (?) from the drop-down list.
2. Click Next to advance to the next set of criteria questions.
   - Click Previous to return to criteria you have already assessed.
   - Click Cancel to return to the Assessments view without saving the assessment.
If you want to pause in the middle of a TAS Coach assessment, and then return to the assessment at a later time, click Finish Later. The assessment does not appear in the Assessments list until it is completed.

Your assessment is saved in the SmartScripts screen’s My Saved Session view. Use Site Map to navigate to the SmartScripts screen.

If you do not have enough information to answer the question, select the question mark (?).

When you have rated all criteria, click Finish to return to the Assessments list.

You must click Finish to save the criteria ratings.
Assessments

Assessing an Opportunity for Target Account Selling (End User)
This chapter describes the resource and calendar access tasks performed by the administrator.

It includes the following topics:

- "About Calendar Resources" on page 197
- "About Calendar Access" on page 197
- "Scenarios for Calendar Administration” on page 197
- "Process of Calendar Administration” on page 198
- "Setting Up Resources” on page 199
- "Adding and Modifying Calendar Access” on page 199
- "Deleting Calendar Access” on page 200
- Configuring the Calendar Alarm on page 200
- Configuring the Calendar on page 201

### About Calendar Resources

Resources are typically things such as conference rooms and audiovisual equipment that are reserved and used by employees for meetings and other calendar activities. Resources have availability associated with them and can be invited as participants to calendar activities, in much the same way as employees and contacts are invited to calendar activities. For more information about adding participants to activities, see *Siebel Fundamentals*. The administrator is responsible for setting up and maintaining the list of resources.

### About Calendar Access

Normally employees grant each other access to their calendars as described in *Siebel Fundamentals*. However, there are various situations when the administrator may be required to add, modify, or delete calendar access for employees.

### Scenarios for Calendar Administration

These scenarios provide examples of calendar tasks performed by the administrator. Your company may follow a different process according to its business requirements.
Resource Administration

This topic presents two scenarios requiring resource administration:

- Before the Siebel application is rolled out to end users, the administrator creates resource records. He creates resource records for all the conference rooms for the various floors and buildings of the company’s sites. He also creates resource records for the audio-visual equipment that employees may want to reserve for use at their meetings.

- After the Siebel application is rolled out, the company grows and more sites and conference rooms are added. Old audio-visual equipment is discarded and new equipment is purchased. The administrator continues to maintain the list of resources, keeping it up-to-date.

See “To administer resources for calendar activities” on page 199 for the procedure associated with these scenarios.

Calendar Access Administration

Here are three scenarios requiring calendar access administration:

- Employee A is out of the office unexpectedly. Employee B needs to view Employee A’s calendar so that she can cancel his appointments. Employee B asks the administrator to give her access to Employee A’s calendar. See “To give Employee B access to Employee A’s calendar” on page 199.

- An executive has been granted access to many of his colleagues’ calendars. When the executive moves to a new division, he no longer needs to access to these employees’ calendars. He asks the administrator to clear the list by removing his name from all employees’ Calendar Access List views. (Alternatively, the executive could have contacted all the employees whose calendars are on his Owner drop-down list and asked each of them to remove his name from their calendar access lists.) See “To remove all employees from an employee’s Owner drop-down list in Calendar view” on page 200.

- When an employee leaves the company, the administrator removes the employee’s name from the Owner lists of other employees. See “To remove an employee from all employees’ Calendar Access List views” on page 200.

Process of Calendar Administration

This example process represents the tasks that are carried out in the “Scenarios for Calendar Administration” on page 197.

Setting up of resources is completed before the end users begin to set up meetings. Other tasks are carried out according to the company’s business needs.

1 “Setting Up Resources” on page 199
2 “Adding and Modifying Calendar Access” on page 199
3 “Deleting Calendar Access” on page 200
Setting Up Resources

The following procedure describes administering resources for calendar activities.

To administer resources for calendar activities

1. Navigate to Administration - User screen > Resources view.
2. In the Resources list, create a new record, and complete the necessary fields.
   
   **TIP:** If the Description and Site fields are not sufficient to identify the resource, other fields can be added to the Resources list applet. For example, your company may want to add Building Number and Floor fields to help end users find and identify resources. For information on creating and exposing fields, see *Configuring Siebel Business Applications*.
3. Edit and delete resource records as required.

Adding and Modifying Calendar Access

There are two Calendar Administration views that can be used to modify calendar access:

- Calendar Admin Access Received lists all the calendars that the selected employee can access.
- Calendar Admin Access Granted lists all the employees who can access the selected employee’s calendar.

To give Employee B access to Employee A’s calendar

1. Navigate to Administration - User > Employees > Calendar Administration > Access Granted.
2. In the Employees list, select the employee (Employee A).
3. In the Calendar Administration list, create a new record or select an existing record and complete the Last Name and Update Access fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Name</td>
<td>This is the name of the Employee B who wants to access Employee A’s calendar.</td>
</tr>
<tr>
<td>Update Access</td>
<td>If this field is selected, Employee B has read/write access to Employee A’s calendar. If this field is not selected, Employee B has read-only access to Employee A’s calendar.</td>
</tr>
</tbody>
</table>

To view all the calendars to which an employee has access

1. Navigate to Administration - User screen > Employees > Calendar Administration > Access Received view.
Calendar Deleting Calendar Access

2 In the Employees list, select the employee.

The Calendar Administration list shows calendars to which the employee has access.

**NOTE:** Records can be added, modified, and deleted from this view.

### Deleting Calendar Access

For a selected employee, the administrator can delete all employees from the Access Granted or the Access Received list.

**To remove all employees from an employee’s Owner drop-down list in Calendar view**

1. Navigate to Administration - User screen > Employees > Calendar Administration > Access Received view.
2. In the Employees list, select the employee.
3. Make sure that you have selected the employee whose Owner drop-down list you want to clear.
4. From the menu button in the Access Received list, select Delete All.

This command deletes *all* records in the list. The employee selected in the Employees list no longer has access to *any* calendars other than his or her own.

**NOTE:** Alternatively, you can use the Delete Record command to remove just one selected employee from the employee’s calendar owner drop-down list.

**To remove an employee from all employees’ Calendar Access List views**

1. Navigate to Administration - User > Employees > Calendar Administration > Access Granted.
2. In the Employees list, select the employee.
3. Make sure that you have selected the employee that you want to remove from all employees’ calendar access lists.
4. From the menu button in the Access Granted list, select Delete All.

This command deletes *all* records in the list. The calendar of the employee selected in the Employees list can no longer be accessed by *any* other employees.

**NOTE:** Alternatively, you can use the Delete Record command to delete the employee from one selected employee’s calendar access list.

### Configuring the Calendar Alarm

This section describes how to administer Calendar alarms:

- Setting Alarm Manager Load Frequency on page 201.
- Setting Retroactive Alarms on page 201.
Setting Alarm Manager Load Frequency

A system preference called Alarm Manager Load Frequency determines how frequently the calendar alarm queries the server for alarm-enabled appointments. The default value is 60 minutes, but you may want to change this time to better suit your business needs: querying the server less frequently results in fewer SQL calls. However, each SQL call takes longer to execute. In certain cases, this trade-off results in improved performance. (Also, if the alarm frequency is less than the session time-out set in the eapps.cfg file, sessions never time out.)

For information on how to edit system preferences, see “Setting System Preferences” on page 46.

Setting Retroactive Alarms

Retroactive alarms are alarms for past events that did not display before the event because the user was not logged in. By default, the application is set to display up to 14 days of past retroactive alarms for missed events. You can change the number of days for retroactive-alarm display by editing the RetroAlarmInterval user property of the Alarm Manager business service.

Configuring the Calendar

This section describes some aspects of the Calendar feature that configurators or administrators can configure:

- Displaying Start and End Times for Calendar on page 202
- Displaying Fields, Colors, Drilldowns, and ToolTips on page 202
- Specifying Day Summary ToolTip on page 203
- Showing and Hiding User Interface Components on page 205
- Changing User Interface Strings on page 206
- Changing Date Display Format on page 207
- Changing the First Day of the Week on page 208
- Overriding User Preferences on page 209
- Enabling and Disabling Calendar Editing on page 209
- Using Special Date Markers on page 209
- Specifying Extra Business Components on page 210
- Dragging-and-Dropping Records from Other Applets into the Calendar on page 210
- Changing Controls in the Calendar Detail View on page 213
- “Showing or Hiding Side Applets on the Life Sciences Calendar” on page 213
Displaying Start and End Times for Calendar

Two fields determine the start and end times for display in the calendar applet (Table 60). These two fields are specified by applet user properties.

<table>
<thead>
<tr>
<th>Applet User Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Date</td>
<td>The name of the field that indicates the start date and time for display in the calendar applet.</td>
</tr>
<tr>
<td>End Date</td>
<td>The name of the field that indicates the end date and time for display in the calendar applet.</td>
</tr>
</tbody>
</table>

Displaying Fields, Colors, Drilldowns, and ToolTips

This section describes displaying fields for calendar records, displaying field colors, and displaying ToolTip text.

Displaying Fields for Calendar Records

You can configure one or more fields as display fields for calendar records. Field configuration is controlled by the applet user property, Display Fields. The value of this user property is a list of comma delimited business component fields that you want displayed for each record in the calendar. For the Activity Calendar, the default value is Description, which is the description of the activity displayed in the calendar.

**TIP:** If you want to display contents of more than one field, you can either configure multiple display fields or create a calculated field that concatenates other fields and set the concatenated field name as the value of the Display Fields user property. For example, multiple display fields are used for the calendar applet (CS CG Activity HI Calendar Applet) used by the Consumer Sector application.

Displaying Field Color

You can configure each display field to display in a specified color and change the color dynamically. Use the Display Field Colors applet user property to configure the colors of the display fields. See Table 62 on page 204 for information about this user property.

Displaying Field Drilldown

You can specify a drilldown object for each Display Field through the applet user property, Display Field Drilldown Object Names. The value of the user property is a comma delimited list of drilldown objects defined for the applet.
Displaying Field ToolTip Text

When you move the mouse over a display field in a calendar record, ToolTip text appears (Figure 10 on page 204.) The ToolTip content is configurable through the applet user property Display Field Name.Tooltip Fields, where Display Field Name is the name of the display field.

The user property value is a list of comma delimited business component fields. The values of these business component fields display as the ToolTip in the display field. By default, the name of the business component field is used as the label in the ToolTip text.

Make the label for a ToolTip field translatable by creating a control in the applet with the name Tooltip Field Label:Field Name. The caption of the control is used as the label for the ToolTip field. For example, for the business component Quote, field Name, the ToolTip label for the field is defined as a control of name ToolTip Field Label:Quote.Name, and the caption of the control will be the label for this field.

Specifying Day Summary ToolTip

For a given day on the Weekly and Monthly Calendar, you can specify the format of the ToolTip that displays all the records for this day.

Day Summary ToolTip User Properties

Table 61 lists the applet user property for the Day Summary ToolTip.

Table 61. Calendar Applet User Property for Day Summary ToolTip

<table>
<thead>
<tr>
<th>Applet User Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Buscomp Name&quot;.Day Summary Tooltip Template</td>
<td>Template for the day summary ToolTip. ToolTip appears when mouse over the tile header (7 day weekly or monthly) or the day slot (5 day weekly).</td>
</tr>
<tr>
<td>Action.Day Summary Tooltip Template</td>
<td>[Planned] – [Planned Completion] [Type]: [Description] It will be rendered as: 12:00PM – 1:00PM Appointment: Test eBiz 1:00PM – 2:00PM Training: Take course 2:00PM – 4:00PM Appointment: Design review</td>
</tr>
</tbody>
</table>
Calendar ToolTip Text Figure

Figure 10 shows an example of the ToolTip text in the Activity Hi Calendar.

Table 62 lists the Calendar user properties for the Calendar fields, colors, drilldowns, and ToolTips.

Table 62. Calendar Applet User Property for Calendar Fields, Colors, Drilldowns, and ToolTips

<table>
<thead>
<tr>
<th>Applet User Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Fields</td>
<td>The value of this user property is a list of comma delimited business component fields that you want displayed for each record in the calendar.</td>
</tr>
<tr>
<td></td>
<td>For the Activity Calendar, the default value is Description, which is the description of the activity displayed in the calendar.</td>
</tr>
<tr>
<td>Display Field Colors</td>
<td>The value can be comma delimited color strings or field names in the format of #RRGGBB.</td>
</tr>
<tr>
<td></td>
<td>If the value is a color string, using the format #RRGGBB, then it is used as a color string, otherwise, if the format is not #RRGGBB, then it is interpreted as a field name.</td>
</tr>
<tr>
<td>Display Field Drilldown Object Names</td>
<td>Comma delimited drilldown object names.</td>
</tr>
<tr>
<td></td>
<td>For example, the Quote. Display Field Drilldown Object Name Applet User Property Name could drilldown to the Quote Detail - Id, Quote Detail - Name User Property Value.</td>
</tr>
</tbody>
</table>
Showing and Hiding User Interface Components

You can show or hide the UI components by user properties, as listed in Table 63. The HI Calendar Base Applet contains the default values for all HI calendars. These user properties can be overwritten by the current applet.

Table 63. Calendar Applet User Property for User Interface Components

<table>
<thead>
<tr>
<th>UI Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Daily</td>
<td>Set the Daily button to N to hide the button, and set to Y to show the button.</td>
</tr>
<tr>
<td>Enable Weekly</td>
<td>Set the Weekly button to N to hide the button, and set to Y to show the button.</td>
</tr>
<tr>
<td>Enable Monthly</td>
<td>Set the Monthly button to N to hide the button, and set to Y to show the button.</td>
</tr>
<tr>
<td>Enable New Button</td>
<td>Set the New button to N to hide the button, and set to Y to show the button.</td>
</tr>
<tr>
<td>Enable Today Button</td>
<td>Set the Today button to N to hide the button, and set to Y to show the button.</td>
</tr>
<tr>
<td>Enable Print Button</td>
<td>Set the Print button to N to hide the button, and set to Y to show the button.</td>
</tr>
</tbody>
</table>
Changing User Interface Strings

By changing the user interface strings, which come from Siebel Tools configurations, you can change the user interface controls.

The HI Calendar Base Applet contains the basic UI strings for all HI calendars and the repeating pop-up dialog. These UI controls can be overwritten by the current applet. Table 64 lists the applet controls.

Table 64. HI Calendar Base Applet Controls

<table>
<thead>
<tr>
<th>Control Name</th>
<th>Caption</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily Tab</td>
<td>Daily</td>
</tr>
<tr>
<td>Weekly Tab</td>
<td>Weekly</td>
</tr>
<tr>
<td>Monthly Tab</td>
<td>Monthly</td>
</tr>
<tr>
<td>New Button</td>
<td>New</td>
</tr>
<tr>
<td>Today Button</td>
<td>Today</td>
</tr>
<tr>
<td>Print Button</td>
<td>Print</td>
</tr>
<tr>
<td>Delete Button</td>
<td>Delete</td>
</tr>
<tr>
<td>5 Day Week Button</td>
<td>5 Day Week</td>
</tr>
<tr>
<td>7 Day Week Button</td>
<td>7 Day Week</td>
</tr>
<tr>
<td>New Account Call Button</td>
<td>New Account Call</td>
</tr>
<tr>
<td>New Contact Call Button</td>
<td>New Contact Call</td>
</tr>
<tr>
<td>New Meeting Button</td>
<td>New Meeting</td>
</tr>
<tr>
<td>Owner Label</td>
<td>Owner</td>
</tr>
<tr>
<td>Timezone Label</td>
<td>Time Zone</td>
</tr>
<tr>
<td>Private Label</td>
<td>(private)</td>
</tr>
<tr>
<td>No Description Label</td>
<td>(no description)</td>
</tr>
<tr>
<td>All Employee View Label</td>
<td>All Employees</td>
</tr>
</tbody>
</table>
Table 64. HI Calendar Base Applet Controls

<table>
<thead>
<tr>
<th>Control Name</th>
<th>Caption</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Slot Label Tooltip</td>
<td>Click to create a new record</td>
</tr>
<tr>
<td>Tile Header Day Label Tooltip</td>
<td>Click to go to this day</td>
</tr>
<tr>
<td>Tooltip Field Label:Description</td>
<td>Description</td>
</tr>
<tr>
<td>Tooltip Field Label:Meeting Location</td>
<td>Meeting Location</td>
</tr>
<tr>
<td>Tooltip Field Label:Comment</td>
<td>Comment:</td>
</tr>
<tr>
<td>Tooltip Field Label:Planned</td>
<td>Planned</td>
</tr>
<tr>
<td>Tooltip Field Label:Planned Completion</td>
<td>Planned Completion</td>
</tr>
<tr>
<td>Tooltip Field Label:Type</td>
<td>Type</td>
</tr>
<tr>
<td>Repeating Dialog Title</td>
<td>Edit Repeating Activities</td>
</tr>
<tr>
<td>Repeating Dialog Label 1</td>
<td>This appointment is part of a repeating series</td>
</tr>
<tr>
<td>Repeating Dialog Label 2</td>
<td>Please choose one of the following:</td>
</tr>
<tr>
<td>Repeating Dialog This Instance</td>
<td>Modify this instance</td>
</tr>
<tr>
<td>Repeating Dialog All Future Instances</td>
<td>Modify this and all future instances</td>
</tr>
<tr>
<td>Repeating Dialog OK Button</td>
<td>OK</td>
</tr>
<tr>
<td>Repeating Dialog Cancel Button</td>
<td>Cancel</td>
</tr>
</tbody>
</table>

**Changing Date Display Format**

Table 65 shows the LOVs used to change the display format for the days of the week, the days of the month, the print header for different views, and the 5 Day Weekly header.

Table 65. Date Display LOVs

<table>
<thead>
<tr>
<th>To change...</th>
<th>Use...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labels for the days of the week.</td>
<td>LOV type IDS_SSA_LOVTYPE_DAY_NAME with names from Monday to Sunday.</td>
</tr>
<tr>
<td>Labels for the months.</td>
<td>LOV type IDS_SSA_LOVTYPE_MONTH_NAME with names from January to December.</td>
</tr>
</tbody>
</table>
Table 65. Date Display LOVs

<table>
<thead>
<tr>
<th>To change...</th>
<th>Use...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Formats of the print header for different views.</td>
<td>LOV type CAL_PRINTHEADER_FORMAT with names: Daily, Weekly, Monthly, WeeklyFromTo.</td>
</tr>
<tr>
<td>Format of other date displays.</td>
<td>LOV type CALDATEDDISPLAY_FORMAT with the following names:</td>
</tr>
<tr>
<td></td>
<td>- Daily. Controls the format of the date string displayed on the button row in the Daily calendar.</td>
</tr>
<tr>
<td></td>
<td>- Weekly. Controls the format of the date string displayed on the button row in the Weekly calendar.</td>
</tr>
<tr>
<td></td>
<td>- Monthly. Controls the format of the date string displayed on the button row in the Monthly calendar.</td>
</tr>
<tr>
<td></td>
<td>- WeeklyFromTo. Controls the from/to format for the Weekly calendar.</td>
</tr>
<tr>
<td></td>
<td>- HI - 5 Day Weekly Header. Controls the date format in 5 day weekly calendar header.</td>
</tr>
<tr>
<td></td>
<td>- SI - Weekly Header. Controls the date format in weekly calendar header for SI calendars.</td>
</tr>
</tbody>
</table>

Changing the First Day of the Week

Use the First Day of Week applet user property to change the first day of the week. Table 66 shows the values for the First Day of the Week applet user property.

Table 66. First Day of Week Applet User Property

<table>
<thead>
<tr>
<th>Use this value...</th>
<th>For...</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Sunday</td>
</tr>
<tr>
<td>1</td>
<td>Monday</td>
</tr>
<tr>
<td>2</td>
<td>Tuesday</td>
</tr>
<tr>
<td>3</td>
<td>Wednesday</td>
</tr>
<tr>
<td>4</td>
<td>Thursday</td>
</tr>
<tr>
<td>5</td>
<td>Friday</td>
</tr>
<tr>
<td>6</td>
<td>Saturday</td>
</tr>
</tbody>
</table>
Overriding User Preferences

You can use the applet user property to override all the user interface user preferences, which are used for all HI calendars. Table 67 shows the applet user property.

Table 67. Applet User Property

<table>
<thead>
<tr>
<th>User Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Calendar Mode</td>
<td>Language independent calendar mode (Daily/Weekly/Monthly).</td>
</tr>
<tr>
<td>Preferred Weekly Mode</td>
<td>Weekly mode (5 Day Week/7 Day Week).</td>
</tr>
<tr>
<td>Preferred Timeslot Interval</td>
<td>Timeslot interval in slot views.</td>
</tr>
<tr>
<td>Preferred Business Day Start Time</td>
<td>End time of a business day.</td>
</tr>
<tr>
<td>Preferred Business Day End Time</td>
<td>Start time of a business day.</td>
</tr>
<tr>
<td>Preferred Appointment Duration</td>
<td>Appointment duration when create new appointments.</td>
</tr>
</tbody>
</table>

Enabling and Disabling Calendar Editing

The following list shows the consequences if the No Insert property or the No Update property is selected, or if the Calendar is based on multiple business components.

- If the No Insert property of the calendar applet is checked, then the New button and inline record creation are disabled. Inline record editing is allowed.
- If the No Update property of the calendar applet is checked, inline editing is disabled. Inline record creation is still allowed.
- If the Calendar is based on multiple business components (see Specifying Extra Business Components on page 210 for details), then the New button, inline record creation, and inline record editing are disabled.

Using Special Date Markers

You can use markers that can be displayed in 7-Day Weekly and Monthly calendars to mark certain days as special days (Table 68). These markers are configured through the applet user property.

Table 68. Special Date Markers

<table>
<thead>
<tr>
<th>User Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Special Date Buscomp Name</td>
<td>Name of the business components to get special date info from.</td>
</tr>
<tr>
<td>Special Date Buscomp Start Date Field</td>
<td>Specify the start date field.</td>
</tr>
<tr>
<td>Special Date Buscomp End Date Field</td>
<td>Specify the end date field.</td>
</tr>
</tbody>
</table>
Specifying Extra Business Components

You can configure a calendar applet to display records from multiple business components (Table 69) by specifying additional source business components using the applet user property, Extra Source Buscomp Names. For each extra source business component, you can specify properties such as its Start Date Field using the [Buscomp Name.] notation. For example, to display both activities and quotes in a single calendar, you can configure the applet based on the Action business component and then specify Quote as the extra source business component. Use the Quote.Start Date Field user property to specify the Start Date Field for Quote business component.

Table 69. Calendar Applet User Property to Display Data from Multiple Business Components

<table>
<thead>
<tr>
<th>Applet User Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extra Source Buscomp Names</td>
<td>This user property specifies the extra business components. You can specify user properties for each extra source business component using the [Buscomp Name.] notation. For example, to specify the Start Date Field for Quote business component, you use Quote.Start Date Field user property. For each extra source business component, Start Date Field user property is required. There are two user properties that are specifically for extra source business components. Visibility Mode Search Specification For example, to specify the visibility mode and search specification for Quote business component, you use Quote.Visibility Mode and Quote.Search Specification user properties.</td>
</tr>
</tbody>
</table>

Dragging-and-Dropping Records from Other Applets into the Calendar

A list applet in the Calendar view can be configured so that one or more records can be dragged from the list applet and dropped onto the calendar applet.
Drag-and-Drop Action Behavior
The behavior of the drag-and-drop action is configurable. Table 70 shows an example of this behavior.

Table 70. Example of Configurable Drag-and-Drop Behavior

<table>
<thead>
<tr>
<th>In the...</th>
<th>Dragging...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pharma application</td>
<td>A record from the Activities list to the daily calendar applet, updates the Planned Start date for the activity according to where it is dropped on the calendar.</td>
</tr>
<tr>
<td>Consumer Sector application</td>
<td>Records from the Activities list to the calendar applet, creates a new record of type In Store Visit for the account, and associates appropriate activity records to the new In Store Visit record. If multiple records are dragged, the account for the new record is based on the account of the last record in the dragged group.</td>
</tr>
</tbody>
</table>

Drag-and-Drop User Properties
Table 71 shows the user properties on the list applet that determine the drag-and-drop behavior.

Table 71. Applet User Property for Calendar Drag-and-Drop (Set on the List Applet)

<table>
<thead>
<tr>
<th>Applet User Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Drag And Drop</td>
<td>Y/N (default to N)</td>
</tr>
</tbody>
</table>
| Calendar Default Action        | Set this to:  
  - NewRecord to create a new calendar activity record when a record is dragged from the list applet to the calendar applet. (This is also the default behavior, unless the Calendar Drag Method user property is set.)  
  - UpdateTime to change the time field in the source (dragged) record according where the record is dropped in the calendar applet. (No new record is created.) This behavior is seen in the Pharma application. |
| Calendar UpdateTime Field      | If Calendar Default Action = UpdateTime, set the Calendar UpdateTime Field user property to the time field in the source applet that you want to have updated by the drag-and-drop action.  
  For example, in the Pharma application (Pharma Calendar Activity List Applet), this is set to Planned. |
### Configuring the Calendar

- **Calendar Drag Field, Calendar Drag Field1, Calendar Drag Field2, Calendar Drag Field3 ... Calendar Drag Fieldn**
  - If Calendar Default Action = NewRecord, set the Calendar Drag Field user properties to copy data from the source record to the new calendar activity (target) record.
  - The format for these user properties is `Source_field_name,Target_field_name`
  - For example, to copy content from a field named Summary in the source record to the Description field in the calendar activity record: Calendar Drag Field = Summary,Description.

- **Calendar Drag Associate**
  - If Calendar Default Action = NewRecord, set this user property to Y if you want to have the source records associated with the new (target) record. The dragged records become child records of the new calendar activity record.

- **Calendar Drag Child Associate Field**
  - If Calendar Drag Associate = Y, set this user property to the name of the field in the dragged (source) records that is to associate them with the new calendar activity record. The field specified gets populated with the row ID of the new calendar activity record.

- **Calendar Drag Method**
  - If the default calendar action does not meet your needs, it is possible to supply your own method to control the drag-and-drop action. This is done by setting this user property to the method name.
  - If this user property is set, the preceding user properties are ignored.
  - For example, in the Consumer Sector application, this is set to the Drag And Drop Handler method.

- **Calendar Drag BusComp**
  - If a method is supplied in the Calendar Drag Method user property, enter the name of the business component on which you want to invoke the method. If this user property is not specified, the method is invoked on the current business component.
  - For example, in the Consumer Sector application, this is set to the In Store Visit business component.

- **Calendar Drag BusObj**
  - If a business component is supplied in the Calendar Drag BusComp user property, enter the name of the business object to use when retrieving the Calendar Drag BusComp business component.
  - If this user property is not specified, the current business object is used. However, it is better to specify a value for this business object, even if it is the same as the current business object. This is to make sure that instantiating the Calendar Drag BusComp business component does not affect other business components within the current view.
  - For example, in the Consumer Sector application, this is set to the In Store Visit business object.

<table>
<thead>
<tr>
<th>Applet User Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendar Drag Field, Calendar Drag Field1, Calendar Drag Field2, Calendar Drag Field3 ... Calendar Drag Fieldn</td>
<td>If Calendar Default Action = NewRecord, set the Calendar Drag Field user properties to copy data from the source record to the new calendar activity (target) record. The format for these user properties is <code>Source_field_name,Target_field_name</code>. For example, to copy content from a field named Summary in the source record to the Description field in the calendar activity record: Calendar Drag Field = Summary,Description.</td>
</tr>
<tr>
<td>Calendar Drag Associate</td>
<td>If Calendar Default Action = NewRecord, set this user property to Y if you want to have the source records associated with the new (target) record. The dragged records become child records of the new calendar activity record.</td>
</tr>
<tr>
<td>Calendar Drag Child Associate Field</td>
<td>If Calendar Drag Associate = Y, set this user property to the name of the field in the dragged (source) records that is to associate them with the new calendar activity record. The field specified gets populated with the row ID of the new calendar activity record.</td>
</tr>
<tr>
<td>Calendar Drag Method</td>
<td>If the default calendar action does not meet your needs, it is possible to supply your own method to control the drag-and-drop action. This is done by setting this user property to the method name. If this user property is set, the preceding user properties are ignored. For example, in the Consumer Sector application, this is set to the Drag And Drop Handler method.</td>
</tr>
<tr>
<td>Calendar Drag BusComp</td>
<td>If a method is supplied in the Calendar Drag Method user property, enter the name of the business component on which you want to invoke the method. If this user property is not specified, the method is invoked on the current business component. For example, in the Consumer Sector application, this is set to the In Store Visit business component.</td>
</tr>
<tr>
<td>Calendar Drag BusObj</td>
<td>If a business component is supplied in the Calendar Drag BusComp user property, enter the name of the business object to use when retrieving the Calendar Drag BusComp business component. If this user property is not specified, the current business object is used. However, it is better to specify a value for this business object, even if it is the same as the current business object. This is to make sure that instantiating the Calendar Drag BusComp business component does not affect other business components within the current view. For example, in the Consumer Sector application, this is set to the In Store Visit business object.</td>
</tr>
</tbody>
</table>
Changing Controls in the Calendar Detail View

The Calendar Detail view (accessed by clicking the New button on the daily, weekly, or monthly calendar views) has three buttons that are managed by the specialized class CSSSWEFrameGanttHiMode in the HI Gantt Chart applet. Table 72 shows the button name and the pop-up applet invoked by the button.

Table 72. Participant Availability Buttons

<table>
<thead>
<tr>
<th>Buttons Name</th>
<th>Popup Applet Invoked</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Employee</td>
<td>HI Gantt Chart Employee Pick Applet</td>
</tr>
<tr>
<td>Add Resource</td>
<td>HI Gantt Chart Resource Pick Applet</td>
</tr>
<tr>
<td>Add Contact</td>
<td>HI Gantt Chart Contact Pick Applet</td>
</tr>
</tbody>
</table>

Showing or Hiding Side Applets on the Life Sciences Calendar

The calendar pages for the Siebel Life Sciences application have list applets on the right side of the calendar applet. See Figure 11 on page 213.

A user property called Suppress Side Applets Calendar Types on the LS Pharma Activity HI Calendar Applet determines whether or not the side list applet is displayed.

For example, you can choose to have the side list applet displayed with the daily and weekly calendars but not with the monthly calendar.

Figure 11. LS Pharma HI Activity Calendar View with Daily Calendar Applet and Side List Applet
To hide or show the side list applet on the LS Pharma HI Activity Calendar View

For the LS Pharma Activity HI Calendar Applet, edit the Suppress Side Applets Calendar Types applet user property to include the calendars for which you want to hide the list applet.

For example, set the value to Daily, Weekly5, Weekly7, Monthly to hide the side list applet on all the calendars.
This chapter is about state models: how to set them up and how they work. It includes the following topics:

- “About State Models” on page 215
- “Scenario for State Models” on page 216
- “Process of Setting Up State Models” on page 216
- “Configuring Business Components for State Models” on page 217
- “Creating State Models and State Transitions” on page 218
- “Activating State Models” on page 220
- “Configuring Child Modification for State Models” on page 221

### About State Models

State model functionality allows you to constrain the state of an object by prescribing allowed state values and allowed state transitions. For example, a service request object may be constrained to three states: Open, Closed, and Pending. Furthermore, the state transitions may be constrained to: Open to Pending, Open to Closed, and Pending to Closed.

For Siebel workflows, state models provide a data-driven method for extending control based on the state of the object. For general information about Siebel workflows, see *Siebel Business Process Framework: Workflow Guide*.

The state model functionality consists of three key elements:

- **State Model.** A blueprint of acceptable states and state transitions that are enforced by the state machine.

- **State Machine.** An engine that enforces the transitions between states for an object during its lifetime. The state represents where the object is in its lifetime. The state can also control whether the data of that object can be modified. For example, a record that is in a Closed state may be considered frozen, such that its attributes cannot be modified. The state machine reviews all required conditions defined for the state model before the state transition is completed.

- **State Transition.** Defines the allowable migration of an object from one state to the next. For instance, a record that has been closed but must be reopened may go from the Closed state to an Open state and may go from Open to Pending, but may not transition directly from Closed to Pending.

Specific conditions can be associated with state transitions. For example, you can specify that only certain individuals can initiate state transitions or that a transition can only be initiated if the object meets certain criteria.
Scenario for State Models

This scenario provides an example of a process performed by the administrator. Your company may follow a different process according to its business requirements.

A company has recently configured its Siebel application to keep track of suggestions for product enhancements received from customers and employees. To do this, they created a new business component called Enhancements, along with a supporting Product Enhancements screen and views.

The administrator’s task is to set up a state model on this new business component.

First, the administrator uses Siebel Tools to check that Enhancements business component is based on the CSSBCBase class. Then, she discovers that the configurator has already enabled the state model user property for this business component.

Within the Siebel application, she creates a state model based on the Status field (an LOV field) of the Enhancement business component.

The state model contains four allowed states:

- **New.** This is set as the default state, the state of any newly received enhancement ideas.
- **Assigned.**
- **Accepted.** This is set as a No Delete and No Update state so that an accepted enhancement is read-only and cannot be deleted.
- **Rejected.** This is set as a No Delete and No Update state so that a rejected enhancement is read-only and cannot be deleted.

The state model contains three allowed transitions:

- **From Open to Assigned.** Managers assign enhancement suggestions to the most suitable employees for investigation. Because of this, the transition from Open to Assigned is restricted to the managers’ positions.
- **From Assigned to Accepted.**
- **From Assigned to Rejected.**

Employees are required to write an assessment of each suggestion before rejecting or accepting it. To encourage this, conditions are created so that the status cannot be changed to Accepted or Rejected if the Assessment field is left blank.

Finally, the administrator activates the state model by restarting the server.

Process of Setting Up State Models

This example process represents the tasks that are carried out in the "Scenario for State Models” on page 216.

1. "Configuring Business Components for State Models” on page 217. This is only required if the business component has not been enabled for state models.

2. “Creating State Models and State Transitions” on page 218.
Configuring Business Components for State Models

You can create state models on business components that are:

- State-model enabled in the preconfigured application
- Based directly on the CSSBCBase class and that are enabled using the procedure given in this section

Creating state models for business components based on subclasses of CSSBCBase class is not supported by Siebel Systems. In particular, do not create or modify state models on the Enterprise Service Definitions, SRM Request, and SRM Repeating Request business components. These are used for server administration.

This task is a step in Process of Setting Up State Models on page 216.

To find out if a business component is already enabled for state models

1. Navigate to the Administration - Application screen > State Models view.
2. Create a new record and try to complete the Business Component field.
   
   Some business components are described in the following table:

<table>
<thead>
<tr>
<th>If the Business Component You Want</th>
<th>Then That Business Component</th>
<th>Continue with Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is listed in the Business Component dialog box</td>
<td>Is already enabled</td>
<td>“To create a new state model” on page 218</td>
</tr>
<tr>
<td>Is not listed in the Business Component dialog box</td>
<td>Is not enabled</td>
<td>“To enable a business component for state models functionality in Siebel Tools” on page 217</td>
</tr>
</tbody>
</table>

3. Delete or undo the new record.

To enable a business component for state models functionality in Siebel Tools

1. Make sure that the business component is based on the CSSBCBase class.
2. Create a new business component user property with the following properties:
   - Name=State Model
   - Value=Y
Creating State Models and State Transitions

This section describes how to create and define state models and state transitions.

To enable a state model on a business component, the field used should:

■ Be an LOV (list of values) or MLOV (multilingual lists of values) field.
■ Have no dependencies on other fields. (For example, do not use a constrained LOV field or a calculated field.)

This task is a step in Process of Setting Up State Models on page 216.

To create a new state model

1. Navigate to the Administration - Application screen > State Models view.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activation</td>
<td>The date on which the state model begins to be enforced.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> You can set up more than one state model for a given field as long as the activation to expiration periods do not overlap.</td>
</tr>
<tr>
<td>Business Component</td>
<td>The business component that the state model is based on. The dialog box for this field displays all of the business components that have been enabled for the state model. To enable a business component that is not enabled by default, see “Configuring Business Components for State Models” on page 217.</td>
</tr>
<tr>
<td>Expiration</td>
<td>The date on which the state model is no longer enforced.</td>
</tr>
<tr>
<td>Field</td>
<td>The name of the field that the state transitions apply to. The dialog box for this field displays the fields that are defined for the business component.</td>
</tr>
<tr>
<td>Name</td>
<td>A name that uniquely identifies the state model.</td>
</tr>
</tbody>
</table>

2. Click the States view tab.

3. In the State list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>State Name</td>
<td>The dialog box for this field presents the list of values for this field.</td>
</tr>
<tr>
<td>Default</td>
<td>The default state name specifies a beginning value for the business component field.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> If the field is predefaulted in Tools, then it cannot be overridden by the state model.</td>
</tr>
</tbody>
</table>

State Models ■ Creating State Models and State Transitions
4 Click the Transitions view tab.

5 In the Transitions list, for each restricted transition, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Delete 1</td>
<td>If checked, records in this state cannot be deleted unless they are referenced by a parent record in which the Cascade Delete property is set to Delete. Cascade Delete always overrides the State Model restrictions. For information about how No Delete effects child records, see “Configuring Child Modification for State Models” on page 221.</td>
</tr>
<tr>
<td>No Update 1</td>
<td>If checked, records in this state are read-only and cannot be updated.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> No Update also affects a record’s child records. For example, if an account becomes read-only due to use of the No Update restriction, the related contacts for the account also become read-only, so inserting and deleting contacts is not possible.</td>
</tr>
<tr>
<td>Restrict Transition</td>
<td>If checked:</td>
</tr>
<tr>
<td></td>
<td>■ Only defined transitions from this state are allowed.</td>
</tr>
<tr>
<td></td>
<td>■ And there are no transitions defined, the state becomes an end state, where users cannot transition from it to any other state.</td>
</tr>
<tr>
<td></td>
<td>If not checked, this state can transition to any of the defined states.</td>
</tr>
</tbody>
</table>

1. **Note:** Even if No Delete and No Update restrictions are specified for the state model, MVG fields that do not have a direct parent-child link between the parent field and the MVG applet are not read-only when a record is in a No Update or No Delete state. To avoid confusion for end users, you can remove MVG fields from the child applet.
State Models ■ Activating State Models

**Activating State Models**
This topic provides information about activating state models.

**How Are State Models Activated?**
Your new state model does not become available to users until a new Application Object Manager (AOM) server process is created. By restarting the server or the Application Object Manager (AOM) server components, you start new AOM processes that obtain your new state model from the refreshed state model cache.

**How Are State Models Activated for Mobile Users?**
For mobile users who connect through Siebel Remote, the state model is enforced once a user has synchronized with the database server. State models are supported on regional nodes. For more information about support for regional nodes, see the *Siebel Business Rules Administration Guide* and *Siebel Remote and Replication Manager Administration Guide*.

---

6 To restrict a state transition to a subset of users (positions), clear the Public field for the transition and create records in the Authorized Positions list.

**NOTE:** If the Public Flag is not checked and no positions have been added in the Authorized Positions list, no users are able to make the transition.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule Field</td>
<td>These three fields allow you to specify a simple field condition that must be satisfied for the transition to occur. For example, a state transition is created that allows users to change the status of a service request from Open to Closed when the sub-status is Resolved uses a rule like this:</td>
</tr>
<tr>
<td>Rule Operator</td>
<td></td>
</tr>
<tr>
<td>Rule Value</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>From State</th>
<th>To State</th>
<th>Rule Field</th>
<th>Rule Operator</th>
<th>Rule Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Closed</td>
<td>Sub-Status</td>
<td>=</td>
<td>'Resolved'</td>
</tr>
</tbody>
</table>

The syntax for rules is the same as the syntax for calculated field values and field validation in Siebel Tools. For more information about the syntax, see about operators, expressions, and conditions in *Siebel Developer’s Reference*.

<table>
<thead>
<tr>
<th>Rule Expression</th>
<th>Allows for the creation of complex or multiple conditions that must be satisfied for the transition to occur.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The syntax for the Rule Expression field is the same as the syntax for calculated field values and field validation in Siebel Tools. For more information about the syntax, see about operators, expressions, and conditions in <em>Siebel Developer’s Reference</em>.</td>
</tr>
</tbody>
</table>
How Are State Models Enforced?
State models are enforced on the Siebel business logic level. Thus, state models are enforced for updates made through Siebel Visual Basic, Siebel eScript, and workflow processes. However, state models are not enforced for updates made through Enterprise Integration Manager (EIM) or workflow policy programs because these do not go through the Siebel Object Managers.

How the AOM Reads State Model Objects
State model objects are read from the run-time database, not from the compiled Siebel repository file (SRF).

NOTE: If you are distributing state models to other environments, you need to migrate the run-time database tables for the state model (as well as distributing the SRF file).

Activating State Models
This task is a step in Process of Setting Up State Models on page 216.

To activate state models
1. Do one of the following:
   - Restart the server.
   - Restart the Application Object Manager (AOM) server components.
2. Clear the browser cache.

Configuring Child Modification for State Models
By default, child records cannot be created, modified, or deleted when the state of the parent record is No Delete.

You can change this behavior in two ways:

- **Globally.** At the business-service level by editing the Enable Child Modification user property for the State Model Cache business service.

- **Locally.** If child modification is enabled at the business-service level, you can disable it for individual business components using the State Model Enable Child Modification business component user property.
To enable child modification for all business components

- In Siebel Tools, set the State Model Cache business service Enable Child Modification user property to Y.

This allows you to create, modify, and delete child records, even when the parent record state is No Delete.

To disable child modification for an individual business component if child modification is globally enabled

- In Siebel Tools, set the State Model Enable Child Modification user property for the business component to N.

The interaction of the Enable Child Modification (business service) and the State Model Enable Child Modification (business component) user properties is summarized in this table.

<table>
<thead>
<tr>
<th>If the Enable Child Modification business service user property is</th>
<th>And the State Model Enable Child Modification business component user property is</th>
<th>Then, for the business component, child modification is</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Y or blank</td>
<td>Enabled</td>
</tr>
<tr>
<td>Yes</td>
<td>N</td>
<td>Disabled</td>
</tr>
<tr>
<td>N</td>
<td>any value</td>
<td>Disabled</td>
</tr>
</tbody>
</table>
This chapter is about administering and using literature in the Siebel application. It includes the following topics:

- “About Literature” on page 223
- “About Setting Up Literature Files” on page 224
- “Creating and Modifying Literature Files” on page 224
- “Creating Literature Records” on page 225
- “Creating Translation Records” on page 227
- “Creating Literature Item Kits” on page 228
- “About Making Literature Visible to Users” on page 229
- “Sharing Literature Through the Products Screen” on page 230
- “Sharing Literature Through the Competitors Screen” on page 230
- “Sharing Literature Through the Decision Issues Screen” on page 231
- “Sharing Literature Through the Correspondence Screen” on page 232
- “Sharing Literature Through eBriefings” on page 232
- “Sharing Literature Through Literature or Infocenter” on page 233

About Literature

Siebel Literature allows you to give your users access to sales and marketing literature, such as product brochures, white papers, data sheets, and other types of literature items. Users view these documents using the application that created them, for example, Microsoft Word, Lotus Word Pro, or Adobe Acrobat.

Literature items may also be grouped into literature kits. Literature kits may include items not normally thought of as literature, such as promotional hats, coffee mugs, or T-Shirts. These kits may then be made available for distribution through fulfillment centers. Literature kits are covered later in this chapter. Fulfillment is covered in Siebel Correspondence, Proposals, and Presentations Guide.

After you create literature records and associate documents with them, your employees can use literature in several ways:

- Employees can use the Literature or Infocenter screen to search through all the literature that is available to them.
You can associate literature with business objects such as products or decision issues. Then users can display the literature when they are looking at the record for the associated business object. For example, the user can navigate to the Product screen, select a product, and click the Product Literature view tab to find all literature items associated with that product.

When your employees use the Correspondence screen to create correspondence, they can include literature as enclosures. The user or fulfillment center may print out this literature document, or it may use preprinted copies of literature such as glossy brochures. It may also enclose promotional items that are parts of literature kits.

Employees can track literature associated with products, industries, accounts and competitors so that they appear on your Briefing pages.

About Setting Up Literature Files
To set up a literature file, you must

- Create the document in another program
- Create a Literature record that includes the document in your Siebel application

**NOTE:** You may want to create a literature record without associating a document with it. For example, if the record represents an item such as a hat or cup, which is part of a literature kit, you need not associate a document with it.

Creating and Modifying Literature Files
Literature files can be created or saved using many kinds of software. The following file types are among the most common:

- Adobe Acrobat (PDF)
- Excel (XLS)
- Word (DOC)
- PowerPoint (PPT)
- Bitmap (BMP)
- JPEG (JPG)

**To create a new literature file**
1. Create a literature file in the appropriate software application.
2. Save the file on your hard drive.

**To modify an existing literature file**
1. Navigate to the Administration - Document screen > Literature view.
Creating Literature Records

After you have created a literature file, you need to create a literature record in the Siebel database, in order to make the file available to Siebel applications users.

To create a literature record

1. Navigate to the Administration - Document screen > Literature view.

2. In the Literature list, create a new record and attach the literature file.
   The new file is added to the available literature. Appropriate information is displayed in the Literature list and the More Info form.

3. Enter the rest of the information required in the Literature list blank row and the More Info form of the new record.
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the literature record.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the document. Because literature items can be in any language, you may want to indicate the language of the item in this field (or in the Name field).</td>
</tr>
<tr>
<td>Literature Type</td>
<td>Select the type of the literature. You can create new literature types in the List of Values Administration view.</td>
</tr>
<tr>
<td></td>
<td>Because the Literature Type field is used to filter literature items in various applets (by setting the Search Specification property for the applet in Siebel Tools), you should be careful when editing the Literature Type field.</td>
</tr>
<tr>
<td>Size</td>
<td>The size of the literature file. The information is automatically entered based on the size of the file that you select.</td>
</tr>
<tr>
<td>File Type</td>
<td>The file type of the literature file, for example DOC or PDF. The information is automatically entered based on the type of the file that you select.</td>
</tr>
</tbody>
</table>
### Literature ■ Creating Literature Records

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modified</td>
<td>The date that the literature file was last modified. The information is automatically updated whenever the file is updated.</td>
</tr>
<tr>
<td>Update File</td>
<td>A check mark in this field indicates that users’ copies of the literature are updated automatically each time the original file is updated.</td>
</tr>
<tr>
<td>File Name</td>
<td>Click Browse and, in the Choose File dialog box, select the document file. You can also enter the file name manually.</td>
</tr>
<tr>
<td>Synopsis</td>
<td>Optionally, enter a synopsis of the document’s content.</td>
</tr>
<tr>
<td>Release Date</td>
<td>The release date when the document is first displayed in My Briefings. For more information about eBriefings, see <em>Siebel Briefings Administration Guide</em>.</td>
</tr>
<tr>
<td>Expiration Date</td>
<td>The expiration date when the document will no longer be displayed in My Briefings. For more information about eBriefings, see <em>Siebel Briefings Administration Guide</em>.</td>
</tr>
<tr>
<td>Author</td>
<td>Optionally, click the select button and select the document’s author.</td>
</tr>
<tr>
<td>Accounts</td>
<td>Select accounts with which the literature is associated. The literature is displayed in the Account Briefing if this account is tracked by the user. For more information, see <em>Siebel Briefings Administration Guide</em>.</td>
</tr>
<tr>
<td>Competitors</td>
<td>Select competitors with which the literature is associated. Use this field to allow the user to display the literature using the Competitors screen. If you also select the Internal field, this literature is displayed in the Comparative Literature view of the Competitors screen. If you do not select the Internal field, this literature is displayed in the Competitor’s Literature view of the Competitors screen. The literature is also displayed in a Competitor Briefing, if this competitor is tracked by the user. For more information, see <em>Siebel Briefings Administration Guide</em>.</td>
</tr>
<tr>
<td>Internal</td>
<td>Select this field if the document is internally sensitive and not intended for public distribution.</td>
</tr>
<tr>
<td></td>
<td>If Internal is selected, the literature is not available as an enclosure in the Correspondence screen, and it is displayed in the Comparative Literature list of the Competitors screen. If Internal is not selected, the literature is available as an enclosure in the Correspondence screen, and it is displayed in the Competitive Literature list of the Competitors screen.</td>
</tr>
<tr>
<td>Local</td>
<td>For users of the Remote Client, this fields specifies whether the document is available on the local File System. If a document is not available locally, the user can request it by selecting the Request field.</td>
</tr>
</tbody>
</table>
Creating Translation Records

Translated literature files can be created using any of the previously listed software tools. (See “Creating and Modifying Literature Files” on page 224.) You can create a record in the Siebel application for any translated file associated with your document.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request</td>
<td>For users of the Remote Client, if this check box is selected, the literature is downloaded during each synchronization session.</td>
</tr>
</tbody>
</table>
| Distribution Method | Use this drop-down list to specify whether or not the file is automatically downloaded to users of the Remote Client.  

Publish: During each synchronization session, if your user does nothing, the file is downloaded automatically. If your user explicitly skips the file, the file is not downloaded in that synchronization session.  

By Request: During synchronization, the user receives the record, but not the actual file. To receive the file, the user must select the Request field.  |
| Industries        | Select any industries associated with the literature. The literature is displayed in My Briefing if the user tracks the industry.                                                                       |
| Products          | Select any products associated with the literature. Use this field to allow the user to display the literature using the Products screen. The literature is displayed in My Briefing if the user tracks the product. |
| Organization      | Select organizations that will have visibility to this data.                                                                                                                                             |
| Web Display       | If you are linking to a Web page, use this field to determine how to display it.                                                                                                                        |
|                   | **Frame.** Displays a link to the Web page. When the user clicks the link, the page appears in the current frame.                                                                                       |
|                   | Window. Displays a link to the Web page. When the user clicks the link, the page appears in an expanded window. The user must use the Web browser’s Back button to return to Siebel ERM.  |
|                   | **New Window.** Displays a link to the Web page. When the user clicks the link, the page is displayed in a new browser window, allowing the user to switch between Siebel ERM and the Web page. |
|                   | **In-Line.** Displays the entire Web page in the selected section of the portal page.                                                                                                                    |
|                   | Displaying Web pages in-line works best with simple Web pages. Large or complex pages, such as those that use JavaScript, can slow down the system and cause unexpected results. Be sure to test in-line pages before distributing them to users. |
Creating Literature Item Kits

After you have created more than one literature file, you can combine individual files and other material to create literature item kits. This feature allows you to combine individual literature items into groups, so you can work with the group instead of with each of the individual files. Literature item kits are used only as enclosures in correspondence.

For instance, you might have a set of literature items for prospective customers, including promotional brochures for your most popular products. You might also include items that are not documents: for example, a promotional kit for one of your products might include a brochure, a specifications sheet, a coffee cup, and a T-shirt.

Creating a literature item kit makes it easier to send this information out. When the user adds an attachment to correspondence, the user only has to select one literature item kit instead of all the individual items. Then the fulfillment center can mail all the items with the correspondence.

When you create a literature item kit, you create a Literature record that represents the entire kit, and you associate Literature Item records with it that represent the items in the kit. The fulfillment center can view the Literature record, but cannot view the Literature Item records. To let the fulfillment center know which items make up the kit, you can:

- **Pack kits together at the fulfillment center.** For example, you have a kit named Sales Promo that includes a brochure and a hat. The brochure and hat might be shrink wrapped together at the fulfillment center or they might be stored in one bin at the fulfillment center, so the fulfillment center can select one of each item in the bin. Then, when the fulfillment center sees that they must fulfill the Sales Promo literature record, they would mail out this shrink-wrapped package or the items from this bin.

- **Make the Literature record a bill of materials.** You can include a document in the Literature record that describes all the Literature Items in the kit, or use the Literature records Description or Synopsis field to list all the Literature Items in the kit. For example, if the kit consists of a sales brochure and a hat, you would create a Literature record that represents the entire kit, you would attach two Literature Item records to it that represent the brochure and the hat, and you might also use the description field of the Literature record to say the kit includes a brochure and a hat. Then the fulfillment center would read the description field and mail out the items listed.

To create a literature item kit

1. Navigate to the Administration - Document screen > Literature view.
In the Literature list, create a new record or select an existing record. This record represents the literature item kit, so you should give it a name that indicates the kit contents.

Click the Literature Items tab. The fields previously displayed in More Info are shown under the Literature list at the top. The fields in the Literature Items list, in the middle of the view, display specific item information. The Component Items list appears at the bottom of the view.

In the Literature Items list, create a new record, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary</td>
<td>Indicates whether this is the primary item in the kit.</td>
</tr>
<tr>
<td>Physical Form</td>
<td>A description of the item’s physical form. This field supports multiple values to allow for multiple physical forms. For a document, you might choose 8 1/2 x 11 and Microfiche.</td>
</tr>
<tr>
<td># of Pages</td>
<td>The number of pages in the document, if applicable.</td>
</tr>
<tr>
<td>In Stock</td>
<td>Select the check box to specify whether the item is in stock, if applicable.</td>
</tr>
<tr>
<td>Part #</td>
<td>The item’s part number, if applicable.</td>
</tr>
</tbody>
</table>

In the Component Items list, create a new record.

Select the record to be added and click Add.

In the Component Items list, create any other new records that are needed to create the kit.

About Making Literature Visible to Users

You can make literature visible to users in the following ways:

- **The Products Screen.** You can associate literature with a product, and the user can display it using the Products screen.

- **The Competitors Screen.** You can associate literature with a competitor, and the user can display it using the Competitors screen.

- **The Decision Issues Screen.** You can associate literature with a decision issue, and the user can display it using the Decision Issues screen.

- **The Correspondence Screen.** You can deselect the Internal field of a literature record and the user can select it as an enclosure in correspondence.

- **eBriefings.** You can associate literature with an account competitor, product, or industry. Literature is displayed in the Account Briefing, Competitor Briefing, or My Briefing page as a hyperlink.
Sharing Literature Through the Products Screen

End users who are salespeople find it useful to view literature about your products when they are viewing other information about the products. If you associate literature with a product, end users can view this literature when they view the product record in the Products screen.

To share literature through the Products screen

1. Navigate to the Administration - Document screen > Literature view.
2. In the Literature list, select a literature record or create a new literature record.
3. In the More Info form, click the select button in the Products field.
4. In the dialog box, select a Product and Part # to be associated with the literature record, and then click OK.

If no Products were previously associated with the literature record, you can use the Associated Products dialog to set up a new association.

Sharing Literature Through the Competitors Screen

Salespeople find it useful to view their competitors’ literature or to view literature that your company has prepared that compares your products with your competitors. If you associate literature with a competitor, end users can view this literature when they view the competitor record in the Competitors screen.

To share literature through the Competitors screen, you must associate it with a competitor. You must also decide whether to select the Internal flag, which determines whether it is displayed in the Comparative Literature List or the Competitive Literature list of the Competitors screen:

- If you select the Internal flag, the literature appears in the Comparative Literature list, and it is not available as an enclosure in the Correspondence screen.
- If you do not select the Internal flag, the literature appears in the Competitive Literature list, and it is available as an enclosure in the Correspondence screen.

Whether you select Internal depends on what type of literature it is:

- Competitors’ literature. Your salespeople may want to use literature produced by competitors, such as sales brochures, to help them compare your products with what the competition is offering, However, you would not want to distribute this literature outside your company. You should select Internal, so the literature is not available in the Enclosures list of the Correspondence screen, but it appears in the Comparative Literature in the Competitors screen.
Comparative literature for internal use. You may develop comparative literature internally, such as competitive intelligence, that is meant for use by your salespeople and that you do not want to distribute outside your company. You should select Internal, so the literature is not available in the Enclosures list of the Correspondence screen, but it appears in Comparative Literature in the Competitors screen.

Comparative literature for external use. You may develop comparative literature internally that is aimed at your customers, or you may have third party comparative reports that you want to distribute to your customers. You should not select Internal, so the literature is available in the Enclosures list of the Correspondence screen, and it also appears in Competitive Literature in the Competitors screen.

To share literature through the Competitors screen
1. Navigate to the Administration - Document screen > Literature view.
2. In the Literature list, select a literature record or create a new literature record.
3. In the More Info form, click the select button in the Competitors field.
4. Select the competitors in the dialog box, then click Close.

When users display this competitor record in the Competitors screen, they are able to display the literature in the Comparative Literature list if you selected Internal or in the Competitive Literature list if you did not select Internal.

Sharing Literature Through the Decision Issues Screen

End users who are salespeople find it useful to view literature about a decision issue when they are viewing other information about the decision issue. If you associate literature with a decision issue, end users can view this literature when they view the decision issue.

To share literature through the Decision Issues screen
1. Navigate to the Administration - Data screen > Decision Issues view.
2. In the Decision Issues list, select the decision issue that you want to associate the literature with.

   The More Info list shows information about the issue. Existing literature records are listed under the Literature tab.

3. In the Literature list, create a new record.
4. Select the literature item that you want to associate with the decision issue, and click OK.

   The Literature list shows the selected literature item.
Sharing Literature Through the Correspondence Screen

End users may want to use literature as enclosures in correspondence. They may also use literature records that represent literature item kits as enclosures in correspondence.

Literature is available to users in the correspondence screen if the Internal field of the Literature record is not selected.

To share literature through the Correspondence screen

1. Navigate to the Administration - Document screen > Literature view.
2. In the Literature list, select a literature record or create a new literature record.
   Make sure the Internal field of this record is not selected.
   When users create correspondence, they are able to add this literature as an enclosure.

Sharing Literature Through eBriefings

Siebel eBriefings are personalized pages that combine information from the Siebel database, such as links with a user’s new opportunities or new service requests, with background information about businesses the user works with. The user can choose which customer accounts and competitors to track, and information about those businesses appear in the Account Briefing and Competitor Briefing view of that user’s eBriefings screen. You can include links to literature about the account or competitor.

To share literature through eBriefings, you can associate it with Accounts, Competitors, Industries, or Products.

For more information about Briefings, see Siebel Briefings Administration Guide.

To share literature through eBriefings

1. Navigate to the Administration - Document screen > Literature view.
2. In the Literature list, select a literature record or create a new literature record.
3. If you want to display the literature in Account Briefings, in the More Info Accounts field, select the accounts with which the literature is associated. The end users who are tracking that account see the literature item in the Account Briefing.
4. If you want to display the literature in Competitor Briefings, in the More Info form’s Accounts field, select the competitors with which the literature is associated. End users must track that competitor for it to appear in Competitor Briefing.
5. In the Release Date field, enter the first date when the literature will appear in briefings. Literature associated with products or industries appears in My Briefing if the end user tracks those products and industries.
6 In the Expiration Date field, enter the last date that you want the literature to appear in briefings.

Sharing Literature Through Literature or Infocenter

Your end users may work with literature by displaying the Literature screen or Infocenter screen and searching the Literature list in that screen for the piece of literature they need.

You generally share literature with users by associating the user with access groups and associating literature with categories. Before you can do this, you must create categories that include literature, create access groups that include end users, and associate the categories with the access groups. For more information, see Siebel Security Guide.

After you have completed this preliminary work, you can assign literature to end users as follows:

- When you produce new literature, associate it with the appropriate category and it is visible to all end users in access groups associated with that category.
- When you hire new employees, associate them to with the appropriate access group and so that they have visibility to all the literature in categories associated with that category.

A business manager who administers literature makes it visible to users by associating it with the appropriate category in either the Literature Administration screen or the Catalog Administration screen. After it is assigned in either of these ways, users in access groups associated with this category are able to display it in the Literature screen.

To associate literature with a category using the Literature Administration screen

1 Navigate to the Administration - Document screen > Literature view.
2 In the Literature list, select the record for the literature you want to associate with a category.
3 In the Category form, create a new record.
4 In the dialog box, select the item to be associated with the category, and then click OK. The literature is associated with the category.

To associate literature with a category using the Catalog Administration screen

1 Navigate to the Administration - Catalog screen > Catalog Administration view.
2 In the Catalogs list, drill down on the Name of the catalog to be associated with the literature. A Categories list appears.
3 Click the Literature view tab.
4 In the Literature list, create a new record.
5 In the dialog box, enter identifying information about the literature (for example, the document Name), and then click Go.
6 When the dialog box reappears listing the needed literature, select the literature item and click OK.

The literature is associated with the category.
This chapter is about Global Target List Management. It includes the following topics:

- “About Global Target List Management” on page 235
- “Scenario for Global Target List Management” on page 236
- “Process of Global Target List Management” on page 237
- “Creating Target Lists by Querying (End User)” on page 237
- “Editing Target Lists (End User)” on page 238
- “Creating Target Lists By Combining Lists (End User)” on page 239
- “Applying Target Lists (End User)” on page 239
- “Creating Activities From Target Lists (End User)” on page 239
- “About Configuring Target Lists” on page 240

About Global Target List Management

Global Target List Management Is For SIA Only
The Global Target List Management only applies to Siebel Industry Applications (SIA) such as Siebel Life Sciences and Siebel Financial Services. Global Target List Management does not apply to non-SIA applications such as Siebel Sales or Siebel Call Center.

What Is Global Target List Management?
Global Target List Management is used to create reusable lists of party entities (accounts, contacts, employees, positions, and prospects) from many different views in the application. These lists can be applied in various views and can be used to create activities.

Target lists differ from PDQs (saved queries) in that target lists are static; the saved list contains a specific set of records. Whereas, the records returned by a PDQ can vary over time as edits are made to the database.

Global Target List Management builds on the general List Management features that are available for both SIA and the non-SIA applications.

Things you can do with Global Target List Management that you cannot do with general List Management are:

- Create lists in many views (not just in the List Management view)
- Apply lists in many views
Create lists of accounts and positions
Generate activities for records in a list

What Kind of Lists Can Be Created?
In the preconfigured application, you can create and apply target lists for contacts, accounts, positions, and employees.
However, the application can be configured for lists of prospects.

Where to Find More Information

<table>
<thead>
<tr>
<th>Topic</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>General List Management functionality, including field descriptions</td>
<td>Siebel Marketing User Guide</td>
</tr>
<tr>
<td>and instructions for importing and exporting lists</td>
<td></td>
</tr>
<tr>
<td>Call List functionality, which is unique to Financial Services</td>
<td>Siebel Finance Guide</td>
</tr>
<tr>
<td>Professional and account targeting, which is unique to Siebel Pharma</td>
<td>Siebel Life Sciences Guide</td>
</tr>
</tbody>
</table>

Scenario for Global Target List Management

This scenario provides one simple example of a process performed by an administrative assistant. There are many ways that target lists can be used in your company’s business processes.

An administrative assistant has been asked to send personalized birthday gifts to all of the company’s top clients who have birthdays in the upcoming month, March. She uses Global Target List Management to help her create a set of activities, one for each gift she needs to purchase and send.

First, she notices that the company administrator has already prepared a list of the top clients. This top-client list is not a private list and so the list can be used by the administrative assistant.

Next, she queries for company contacts who have birthdays in March and saves these records to a private list, which she calls March-birthdays.

Then, she combines her March-birthdays list and the company’s top-client list. The list resulting from this intersection contains the company’s top clients who have birthdays in March.

The last step is to create an activity for each client in the final list. Each activity can be marked completed when the client’s gift has been sent.
Process of Global Target List Management

This example process represents the tasks that are carried out in the "Scenario for Global Target List Management" on page 236.

- "Creating Target Lists by Querying (End User)” on page 237
- "Editing Target Lists (End User)” on page 238
- “Creating Target Lists By Combining Lists (End User)” on page 239
- “Applying Target Lists (End User)” on page 239
- ”Creating Activities From Target Lists (End User)” on page 239

Creating Target Lists by Querying (End User)

The most usual way to create a target list is by querying and then saving to a target list some or all of the party records returned by the query.

<table>
<thead>
<tr>
<th>The records you save can be...</th>
<th>For example...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Those records returned by the query</td>
<td>If you query contacts, you can save those contact records to a target list</td>
</tr>
<tr>
<td>The records associated with those records returned by the query</td>
<td>If you query opportunities, you can save the positions on the opportunities’ sales teams to a target list (You cannot save the opportunity records to a target list.)</td>
</tr>
</tbody>
</table>

This task is a step in Process of Global Target List Management on page 237.

To create a target list by querying

1. Navigate to a screen where target lists are enabled.
2. Perform a query.
3. On the toolbar, click the Save Target List button.
4 Complete the fields in the Save to List dialog box. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Based On</td>
<td>You can save the records themselves, for example contacts or accounts. Or, you can save the contacts or positions (team) associated with the records. If multiple contacts or positions can be associated with the records, you can choose to save all or only the primary. The choices available depend on the view.</td>
</tr>
<tr>
<td>Private</td>
<td>If this check box is selected, only you can view and apply this list. If this check box is cleared, all users can view and apply this list.</td>
</tr>
</tbody>
</table>

### Editing Target Lists (End User)

You can add and delete records from saved target lists.

This task is a step in Process of Global Target List Management on page 237.

To edit a target list

1. Navigate to the List Management screen > Lists view. You can also navigate to this view by clicking the Save and Edit button in the Save to List dialog box as in Step 4 on page 238.

2. Drill down on the target list record.

3. Click the appropriate view tab.

<table>
<thead>
<tr>
<th>If the Target List Contains...</th>
<th>Use This View to Add or Delete from the List...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts</td>
<td>Accounts</td>
</tr>
<tr>
<td>Team members</td>
<td>Positions</td>
</tr>
<tr>
<td>Contacts</td>
<td>All Contacts, My Contacts, or List Contacts and Prospects</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> The My Contacts view filters the list to show only your contacts.</td>
</tr>
<tr>
<td>Employees</td>
<td>Employees</td>
</tr>
</tbody>
</table>
Creating Target Lists By Combining Lists (End User)

You can create new lists by combining existing lists. Lists can be combined as unions or intersections.

This task is a step in Process of Global Target List Management on page 237.

To create a target list by combining other lists
1. Navigate to the List Management screen > Lists view.
2. Select the lists you want to combine.
3. Click Create Union or Create Intersection.

Applying Target Lists (End User)

Once you or an administrator have created target lists, you can apply them. For a target list to be applied, you must be in a target list-enabled view.

This task is a step in Process of Global Target List Management on page 237.

To apply a target list
1. Navigate to a screen where target lists are enabled.
2. On the toolbar, click the Apply Target List button.
3. In the Apply Target List dialog box:
   a. Select one or more lists
   b. Click Available to preserve the current query (That is, records are displayed only if they are in both the list and the current query.)
   c. Click OK, Union, or Intersection to apply the list(s)

Creating Activities From Target Lists (End User)

From the List Management screen, you can create activities for each member in a list.

How fields for the activities are completed, including which fields are copied from the list member records, is determined by “activity templates.” These templates are set up by the Siebel administrator; see “Setting Up Data Map Object “Activity Templates” for Target Lists” on page 240. In the preconfigured application, the “activity templates” can only be applied for lists of contacts.

This task is a step in Process of Global Target List Management on page 237.
To create an activity for each party in a list

1. Navigate to the List Management screen > Lists view.
2. Select a list record.
3. Click Create Activity.
4. In the Create Activity dialog box, select an “activity template.”

<table>
<thead>
<tr>
<th>“Activity Template”</th>
<th>For each contact in the list, creates a ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Status Call</td>
<td>High priority activity of type Call - Outbound</td>
</tr>
<tr>
<td>Customer Status Email</td>
<td>High priority activity of type Email - Outbound</td>
</tr>
<tr>
<td>End Information Email</td>
<td>Medium priority activity of type Email - Outbound</td>
</tr>
<tr>
<td>Targeted Call</td>
<td>Activity of type Targeted Call</td>
</tr>
</tbody>
</table>

**NOTE:** These “activity templates” are data map objects created through the Data Transfer Utilities. They are not the same as the activity templates used to create activity plans.

**About Configuring Target Lists**

This section discusses some aspects of configuring Global Target List Management:

- “Setting Up Data Map Object “Activity Templates” for Target Lists” on page 240
- “About Workflows for Global Target List Management” on page 241
- “Configuring Global Target List Management to Create Activities Asynchronously” on page 241
- “Enabling Application of Target Lists on an Applet” on page 242
- “Enabling Saving of Target Lists in an Applet” on page 244

**Setting Up Data Map Object “Activity Templates” for Target Lists**

Some activity template data map objects are provided in seed data. (These are listed in Step 4 on page 240.) You can edit these objects or create your own objects, using those provided as a model. For more information about Data Map Objects, see *Siebel Finance Guide*. 
About Workflows for Global Target List Management

Four workflows for Global Target List Management are provided in seed data. These are described in Table 73.

Table 73. Workflows for Global Target List Management

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLM Create Activity From List</td>
<td>This workflow can be used to create activities asynchronously. See “Configuring Global Target List Management to Create Activities Asynchronously” on page 241.</td>
</tr>
<tr>
<td>SLM Edit Call List Workflow</td>
<td>This workflow is triggered by the Save and Edit button on the Save to List dialog box. This workflow takes the user to the List Mgmt Lists View of the List Management screen.</td>
</tr>
<tr>
<td>SLM List Operation - Generic</td>
<td>Modification of this workflow is not recommended. This workflow is triggered when the Create Union and Create Intersection buttons are clicked.</td>
</tr>
<tr>
<td>SLM Update Parent</td>
<td>Modification of this workflow is not recommended. This workflow is triggered when a new member (such as a contact or an account) is added to a list. The workflow checks the content type of the new member and updates the Content field for the list if necessary. For example, if an account is added to a list of contacts, the Content field is changed to Hybrid.</td>
</tr>
</tbody>
</table>

Configuring Global Target List Management to Create Activities Asynchronously

In the preconfigured application, when the Create Activities for List command (Create Activity button) is invoked, activities are created synchronously. If your users typically create activities for long lists, the response time for synchronous creation can be slow. To resolve this, you can configure the application to create the activities asynchronously.

To configure asynchronous activity creation from target lists

1. In Siebel Tools:

<table>
<thead>
<tr>
<th>For This Applet</th>
<th>Change This Applet User Property</th>
<th>From the Default Value of</th>
<th>To This Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLM Create Activity Popup</td>
<td>On Close Invoke Parent Method</td>
<td>ContinueCreateActivity</td>
<td>ContinueCreateActAsync</td>
</tr>
</tbody>
</table>
Global Target List Management ■ About Configuring Target Lists

2 Activate the SLM Create Activity From List workflow.


Enabling Application of Target Lists on an Applet

You can configure list applets and association list applets so that target lists can be applied to them.

In order for a list applet to be configurable, the business component on which the applet is based must contain an multi-value id field for the list category (accounts, contacts, employees, positions, or prospects).

To configure list and association list applets so that target lists can be applied

1 Create a multi-value link between the applet’s business component and the List Mgmt Lists business component where:
   ■ Destination Business Component = List Mgmt Lists
   ■ Destination Link is one of the following (as appropriate for the list category that will be applied in the applet):
     ❏ SLM Account/List Mgmt Lists
     ❏ Contact/List Mgmt Lists
     ❏ Employee/List Mgmt Lists
     ❏ Position/List Mgmt Lists
     ❏ Prospects/List Mgmt Lists
   For example, the SIS Account List Applet is based on the Account business component; it contains a multi-value link called List Mgmt Lists, where Destination Link = SLM Account/List Mgmt Lists.

2 Create a multi-value field for the applet’s business component where:
   ■ Multivalue Link = The multi-value link created in Step 1
   ■ Field = Id
3 For the applet’s business component, create a user property called TargetProp (or TargetProp 1, TargetProp 2, and so on), and enter a value for the user property in the form:

"Entity Display Name", "Multi-Value Field Name", "List Category"

For example, "Accounts", "List Mgmt List Id", "Accounts"

The following table describes each term.

<table>
<thead>
<tr>
<th>Term in User Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entity Display Name</td>
<td>Type a name for the user property.</td>
</tr>
<tr>
<td>Multi-Value Field Name</td>
<td>The name of the field created in Step 2.</td>
</tr>
<tr>
<td>List Category</td>
<td>This must be one of the display values defined for the SLM_LST_CATEGORY LOV: Accounts, Contacts, Employees, Positions, or Prospects.</td>
</tr>
</tbody>
</table>

4 Repeat Step 1 to Step 3 for each category of list that you want to be able to apply to the applet.

5 If you are configuring an association list applet, create an Apply List button for the applet: (If you are configuring a list applet, skip to Step 6.)

   a Create the ButtonApplyList control for the applet.

   The following table describes the values for the new control.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>ButtonApplyList</td>
</tr>
<tr>
<td>Caption</td>
<td>Apply List</td>
</tr>
<tr>
<td>HTML Type</td>
<td>MiniButton</td>
</tr>
<tr>
<td>Method Invoked</td>
<td>ShowPopup</td>
</tr>
</tbody>
</table>

   b Create two control user properties for the new ButtonApplyList control.

   The following table describes the values for the two control user properties.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value for 1st User Property</th>
<th>Value for 2nd User Property</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Mode</td>
<td>Popup</td>
</tr>
<tr>
<td>Value</td>
<td>Edit List</td>
<td>SIA Apply Target List Applet - Simple</td>
</tr>
</tbody>
</table>

   c Edit the Applet Web Template for the association applet to add the new ButtonApplyList control to the applet’s layout.

6 (Optional) Add an “Apply List” item to the applet’s menu button.

   a Create an Applet Menu Method Item for the applet.
About Configuring Target Lists

b If the applet’s business component contains
- Only one TargetProp user property, set Command to Apply List Popup—Simple.
- Multiple TargetProp user properties for the applet, set the command property to Apply List Popup.

c Set Menu Text to Apply List.

NOTE: If you do not carry out this step, target list can still be applied using the Apply Target List button in the toolbar or using the application-level menu Edit > Apply List.

Enabling Saving of Target Lists in an Applet

You can configure list applets so that target lists can be saved from them.

In order for a list applet to be configurable, the business component on which the applet is based must contain an ID field for the party entity that you want to save to the list.

To enable target list saving for a list applet

1 In Siebel Tools, create a user property for the applet called Save Target List Source n, where n is a consecutive integer starting from 1.

For example, the first user property that you create for the applet is named Save Target List Source 1, the second is named Save Target List Source 2, and so on.

2 Find or create the list column for the party entity that you want to save:
   a On the applet’s business component, locate the ID field of the party entity.
   b If the applet does not have a List Column that maps to that ID field, create one.

3 Enter a value for the user property of the form:
   "List Column", "Saved Entity Name", "PrimaryOnly", "Extra Src Field 1", "Extra Dst Field 1", "Extra Src Field 1", "Extra Dst Field 2"

For example, these properties applied to the SIS Account List Applet:
   ■ Save Target List Source 1 = "SLM Position - Primary", "Position", "PrimaryOnly"
      Saves the primary team member on the accounts.
Save Target List Source 2 = "SLM Contact", "Contact", "Main Phone Number", "Acct Phone Number"

Saves all contacts and the main phone number of the account with each contact.

**NOTE:** For the preceding example, the destination list member business component (SLM List Member - Contact) needs to have a field that can store the account phone number.

The following table describes each term for the Save Target List Source user property.

<table>
<thead>
<tr>
<th>Term in User Property Value 1</th>
<th>Required or Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List Column</td>
<td>Required</td>
<td>The name of a list column identified in Step 2. The Field value for this list column is the source business component field for the target list. This field must be an ID field. The Display Name value for this list column is used in the List Name drop-down list in the Save to List dialog box. See Figure 12 on page 246.</td>
</tr>
<tr>
<td>Saved Entity Name</td>
<td>Required</td>
<td>The content of target list that you are saving: Contact, Employee, Account, Position, or Prospect.</td>
</tr>
<tr>
<td>PrimaryOnly</td>
<td>Required 2</td>
<td>If the list column corresponds to a multi-value ID field, then use the &quot;PrimaryOnly&quot; term to save only the primary record of the multi-value group to the target list. If this term is not specified or empty, then all records in the multi-value group are saved to the target list.</td>
</tr>
<tr>
<td>Extra Src Field 1</td>
<td>Optional</td>
<td>If you want to save an additional field to the target list, specify the field name of this source.</td>
</tr>
<tr>
<td>Extra Dst Field 1</td>
<td>Optional 3</td>
<td>If you specify an Extra Src Field 1, then specify a destination field name. This field must exist in the list member’s applet and corresponding business component so that it can be seen in the List Management screen.</td>
</tr>
<tr>
<td>Extra Src Field 2</td>
<td>Optional</td>
<td>If you want to save an additional field to the target list, specify the field name of this source.</td>
</tr>
<tr>
<td>Extra Dst Field 2</td>
<td>Optional 4</td>
<td>If you specify an Extra Src Field 2, then specify a destination field.</td>
</tr>
</tbody>
</table>

1. Terms must be enclosed in double quotes and separated by commas.
2. Optional if no Extra Src Field 1 is specified and not "PrimaryOnly".
3. Required if Extra Src Field 1 is specified.
4. Required if Extra Src Field 2 is specified.
4 Repeat Step 1 and Step 3 to create a user property for each type of list that you want users to be able to create in that applet.

Figure 12. Save to List Dialog Box for the SIS Account List Applet
This chapter describes the integration of D&B data with your Siebel application. It includes the following topics:

- “About D&B Data” on page 247
- “Business Scenarios for D&B” on page 248
- “About the D&B D-U-N-S Number” on page 249
- “Process of Integrating D&B Data” on page 249
  - “Obtaining D&B Data” on page 250
  - “Loading D&B Data” on page 250
  - “Loading D&B Data Using Sample Scripts” on page 251
  - “About Siebel Update Server Components” on page 254
  - “Running the Siebel Update Server Components” on page 258
- “Setting Up the Symbolic URL for Access to the D&B Database” on page 262
- “Configuring D&B Integration” on page 263
- “Field Mappings for Configuration of D&B Integration” on page 267

About D&B Data

D&B is a leading provider of business information. D&B’s information and technology solutions help businesses find profitable customers, reduce credit risk, manage receivables, and manage vendors. D&B’s database of commercial information consists of over 75 million records world wide.

For connected users, you can use your Siebel application to integrate with D&B data and reports. As a mobile client, you can access D&B data for accounts and contacts that have been promoted from D&B marketing data.

This allows you to:

- Use D&B marketing data within your Siebel application.
- Access D&B business and credit reports from within your Siebel application.

You can use this D&B data to support the following:

- **New Business or Customer Acquisition.** By querying on company size, line of business, and other criteria provided by D&B, you can generate lists of prospects to add to the sales pipeline or to support outbound marketing programs. By using the D&B corporate family linkage information, you can identify new prospects and opportunities within a company’s extended family.
Customer Segmentation and Penetration. You can profile specific market segments such as geography, industry, size, and other criteria to identify untapped opportunities or better align sales territories.

Customer Qualification. Use your access to D&B business and credit reports to obtain detailed background and risk information on a company in order to focus sales efforts on higher-probability accounts and shorten the sales cycle.

NOTE: This chapter describes how the administrator loads and updates D&B data. For information about viewing and using D&B data within the Siebel application, see Chapter 20, “D&B Integration.”

Business Scenarios for D&B

The following scenarios describe how you can use D&B data in your company.

Build and Grow Current Customer Relationships
A company can increase market penetration across its existing customer base by determining how many relationships the company already has within a corporate family structure. Sales managers and representatives can use D&B D-U-N-S numbers to view the organizational hierarchies of clients and aggregate account attributes at each level.

For instance, a sales representative plans to sell computers to 20 business locations and he discovers that there are locations for this company that he has not yet contacted. In another situation, the sales manager may want to see a rollup of opportunities and the potential revenue for each subsidiary and location for a specific company on a worldwide basis.

New Business or Customer Acquisition
Because a sales organization is always looking for more leads to new business, sales professionals can access company information in the Siebel D&B database, allowing them to generate prospects in their territories.

With D&B, the sales representative can query the Siebel D&B database using criteria to target new leads. The sales representative can query using demographic data, revenue profiles, or other criteria. After generating a list of leads, the sales representative can automatically add the companies and contacts to their company’s accounts list. These promoted accounts and contacts are automatically updated when D&B updates occur.

Customer Satisfaction and Account Planning
Standardizing customer information on the D&B D-U-N-S number gives you a means for householding your customer data and eliminating duplicate customer records. This increases your ability to manage existing customer relationships because all opportunities for a customer are linked to the same customer record.

Add D&B’s corporate family linkage, and you have the ability to manage and plan for customers at a local and global level. For example, you may want to see a roll up of all opportunities and potential revenue for all companies and locations related to a particular company worldwide.
D&B Search for New Account Information
Sales professionals can access the D&B database in real time to find and retrieve new D&B account information that is immediately available for use within Siebel Sales. This information includes company demographic, corporate linkage, and address data maintained by D&B.

For example, a sales representative discovers a new opportunity, but the representative cannot find the account in either the Siebel account list or the D&B account list. Instead of creating a new account, the sales manager performs a real-time D&B search to obtain up-to-date, quality information that can be used to automatically establish a new Siebel account. This provides the sales team with valuable information that they can use when working on the new opportunity.

About the D&B D-U-N-S Number
The D-U-N-S (Data Universal Numbering System) number is a crucial component of D&B data. A D&B D-U-N-S number is a nonindicative, nine-digit number assigned to each business location in the D&B database. Each D-U-N-S number has a unique, separate, and distinct operation and is maintained solely by D&B. Industries and organizations around the world use the D&B D-U-N-S number as a global standard for business identification and tracking.

Each company has a unique D&B D-U-N-S number associated with it. It acts as a unique identifier for a company in the D&B database.

To uniquely identify the association between different companies in the D&B database, each company also has associated D&B D-U-N-S numbers.

Several categories of D&B D-U-N-S numbers exist:

- D&B D-U-N-S Number—each unique business location listed in the D&B database is assigned a D&B D-U-N-S number. This column is called simply DUNS Number in your Siebel application.
- Global Ultimate D-U-N-S—the D&B D-U-N-S number belonging to a business’s worldwide ultimate parent company.
- Domestic Ultimate D-U-N-S—the D&B D-U-N-S number belonging to the highest-level family member within a specific country.
- Parent/HQ D-U-N-S—the D&B D-U-N-S number belonging to a business’s immediate headquarters or parent.

These numbers allow D&B to establish the relationships between different companies.

Process of Integrating D&B Data
The process of integrating D&B data into the D&B Account tables and the Siebel Account tables in the Siebel database involves the following steps:

1. Obtaining D&B Data
2. Loading D&B Data into staging tables in the Siebel database
3. Running the Siebel Update Server Components
Obtaining D&B Data

You must obtain three data files from D&B:

- The Marketing Data file
- The MRC file
- The SIC file

Request these files in Siebel format, also referred to as 2202 or GDMDI data file format. D&B should be able to provide files in this format without difficulty.

To obtain MRC and SIC files, send email to:

   dnb4siebel@dnb.com

In addition to these files, you can request D&B data layout documentation from D&B.

The Marketing Data File. This file contains detailed company information, such as the company's legal name, address, contact information, and so on.

The MRC and SIC Files. These are both reference files required by the Siebel D&B modules. Both files contain information referenced by the demographic company data provided by D&B.

MRC stands for Management Responsibility Code. The MRC file contains a list of lookup values for the contacts and their positions such as CEO, Vice President of Marketing, and so on. Each contact has an associated numerical code that is referenced by the D&B marketing data to determine the title or position of a company contact.

SIC stands for Standard Industrial Classification and is a code developed by the Federal government to describe the type of activity performed by the business at this location. The SIC file contains a list of SIC codes assigned and maintained by D&B along with their definitions. D&B’s Primary SIC code indicates the line of business that provides the largest revenue contribution to the business. D&B also maintains and assigns six levels of subsidiary SIC codes to describe in greater detail additional lines of business activity for a given company. By default, the SIC code provided in the SIC file and the Marketing Data file is the 4-digit SIC code.

Loading D&B Data

After you have obtained the three D&B data files, you can start to load the data into the Siebel database. You can load the files in any order, but you must load all three files before running the Siebel update server component.

When creating your data loading scripts, refer to the documentation provided by D&B and to Siebel Data Model Reference.

The scripts and processes differ according to your database platform.

NOTE: When you integrate D&B data for the first time, you might want to obtain sample loading scripts for use as templates. For help obtaining sample loading scripts, create a service request (SR) on OracleMetaLink 3. See “Loading D&B Data Using Sample Scripts” on page 251.
The scripts load D&B data into staging tables in the Siebel database, as shown in Table 74.

Table 74. Staging Tables for Uploading D&B Data

<table>
<thead>
<tr>
<th>File</th>
<th>Upload Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Marketing Data file</td>
<td>S_DNB_UPDATE table</td>
</tr>
<tr>
<td></td>
<td>This table is used as a staging area for the un-normalized D&amp;B Marketing data.</td>
</tr>
<tr>
<td>SIC file</td>
<td>S_DNB_SIC table</td>
</tr>
<tr>
<td>MRC file</td>
<td>S_DNB_MRC table</td>
</tr>
</tbody>
</table>

**NOTE:** Definitions of these tables can be found in *Siebel Data Model Reference*.

Because SIC and MRC files change only rarely, updating D&B data usually requires deleting and reloading the D&B marketing data in the S_DNB_UPDATE table alone.

If you need to load new versions of the SIC and MRC files, you must delete the previously used staging tables.

Table 75 lists what D&B data to delete and what to load.

Table 75. Loading or Reloading D&B Data

<table>
<thead>
<tr>
<th>If You Are...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loading D&amp;B data for the first time</td>
<td>□ Load the three D&amp;B data files: Marketing Data file, SIC file, and MRC file.</td>
</tr>
</tbody>
</table>
| Updating D&B data with a new Marketing Data file, but the SIC and MRC files have not changed | □ Delete data from the S_DNB_UPDATE table.  
□ Load the Marketing file. |
| Updating D&B data with new Marketing Data, SIC, and MRC files | □ Delete data from the S_DNB_UPDATE, the S_DNB_SIC, and the S_DNB_MRC tables.  
□ Load the three D&B data files: Marketing Data file, SIC file, and MRC file. |

After loading files, you must run the D&B Update Manager (D&B) and the D&B Update Manager (Siebel) as described in “About Siebel Update Server Components” on page 254.

**Loading D&B Data Using Sample Scripts**

This section provides some guidance on how to use sample scripts for:

- "Loading D&B Data on Oracle” on page 252
- “Loading D&B Data on DB2” on page 252
"Loading D&B Data on Microsoft SQL Server” on page 253

The sample scripts are not provided as part of the Siebel product, but can be obtained by logging a service request (SR) on OracleMetaLink 3.

CAUTION: Before running scripts, you should check them against the D&B data layout documentation and against the S_DNB_UPDATE table columns documented in Siebel Data Model Reference. Then, modify the scripts as required.

Loading D&B Data on Oracle

Oracle installations require you to run SQLLOADER control files. You need the following control files:

- s_dnb_update.ctl (for loading Marketing Data file into S_DNB_UPDATE table)
- s_dnb_sic.ctl (only required if loading the SIC file)
- s_dnb_mrc.ctl (only required if loading the MRC file)

NOTE: This procedure is based on the assumption that you understand how to run SQLLOADER. SQLLOADER is described in the Oracle documentation.

To load D&B data if you are using Oracle

1. Verify that the column order of your D&B file matches the column requirements in the CTL file before running the loading script.

2. Truncate the appropriate staging tables (see Table 75 on page 251).

   To optimize loading performance, drop all indexes on the S_DNB_UPDATE table and re-create them after the scripts have completed. This can be done using Siebel utilities ddlexp (to back up the indexes before dropping) and ddlimp (to re-create them).

3. Modify the SQL file as appropriate for:
   - The name of your database
   - The D&B filename and directory location
   - The database table owner
   - The user ID and password (with loading privileges) that you are using to load the data

4. Run SQLLOADER.

Loading D&B Data on DB2

DB2 installations require you to run DB2 IMPORT. You need the following SQL files:

- imp_update_new.sql (for loading Marketing Data file into S_DNB_UPDATE table)
- imp_sic_new.sql (only required if loading the SIC file)
- imp_mrc_new.sql (only required if loading the MRC file)

NOTE: This procedure is based on the assumption that you understand how to run DB2 IMPORT. DB2 IMPORT is described in the DB2 documentation.
To load D&B data if you are using DB2
1. Verify that the column order of your D&B file matches the column requirements in the SQL file before running the loading script.
2. Truncate the appropriate staging tables (see Table 75 on page 251).
   To optimize loading performance, drop all indexes on the S_DNB_UPDATE table and re-create them after the scripts have completed. This can be done using Siebel utilities ddlexp (to back up the indexes before dropping) and ddlimp (to re-create them).
3. Modify the SQL file as appropriate for:
   - The name of your database
   - The D&B filenames and directory location
   - The database table owner
   - The user ID and password (with loading privileges) that you are using to load the data
4. Run DB2 IMPORT.
5. Optional: After running the import scripts, update the DB2 catalog statistics by executing RUNSTATS on the three tables that received the D&B data (S_DNB_MRC, S_DNB_SIC, S_DNB_UPDATE).

Loading D&B Data on Microsoft SQL Server
Microsoft SQL Server installations require you to run SQL scripts. You need the following format files and SQL scripts:
- For loading the Marketing Data file:
  - S_DNB_UPDATE.fmt—a format file to load the data into the tempS_DNB_UPDATE table
  - S_DNB_UPDATE.sql—an SQL script that loads the data into S_DNB_UPDATE table
- For loading the SIC file:
  - S_DNB_SIC.fmt—a format file to load the data into the tempS_DNB_SIC table
  - S_DNB_SIC.sql—an SQL script that loads the data into the S_DNB_SIC table
- For loading the MRC file:
  - S_DNB_MRC.fmt—a format file to load the data into the tempS_DNB_MRC table
  - S_DNB_MRC.sql—an SQL script that loads the data into the S_DNB_MRC table

NOTE: This procedure is based on the assumption that you understand how to run bcp (bulk copy process) or similar data-loading utility. The bcp utility is described in the Microsoft SQL Server documentation.

To load D&B data if you are using Microsoft SQL Server
1. Verify that the column order of your D&B file matches the column requirements in the SQL file before running the loading script.
2 Truncate the appropriate staging tables (see Table 75 on page 251).

To optimize loading performance, drop all indexes on the S_DNB_UPDATE table and re-create
them after the scripts have completed. This can be done using Siebel utilities ddlexp (to back up
the indexes before dropping) and ddlimp (to re-create them).

3 Modify the SQL file as appropriate for:
   - The name of your database
   - The D&B filename and directory location
   - The database table owner
   - The user ID and password (with loading privileges) that you are using to load the data

4 Run bcp or another data loading utility.

**About Siebel Update Server Components**

Whenever you load or reload D&B data, you must update the D&B Account tables and the Siebel
Account tables in the Siebel database. This update is accomplished by running server components:

- D&B Update Manager (D&B): Moving D&B marketing data from the staging table
  (S_DNB_UPDATE) into the normalized D&B Account tables, which are the basis for the D&B All
  Accounts View (Figure 13 on page 255).
- D&B Update Manager (Siebel): Updating the records in the Siebel Account tables for accounts
  with matching D-U-N-S numbers (Figure 14 on page 256).
- A third component, D&B Update Manager MultiTask, is also provided. This component can be used
  in place of D&B Update Manager (D&B) or D&B Update Manager (Siebel) to run the update using
  multiple, parallel processes (“Multiple Task Siebel Update Server Component” on page 256).

**Overview of the Update Process**

This section outlines the process of loading D&B data from the staging tables to the D&B Account
tables through to updating the Siebel account tables.

This process recommends using the D&B Update Manager MultiTask server component to run server
component tasks in parallel. However, use of the single task D&B Update Manager (D&B) and D&B
Update Manager (Siebel) server components is also documented in this chapter.

1 Make sure you have loaded the D&B data into the staging tables as discussed in “Loading D&B
Data” on page 250 and “Loading D&B Data Using Sample Scripts” on page 251.

2 Update the D&B Account tables with data from the staging tables:
   a To optimize performance, you may choose to do one of the following:
      - For first time data loading, that is, when there are no D&B records in the database, drop
        the indexes on these D&B Account tables: S_DNB_ORG, S_DNB_ORG_SIC,
        S_DNB_CON_MRC, and S_PRSP_CONTACT.
For subsequent updates, drop the indexes on the S_DNB_ORG table only, all except for the indexes S_DNB_ORG_U1 (DUNS_NUM), S_DNB_ORG_P1 (ROW_ID), and S_DNB_ORG_M01 (the clustered index) on this table.

b  Create a search specification on the D-U-N-S number to set up your preferred batch sizes and determine the corresponding D-U-N-S number ranges per batch for loading the data from the staging tables to the D&B Account tables.

c  Execute concurrent D&B Update Manager (D&B) server tasks by running the D&B Update Manager MultiTask server component. See “Multiple Task Siebel Update Server Component” on page 256 and “Running the Siebel Update Server Components” on page 258.

d  Continue to execute the concurrent D&B Update Manager (D&B) server tasks until all data is loaded into the D&B Account tables.

e  If you dropped indexes on the D&B Account tables, re-create them. This can be done using Siebel utilities ddlexp (to back up the indexes before dropping) and ddlimp (to re-create them).

3  Update the Siebel Account tables from the D&B Account tables for accounts with matching D-U-N-S numbers by executing concurrent D&B Update Manager (Siebel) server tasks using the D&B Update Manager MultiTask server component. See “Multiple D&B Update Manager (Siebel) Processes” on page 257 and “Running the Siebel Update Server Components” on page 258.

**Single Task Siebel Update Server Components**
The update server components are part of the Dun and Bradstreet Enterprise Component Group. This group and each of its D&B Batch Components must be enabled. Once enabled, each component can be run as a batch task. Figure 13 shows how the staging tables are mapped to the D&B Account tables.

![Figure 13. D&B Update Manager (D&B) Table Names](image-url)
Figure 14 shows how the D&B Account tables are mapped to the Siebel Account tables.

"Field Mapping for the D&B Update Manager Process" on page 267 lists the default table mapping from the D&B Account tables to the Siebel Account tables that are used by the D&B Update Manager (Siebel) server component.

**Multiple Task Siebel Update Server Component**

You can use the server component DNBUpMgrMultiTask to spawn multiple Update Manager processes. Running several parallel processes helps you maximize your performance with large data loads and gives you greater scheduling flexibility. You can control the number of processes that are created by editing the dnbtask.cfg file. The dnbtask.cfg file contains two sections, one to set tasks for the D&B Update Manager (D&B) process and the second to set tasks for the D&B Update Manager (Siebel) process.

The dnbtask.cfg file is located in the sqltempl subdirectory, in the server installation directory.

**Multiple D&B Update Manager (D&B) Processes**

By default the dnbtask.cfg file sets up three simultaneous tasks, based on D-U-N-S number ranges. The DNBUpMgrDNB portion of the file looks like this:

```
[ DNB ]
Task1 = ,10000000
Task2 = 10000000,20000000
```
Task3 = 200000000,

These three ranges translate into three DNBUpMgrDNB tasks, each taking care of loading records within a particular D-U-N-S number range:

100000000 means D-U-N-S numbers < 100000000
100000000,200000000 means D-U-N-S numbers >=100000000 and < 200000000
200000000, means D-U-N-S numbers >=200000000

Edit the file to change the number of parallel processes created or the range of D-U-N-S numbers updated.

CAUTION: If you use DNBUpMgrMultiTask to run multiple UpdateMgr processes, you must make sure that processes running at the same time have mutually exclusive ranges. Unpredictable results occur if multiple processes collide.

Multiple D&B Update Manager (D&B) Processes with First Time Data Loading

The first time you load D&B data, that is, when there are no D&B records in the database, you may use a special SQL file (dnbinitial.sql) which is optimized to do only inserts. This results in faster loading of data than using the dnbmaps.tsq file.

To use the dnbinitial.sql file, set the server component parameter DNBConfigFile to dnbinitial.sql. For examples, see "Running the Siebel Update Server Components" on page 258.

For subsequent updates, the DNBConfigFile should be set to dnbmaps.tsq.

NOTE: The dnbinitial.sql file assumes that you dropped the indexes on the D&B Account tables when loading data ("Loading D&B Data Using Sample Scripts" on page 251).

Multiple D&B Update Manager (Siebel) Processes

By default the dnbtask.cfg file sets up five simultaneous tasks, based on tables updated. The DNBUpMgrSieb portion of the file looks like this:

```
[Siebel]
Task1 = UPDATE_SIEBEL_ACCOUNT
Task2 = UPDATE_INDUST, COMMIT, UPDATE_SIEBEL_INDUST, COMMIT, UPDATE_SIEBEL_SYN
Task3 = UPDATE_SIEBEL_ADDR_PHY, COMMIT, UPDATE_SIEBEL_ADDR_MAIL
Task4 = UPDATE_SIEBEL_CONTACT
Task5 = UPDATE_SIEBEL_LOC1, COMMIT, UPDATE_SIEBEL_LOC2, COMMIT, UPDATE_SIEBEL_LOC3
```
You may edit the file to change the number of parallel processes created. However, note that the order of the updates within individual tasks is important; for example UPDATE_INDUST should be done before UPDATE_SIEBEL_INDUST. Use caution when updating the DNBUpMgrSieb portion of the dnbtask.cfg file.

**CAUTION:** If you have modified the RTI configuration file to insert new accounts into the Siebel Accounts table, do not run the multiple task process. Instead you must run the single task D&B Update Mgr (Siebel) server component. Make sure you have modified the dnbmaps.sql file used by the single task server component. The order of the updates is critical to data integrity if new accounts are being added.

**Running the Siebel Update Server Components**

There are two ways to run the Siebel update server components:

- From within the Siebel application
- From a command line interface, using Siebel Server Manager
The procedures for running the update processes from both within the Siebel application and from the command line are shown in Table 76. Whatever procedures you choose to follow, make sure that the D&B Update Manager (D&B) process is complete before you start the D&B Update Manager (Siebel) process.

Table 76. Procedures for Running Siebel Update Server Components

<table>
<thead>
<tr>
<th>Process</th>
<th>From Within the Application</th>
<th>From the Command Line Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>D&amp;B</td>
<td>&quot;To run the D&amp;B Update Manager (D&amp;B) server component from within your Siebel application (single task process)&quot; on page 259 OR &quot;To run the D&amp;B Update Manager (D&amp;B) server component from within your Siebel application (multiple task process)&quot; on page 260</td>
<td>&quot;To run the D&amp;B Update Manager (D&amp;B) server component from a command line (single or multiple task process)&quot; on page 261</td>
</tr>
<tr>
<td>Siebel</td>
<td>&quot;To run the D&amp;B Update Manager (Siebel) server component from within your Siebel application (single task process)&quot; on page 260 OR &quot;To run the D&amp;B Update Manager (Siebel) server component from within your Siebel application (multiple task process)&quot; on page 260</td>
<td>&quot;To run the D&amp;B Update Manager (Siebel) server component from a command line (single or multiple task process)&quot; on page 261</td>
</tr>
</tbody>
</table>

1. For general information about using Siebel Server Manager, see Siebel System Administration Guide.

**NOTE:** If you have just installed the Siebel Server or if you have made changes to the Siebel Name Server, you need to synchronize before running the Siebel update server component. For more information about synchronizing server components, see Siebel System Administration Guide.

**TIP:** If you are going to run the D&B Update Mgr (Multi-task) component, make sure that the maximum number of tasks (MaxTasks parameter) is set correctly to accommodate the number of tasks that you specified in the dnbtask.cfg file. For information about MaxTasks, see Siebel System Administration Guide.

---

**To run the D&B Update Manager (D&B) server component from within your Siebel application (single task process)**

1. Check that the Dun and Bradstreet component group is enabled.
2. Submit a component job for D&B Update Mgr (D&B); make sure to set the Mode to Asynchronous.
3. When the D&B Update Mgr (D&B) is done, open the log directory. If there have been problems with the process, there will be a log file, which you should review. The log file is named DNBUpMgrDNB_TaskNumber.log.
D&B Integration ■ Process of Integrating D&B Data

For information on running server components, see *Siebel System Administration Guide*.

**To run the D&B Update Manager (D&B) server component from within your Siebel application (multiple task process)**

1. Check that the Dun and Bradstreet component group is enabled.
2. Prepare a component job for D&B Update Mgr (Multi-task):
   - Make sure to set the Mode to Asynchronous.
   - Create a job parameter where Name is Task Code (Abbreviation is DNBTaskCode) and Value is DNB.
   - If the data is being loaded for the first time, create a job parameter where Name is Configuration File Name (Abbreviation is DNBConfigFile) and Value is dnbinitial.sql.
3. Submit the component job.
4. When the process is done, open the log directory. If there have been problems with the process, there will be a log file, which you should review.

For information on running server components, see *Siebel System Administration Guide*.

**To run the D&B Update Manager (Siebel) server component from within your Siebel application (single task process)**

1. Check that the Dun and Bradstreet component group is enabled.
2. Submit a component job for D&B Update Mgr (Siebel); make sure to set the Mode to Asynchronous.
3. When the D&B Update Mgr (Siebel) is done, open the log directory. If there have been problems with the process, there will be a log file, which you should review. The log file is named DNBUpMgrDNB_TaskNumber.log.

For information on running server components, see *Siebel System Administration Guide*.

**To run the D&B Update Manager (Siebel) server component from within your Siebel application (multiple task process)**

1. Check that the Dun and Bradstreet component group is enabled.
2. Prepare a component job for D&B Update Mgr (Multi-task):
   - Make sure to set the Mode to Asynchronous.
   - Create a job parameter where Name is Task Code (Abbreviation is DNBTaskCode) and Value is Siebel.
3. Submit the component job.
4. When the process is done, open the log directory. If there have been problems with the process, there will be a log file, which you should review.

For information on running server components, see *Siebel System Administration Guide*. 
To run the D&B Update Manager (D&B) server component from a command line (single or multiple task process)

1. Log in to the server using Server Manager. Use a command with this format:
   
   ```
   SIEBEL_ROOT\siebsrvr\bin\>srvmgr /g gateway /e enterprise_name /u db_username /p password /s siebserver
   ```
   
   Examples:
   
   ```
   >srvmgr /g evlab6 /e siebel /u sadmin /p sadmin /s evlab6
   ```

2. At the srvrmgr prompt, enter one of the following commands:
   - `start task for comp DNBUpMgrDNB` (for single task process)
   - `start task for comp DNBUpMgrMultiTask with DNBTaskCode=DNB` (for multitask process)
   - `start task for comp DNBUpMgrMultiTask with DNBTaskCode=DNB, DNBConfigFile=dnbinitial.sql` (for initial data loading; see “Multiple D&B Update Manager (D&B) Processes with First Time Data Loading” on page 257)

3. During the DNBUpMgrDNB or DNBUpMgrMultiTask server process, monitor the status by entering the list task command:
   
   ```
   list task for comp DNB%
   ```

4. When the D&B Update Mgr (D&B) or D&B Update Mgr (Multi-task) server process is finished, open the log directory. If there have been problems with the process, there will be a log file, which you should review. The log files are named DNBUpMgrDNB_TaskNumber.log or DNBUpMgrMultiTask_TaskNumber.log.

   For information on running server components, see Siebel System Administration Guide.

To run the D&B Update Manager (Siebel) server component from a command line (single or multiple task process)

1. Log in to the server using Server Manager. Use a command with this format:

   ```
   SIEBEL_ROOT\siebsrvr\bin\>srvmgr /g gateway /e enterprise_name /u db_username /p password /s siebserver
   ```

   Examples:

   ```
   >srvmgr /g evlab6 /e siebel /u sadmin /p sadmin /s evlab6
   ```

2. At the srvrmgr prompt, enter one of the following commands:
   - `start task for comp DNBUpMgrSieb` (for single task process)
   - `start task for comp DNBUpMgrMultiTask with DNBTaskCode=Siebel` (for multitask process)

3. During the DNBUpMgrDNB or DNBUpMgrMultiTask server process, monitor the status by entering the list task command:

   ```
   list task for comp DNB%
   ```
When the D&B Update Mgr (D&B) or D&B Update Mgr (Multi-task) server process is finished, open the log directory. If there have been problems with the process, there will be a log file, which you should review. The log files are named DNBUpMgrDNB_TaskNumber.log or DNBUpMgrMultiTask_TaskNumber.log.

For information on running server components, see *Siebel System Administration Guide*.

### Setting Up the Symbolic URL for Access to the D&B Database

When you have a connection to the Internet and have a D&B account set up already (with a user ID and password), you can:

- Obtain the most current account information by invoking real-time searches of the D&B database and online purchase
- Access and order D&B business and credit reports

For more information about D&B reports and about searching D&B for new accounts, see "Accessing Company Data and Reports with D&B" on page 273.

To access D&B data live from your Siebel application through the D&B Web site, you must first contact D&B for a user ID, password, and payment options. Then you can set up your Siebel application to access the D&B database.

#### To set up the symbolic URL for D&B real-time search and update

1. Navigate to the Administration - Integration screen > WI Symbolic URL List.
2. From the Show drop-down list, choose Symbolic URL Administration.
3. In the Symbolic URL list, select DNBGlobalAccess.
4. Make sure the URL is [https://globalaccess.dnb.com/access/scripts/broker.asp](https://globalaccess.dnb.com/access/scripts/broker.asp)
5. In the Symbolic URL Arguments list:
   - Select the USERID record, and enter the user ID provided by D&B in the Argument Value field. **NOTE:** This field is not case-sensitive.
   - Select the USERPASS record, and enter the password provided by D&B in the Argument Value field.

#### To set up the symbolic URL for D&B report ordering

1. Navigate to the Administration - Integration screen > WI Symbolic URL List.
2. From the Show drop-down list, choose Symbolic URL Administration.
3. In the Symbolic URL list, select DNBReport.
4. Make sure the URL is [https://reportserver/scripts/ProductRetriever](https://reportserver/scripts/ProductRetriever) and that the Host Name is www.dnb.com.
5  In the Symbolic URL Arguments list:
   a  Select the USERID record, and enter the user ID provided by D&B in the Argument Value field.
      **NOTE:** This field is not case-sensitive.
   b  Select the USERPSWD record, and enter the password provided by D&B in the Argument Value field.

6  From the Show drop-down list, select Host Administration.

7  In the HTTP Host list, make sure that there is a record where Name is www.dnb.com and Virtual Name is reportserver.

**NOTE:** If you are using Siebel eBriefings and want to enable a link from briefing documents to the D&B report ordering site, see *Siebel Briefings Administration Guide*.

### Configuring D&B Integration

For general guidance on configuration, refer to [Table 77](#).

<table>
<thead>
<tr>
<th>If You Need to Customize the…</th>
<th>Then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single task server processes for D&amp;B Update Manager (D&amp;B) or D&amp;B Update Manager (Siebel)</td>
<td>▶ Edit the dnbmaps.sql file in the <code>...\siebelserver\SQLTEMPL</code> directory.</td>
</tr>
<tr>
<td>Multiple task server processes for D&amp;B Update Manager (D&amp;B) or D&amp;B Update Manager (Siebel)</td>
<td>▶ Edit the dnbmaps.tsq file in the <code>...\siebelserver\SQLTEMPL</code> directory.</td>
</tr>
</tbody>
</table>
| Account promotion | ▶ Configure the maps listed in [Table 83](#).  
▶ Determine and make, if necessary, corresponding changes in the update server processes. |

A number of specific configuration topics are discussed in this section:

- [Update Server Process Configuration](#) on page 264
- [Account Promotion and Prospect List Creation Configuration](#) on page 264
- [Running the D&B Update Manager (D&B) Process Without Updating or Deleting Existing Data](#) on page 265
Running the D&B Update Manager (Siebel) Process Without Updating Account Name or Account Location on page 266

**TIP:** When debugging in your test environment, increase the event log level to 4 to see more details in the log file. However, it is strongly recommended that you set the level to 1 (the default) when you run in a production environment in order to prevent the log file from overflowing. For information on event logging, see *Siebel System Monitoring and Diagnostics Guide*.

**Update Server Process Configuration**

The D&B update server processes use the Batch Real-Time Integration (RTI) technology and the RTI configuration files (dnbmaps.sql for single task and dnbmaps.tsq for multiple tasks). You can edit the RTI configuration files to suit your business requirements.

The general syntax of the RTI maps specified in the configuration files is as follows:

```
UPDATE_SOME_TABLE.MOD1TABLE = [Target Table to update]
UPDATE_SOME_TABLE.MOD1WHERE = [A WHERE clause]
UPDATE_SOME_TABLE.MOD1INSERT = [TRUE/FALSE]
UPDATE_SOME_TABLE.MOD1UPDATE = [TRUE/FALSE]
UPDATE_SOME_TABLE.MOD1DELETE = [TRUE/FALSE]
UPDATE_SOME_TABLE.MOD1SQL = [A Valid SQL Query]
```

The RTI configuration files are located in the `...\siebelserver\SQLTEMPL` directory.

“Field Mapping for the D&B Update Manager Process” on page 267 lists the default mapping for the D&B Update Manager (Siebel) server component.

Use caution when making changes to these RTI configuration files. It is recommended that you engage a qualified professional for your customization process.

**CAUTION:** Do not change the default DELETE setting in the existing UPDATE* sections. Do not set DELETE to TRUE. If your business need necessitates deleting rows in the target table as part of the D&B Update Manager process, you can request help by creating a service request (SR) on OracleMetaLink 3.

**Account Promotion and Prospect List Creation Configuration**

You can select specific fields that will be populated by the D&B promotion to a Siebel account or by the D&B list-creation process. These are controlled by maps in the business component user properties within the DNB Account and DNB Contact business components. These maps are listed in Table 83 on page 271.

Using Siebel Tools, you can change, add, or delete source and destination field mapping. Reference the map descriptions given in Table 83 on page 271 to determine which map to use for a given set of source and destination fields.
Use caution when making changes to these maps. It is recommended that you engage a qualified professional for your customization process.

**CAUTION:** Although the delete capability is available, it is recommended that you deactivate unwanted map entries instead of deleting them. This is safer and can be accomplished by checking or clicking the deactivate column for the undesired entry.

You can create an entry using the following syntax:

- **Name Column:** [MAP NAME]: [DESTINATION FIELD]
- **Value Column:** [D&B SOURCE FIELD]

**NOTE:** Each map works only with a specific Destination Business Component and a specific Source Business Component.

### Running the D&B Update Manager (D&B) Process Without Updating or Deleting Existing Data

Depending on your business process, you may want to run the D&B Update Manager (D&B) server component without updating or deleting any existing data in the S_DNB_ORG table. This is done by editing the RTI configuration file.

**To edit the RTI configuration file so that existing data in the S_DNB_ORG table is not updated or deleted**

1. Open the RTI configuration file (dnbmaps.sql for single task or dnbmaps.tsq for multiple task) in a text editor.
2. Search for the `UPDATE_DNB_ACCOUNT` section under [Common] heading.
3. Modify the section to look like the following (If you are using the default file, you need only to change `UPDATE_DNB_ACCOUNT.MOD1UPDATE` from TRUE to FALSE):
   ```
   UPDATE_DNB_ACCOUNT.Function = NONE
   UPDATE_DNB_ACCOUNT.MOD1TABLE = S_DNB_ORG
   UPDATE_DNB_ACCOUNT.MOD1WHERE = WHERE 1 = 1
   UPDATE_DNB_ACCOUNT.MOD1INSERT = TRUE
   UPDATE_DNB_ACCOUNT.MOD1UPDATE = FALSE
   UPDATE_DNB_ACCOUNT.MOD1DELETE = FALSE
   UPDATE_DNB_ACCOUNT.MOD1TXNLOG = FALSE
   ```
4. Save and close the file.
Running the D&B Update Manager (Siebel) Process Without Updating Account Name or Account Location

Depending on your business process, you may want to run the D&B Update Manager (Siebel) server component without updating the existing account names and account locations. This is done by editing the RTI configuration file.

To edit the RTI configuration file so that account names are not updated

1. Open the RTI configuration file (dnbmaps.sql for single task or dnbmaps.tsq for multiple task) in a text editor.
2. Search for `UPDATE_SIEBEL_ACCOUNT.MOD1SQL` under the Oracle, Oracle 8, Microsoft SQL Server, or DB2 statements.
3. Search for `dnb.BUSINESS_NAME` within the `UPDATE_SIEBEL_ACCOUNT.MOD1SQL` SELECT statement.
4. Comment out the line that begins `dnb.BUSINESS_NAME`... as shown.
   ```sql
   UPDATE_SIEBEL_ACCOUNT.MOD1SQL =
   SELECT acct.ROW_ID ROW_ID,
   ;dnb.BUSINESS_NAME NAME,
   ```
5. Save and close the file.

To edit the RTI configuration file so that account locations are not updated (single task)

1. Open the dnbmaps.sql file in a text editor.
2. Search for the `UPDATE_SIEBEL = UPDATE_SIEBEL_ADDR_PHY...` statement. This statement specifies the Siebel Table Groups to be updated when D&B Update Manager (Siebel) server component is run.
3. Within this statement, remove `COMMIT, UPDATE_SIEBEL_LOC1, COMMIT, UPDATE_SIEBEL_LOC2, COMMIT, UPDATE_SIEBEL_LOC3`.
4. Save and close the file.

To edit the RTI configuration file so that account locations are not updated (multiple task)

1. Open the dnbtask.cfg file in a text editor.
2. Under the `[Siebel]` section, comment out the line that begins `Task5...` as shown.
   ```config
   ;;Task5 = UPDATE_SIEBEL_LOC1, COMMIT, UPDATE_SIEBEL_LOC2, COMMIT, UPDATE_SIEBEL_LOC3
   ```
3. Save and close the file.
Field Mappings for Configuration of D&B Integration

This section provides field mapping information for three types of D&B integration processes:

- Field Mapping for the D&B Update Manager Process
- Field Mapping for D&B Real-Time Updates
- Field Mapping for Account Promotion and Prospect Lists

Field Mapping for the D&B Update Manager Process

**D&B Update Manager (D&B) server component.** For the table mapping for the D&B Update Manager (D&B) component, examine the appropriate tables (Figure 13 on page 255) using Siebel Tools. The default field mappings can be determined by examining the UPDATE_DNB* sections of the RTI configuration file (dnbmaps.sql or dnbmaps.tsq).

**D&B Update Manager (Siebel) server component.** When the D&B Update Manager (Siebel) server component is run (Figure 14 on page 256), the fields listed in Table 78, Table 79 on page 268, and Table 80 on page 269 are mapped. The field mappings can also be determined by examining the UPDATE_SIEBEL* sections of the RTI configuration file.

For information about changing these default mappings, see “Update Server Process Configuration” on page 264.

Table 78. S_DNB_ORG Table Mapping for D&B Update Manager (Siebel)

<table>
<thead>
<tr>
<th>From Column</th>
<th>To Table</th>
<th>To Column</th>
</tr>
</thead>
<tbody>
<tr>
<td>DUNS_NUM</td>
<td>S_ORG_EXT</td>
<td>DUNS_NUMBER</td>
</tr>
<tr>
<td>BUSINESS_NAME</td>
<td>S_ORG_EXT</td>
<td>NAME</td>
</tr>
<tr>
<td>TRADESTYLE</td>
<td>S_ORG_SYN</td>
<td>NAME</td>
</tr>
<tr>
<td>SCND_TRADESTYLE</td>
<td>S_ORG_SYN</td>
<td>NAME</td>
</tr>
<tr>
<td>PHYS_STREET_ADDR</td>
<td>S_ADDR_ORG</td>
<td>ADDR</td>
</tr>
<tr>
<td>SECOND_STREET_ADDR</td>
<td>S_ADDR_ORG</td>
<td>ADDR</td>
</tr>
<tr>
<td>PHYSICAL_CITY</td>
<td>S_ADDR_ORG</td>
<td>CITY</td>
</tr>
<tr>
<td>PHYSICAL_STATE</td>
<td>S_ADDR_ORG</td>
<td>PROVINCE or STATE</td>
</tr>
<tr>
<td>PHYSICAL_ZIP</td>
<td>S_ADDR_ORG</td>
<td>ZIPCODE</td>
</tr>
<tr>
<td>COUNTRY_NAME</td>
<td>S_ADDR_ORG</td>
<td>COUNTRY</td>
</tr>
<tr>
<td>COUNTRY_NAME</td>
<td>S_ADDR_ORG</td>
<td>COUNTRY</td>
</tr>
<tr>
<td>MAIL_ADDRESS</td>
<td>S_ADDR_ORG</td>
<td>ADDR</td>
</tr>
<tr>
<td>MAIL_ADDRESS_2</td>
<td>S_ADDR_ORG</td>
<td>ADDR</td>
</tr>
<tr>
<td>MAIL_CITY</td>
<td>S_ADDR_ORG</td>
<td>CITY</td>
</tr>
</tbody>
</table>
The S_PRSP_CONTACT table contains information about the D&B contacts such as the name of the CEO and various company executives. D&B provides up to four contacts per D&B account.

Table 78. S_DNB_ORG Table Mapping for D&B Update Manager (Siebel)

<table>
<thead>
<tr>
<th>From Column</th>
<th>To Table</th>
<th>To Column</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAIL_STATE</td>
<td>S_ADDR_ORG</td>
<td>STATE</td>
</tr>
<tr>
<td>MAIL_ZIP</td>
<td>S_ADDR_ORG</td>
<td>ZIPCODE</td>
</tr>
<tr>
<td>TELEPHONE</td>
<td>S_ORG_EXT</td>
<td>PH_NUM</td>
</tr>
<tr>
<td>FAX_NUMBER</td>
<td>S_ORG_EXT</td>
<td>FAX_PH_NUM</td>
</tr>
<tr>
<td>ANNL_SLS_AMT</td>
<td>S_ORG_EXT_X</td>
<td>ATTRIB_14</td>
</tr>
<tr>
<td>CURRENCY_CODE</td>
<td>S_ORG_EXT</td>
<td>BASE_CURCY_CD</td>
</tr>
<tr>
<td>EMPLOYEES_TOTAL</td>
<td>S_ORG_EXT_X</td>
<td>ATTRIB_26</td>
</tr>
<tr>
<td>EMPLOYEES_HERE</td>
<td>S_ORG_EXT</td>
<td>EMP_COUNT</td>
</tr>
<tr>
<td>YEAR_STARTED</td>
<td>S_ORG_EXT_X</td>
<td>ATTRIB_27</td>
</tr>
<tr>
<td>LOC_TYPE_STAT_IND</td>
<td>S_ORG_EXT</td>
<td>included in LOC</td>
</tr>
<tr>
<td>PUBLIC_PRIVATE_IND</td>
<td>S_ORG_EXT_X</td>
<td>ATTRIB_08</td>
</tr>
<tr>
<td>GBLULT_DUNS_NUM</td>
<td>S_ORG_EXT</td>
<td>GBLULT_DUNS_NUM</td>
</tr>
<tr>
<td>DOM_ULT_DUNS_NUM</td>
<td>S_ORG_EXT</td>
<td>DOM_ULT_DUNS_NUM</td>
</tr>
<tr>
<td>PAR_DUNS_NUM</td>
<td>S_ORG_EXT</td>
<td>PAR_DUNS_NUM</td>
</tr>
<tr>
<td>LINE_OF_BUSINESS</td>
<td>S_ORG_EXT_X</td>
<td>ATTRIB_03</td>
</tr>
<tr>
<td>PCT_GROWTH_SLS_3YR</td>
<td>S_ORG_EXT_X</td>
<td>ATTRIB_15</td>
</tr>
</tbody>
</table>

Table 79. S_PRSP_CONTACT Table Mapping for D&B Update Manager (Siebel)

<table>
<thead>
<tr>
<th>From Column</th>
<th>To Table</th>
<th>To Column</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAST_NAME</td>
<td>S_CONTACT</td>
<td>LAST_NAME</td>
</tr>
<tr>
<td>FST_NAME</td>
<td>S_CONTACT</td>
<td>FST_NAME</td>
</tr>
<tr>
<td>MID_NAME</td>
<td>S_CONTACT</td>
<td>MID_NAME</td>
</tr>
<tr>
<td>PER_TITLE</td>
<td>S_CONTACT</td>
<td>PER_TITLE</td>
</tr>
<tr>
<td>PER_TITLE_SUFFIX</td>
<td>S_CONTACT</td>
<td>PER_TITLE_SUFFIX</td>
</tr>
<tr>
<td>JOB_TITLE</td>
<td>S_CONTACT</td>
<td>JOB_TITLE</td>
</tr>
<tr>
<td>SEX_MF</td>
<td>S_CONTACT</td>
<td>SEX_MF</td>
</tr>
</tbody>
</table>
The S_DNB_ORG_SIC table contains the Standard Industrial Classification (SIC) code developed by the US Government. The code is assigned to businesses and other organizations by classifying and subdividing the activity performed by that establishment at that location. D&B provides up to six SICs per D&B account. In the D&B Update Manager process, the primary SIC code is mapped to the S_INDUST table and all SIC codes are mapped to the S_ORG_INDUST table.

### Table 80. S_DNB_ORG_SIC Table Mapping for D&B Update Manager (Siebel)

<table>
<thead>
<tr>
<th>From Column</th>
<th>To Table</th>
<th>To Column</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROW_ID</td>
<td>S_INDUST</td>
<td>PR_INDUST_ID</td>
</tr>
<tr>
<td></td>
<td>S_ORG_INDUST</td>
<td>INDUST_ID</td>
</tr>
</tbody>
</table>

### Table 81. Update Rules for Addresses and Contacts

<table>
<thead>
<tr>
<th>If This D&amp;B Information Changes...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Street address</td>
<td>A new address record is added to the Address table.</td>
</tr>
<tr>
<td>City</td>
<td>The address record is updated in the Address table.</td>
</tr>
<tr>
<td>(Abbreviated) state</td>
<td></td>
</tr>
<tr>
<td>Address information other than street address, city, or state</td>
<td>The address record is updated in the Address table.</td>
</tr>
<tr>
<td>Phone number</td>
<td>The address record is updated in the Address table.</td>
</tr>
<tr>
<td>Fax number</td>
<td></td>
</tr>
<tr>
<td>Contact first name or</td>
<td>A new contact record is added to the Contact table.</td>
</tr>
<tr>
<td>Contact last name</td>
<td></td>
</tr>
<tr>
<td>Contact information other than first or last name</td>
<td>The contact record is updated in the Contact table.</td>
</tr>
</tbody>
</table>

### Field Mapping for D&B Real-Time Updates

When you purchase account information through the D&B Web site using the D&B real-time search and update feature in the Siebel application, certain fields in the Siebel business components are populated. These fields are a subset of the fields that are populated by the D&B Update Manager (D&B) server component. For example, D&B does not provide the contact first, last, and middle names fields in the real-time update.
Table 82 lists the fields that may be populated or updated when you purchase account information using the D&B real-time search and update feature.

Table 82. Fields Populated by D&B Real-Time Search and Update

<table>
<thead>
<tr>
<th>D&amp;B WorldBase Marketing Plus with Linkage</th>
<th>Siebel Business Component Name.Field Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Structure Code (Location Type)</td>
<td>DNB Account.Location Type</td>
</tr>
<tr>
<td>Domestic Ultimate Name</td>
<td>DNB Account.Domestic Ultimate Business Name</td>
</tr>
<tr>
<td>Global Ultimate Name</td>
<td>DNB Account.Global Ultimate Business Name</td>
</tr>
<tr>
<td>Parent/HQ Business Name</td>
<td>DNB Account.Parent HQ Name</td>
</tr>
<tr>
<td>Physical State</td>
<td>DNB Account.State Name</td>
</tr>
<tr>
<td>Business Name</td>
<td>DNB Account.Business Name</td>
</tr>
<tr>
<td>Trade Style</td>
<td>DNB Account.Trade Style</td>
</tr>
<tr>
<td>Street Address</td>
<td>DNB Account.Physical Address</td>
</tr>
<tr>
<td>Mail Address</td>
<td>DNB Account.Mail Address</td>
</tr>
<tr>
<td>City Name</td>
<td>DNB Account.Physical City</td>
</tr>
<tr>
<td>Mail City Name</td>
<td>DNB Account.Mail City</td>
</tr>
<tr>
<td>Physical State/Province Abbreviation</td>
<td>DNB Account.Physical State</td>
</tr>
<tr>
<td>Mailing State/Province Abbreviation</td>
<td>DNB Account.Mail State</td>
</tr>
<tr>
<td>ZIP/Postal Code</td>
<td>DNB Account.Physical Zip</td>
</tr>
<tr>
<td>Mail Postal/ZIP Code</td>
<td>DNB Account.Mail Zip</td>
</tr>
<tr>
<td>Country Name</td>
<td>DNB Account.Country Name</td>
</tr>
<tr>
<td>D&amp;B D-U-N-S Number</td>
<td>DNB Account.DUNS Number</td>
</tr>
<tr>
<td>Telephone Number</td>
<td>DNB Account.Main Phone 2</td>
</tr>
<tr>
<td>Cable/Telex Code</td>
<td>DNB Account.Cable Telex Number</td>
</tr>
<tr>
<td>Facsimile Number</td>
<td>DNB Account.Main Fax 2</td>
</tr>
<tr>
<td>National ID</td>
<td>DNB Account.National Identification Number 2</td>
</tr>
<tr>
<td>SIC Code</td>
<td>DNB Account.SIC Code</td>
</tr>
<tr>
<td>Primary Local Activity Code</td>
<td>DNB Account.Primary Local Activity Code</td>
</tr>
<tr>
<td>Year Started</td>
<td>DNB Account.Year Started 1</td>
</tr>
<tr>
<td>Employees Here</td>
<td>DNB Account.Employee Here</td>
</tr>
<tr>
<td>Employees Total</td>
<td>DNB Account.Employee Total</td>
</tr>
<tr>
<td>Annual Sales US Dollars</td>
<td>DNB Account.Sales Volume</td>
</tr>
<tr>
<td>Annual Sales Local</td>
<td>DNB Account.Annual Sales Local Currency</td>
</tr>
</tbody>
</table>
Field Mapping for Account Promotion and Prospect Lists

When end users promote D&B accounts or create prospect lists from the D&B screen, fields in the DNB Account and DNB Contact business components are mapped to fields in other business components. These maps are listed in Table 83 and can be viewed in detail in the Business Component User Properties window of Siebel Tools.

For information about promoting accounts and creating prospect lists, see Chapter 29, “Opportunities (User).”

Table 83. Maps of D&B to Siebel Fields for Promotion and List Creation

<table>
<thead>
<tr>
<th>User Property Prefix and Map Name</th>
<th>D&amp;B Source Business Component</th>
<th>Siebel Destination Business Component</th>
<th>Process and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Map</td>
<td>DNB Account</td>
<td>Account</td>
<td>Promotion</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Specifies the fields in DNB Account that is copied to Account business component</td>
</tr>
<tr>
<td>Contact Map</td>
<td>DNB Contact</td>
<td>Contact</td>
<td>Promotion</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Specifies the fields in DNB Contact that is copied to Contact business component</td>
</tr>
<tr>
<td>Mailing Address Map</td>
<td>DNB Account</td>
<td>Business Address</td>
<td>Promotion</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Specifies the mailing address fields in DNB Account that is copied to Business Address</td>
</tr>
</tbody>
</table>
## Field Mappings for Configuration of D&B Integration

### Table 83. Maps of D&B to Siebel Fields for Promotion and List Creation

<table>
<thead>
<tr>
<th>User Property Prefix and Map Name</th>
<th>D&amp;B Source Business Component</th>
<th>Siebel Destination Business Component</th>
<th>Process and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Physical Address Map</td>
<td>DNB Account</td>
<td>Business Address</td>
<td>Promotion&lt;br&gt;Specifies the physical address fields in DNB Account that is copied to Business Address</td>
</tr>
<tr>
<td>Prospect Info Map</td>
<td>DNB Contact</td>
<td>List Mgmt Prospective Contact</td>
<td>Create Prospect List&lt;br&gt;Specifies the biological information (such as last name, first name, and so on)</td>
</tr>
<tr>
<td>Prospect Contact Info Map</td>
<td>DNB Account</td>
<td>List Mgmt Prospective Contact</td>
<td>Create Prospect List&lt;br&gt;Specifies the contact information (such as company, address, phone number, and so on) fields in the DNB Account that is copied into the List Mgmt Prospective Contact</td>
</tr>
</tbody>
</table>
This chapter describes how to use D&B data and reports to manage customer relationships, acquire new customers, and create high quality new account records. It includes the following topics:

- "Accessing Company Data and Reports with D&B” on page 273
- “Viewing D&B Aggregate Data for a Company” on page 273
- “Promoting a D&B Account” on page 274
- “Creating a Prospect List from D&B Data” on page 274
- “Viewing a D&B Report” on page 275
- “Using Global Integration to Add New D&B Accounts” on page 275

### Accessing Company Data and Reports with D&B

The D&B screen allows you to access D&B marketing data as well as business and credit reports from within your Siebel application.

You can directly access D&B data for use in prospecting, qualifying leads, and generating marketing lists. You also can integrate D&B data and reports into your Siebel application, allowing you to perform the following tasks:

- Use D&B information to standardize data for your customer accounts
- Access D&B business and credit reports
- Search D&B for new accounts
- Generate prospect lists based on D&B relationships and demographic data
- View account hierarchies and related opportunities across a corporate family structure

### Viewing D&B Aggregate Data for a Company

When you have the D&B account information loaded into your Siebel application, a number of views allow you to use the data and view company hierarchies. The following procedure explains how to view aggregate data for a company using the D&B screen.

**NOTE:** D&B data for a company is read-only until the company is promoted to a Siebel account. For more information, see “Promoting a D&B Account” on page 274.
To view aggregate data
1. Navigate to the D&B screen.
2. In the D&B Accounts list select the account for which you want to view the aggregate data.
3. In the More Info form, click Query.
4. In the query form, enter the query criteria, and then click Go.

A list of D&B accounts that meet your criteria appear.

NOTE: If the DUNS # field does not appear in the list, click the menu button, choose Columns Displayed, and adjust the list of displayed columns.

Promoting a D&B Account
You can use the D&B list to locate accounts that are potential sales leads. After you identify accounts that meet your criteria, you can promote the accounts into your accounts list.

To promote a D&B account
1. Navigate to the D&B screen.
2. In the D&B Accounts list select the company or companies that you want to add to your accounts list.
   - To select a sequence of account records, hold down the SHIF T key and click the account records.
   - To select multiple accounts that are not in sequence, hold down the CTRL key and click the account records.
3. In the D&B Accounts list, click Promote Account.
   A check mark appears in the Promoted field and the company is added to your Siebel application.

   Drill down on the hyperlink in the Business Name field to view the account profile and related contacts.

Creating a Prospect List from D&B Data
You can use D&B data to generate sales leads. One way to use sales leads is to create a prospect list for your telesales or sales team to contact.

To create a prospect list
1. Navigate to the D&B screen.
2. In the D&B Accounts list select the company or companies that you want to include in your list, and then click Create D&B List.

   The contacts associated with the company or companies are added to a prospect list.
3 To view the prospect list, select D&B Lists from the link bar.
4 In the D&B Lists list, select the list and drill down on the list name hyperlink to view accounts on the list.

Viewing a D&B Report

After a D&B report order is set up by your administrator, you can view business and credit reports from within your Siebel application. This information can also be viewed from the Accounts screen’s D&B Reports view tab.

To view a D&B report
1 Navigate to the D&B screen.
2 In the D&B Accounts list select the company for which you want to view reports.
3 Click the Reports view tab.
   The D&B report for the selected company appears.

Using Global Integration to Add New D&B Accounts

After a D&B Global Integration access is set up by your administrator, you can access D&B real-time within your Siebel application and enter criteria to locate new accounts in the D&B database. Search criteria can include the business name with state/province and country information, D&B D-U-N-S number, local business ID, and telephone number.

When you execute a search for new D&B accounts, the search criteria is sent to D&B's Global Integration, along with the user’s D&B account name and password. When D&B receives the information, Global Integration automatically selects the single best search method to execute based on the criteria. D&B calculates the criteria matches and returns the number to Siebel. If there are no matches for the criteria, the requestor is notified.

At this point, you can opt to purchase the account information, or cancel the Global Integration search process. If an account is purchased, data received from D&B is added to the Siebel D&B tables and is available in D&B All Accounts view.

**NOTE:** If the selected account already exists in your Siebel D&B database, the account is not purchased.

To initiate D&B’s Global Integration search
1 Navigate to the D&B screen > D&B Accounts List view.
2 Click Search D&B for New Account.
3 In the Search D&B dialog box, complete the fields for the query. The following illustration shows an example of the search criteria form.

You must enter sufficient data to initiate a query in the United States. For example, as the following figure shows, in the Search D&B form you can enter Business Name, State/Province and Country as criteria, or just the D-U-N-S number, or the Local Business ID and Country, or the Phone number and Country. If you only enter the Business Name, the search fails because the data is insufficient.

The following table describes the Search D&B query fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Name</td>
<td>The Name/Address search is the most commonly used search method. At a minimum, the business name and country must be supplied. For Canadian businesses, the province must also be included.</td>
</tr>
<tr>
<td>Street Address</td>
<td></td>
</tr>
<tr>
<td>City</td>
<td></td>
</tr>
<tr>
<td>State/Province</td>
<td>When you are searching for a business by name, do not use wildcard characters, (*) for unknown characters in the name.</td>
</tr>
<tr>
<td>Country Name</td>
<td>Additional information such as town, street address, and postal code, can be included to increase the chances of finding an exact match.</td>
</tr>
<tr>
<td>ZIP Code</td>
<td></td>
</tr>
<tr>
<td>DUNS #</td>
<td>This search method allows you to enter a known D&amp;B D-U-N-S number to verify the identity of a business. The D&amp;B D-U-N-S number should contain only nine numeric characters (no spaces, dashes, and so on).</td>
</tr>
</tbody>
</table>
### Field | Comments
--- | ---
Local Business ID | Many countries have their own numbering schemes to identify local businesses. Normally, this is a government-sponsored schema for the purpose of business registration and tax filing.

The local business ID submitted in a search should only contain numeric characters (no spaces, dashes, and so on). A country code must also be included with the request.

D&B Global Integration supports searching by the following local business identifiers.

Australia—CAN
Belgium—BTW/TVA
France—SIREN
Germany—Hr. Number
Ireland—Company House
Italy—CCIAA
Netherlands—KvK Nr
Portugal—Fiscal
Spain—CIF/NIF
Sweden—Company House
United Kingdom—Company House

Phone # | If using a telephone number search, enter the telephone number as dialed from within the country, including the area code or city code if required. The international long distance code (country code) should not be included.

For example 9086655000 for a search in New Jersey, US; 9055686000 for a search in Ontario, Canada; 01494422000 for a search in High Wycombe, England; 0104009400 for a search in Rotterdam, Netherlands.

The telephone number should contain only numeric characters (no spaces, dashes, and so on).

4 After you have entered the criteria, click Search D&B.

The following figure shows sample search results, with the business name, city, and state in the Search Results list.
5 In the Search D&B list of results, select an account, and then click Purchase.
   Click Refine Query to modify the query criteria. Click Cancel to return to the D&B Accounts list without purchasing.
   The purchased account is highlighted in the D&B Accounts list.
22 Contacts

This chapter is about administering and using contacts. It includes the following topics:

- "About Contacts" on page 279
- "Scenario for Contacts" on page 279
- "Adding a Contact" on page 280
- "Promoting a Personal Contact to a Contact" on page 282
- "Creating a Profile for a Contact" on page 282
- "Adding a Contact to a Synchronization List" on page 282
- "Assessing a Contact" on page 283
- "Synchronizing Contact Information with External Systems" on page 283

About Contacts

Contacts are individuals with whom your company conducts business or expects to conduct business in the future. These individuals can be employees of other companies, independent consultants, vendors, or personal acquaintances. Contacts can be associated with several accounts, but a contact is the primary on only one account. Contacts can also be associated with a number of opportunities.

If your organization serves mostly individual consumers, or if you are answering inbound calls related to a marketing campaign, the Contacts screen is a better screen to use when answering inbound calls. If your organization serves mostly businesses, the Accounts screen is a good screen to use when answering general inbound phone calls.

This chapter describes how sales professionals can use the Contacts screen to record information about individuals who interact with their company.

Scenario for Contacts

This scenario provides an example of a business process performed by a sales representative managing new and existing contacts. Your company may follow a different process according to its business requirements.

In the course of a business day, a sales representative interacts with other professionals. These formal and informal exchanges can result in potential leads or sales opportunities.

A sales representative determines if her company has done business with a particular company by reviewing account and contact records. In cases where contacts are not listed, the sales representative creates new contact records in the Siebel Sales application, and associates the contacts with new or existing accounts.
If the possibility of doing business—an opportunity—arises, the sales representative creates the opportunity and associates activities and contacts with the opportunity. This helps the sales representative track important milestones for obtaining and closing deals.

**Adding a Contact**

When a sales representative identifies an individual as a possible source for leads, that individual's information is added to Siebel Sales as a contact. Team members can access this contact information while they are working on potential business opportunities.

A contact team is a group of employees or partners who can view the contact information in the My Contacts view. If you work in a Mobile Web Client environment and are a member of the contact team, the contact information is downloaded to your local database the next time you synchronize.

Use the following procedure to create a contact record.

**To add a contact**

1. Navigate to the Contacts screen > Contacts List view.
2. In the Contacts List, create a new record, and complete the necessary fields.
   
   A contact record appears on the My Contacts view only if you are on the contact team for the contact.
3. Drill down on the record, and click the view tabs to complete more fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Name</td>
<td>Displays the account with which the contact is associated.</td>
</tr>
<tr>
<td>Account Status</td>
<td>Displays the status of the account with which the contact is associated.</td>
</tr>
<tr>
<td>Account Address</td>
<td>Inherits the primary address for the account associated with the contact.</td>
</tr>
<tr>
<td>Comments</td>
<td>A text field that shows any additional information associated with the contact.</td>
</tr>
<tr>
<td>Contact Method</td>
<td>A list of values established by your company that is used to define the contact's preferred method of interaction. Default values include Email, Fax, Pager, and Phone.</td>
</tr>
<tr>
<td>Contact Team</td>
<td>A default value based on your user ID. After you create a contact, you are automatically listed as the primary team member. You can add individuals to the contact team by selecting them from the employee list. Only a manager or administrator can change the primary contact team member, or can delete the primary contact team member.</td>
</tr>
<tr>
<td>Disable Cleansing</td>
<td>A check box which, when selected, does not allow data cleansing.</td>
</tr>
</tbody>
</table>
### Contacts ■ Adding a Contact

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Flag</td>
<td>If checked, this flag indicates that the contact is an employee of your company.</td>
</tr>
<tr>
<td>First Name</td>
<td>A required field that displays the contact’s first name.</td>
</tr>
<tr>
<td>Global Owner</td>
<td>Displays the name of the team member who is the global account owner. In cases of multinational or global companies, this designates one main account team member to oversee the account.</td>
</tr>
<tr>
<td>Households</td>
<td>Displays the household to which the contact is affiliated. Households allow you to track and target contact affiliations, and often these contacts share an address. For more information on Households, see Chapter 30, &quot;Households.&quot;</td>
</tr>
<tr>
<td>Household Status</td>
<td>Displays the status of the household to which the contact is affiliated.</td>
</tr>
<tr>
<td>Job Title</td>
<td>A text field that displays the contact’s professional title.</td>
</tr>
<tr>
<td>Last Name</td>
<td>A required field that displays the contact’s last name.</td>
</tr>
<tr>
<td>Lock Assignment</td>
<td>A check box which, when selected, locks the contact team assignment from reassignment by Siebel Assignment Manager.</td>
</tr>
<tr>
<td>Manager Last Name</td>
<td>Displays the manager’s last name. This field must be populated before you can perform an organizational analysis.</td>
</tr>
<tr>
<td>Middle Initial</td>
<td>An optional field that displays the contact’s middle initial.</td>
</tr>
<tr>
<td>Do Not Call, Do Not Email, Do Not Mail</td>
<td>Select this option to indicate not to telephone, send email, or send mail to the contact.</td>
</tr>
<tr>
<td>Organization</td>
<td>A default value displaying the name of the organization to which you belong. Your system administrator sets up organizations in your Siebel application. You can associate multiple organizations with an opportunity, but your organization is listed as the default organization.</td>
</tr>
<tr>
<td>Send Email Updates</td>
<td>A check box which, when selected, indicates that the contact is willing to receive email updates about products and services.</td>
</tr>
<tr>
<td>Contact Status</td>
<td>Examples are Active, Qualified, Marked for Deletion.</td>
</tr>
<tr>
<td>Sync</td>
<td>A read-only check box, which indicates the user has included the contact record in the user’s Sync List. Requires Siebel Server Sync.</td>
</tr>
<tr>
<td>Sync List</td>
<td>A dialog box that displays the User IDs of users who synchronize the contact with a personal information manager (PIM) such as Lotus Notes or Microsoft Outlook. Requires Siebel Server Sync.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Displays the time zone in which the contact works or lives.</td>
</tr>
<tr>
<td>Registration Source</td>
<td>Displays how the contact was registered, for example, the contact might have been registered at a particular marketing event.</td>
</tr>
<tr>
<td>Price List</td>
<td>Displays the price list associated with the contact.</td>
</tr>
</tbody>
</table>
Promoting a Personal Contact to a Contact

Contact records can be promoted from the My Personal Contacts view to the My Contacts view.

To promote a contact from My Personal Contacts to My Contacts

1. Navigate to the Contacts screen > Personal Contacts List view.
2. In the Contacts list, select the contact for promotion.
3. In the Contact form, clear the check box in the Private field.

   The Contact record appears in the My Contacts list.

   NOTE: You cannot designate a contact as Private (My Personal Contacts) from the My Contacts list.

Creating a Profile for a Contact

A profile consists of information that is collected about a contact. This information can include a contact’s expenditure approval, hobbies, education, and the name of the contact’s spouse.

To create a profile

1. Navigate to the Contacts screen > Contacts List > Profile view.
2. Query for the contact.
3. In the Profile form, complete the fields.

Adding a Contact to a Synchronization List

A contact can be added to a list for synchronization with a personal information manager (PIM), for example, Microsoft Outlook, using Siebel Server Sync. For more information about synchronizing contacts, see Siebel Server Sync Guide.

To add a contact to a sync list

1. Navigate to the Contacts screen > Contacts List view.
2. In the Contacts list, select the contact to be added to the Sync List.
3. Click the menu button, and then select Add to Sync List.
   - A check mark appears in the Sync check box in the Contact form.
   - A contact can also be added to a different Sync List by clicking the select button in the Sync List field in the contact form.
To remove a contact from a sync list
1. Navigate to the Contacts screen > Contacts List view.
2. In the Contacts list, select the contact to be removed from the Sync List.
3. Click the menu button, and then select Remove from Sync List.
   The check mark is removed from the Sync check box in the Contact form.

Assessing a Contact
You can use assessments to compare contacts with one another, compare them with a model, or to determine what information is present or not for a contact. To perform the assessment, you enter values for the assessment attributes. The application calculates a composite assessment value for the contact. For information about how to perform an assessment, see “Performing an Assessment (User)” on page 192.

Synchronizing Contact Information with External Systems
The Application Services Interface (ASI) feature allows you to synchronize the contact data between a Siebel application and an external system in real time. This feature enables you to maintain consistent contact information across your enterprise, and to eliminate manual entry of data in multiple systems.

If your Siebel administrator has set up real-time contact integration between a Siebel application and another system, you can use the Update External System command to send new and modified contact information from the application to the other system in real time. For more information about ASI, see Siebel Application Services Interface Reference and Chapter 24, “Integration Using ASIs.”

To synchronize contact information with an external system
1. Navigate to the Contacts screen > Contacts List view.
2. In the Contacts list, select a contact record.
   To create a new contact record, see “Adding a Contact” on page 280.
3. In the Contacts list, click the menu button, and then choose Update External System.
This chapter describes how to set up and use Adobe forms integration. It includes the following topics:

- About Forms Integration on page 285
- Scenarios for Forms Integration on page 286
- Process of Setting Up Adobe Forms Integration on page 287
- Preparing for Adobe Forms Integration Setup on page 288
- Creating the Web Service for Adobe Forms Integration on page 288
- Configuring the Web Service for Adobe Forms Integration on page 289
- Enabling Forms Integration for Additional Applets Using Siebel Tools on page 290
- Creating an Integration Object for Adobe Forms Integration on page 290
- Generating an XML Schema for Forms Integration on page 291
- Mapping the XML Schema to the PDF Form Using Adobe Designer on page 292
- Creating the Form Record Referencing the PDF File on page 292
- Generating a Form from a Record (User) on page 294

### About Forms Integration

Government agencies generate paper documents for record-keeping purposes when processing applications, such as those for immigration, citizenship, and visas. These documents might include letters to applicants, as well as standardized forms with a precise layout that must be maintained. Forms and letters might be issued on preprinted paper stock, such as with visas. You can use data from Siebel Business Applications to populate these forms and letters.

Siebel Business Applications provide preconfigured Web services-based integration with Adobe Forms Server 6.0 and Adobe Forms Designer software. This integration allows the generation of PDF forms based on data captured in Siebel Business Applications. For example, users can extract contact data within an application such as Siebel Call Center, and populate the appropriate fields in a standard PDF application form.

The data for the form can come from the primary business component of a record, or any child business components. The available forms are those that are associated with the primary business component. The application can also use a search specification to select a particular record from a child business component. For example, the application can select the primary contact associated with a case record.
Users can also generate multiple populated PDF forms at one time. The user selects multiple records, then generates the forms. A PDF form is generated for each record, and is added to each record as an attachment. You can then use Adobe Acrobat Reader to open, print, edit, email, and save the document.

Administrators can use drag-and-drop functionality in Adobe Designer to map the data from Siebel Business Applications to fields in an Adobe PDF form. Administrators can also specify the text style (font), size, justification, and word wrapping for each field in the form, or choose to use the default style settings.

In Siebel Business Applications, the Forms Administration view provides a list of forms available in the application. The available date and expiration date of each form determines the availability of the form to users, and provides version control.

Scenarios for Forms Integration

The following scenarios provide examples of processes performed by administrators and users. Your organization might follow different processes according to your particular business requirements.

Users can generate a schema, and then import and map to fields on a PDF using either XSD or XML data. In these business scenarios, XML is used to illustrate the examples.

Setting Up Forms Integration

An immigration and citizenship agency administrator generates an XML schema in a Siebel application and maps the XML data to fields in a visa application form. The administrator then creates a form record that agency personnel can select when they process applications for visitor status.

Generating a Form from Data in a Siebel Application

A client requests written proof of his citizenship. A citizenship clerk locates the record for the client, determines that the client is a citizen, and generates a proof-of-citizenship form. The system generates the form, and populates the form with data from the record. The clerk can then print the form and mail it, or transmit the form to the client electronically.

Generating Multiple Forms

A citizenship clerk prepares all the necessary documentation for a citizenship ceremony. Before the ceremony, the clerk prints a new grant-of-citizenship form for each client who is scheduled to attend the ceremony. Each form is printed on an official government document. Each form contains fields for specific information about the client, such as First Name and Last Name, and general information about the event, such as event date, office location, and so on.

The clerk reviews the list of clients scheduled to attend the event, selects the client records, and then chooses the appropriate form to generate. The system creates the forms and populates the forms with the required data. The clerk reviews the forms, then prints the forms.
Process of Setting Up Adobe Forms Integration

This topic lists the tasks that administrators typically perform to set up Adobe forms integration. Your organization may follow a different process according to its business requirements.

Administrator Procedures
The following list shows the tasks that administrators typically perform to set up Adobe forms integration:

1. Install the required Adobe software. For more information, see "Preparing for Adobe Forms Integration Setup" on page 288.
2. Use Siebel Tools to create the Adobe Web Service. For more information, see "Creating the Web Service for Adobe Forms Integration" on page 288.
3. Configure the Adobe Web Service. For more information, see "Configuring the Web Service for Adobe Forms Integration" on page 289.
4. (Optional) If forms integration functionality is required for business objects other than those that are preconfigured for Siebel Public Sector, use Siebel Tools to add Adobe forms integration functionality. For more information, see "Enabling Forms Integration for Additional Applets Using Siebel Tools" on page 290.
5. During the design process, use Siebel Tools to create an integration object for the selected business component. For more information, see "Creating an Integration Object for Adobe Forms Integration" on page 290.
6. In Siebel Public Sector, a preconfigured PUB Immigration Contact integration object is provided. For Siebel Business Applications, a Sample Contact integration object is provided. Verify that both objects are active; make sure that the Inactive check box is not selected.
7. Generate the XML schema document. For more information, see "Generating an XML Schema for Forms Integration" on page 291.
   NOTE: Administrators can generate a schema, import the XML schema, and then map the schema to fields on a PDF using either XSD or XML data. In this process, XML is used in the procedures.
8. In Adobe Forms Designer, import the XML schema, and then map the schema to fields on the PDF form. For more information, see "Mapping the XML Schema to the PDF Form Using Adobe Designer" on page 292.
9. In a Siebel application, create a form record that points to the PDF file. For more information, see "Creating the Form Record Referencing the PDF File" on page 292.

User Procedure
Users typically perform the following task to use Adobe forms integration:
Adobe Forms Integration  ■ Preparing for Adobe Forms Integration Setup

Generate a form from a record in a Siebel application. A copy of the PDF form is stored in the Attachments view of the record. For more information, see “Generating a Form from a Record (User)” on page 294.

Preparing for Adobe Forms Integration Setup

You must perform the following steps before you can set up and use Adobe forms integration with a Siebel application. After you verify that the tasks are complete, you can begin the forms integration tasks.

For more information on software version requirements for Adobe forms integration, see Siebel System Requirements and Supported Platforms for Self-Service Applications on Oracle Technology Network.

This task is a step in “Process of Setting Up Adobe Forms Integration” on page 287.

Preparing the Setup for Adobe Forms Integration

Perform the following steps:

1. Install Adobe Form Server.
   
   This server deploys high-volume, secure, XML-based forms as Adobe PDF files to any platform. For installation instructions, see the documentation provided with the application. You must install Java 2 SDK, SE, and IBM WebSphere before you install Adobe Forms Server.

2. Install Adobe Designer.
   
   This form design tool allows you to create forms based on XML. Adobe provides the installation instructions for the application.

3. Make sure that your computer can read Adobe documents.
   
   Users view and interact with Adobe forms and other PDF documents in Adobe Acrobat Reader. Siebel Business Applications use Adobe Acrobat Reader to display PDF documents. You might need to install Adobe Acrobat Reader.
   
   For more information about how to install Adobe Acrobat Reader, and how to configure your computer to display PDF documents, see the Adobe Web site.

Creating the Web Service for Adobe Forms Integration

To create the Web Service for Adobe forms integration, use Siebel Tools to perform the steps in the following procedure. For more information, see Using Siebel Tools.

This task is a step in “Process of Setting Up Adobe Forms Integration” on page 287.
To create the Web Service

1. Start Siebel Tools and log in as the administrator.
2. From the application-level menu, choose File > New Object, and from the New Objects Wizard dialog box, click the EAI tab and choose Web Service.
3. From the WSDL Import Wizard wizard screen, perform the following tasks:
   a. Select a project.
      For example, select Contact as the project.
   b. Specify the WSDL document file from which to import.
      The WSDL document file is provided by Adobe.
      After you specify the WSDL document file, the following field values are automatically populated. Do not change the default values.
      - Run-time data file: `<path>`\SiebellIntegration.xml
      - Log file: `<path>`\SiebellIntegration.log
   c. Click Next, and then click Finish.
4. Use Siebel Tools to compile the project.

Configuring the Web Service for Adobe Forms Integration

Complete the steps in the following procedure to configure the Web Service for Adobe forms integration.

This task is a step in “Process of Setting Up Adobe Forms Integration” on page 287.

To configure the Adobe Web Service

1. Navigate to the Administration - Web Services screen > Outbound Web Services view.
2. From the Outbound Web Services list, click the Import button.
3. From the EAI Web Service Import dialog box click Browse, locate the Adobe Web Service created in Siebel Tools (SiebelIntegration.XML) on the network, and then click Import.
4. In the Outbound Web Services list, select Adobe Web Service.
5. In the Service Ports list, update the address field with the correct IP address for the Adobe Form Server.
   For example, the field should show an address similar to the following address:
   
   `http://255.255.255.0:9080/IDPWeb/IDPFormServer`
Enabling Forms Integration for Additional Applets Using Siebel Tools

By default, Adobe forms integration is enabled on the following applets:

- Contact List
- PUB Immigration Contact List
- PUB Immigration Credentials List
- PUB Immigration Identity List
- PUB Immigration Identity Form
- PUB Immigration Contact Identity Form

You can also generate forms based on other business objects, such as opportunities. Administrators can use Siebel Tools to add Adobe forms integration functionality to other applets in Siebel Business Applications. For more information, see Siebel Tools Online Help and Using Siebel Tools.

This task is a step in “Process of Setting Up Adobe Forms Integration” on page 287.

To add forms integration functionality to application applets

1. In Siebel Tools, select the applet to which you want to add the forms integration menu option.
2. Add a new Applet Method Menu Item to the applet. In the Command field, select the Generate Form Command object.

Creating an Integration Object for Adobe Forms Integration

The following procedure provides information on how to create a new integration object for Adobe forms integration by using Siebel Tools and the source object Contact. For more information about how to create an integration object, see XML Reference: Siebel Enterprise Application Integration, Siebel Tools Online Help, and Using Siebel Tools.

**NOTE:** When you create the Integration Object for forms integration, make sure not to include fields that include a period (.) in the name. Adobe Designer does not support fields with this character.

This task is a step in “Process of Setting Up Adobe Forms Integration” on page 287.

To create an integration object

1. Start Siebel Tools and log in as the administrator.
2. From Object Explorer, query for the project (for example, Contacts), and then lock the project.
3. Choose File > New Object, and from the New Objects Wizard dialog box click the EAI tab and choose Integration Object.
4. From the Integration Object Builder wizard screen:
a  Select a project.
   For example, select Contact as the project.

b  Specify the source system of the new Integration Object (business service), and then click Next.
   For example, select EAI Siebel Wizard.

5  Select the source object for the new Integration Object from the list.
   For example, select Contact.

6  Enter a name for the Integration Object.
   For example, name the object Contact_Form_Integration. The name must be unique among all of the Integration Objects in Projects.

7  Select the appropriate check boxes to activate the components for the Integration Object.
   For example, expand the Contacts object hierarchy, and select the check box for the appropriate item to choose Contact_Personal Address and Contact_Opportunity.

   **NOTE:** Developers might want to include multiple integration components when the integration object is built, so that the integration object can be reused for many different forms. This also reduces the maintenance required for integration objects.

8  Click Next, and then click Finish.

9  Select the integration object, right-click the mouse, and choose Validate.

### Generating an XML Schema for Forms Integration

Complete the steps in the following procedure to generate the XML schema. For more information, see *XML Reference: Siebel Enterprise Application Integration*.

This task is a step in “Process of Setting Up Adobe Forms Integration” on page 287.

#### To generate the schema for the forms integration object

1  From the Siebel Tools Object Explorer list, select the new integration object, and then click Generate Schema.

2  From the Generate XML Schema window, select a Business Service from the list.
   For example, choose EAI XML XSD Generator.

3  In the Select an envelope type from the list field, select No Envelope.

4  In the Choose the file name to save the schema object field, click Browse, select the file to which you want to save, and then click Finish.
   You must save the file in a network location that the Siebel application can access at run time.
   The XML Schema file, for example Contact_schema.xml, is generated, based on user inputs.
Mapping the XML Schema to the PDF Form Using Adobe Designer

Administrators can map the data schema from a Siebel application to an Adobe PDF template using the drag-and-drop functionality provided with Adobe Designer software. For more information about using Adobe Designer 6.0, see the documentation provided with the Adobe application.

This task is a step in “Process of Setting Up Adobe Forms Integration” on page 287.

**To map the schema to the PDF form**

1. Start Adobe Designer, and select the PDF file.
   
   For example, start Adobe Designer with a PDF file named, Contact.pdf.

2. Choose File > New Data Connection.

3. Select the XML Schema option, and click Next.

4. Use the XML Schema File field to select the XML schema file.
   
   Select the Embed XML Schema option, then click Finish.

5. Click the Data View tab, and expand the node.
   
   For example, expand the Contact node. The schema columns are displayed under Contact. The columns include child components, which might be selected during mapping.

6. In the PDF form, select the target field.

7. Drag the data column from the Data View, and drop the column on the placeholder field in the PDF file.
   
   For example, drag and drop Last Name, First Name, Cellular Phone, Home Phone, and so on.

8. Save the file.
   
   **NOTE:** You must save the PDF file in a network location that the Siebel application can access at run time.

Creating the Form Record Referencing the PDF File

Form records must be maintained within Siebel Business Applications so that the forms are available to users. This process allows administrators to add new forms, update forms with newer versions, and deactivate or remove old and obsolete forms.

Only users with administrator privileges can modify or delete form records. Typically, older forms are flagged as inactive rather than deleted.

This task is a step in “Process of Setting Up Adobe Forms Integration” on page 287.
To create a form record

1. Navigate to the Administration - Document screen > Forms Integration Administration view.

2. In the Forms Integration list, create a new record, and provide a name and description.
   For example, create a form record named Contacts.

3. Complete the fields, and select the appropriate integration object.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>Type the version number of the form.</td>
<td>1</td>
</tr>
<tr>
<td>Inactive</td>
<td>Select this check box to make the form inactive.</td>
<td></td>
</tr>
<tr>
<td>Integration Object</td>
<td>Select the source object for the integration object.</td>
<td>Contact</td>
</tr>
<tr>
<td>Request</td>
<td>(Siebel Remote only) Select this check box to retrieve the document from the server during the next synchronization session.</td>
<td></td>
</tr>
<tr>
<td>Update</td>
<td>Select this check box to update your copy of the file automatically when the original file is updated.</td>
<td></td>
</tr>
<tr>
<td>Business Object</td>
<td>Displays the business object associated with the integration object you selected.</td>
<td>Contact</td>
</tr>
<tr>
<td>File Name</td>
<td>Select the filename of the PDF form.</td>
<td>Sample_Contact.pdf</td>
</tr>
<tr>
<td>File Type</td>
<td>Displays the file type of the PDF form.</td>
<td>PDF</td>
</tr>
<tr>
<td>Type</td>
<td>Select PDF as the file type in which the form is generated.</td>
<td>PDF</td>
</tr>
<tr>
<td>Attachment Business Component</td>
<td>Select the business component in whose Attachments view you want to attach the generated form.</td>
<td>Contact</td>
</tr>
<tr>
<td>Forms Adapter</td>
<td>Select Forms Integration PDF Adapter Service. Use the Debug Forms Integration PDF Adapter to troubleshoot issues with the Adobe integration.</td>
<td>Forms Integration PDF Adapter Service.</td>
</tr>
<tr>
<td>File Adapter</td>
<td>Select Forms Integration File Adapter Service.</td>
<td>Forms Integration File Adapter Service.</td>
</tr>
</tbody>
</table>
Generating a Form from a Record (User)

Users can generate a PDF document that is automatically populated with data from a record in a Siebel application, such as a contact. The PDF file is stored in the Attachments view associated with the record.

This task is a step in “Process of Setting Up Adobe Forms Integration” on page 287.

To generate a form with data from a record

1. Navigate to the Contacts screen and select the appropriate record.
   You can also create a new contact record and verify that the record contains the data necessary to populate the form.

2. From the Contacts list menu, select Generate Form.
   The dialog box provides a list of forms associated with the parent business object.

3. From the Select Forms dialog box, click the caret symbol on the left side of the list to choose the appropriate form. Click OK.
   The user is automatically navigated to the Attachments view of the record where the PDF file is stored for archival purposes. The user can then drill down on the hyperlink in the Attachment name form to open the document in Acrobat Reader.

4. Verify that the form is correctly populated with the data.

Generating Forms for Multiple Records

To generate forms from multiple records such as contacts, perform the same procedure as for a single record, except select multiple records.
When you generate multiple forms, consider the complexity of the form and the number to be generated. If the form is relatively simple, you can typically generate 200 forms at one time without an impact to performance. If the form is complex, generate the forms in batches of no more than 100 forms. For example, for a Citizenship Ceremony, assess the complexity of the form before you decide whether to generate forms in one procedure or in batches.
This chapter is about administering iHelp. It includes the following topics:

- “About ASIs” on page 297
- “Setting Up Account, Contact, and Household ASIs” on page 297
- “ASI Workflow Descriptions” on page 299

### About ASIs

ASIs allow you to integrate Siebel applications with other applications in real time.

The Accounts, Contacts, or Households screens use ASIs to exchange data with any external system such as a back-office application. These are listed in Table 84.

You must set up these ASIs shipped with your Siebel application before they can be used. This chapter provides the procedures that you must perform to set up these ASIs. Depending on your business needs, you may choose to set up ASIs and activate workflows for some or all of the GUI commands listed in Table 84.

For general information about ASIs, see Siebel Application Services Interface Reference.

### Table 84. ASIs for Accounts, Contacts, and Households

<table>
<thead>
<tr>
<th>Screen</th>
<th>GUI Command</th>
<th>Workflow</th>
<th>Outbound and Inbound ASI Pairs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts</td>
<td>Update External System</td>
<td>Synchronize Account ASI</td>
<td>External Account</td>
</tr>
<tr>
<td>Accounts (Credit Profile view)</td>
<td>Refresh</td>
<td>Get Account ASI</td>
<td>Siebel Account</td>
</tr>
<tr>
<td>Contacts</td>
<td>Update External System</td>
<td>Synchronize Contact ASI</td>
<td>External Contact</td>
</tr>
<tr>
<td>Households</td>
<td>Update External System</td>
<td>Synchronize Household ASI</td>
<td>External Household</td>
</tr>
</tbody>
</table>

### Setting Up Account, Contact, and Household ASIs

This section describes how to set up the prebuilt ASIs for Accounts, Contacts, and Households:
Integration Using ASIs ■ Setting Up Account, Contact, and Household ASIs

1 Set up outbound and inbound Web services. See "Setting Up Web Services for Account, Contact, and Household ASIs" on page 298.

2 Activate workflows. See "Activate Workflows for Account, Contact, and Household ASIs" on page 299.

Other tasks you may want to perform are:

■ Extending ASIs. See Siebel Application Services Interface Reference.

■ Deactivating fields in the ASIs. See Siebel Application Services Interface Reference.


Setting Up Web Services for Account, Contact, and Household ASIs
To set up the Web services, you must set up both outbound and inbound Web services for the ASIs. The procedures that follow show you the steps required for each ASI.

To set up an outbound Web service
1 Navigate to the Administration - Web Services screen > Outbound Web Services view.

2 In the Outbound Web Services list, create a query to display the record with External Account, External Contact, or External Household in the Name field.

3 Verify that the fields in the Outbound Web Services list match those in the following table.

<table>
<thead>
<tr>
<th>Namespace</th>
<th>Name</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="http://siebel.com/asi/">http://siebel.com/asi/</a></td>
<td>One of the following:</td>
<td>Active</td>
</tr>
<tr>
<td></td>
<td>External Account</td>
<td></td>
</tr>
<tr>
<td></td>
<td>External Contact</td>
<td></td>
</tr>
<tr>
<td></td>
<td>External Household</td>
<td></td>
</tr>
</tbody>
</table>

4 In the Service Ports list, click New, and enter the following values in the fields of the new record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the port.</td>
</tr>
<tr>
<td>Service Display Name</td>
<td>Enter External Account, External Contact, or External Household.</td>
</tr>
<tr>
<td>Transport</td>
<td>Select from the drop-down list.</td>
</tr>
<tr>
<td>Address</td>
<td>When you select a transport, the field will be populated with a template address. Edit the address based on where you are sending the data.</td>
</tr>
<tr>
<td>Binding</td>
<td>If a SOAP header is expected by the receiving application, select SOAP_RPC.</td>
</tr>
</tbody>
</table>
**To set up an inbound Web service**

1. Navigate to the Administration - Web Services screen > Inbound Web Services view.

2. In the Inbound Web Service list, create a query to display the record with Siebel Account, Siebel Contact, or Siebel Household in the Name field.

3. Verify that the fields in the Inbound Web Services list match those in the following table.

<table>
<thead>
<tr>
<th>Namespace</th>
<th>Name</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="http://siebel.com/asi/">http://siebel.com/asi/</a></td>
<td>One of the following:</td>
<td>Active</td>
</tr>
<tr>
<td></td>
<td>Siebel Account</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Siebel Contact</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Siebel Household</td>
<td></td>
</tr>
</tbody>
</table>

4. In the Service Ports list, review the information in the fields for the service port and make any changes required for your system.

5. In the Operations list, review the information shown and make any changes required for your system.

**Activate Workflows for Account, Contact, and Household ASIs**

You must activate the following workflow processes used for real-time integration of account, contact and household data:

- Synchronize Account ASI
- Get Account ASI
- Synchronize Contact ASI
- Synchronize Household ASI

For a description of these workflows, see "ASI Workflow Descriptions" on page 299.

**To activate workflows used by Account, Contact, and Household ASIs**


**ASI Workflow Descriptions**

This section describes the workflow processes that are used to invoke the ASIs for account processes. It is not necessary to modify these workflows, but you can modify them to suit your business model.
**Synchronize Account ASI**
This workflow submits the account information to the outside system to synchronize the information between the two systems.

- **Query For Account By Id:** Queries for the account on the current system using the object ID. Returns an account property set containing the account information.
- **External Account Proxy:** Calls the Synchronize method on the outside system, passing in the account property set. This step returns an account property set, which will contain any changes the outside system made to the account.
- **Synchronize Account:** Takes the account property set returned by the previous step and synchronizes it with the account in the current system.

**Synchronize Contact ASI**
The Synchronize Contact ASI process is essentially the same as the Synchronize Account ASI process, except that contact replaces account.

**Synchronize Household ASI**
The Synchronize Household ASI process is essentially the same as the Synchronize Account ASI process, except that household replaces account.

**Get Account ASI**
This workflow queries the outside system to retrieve the latest information on the account. It returns the new information and synchronizes the account on the current system.

- **Query Account By Id:** Queries for the account on the current system using the object ID. Returns an account property set containing the account information.
- **Isolate Integration Id:** In the next step, the workflow uses a query by example. Query by example takes the property set and looks for an account with exactly the same values for the fields in the property set. If the account has changed on the outside system, those values will no longer match. The workflow needs to query by a value that does not change, that is, the integration ID. Isolate Integration Id takes in a property set and removes all the fields, except the integration ID.
- **External Account Proxy:** Using the property set, which only has an integration ID now, this step queries by example on the outside systems. Once it finds the account with that integration ID, it returns an account property set containing the account information.
- **Synchronize Account:** Takes the account property set returned by the previous step and synchronizes it with the account in the current system.
This chapter is about the Web services which enable you to access the Siebel database from Microsoft Excel and Microsoft Word.

- About Web Services for Microsoft Applications on page 301
- About the Excel Web Service on page 302
- About the Word Web Service on page 302
- Seed Data for Excel and Word Web Services on page 303
- Prerequisites for Connecting Templates to Siebel EAI on page 303
- Process of Configuring Excel Web Service on page 303
- Downloading the Template for the Excel Web Service on page 304
- Connecting the Excel Template to Siebel EAI on page 304
- Using the Excel Web Service on page 305
- Process of Configuring Word Web Service on page 306
- Downloading the Template for the Word Web Service on page 306
- Connecting the Word Template to Siebel EAI on page 306
- Process of Using Word Web Service to Perform a Mail Merge on page 307
- Getting the Data for a Mail Merge From the Siebel Database on page 308
- Refining Recipients for a Mail Merge on page 308
- Refining the Message for a Mail Merge on page 309
- Previewing Messages for a Mail Merge on page 309
- Printing or Sending Mail Merge Messages on page 310
- Logging Messages as a Siebel Activity on page 310

About Web Services for Microsoft Applications

These Web services work with Microsoft Office. For information on supported versions see Siebel System Requirements and Supported Platforms on Oracle Technology Network.

Users must have the macro-security level set to medium or lower to use these Web services.
About the Excel Web Service

The Excel Web service provides several useful features for Siebel users. For example, if you use the Excel Web service, you do not need to export data from your Siebel database, then import it to Excel. You can use the Excel Web service to do the following tasks:

- Create and populate spreadsheets with data from your Siebel database.
- Define and save reports which specify the fields to take from your Siebel database, and filters to apply.
- Update your reports as required to get the latest information from the database.
- Use Excel pivot tables and charts to analyze data from your Siebel database.

By default, the following record types are supported:

- Accounts
- Contacts
- Opportunities
- Service Requests

About the Word Web Service

The Word Web service enables you to use the Word mail merge feature directly with your Siebel database. The Word Web service adds a custom toolbar to your documents. You can use the toolbar to perform your mail merge tasks. You can use the Word Web service to do the following tasks:

- Create a list of mail merge recipients with data from your Siebel database.
- Refine your mail merge message and add fields to represent fields from your Siebel database.
- Preview your mail merge documents with the data fields populated with data from your Siebel database.
- Print or email your mail merge documents directly from Word.
- Log each mail merge event as an activity in your Siebel database.

By default, the following record types are supported:

- Accounts
- Activities
- Contacts
- Opportunities
- Service Requests
Seed Data for Excel and Word Web Services

Siebel Business Applications include seed data for the Excel and Word Web services. The seed data includes the following items:

- Template files for the services.
- SAF files. These files are generated when you add templates as literature items. These files must be present to enable users to open the templates from the Literature view.

**To enable users to open Web services templates from the Literature view**

- Copy the *.SAF files from $SIEBEL_ROOT/temp/SFA into the $FILESYSTEM directory.

**To download the Excel or Word template**

1. Navigate to the Administration - Document screen > Literature view.
2. In the Literature list, select the Excel or Word template.
3. Click the template, then save the file to your computer.

Prerequisites for Connecting Templates to Siebel EAI

Before you can connect an Excel or Word template to the Siebel Enterprise Application Integration (EAI) component, you must make sure that the following conditions are met:

- Siebel Enterprise Server is running
- Siebel Server or Siebel Gateway Server is running
- Siebel EAI component group is enabled
- Siebel Workflow Management component group is enabled
- The object manager for the Siebel application with which you want to use the Excel or Word template is running
- Seed data for inbound Web services is available
- The Excel or Word template is available

Process of Configuring Excel Web Service

To configure the Excel Web service, you must perform the following tasks:

1. Downloading the Template for the Excel Web Service on page 304
Connecting the Excel Template to Siebel EAI

Before you can connect an Excel template to the Siebel Enterprise Application Integration (EAI) component, you must make sure that particular conditions are met. For more information about these prerequisites, see Prerequisites for Connecting Templates to Siebel EAI on page 303.

This task is a step in Process of Configuring Excel Web Service on page 303.

To connect an Excel template to Siebel EAI

1. In Excel, open the workbook template.
2. Choose File > Properties.
3. Click the Custom tab.
4. Create custom properties with values as shown in the following table:

<table>
<thead>
<tr>
<th>Custom Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>SFAServer</td>
<td>ServerName/eai_language, where ServerName is the name of your server, and language is the language of the object manager.</td>
</tr>
<tr>
<td>SFAProtocol</td>
<td>http</td>
</tr>
<tr>
<td>SFAPort</td>
<td>port_number, where port_number is the number of the port you want to use.</td>
</tr>
</tbody>
</table>

5. Save the workbook template.
Using the Excel Web Service

You can use the Excel Web service to create Siebel reports in Excel. You perform the following actions to create the query to run for the report:

- Log in to the Siebel database.
- Select the business component on which you want to run the report.
- Specify conditions to apply to the data.
- Select the fields you require.

When you run the report, the report output is inserted into the workbook as a new worksheet. You can add multiple Siebel reports to your Excel workbook.

After you create your Siebel reports, you can run all of the reports again. When you do this, you refresh the content of each of the worksheets in your workbook.

**NOTE:** After you log in to the Siebel database in this process, your session might time out. If this occurs, you must log in again.

**To create Siebel reports in Excel**

1. In Excel, create a new workbook based on the workbook template.
2. Click the Configure Siebel Report button.
3. Enter your Siebel username and password, then click Login.
4. Select the type of records you require from the Select Record Type drop-down list on the Configure Reports dialog box.
5. Select the type of report you require from the Available Reports list, then click the Run Report button.

Alternatively, to create a new report perform the following steps:

- **a** Click the New Report button.
- **b** Specify any filters that you want to apply to the data on the Filters tab of the Define Report dialog box.
- **c** Click the Fields tab, then use the dialog to specify the fields that you want to include in the report.
- **d** Click OK.
- **e** Type a name for the report on the Save Report As dialog, then click Save.
- **f** Select the new report on the Configure Reports dialog box, then click the Run Report button.

The report data is inserted into the workbook as a new worksheet with the name of the report.

**To update Siebel reports in Excel**

1. In Excel, open the workbook that contains the Siebel reports that you want to update.
2. Click the Refresh Siebel Report button.
3. Enter your Siebel username and password, then click Login.
   Each report in your workbook is run again, and the data in each worksheet is updated.

### Process of Configuring Word Web Service

To configure the Word Web service, perform the following tasks:

1. **Downloading the Template for the Word Web Service on page 306**
2. **Connecting the Word Template to Siebel EAI on page 306**

### Downloading the Template for the Word Web Service

The Word document template that is provided as seed data with Siebel Business Applications contains a toolbar and macros that you can use to work with data from your Siebel database in Word.

For more information about how to download the Word template, see Seed Data for Excel and Word Web Services on page 303. If you want help with customizing a template to your requirements, contact your Oracle sales representative for Oracle Advanced Customer Services to request assistance from Oracle's Application Expert Services.

### Connecting the Word Template to Siebel EAI

Before you can connect a Word template to the Siebel Enterprise Application Integration (EAI) component, you must make sure that particular conditions are met. For more information about these prerequisites, see Prerequisites for Connecting Templates to Siebel EAI on page 303.

This task is a step in Process of Configuring Word Web Service on page 306.

**To connect the Word template to Siebel EAI**

1. In Word, open the document template.
2. Choose File > Properties.
3. Click the Custom tab.
Create custom properties with values as shown in the following table:

<table>
<thead>
<tr>
<th>Custom Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>SFAServer</td>
<td>ServerName/eai_language, where ServerName is the name of your server, and language is the language of the object manager. Include the DNS name of the server. For example, if your server name is abcdef, and your domain name is corp.xyz.com, type abcd.corp.xyz.com in this field.</td>
</tr>
<tr>
<td>SFAProtocol</td>
<td>http or https</td>
</tr>
<tr>
<td>SFAPort</td>
<td>port_number, where port_number is the number of the port you want to use. Typically, this number is 80.</td>
</tr>
</tbody>
</table>

Save the document template.

In your Siebel application, click the Generate WSDL button.

Generate a proxy class from the WSDL.

For more information about how to publish Web services and generate WSDLs, see Integration Platform Technologies: Siebel Enterprise Application Integration.

Process of Using Word Web Service to Perform a Mail Merge

To use the Word Web service to perform a mail merge with data from the Siebel database, perform the following tasks:

1. Getting the Data for a Mail Merge From the Siebel Database on page 308
2. Refining Recipients for a Mail Merge on page 308
3. Refining the Message for a Mail Merge on page 309
4. Previewing Messages for a Mail Merge on page 309
5. Printing or Sending Mail Merge Messages on page 310
6. Logging Messages as a Siebel Activity on page 310

**NOTE:** After you log in to the Siebel database in this process, your session might time out. If this occurs, you must log in again.
Getting the Data for a Mail Merge From the Siebel Database

You can use the Word Web service to get contact information for a mail merge from your Siebel database. You perform the following actions to create the query to run:

■ Select the business component from which you want contact information.
■ Specify conditions to apply to the contact records. You can specify up to six conditions.
■ Select the fields you require from the contact records. You can specify up to 40 fields.

When you run the query, the output is saved in a local area as the data source for your mail merge.

This task is a step in Process of Using Word Web Service to Perform a Mail Merge on page 307.

To get contact data from the Siebel database

1 In Word, open the document template.
2 Click the Get Siebel Data button, then select the type of information you want to include in mail merge. Select one of the following options:
   ■ Account
   ■ Contacts
   ■ Opportunity
   ■ Service Request
   Alternatively, if you have saved contact data previously, choose Use Saved List and select the list you require.
3 Enter your Siebel username and password, then click Login.
4 Specify any conditions that you want to apply to the data on the Filters tab of the Define List dialog box.
5 Click the Fields tab, then use the dialog to specify the fields that you want to include in the report.
6 Click OK.

Refining Recipients for a Mail Merge

After you save the contact data, you can review the list of recipients for your mail merge, and make modifications to the list if required.

This task is a step in Process of Using Word Web Service to Perform a Mail Merge on page 307.

To modify recipients

1 Open the Word document to which you added a data source in Getting the Data for a Mail Merge From the Siebel Database on page 308.
Refining the Message for a Mail Merge

After you modify the list of contacts for your mail merge, you can modify the message. You can add fields from the data source to the message.

This task is a step in Process of Using Word Web Service to Perform a Mail Merge on page 307.

To modify the message

1. Open the Word document with which you associated contact data in Getting the Data for a Mail Merge From the Siebel Database on page 308.
2. To insert a data field from the data source, perform the following steps:
   a. Position the cursor where you want the data field to appear in the message.
   b. Click the Refine Message button, then select Insert Siebel Field from the menu.
   c. Select the field that you want to insert from the submenu.
   The data fields are added to the message as fields, and are not populated with data from the data source yet.
3. To insert text from the Word AutoText feature, perform the following steps:
   a. Position the cursor where you want the AutoText item to appear in the message.
   b. Click the Refine Message button, then select AutoText from the menu.
   c. Select the AutoText item that you want to insert from the submenu.
4. Click the Save toolbar button to save the document.

Previewing Messages for a Mail Merge

After you specify the data fields to include in the mail merge message, you can preview your mail merge messages with the data fields populated with data from the Siebel database.

This task is a step in Process of Using Word Web Service to Perform a Mail Merge on page 307.

To preview messages

1. Open the Word document to which you added a data source in Getting the Data for a Mail Merge From the Siebel Database on page 308.
2. Click the Preview button.
3 Use the First Record, Last Record, Previous Record, and Next Record buttons to preview your mail merge messages.

## Printing or Sending Mail Merge Messages

After you preview your mail merge messages, you can merge all of the messages to one Word document, send all of the messages to a printer, or send all of the messages as email messages.

This task is a step in Process of Using Word Web Service to Perform a Mail Merge on page 307.

### To print or send messages

1. Open the Word document to which you added a data source in Getting the Data for a Mail Merge From the Siebel Database on page 308.
2. Click the Print or Send Message button, then select one of the following menu items:

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Merge to Document</td>
<td>Merges all records from the data source, and adds each merged document into one Word document.</td>
</tr>
<tr>
<td>Merge to Printer</td>
<td>Merges all records from the data source, and prints each document.</td>
</tr>
<tr>
<td>Send as Email</td>
<td>Merges all records from the data source, and emails each document to an address specified in the data source. Use the Merge to E-mail dialog box to specify the field where the email address is stored in the data source, and other details of the email message.</td>
</tr>
</tbody>
</table>

## Logging Messages as a Siebel Activity

After you send the mail merge to the contacts in the data source, you might want to log an activity record in your Siebel database to record the activity.

This task is a step in Process of Using Word Web Service to Perform a Mail Merge on page 307.

### To log messages as a Siebel activity

1. Open the Word document to which you added a data source in Getting the Data for a Mail Merge From the Siebel Database on page 308.
2. Click the Log as Siebel Activity button.
3 Complete the fields in the Log as Siebel Activity dialog box.

<table>
<thead>
<tr>
<th>Field</th>
<th>Maps to Siebel Activity Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Start Date</td>
</tr>
<tr>
<td>Description</td>
<td>Comments</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority</td>
</tr>
<tr>
<td>Status</td>
<td>Status</td>
</tr>
<tr>
<td>Subject</td>
<td>Description</td>
</tr>
<tr>
<td>Type</td>
<td>Type</td>
</tr>
</tbody>
</table>

4 Click Save.

An activity record for the communication event is created in the Siebel database for each recipient or contact. The record contains the message to the recipient or contact, with the merged fields relevant to the recipient or contact.
This chapter covers how to work with accounts in Siebel applications. It includes the following topics:

- About Accounts on page 313
- Scenario for Accounts in Siebel Sales on page 313
- Scenario for Accounts in Siebel Call Center on page 314
- Creating an Account on page 314
- Associating a Contact with an Account on page 317
- Associating an Activity with an Account on page 317
- Associating an Opportunity with an Account on page 318
- Assessing an Account on page 318
- Synchronizing Account Information with External Systems on page 319
- Viewing Account Credit Profiles on page 319

About Accounts

An account is a business external to your company. An account represents a current or potential client, a business partner, or a competitor.

In Siebel applications, you work with accounts through the Accounts screen. Sales representatives use the Accounts screen and the associated views as the primary navigation tool for customer interactions. Call center agents use the Accounts screen to record information about companies and other organizations that interact with your company.

If your organization serves mostly businesses, the Accounts screen is a good screen to use when answering general inbound phone calls. If your organization serves mostly individual consumers, or if you are answering inbound calls related to a marketing campaign, the Contacts screen is a better screen to use when answering inbound calls.

Scenario for Accounts in Siebel Sales

This scenario provides an example of the business process performed by a sales representative managing new and existing accounts. Your company may follow a different process according to its business requirements.

At a vendor site, a sales representative meets a prospect. After a brief discussion, the sales representative determines that the prospect is interested in learning more about the products and services that the sales representative’s company sells. The sales representative sets up a sales call with the prospect.
During the sales call, the sales representative asks a number of questions to determine the account structure of the prospect’s business and to decide how best to meet the prospect’s needs.

The sales representative learns that the prospect’s business has four locations, and that each service is billed through the main office, and each location receives a billing statement.

After the meeting, the sales representative returns to the office and begins creating the account structure for the prospect’s business.

**Scenario for Accounts in Siebel Call Center**

The Accounts screen and views often provide the central navigation point to help call center agents research customers and respond to inbound calls. The type of call determines which view is used by the agent in the application. The following scenarios provide examples of how the Accounts screen is used:

- The call center agent needs to see the existing account information, including the products owned by the account, to assist a caller with a service request or to follow up on a service request.

- A caller contacts the call center in response to a sales campaign. Assuming the caller is unknown, the call center agent creates a new account. First, the agent records the account name, address, and other important information. Then, the agent adds a contact or enters other information about the new account. Finally, the agent associates the contact with the campaign that resulted in the call.

- A call center agent wants to enter information about a prospective account. For example, the agent might call a prospective customer to find out if the customer located requested information on the company’s Web site, and whether the customer requires any additional information. The agent adds notes that can be used by a sales representative or schedules follow-up activities to help manage the account relationship.

**Creating an Account**

After you identify a business relationship, you add an account to your Siebel application. As the business relationship develops, you can update the account to track important details, such as individual contacts, opportunities, and service requests.

Before you add a new account, search the accounts list to make sure that the account does not already exist.

*To create an account*

1. Navigate to the Accounts screen > Accounts List view.
2. In the Accounts List, create a new record, and complete the necessary fields.
Drill down on the record and click the view tabs to complete more fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Name</td>
<td>A required value that identifies the account.</td>
</tr>
<tr>
<td>Account Team</td>
<td>Employees assigned to work with this account. If a call center user is not a member of the Account Team, that user will not receive information about this account during the Mobile Web Client synchronization.</td>
</tr>
<tr>
<td>Account Type</td>
<td>A list of values established by your company defines the type of account. Default values include Commercial, Competitor, Consultant, and Customer.</td>
</tr>
<tr>
<td>Address</td>
<td>First line of account address. This value appears in some Contacts screen views, as well as Account screen views, for contacts that are associated with this account.</td>
</tr>
<tr>
<td>Address Line 2</td>
<td>Second line of account address. This value appears in some Contacts screen views, as well as Account screen views, for contacts that are associated with this account.</td>
</tr>
<tr>
<td>Assignment Area Code</td>
<td>Displays an area code for the account. This indicates that a sales representative from the same area code should be assigned to the account.</td>
</tr>
<tr>
<td>Assignment Country Code</td>
<td>Displays a country code for the account. This indicates that a sales representative from the same country code should be assigned to the account.</td>
</tr>
<tr>
<td>Competitor</td>
<td>A check box which, when selected, indicates the account is a competitor.</td>
</tr>
<tr>
<td>Current Volume</td>
<td>Displays a monetary amount that represents the account’s current sales volume.</td>
</tr>
<tr>
<td>Disable Cleansing</td>
<td>A check box which, when selected, does not allow data cleansing.</td>
</tr>
<tr>
<td>Domestic Ultimate DUNS</td>
<td>Displays the D-U-N-S number for the domestic ultimate, which is the highest member in the hierarchy for the same business entity within the same country. A case can be its own domestic ultimate.</td>
</tr>
<tr>
<td>DUNS#</td>
<td>The Data Universal Numbering System (D-U-N-S) numeric serial number for a company. The D-U-N-S number is unique for each company.</td>
</tr>
<tr>
<td>Expertise</td>
<td>A list of values established by your company that defines the area of expertise for the account. Default values include Technology, Quality Control, and Client Management.</td>
</tr>
<tr>
<td>Global Owner</td>
<td>Displays the ID of the team member who is the global account owner. In cases of multi-national or global companies, this designates one main account team member to oversee the account.</td>
</tr>
</tbody>
</table>
## Accounts — Creating an Account

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Ultimate DUNS</td>
<td>Displays the D-U-N-S number for the global ultimate, which is the highest member in the hierarchy for the same business entity worldwide.</td>
</tr>
<tr>
<td>Industries</td>
<td>Types of business engaged in by the account.</td>
</tr>
<tr>
<td>Inventory Location</td>
<td>Displays the physical location of the inventory.</td>
</tr>
<tr>
<td>Location Type</td>
<td>Type of facility operated by the account at the specified site.</td>
</tr>
<tr>
<td>Lock Assignment</td>
<td>A check box which, when selected, locks the sales team assignment from reassignment by Siebel Assignment Manager.</td>
</tr>
<tr>
<td>Organization</td>
<td>Displays the name of the organization with which the account is associated in your Siebel application.</td>
</tr>
<tr>
<td>Parent</td>
<td>Displays a parent account if the account is a subsidiary of a larger company.</td>
</tr>
<tr>
<td>Parent/HQ DUNS</td>
<td>D&amp;B number for the account's parent account.</td>
</tr>
<tr>
<td>Parent Site</td>
<td>Location of the company of which the account is a subsidiary.</td>
</tr>
<tr>
<td>Partner</td>
<td>A check box which, when selected, indicates the account is a business partner.</td>
</tr>
<tr>
<td>PO Approved</td>
<td>A check box which, when selected, indicates the Purchase Order (PO) has been approved.</td>
</tr>
<tr>
<td>PO Auto-Approval Limit</td>
<td>The amount for which a Purchase Order can be automatically approved.</td>
</tr>
<tr>
<td>Potential Volume</td>
<td>Displays a monetary amount that represents the account's potential sales volume.</td>
</tr>
<tr>
<td>Price List</td>
<td>Displays a price list associated with the account. Your application administrator establishes price lists based on criteria defined by your company.</td>
</tr>
<tr>
<td>Reference</td>
<td>A check box which when selected indicates the account offers a reference for your company's products or services.</td>
</tr>
<tr>
<td>Reference Date</td>
<td>Displays the date when the account first became a reference.</td>
</tr>
<tr>
<td>Shipping Info</td>
<td>A text field for additional shipping details.</td>
</tr>
<tr>
<td>Shipping Terms</td>
<td>A list of values established by your company that defines the terms for shipping. Default values include Due, FOB, TBD, and No Charge.</td>
</tr>
<tr>
<td>Site</td>
<td>Location of the account.</td>
</tr>
<tr>
<td>Stage</td>
<td>A list of values established by your company that defines the account stage according to your sales or other methodology. Default values include Project Planning and Strategy, Analysis and Design, Testing and Production Pilot, Rollout, and On Hold.</td>
</tr>
</tbody>
</table>
NOTE: When a company changes names or merges with another company, you must transfer account names and contacts to the new account name. For help renaming an account, create a service request (SR) on OracleMetaLink 3.

### Accounts

#### Associating a Contact with an Account

As you work with a prospective account, you develop business relationships with the contacts associated with an account.

Contacts can belong to multiple accounts, only one of which can be the primary account. Deleting a contact record in the Accounts screen's Contacts view only removes the contact’s association with the account. The original contact record is still available in the Contacts list.

**To associate a contact with an account**

1. Navigate to the Accounts screen > Accounts List view.
2. In the Accounts list, drill down on the account, and then click the Contacts view tab.
3. In the Contacts list, click Add.
4. In the Add Contacts dialog box, select the contact to add, and then click OK.

### Associating an Activity with an Account

An activity is a task or event that is generally, but not always, performed for a contact, an account, or an opportunity. You will most likely attend meetings, calls, presentations, and perform other activities associated with an account. You can use the Activities list to enter and track account-related activities. If the activity has a time associated with it, the activity appears in the Activities list and Calendar.
An account can have a number of activities associated with it. You can associate an activity with an account to track which activities you have completed and track those you want to accomplish in the future as you manage the account relationship.

To associate an activity with an account
1. Navigate to the Accounts screen > Accounts List view.
2. In the Accounts list, drill down on the account associated with the activity, and then click the Activities view tab.
3. In the Activities list, select the record to associate with the account. For information on how to add an activity, see “Creating Activities (End User)” on page 173.

Associating an Opportunity with an Account

Accounts are a source of business for your company. An opportunity is a potential revenue-generating event and the opportunity record stores information that you can use to manage accounts.

To associate an opportunity with an account
1. Navigate to the Accounts screen > Accounts List view.
2. In the Accounts list, drill down on the account.
3. Click the Opportunities view tab.
4. In the Opportunities list, select the record to associate with the account.
   For information on how to add an opportunity, see “Creating an Opportunity” on page 340.

Assessing an Account

You can use assessments to compare accounts with one another, compare them with a model, or to determine what information is present or not for an account. To perform the assessment, you enter values for the assessment attributes. The application calculates a composite assessment value for the account. For information about how to perform an assessment, see “Performing an Assessment (User)” on page 192.
Synchronizing Account Information with External Systems

The Application Services Interface (ASI) feature allows you to synchronize the account data between a Siebel application and an external system in real time. This feature enables you to maintain consistent account information across your enterprise, and to eliminate manual entry of data in multiple systems.

If your Siebel administrator has set up real-time account integration between a Siebel application and another system, you can use the Update External System command to send new and modified account information from the application to the other system in real time. For more information about ASI, see *Siebel Application Services Interface Reference* and Chapter 24, “Integration Using ASIs.”

If an account has associated contacts, you must synchronize the contacts with the external system separately. For more information, see “Synchronizing Contact Information with External Systems” on page 283.

**To synchronize account information with an external system**

1. Navigate to Accounts > Accounts List.
2. In the Accounts list, select an account record.
   
   To create a new account record, see “Creating an Account” on page 314.
3. In the Accounts list, click the menu button, and then choose Update External System.

Viewing Account Credit Profiles

If your organization uses back-office software or another external credit management system to store customer credit information, you can use the Credit Profile read-only view to get the most current account credit profile information.

The Accounts screen’s Credit Profile view allows you to improve employee productivity by providing visibility to complete customer information within your Siebel application, and streamlines the quote-to-cash process by allowing the sales professional to identify potential credit problem early.

This procedure assumes that your Siebel administrator has completed the work necessary to allow real-time account integration through Application Service Interfaces (ASI). For information about how to set up the Web services administration to communicate with the external system, ASI structures, configuring and customizing the ASI, see *Application Services Interface Reference* and Chapter 24, “Integration Using ASIs.”

**To view account credit profile information**

1. Navigate to Accounts > Accounts List > Credit Profile.
2 Query the Account Name field for the account whose credit profile you want to view, and then click the Credit Profile view tab.

The Credit Profile form appears and includes information on credit status, risk category, credit limit, and so on.

Fields in this form are read-only, except for Skip Credit Check and Credit Auto Approval Limit. For more information on how to use these fields, see *Siebel Order Management Guide*.

3 Click Refresh to update the information in the Credit Profile form.
This chapter describes the administration and management tasks associated with Siebel Global Accounts. It includes the following topics:

- "About Global Accounts" on page 321
- “Scenario for Using and Administering Global Accounts” on page 322
- “Process for Using and Administering Global Accounts” on page 323
- “Generating a Default Hierarchy” on page 323
- “Creating a Custom Hierarchy” on page 324
- “Assigning a Custom Hierarchy to an Organization” on page 325
- “Updating a Custom Hierarchy” on page 325
- “Restoring a Custom Hierarchy” on page 326
- “Viewing Global Accounts (User)” on page 327

### About Global Accounts

Siebel Global Accounts is a module that provides sales professionals with global account-level visibility into the interactions that the company’s sales organization and partner’s sales organizations have had with the account. Users can view all accounts, opportunities, activities, contacts, and account team members across the account hierarchy on one screen, allowing sales professionals to build a deep understanding of target accounts.

Global Account hierarchies are not provided preconfigured with your Siebel Business Application. They must be set up by an administrator. There are two kinds of account hierarchies that can be set up by the administrator:

- **Default.** This type of account hierarchy is based solely on the accounts’ Parent fields. This account hierarchy is self-maintaining in that whenever the Parent field of any account is updated, the default hierarchy is also updated. Once set up, the default hierarchy is applied to all organizations that do not already have an organization.

- **Custom.** This type of hierarchy is created by the administrator, either by modifying the default hierarchy or from the beginning. Once set up, this hierarchy is independent of the accounts’ Parent fields, and as such must be updated by the administrator when changes occur.
Scenario for Using and Administering Global Accounts

This scenario provides an example of a process flow performed by the accounts administrator. Your company may follow a different process flow according to its business requirements.

A midsized company, Corp 123, wants to view consolidated data at the global account level. This company has two organizations set up in its Siebel application: a sales organization and a financial organization. The accounts administrator sets up two account hierarchies, one for each organization. These hierarchies allow end users to view the opportunities and contact information associated with parent accounts.

The sales organization uses the default hierarchy, which is based on the Parent account field. For various reasons, the financial organization requires a modified version of the account hierarchy. One of these reasons is that some accounts’ billing structures are different from the accounts’ purchasing structures. For example, in the case of XYZ Inc. there are four XYZ accounts who are customers of Corp 123: the XYZ Holding company, two regional subsidiaries, and a financial company. The 123 sales organization wants to view the account hierarchy where all accounts report to the parent holding company. Because all account billing for the XYZ companies is funneled through XYZ Financial, Corp 123’s financial organization wants to view the account hierarchy where all accounts report to the XYZ Financial. Figure 15 shows the two hierarchies.

The default hierarchy used by the sales organization updates automatically when new accounts are added or Parent fields are changed. However, the accounts administrator updates the finance hierarchy on a weekly basis as new accounts are added and the structure of existing accounts changes.

The global accounts manager wants to review all opportunities at Corp 123. The global accounts manager navigates to the Accounts screen, and selects the Global Accounts view tab. In this view, the manager can see the opportunities for Corp 123.

The global accounts manager can use the Enterprise Selling process (ESP) module to develop global account strategies. See Chapter 37, “Enterprise Selling Process” for a discussion of how to use ESP with global accounts.
Process for Using and Administering Global Accounts

The process flow for global accounts administration requires several tasks. Carry out these tasks in the following order:

1. "Generating a Default Hierarchy" on page 323
2. "Creating a Custom Hierarchy" on page 324
3. "Assigning a Custom Hierarchy to an Organization" on page 325
4. "Updating a Custom Hierarchy" on page 325
5. "Restoring a Custom Hierarchy" on page 326
6. "Viewing Global Accounts (User)" on page 327

Generating a Default Hierarchy

Follow this procedure to set up a default hierarchy. Once generated, this default hierarchy is automatically assigned to organizations without an account hierarchy.

**NOTE:** Only use the Generate Hierarchy function for hierarchy structures with a small number of accounts, preferably fewer than 100,000.

To change the account hierarchy assigned to an organization, see “Assigning a Custom Hierarchy to an Organization” on page 325.

To create a default hierarchy

1. Navigate to the Accounts screen > Global Accounts Administration view.
2. In the Account Hierarchy list, click Generate Hierarchy.
   
   A new account hierarchy is created.

   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A default name is generated based on your user ID and the date.</td>
</tr>
<tr>
<td>Default</td>
<td>Select so that the account hierarchy is the default. The default hierarchy is assigned to all organizations without an account hierarchy and is updated when new Parent fields on the account records are added or modified.</td>
</tr>
</tbody>
</table>

**TIP:** If the generated hierarchy does not appear in the Account Relationships lists, refresh the view by navigating to a different view and then returning to the Global Accounts view.
In the Account Relationships list, review the hierarchy records.

**NOTE:** If end users are using the application when you generate the account hierarchy, they must log off and log on again to see the default account hierarchy in the rollup views.

## Enabling Users to Add Accounts With No Parent to the Default Hierarchy

If your users need to add accounts that have no parent account to the default hierarchy, follow this procedure.

**To enable users to add accounts with no parent account to the default hierarchy**

1. Start Siebel Tools.
2. Select the Dynamic Hierarchy Direct Relationship business component.
3. Set the value of the DynHierarchy LoadAllAccounts user property to Y.
4. Select the Account business component, then select the Parent Account Id field.
5. Set the value of the ForceActive property for the Parent Account Id field to TRUE.
6. Compile the Siebel repository file.
7. Copy the Siebel repository file to your Siebel installation.

## Creating a Custom Hierarchy

You can create a custom hierarchy by generating a hierarchy as described in the preceding section or by starting from the beginning and creating a series of new records in the Account Relationships list.

**To create a custom hierarchy**

1. Navigate to the Accounts screen > Global Accounts Administration view.
2. In the Account hierarchy list, create a new record, and complete the necessary fields. Do not check Default.
3. In the Account Relationships list:
   - Create new records for each of the top level parent accounts. Leave the Parent Account field blank for each of these.
   - Create new records for the child accounts, entering the Parent Account for each.

**To create a custom hierarchy based on the default hierarchy**

1. Create an account hierarchy as described in “To create a default hierarchy” on page 323.
Assigning a Custom Hierarchy to an Organization

An organization uses the default hierarchy unless a custom hierarchy has been assigned to it.

**To assign a custom hierarchy to an organization**

1. Navigate to the Administration - Group screen > Organizations view.
2. Select the organization whose account hierarchy you want to change.
3. In the form in the lower part of the page, in the Account Hierarchy field, select the custom hierarchy that you want the organization to use when viewing global accounts.

Updating a Custom Hierarchy

Custom hierarchies are static and must be updated by the administrator. There are two approaches to updating an account hierarchy:

- Edit the account relationships in the current hierarchy.
- Update the hierarchy to the default (parent account) hierarchy, and then edit the account relationships in the hierarchy.

**To update a custom hierarchy**

1. Navigate to Accounts screen > Global Accounts Administration view.
2. Select the account hierarchy record.
3. Do one of the following:
   - In the Account Relationships list, edit the Parent Account fields for existing accounts and create new relationship records as required.
   - In the Account Hierarchy list, click Update Hierarchy to return the hierarchy to the default. Then, in the Account Relationships list, edit the Parent Account fields for existing accounts, and create new relationship records as required.

**To add hierarchy update to a batch workflow policy**

1. In Siebel Tools, create a workflow policy.
2 Configure the workflow policy to call the Update Hierarchy business service.
3 Use the Workflow Process simulator to test that the workflow process functions correctly.
4 Set the status of the workflow process to Active.
   For information about how to create and configure a workflow policy, use the Workflow Process
   Simulator, and set the status of a workflow process, see Siebel Business Process Framework:
   Workflow Guide.
   **NOTE:** If you create the business service in Siebel Tools, and compile the business service into
   the SRF file, make sure that you copy the SRF file to the objects/lang directory.
5 Execute the workflow policy as a batch component in the Siebel application, as follows:
   a Navigate to the Administration - Server Management screen > Jobs view.
   b In the Jobs view, create a new job with a Component/Job value of Workflow Process Manager.
   c In the Job Parameters form, add a parameter for the new job with the following details:
      | Field       | Description                  |
      |-------------|------------------------------|
      | Name        | Enter the value Workflow Process Name. |
      | Value       | Enter the name of the workflow policy you created in Step 1. |
   d In the Job Detail form, enter the time and date when you want the job to start in the Scheduled
      Start field.
   e In the Jobs view, click Submit Job.
      The job starts automatically at the scheduled time, and a Task ID is generated for the job.
   f To track the execution of the task, in the Jobs view, select the job whose Task ID you want to
      track, then click Tasks in the link bar.
      You can view the details of the task in the Tasks view and subviews.

Restoring a Custom Hierarchy

When you perform the update hierarchy procedure, the records that are deleted using Enterprise Integration Manager (EIM) are not processed. This results in some records not having a parent record. To delete these records, restore the custom hierarchy.

The Restore Hierarchy function updates only the denormalized table S_DYNHR_RPT_REL, based on the new entries in the relationship table S_DYN_HRCHY_REL. This function does not affect the user interface; the function affects only the data processing.

To restore a custom hierarchy
1 Navigate to Accounts screen > Global Accounts Administration view.
2 Select the account relationships record that you want to restore.
3 Click Restore Hierarchy.
Viewing Global Accounts (User)

Available as an option, Global Accounts allow users to see opportunities, activities, contacts, and account team information for an account and its subsidiary accounts.

Global Accounts consist of a parent account, the child accounts, the child accounts’ children, and so on. These hierarchies are determined in one of two ways:

- Hierarchies are determined by the value in the parent field on the Account Record.
- Hierarchies are determined by the administrator who creates custom hierarchies.

Global Accounts are created and maintained by the administrator. If an account has no child account or the administrator has not defined a hierarchy for an account, then a message appears advising you that the selected record is not included as part of your defined hierarchy. For more information on how global-account hierarchies are created, see “Creating a Custom Hierarchy” on page 324.

To view global accounts information

1. Navigate to the Accounts screen > Global Accounts Hierarchy List view.

2. From the Show drop-down list, choose My Global Accounts.

   Other Show drop-down list options include All Global Accounts, and All Global Accounts Across Organizations.

   The Global Accounts subviews appear with the explorer on the left showing the hierarchy of the account, subaccounts, contacts, and opportunities, and the list on the right showing the records associated with each subview.

3. Click the individual view tabs for Subaccounts, Contacts, Activities, Opportunities, and Account Team.

   The records associated with these subviews appear in a list on the right of the explorer.

Accounts Displayed in the Global Accounts Hierarchy List View

Depending on whether or not you define a hierarchy, different accounts are displayed in the Global Accounts Hierarchy List view. This occurs because Siebel Business Applications use different SQL code to generate the Global Accounts Hierarchy List view, depending on whether you define a hierarchy.

If you define a global account hierarchy, the Global Accounts Hierarchy List view displays that hierarchy. If you define a hierarchy and use EIM to import records, the accounts are not displayed in the Global Accounts Hierarchy List view unless you update the global account hierarchy. To update the global account hierarchy, select the account hierarchy record, then click Update Hierarchy.

If you do not define a global accounts hierarchy, the Global Accounts Hierarchy List view displays the account hierarchy based on the Parent fields of the accounts. If you do not define a hierarchy and use EIM to import records, the accounts are displayed in the Global Accounts Hierarchy List view based on the Parent fields of the accounts.
The Opportunities screen allows you to manage and track information associated with a potential revenue-generating event. Opportunity workflows allow managers to manage opportunities by tracking potential high-income opportunities, informing managers about sales teams actions regarding an opportunity, and notifying sales team when an opportunity meets a set of criteria.

This chapter covers setting up and managing opportunity workflows. It includes the following topics:

- "About Opportunity Workflows" on page 329
- "Setting Up Opportunity Notification Workflows" on page 330
- "Activating the Opportunity Notification Workflow Processes and Policies" on page 331
- "Rerouting an Opportunity Using Workflows" on page 333
- "Modifying Opportunity Workflows" on page 333
- "Setting Up the Get Manager Email" on page 334

About Opportunity Workflows

Opportunity workflows enhance lead routing and provide sales professionals with greater visibility into their sales activities. These workflows are executed from the Opportunities screen. An opportunity record describes important information about the opportunity such as the account, potential revenue of the deal, the probability of closure, the lead status and sales stage, the sales team primary, and the expected close date.

The predefined opportunity workflows allow you to use email to capture information related to the opportunity and distribute timely notifications to key members of the sales team. These workflows help improve the efficiency and effectiveness of the sales cycle while also providing sales representatives and sales managers greater visibility into sales activities. The email notification process is activated only if the opportunity has a possible revenue of more than $50,000.

The seven predefined opportunity workflows are:

- Opportunity Assigned Notification Process
- Opportunity Inactive Notification Process
- Opportunity Lost Notification Process
- Opportunity Pending Notification Process
- Opportunity Won Notification Process
- Create rerouted Oppty Activity
- Get Manager Email
You can use Audit Trail to track the changes that have been made to the opportunity records. For more information about how to audit opportunities, see Chapter 6, “Audit Trail”. For information about configuring, implementing, testing, and monitoring workflows, see Siebel Business Process Framework: Workflow Guide.

**Setting Up Opportunity Notification Workflows**

Follow these steps to correctly set up the opportunity workflows:

- In Siebel Tools, revise all Siebel workflows so that they are editable and have a status of *In Progress*. All Siebel workflows are initially inactive and cannot be edited. Make any necessary changes and activate the workflows. For more information about how to revise Siebel workflows, see Siebel Business Process Framework: Workflow Guide.

- Verify that the Workflow Server component and the Communication Manager component are enabled and running. For detailed instructions, see the system requirements and supported platform documentation for your Siebel application.

- Create a communications profile called *Opportunity Notification Profile* for the Internet SMTP/POP3 Server driver. Enter the appropriate values in the From Address and in the SMTP Server parameter overrides for the profile. For more information about implementing and configuring communications integrations for your Siebel applications, including creating profiles for the Internet SMTP/POP3 Server driver, see Siebel Communications Server Administration Guide.

- Set up and activate the workflows and policies.
  - Activate the opportunity workflow processes. See “Activating the Opportunity Notification Workflow Processes and Policies” on page 331.
  - Modify Opportunity workflows, as necessary. See “Modifying Opportunity Workflows” on page 333.
  - Set up the Create Reroute Oppty Activity. See “Rerouting an Opportunity Using Workflows” on page 333.
  - Set up the Get Manager Email. See “Setting Up the Get Manager Email” on page 334.

- Load the run-time events for the emails. For more information about run-time events, see Siebel Business Process Framework: Workflow Guide.

- Generate the triggers. For more information about how to generate triggers, see Siebel Business Process Framework: Workflow Guide.

- Run the workflow monitoring agent. For more information about the workflow monitoring agent, see Siebel Business Process Framework: Workflow Guide.
Activating the Opportunity Notification Workflow Processes and Policies

There are five different workflow processes that will generate automatic emails. All of these processes need to have the communication profile specified. See "Activating the Opportunity Notification Workflow Processes and Policies" on page 331.

- Opportunity Assigned Notification Process
- Opportunity Inactive Notification Process
- Opportunity Pending Notification Process
- Opportunity Lost Notification Process
- Opportunity Won Notification Process

The following procedure sets up this automatic notification process.

To set up the opportunity workflows
- For each of the workflows listed above, make sure to:
  - Revise the workflow
  - Set the Communication Profile to Opportunity Notification Profile
  - Activate the workflow
  - Clear the Expiration field

Opportunity Assigned Notification Process
This workflow sends an email message to both the primary sales representative and the sales representative's direct manager when a new lead is assigned to a sales representative. The email provides the basic information about the opportunity, including the opportunity ID and account, the primary revenue amount, and the number of days allowed before the lead is withdrawn and rerouted. The sales representative is directed to the Opportunities screen for further details.

Opportunity Inactive Notification Process
This workflow sends out an email notice when the sales representative has accepted a lead by changing the Status field to Accept, but has not taken any action on the lead for 30 consecutive days. An email reminder is sent to both the sales representative and the sales representatives direct manager. The notice reminds the sales representative that if no action is taken on the lead within seven days, the lead will be withdrawn from the queue and rerouted.
Opportunity Workflows ■ Activating the Opportunity Notification Workflow Processes and Policies

The default time lapse between when the lead is accepted (or last worked on) and when the email is delivered is 30 days. To modify this default value, edit the Duration Days property for the workflow in Siebel Tools.

**NOTE:** Out-of-the-box reassignment of leads is executed manually. You may want to create a workflow that automatically reassigns the lead to a sales manager or administrator after a specified amount of time.

### Opportunity Pending Notification Process

This workflow sends an email notice when the sales representative has not responded or taken action on the opportunity for five days. This occurs when the sales representative has not changed the Status field from pending to accept, reject, or reroute. The email is sent to both the primary sales representative and the sales representative’s direct manager. The email reminds the sales representative to act on the lead or risk having the lead withdrawn from the queue.

**To modify the time lapse between lead assignment and email delivery**

2. Select Email Notification of Pending Oppty.
3. Verify that the policy is activated.
4. Select the policy and modify the Duration and Units fields.

### Opportunity Lost Notification Process

This workflow sends an email message to both the primary sales representative and the sales representative’s direct manager when an opportunity is closed with a loss. The status of the opportunity must change to *lost* before the email notice is generated. The email refers to the Opportunities screen and asks the sales representative to update the Reason field.

### Opportunity Won Notification Process

This workflow sends an email message to both the primary sales representative and the sales representative’s direct manager when an opportunity is closed with a win. The status of the opportunity must change to *win* before the email notice is generated. The email refers to the Opportunities screen and asks the sales representative to update the Reason field.
Rerouting an Opportunity Using Workflows

The Create Rerouted Oppty Activity workflow is executed when a sales representative receives a lead and changes the Status field to Reroute. The workflow creates a new Activity record with Type = Reroute for the designated sales operator. This informs the sales operator that a specific opportunity has been requested for rerouting. All reassigned opportunities are listed in the Activities view as rerouted activities.

**NOTE:** If a sales manager or sales administrator is responsible for rerouting leads, you can modify the workflow so that the Create Rerouted Oppty Activity is assigned to the sales manager or administrator. You can also create a workflow that reassigns the lead to a sales manager or administrator.

To set up the opportunity reroute activity

- Revise the Create Rerouted Oppty Activity workflow process. Replace the value of the Default String field in the Sales Operator Login record with the username of the sales operator who will receive the activity. Remember that the username is case-sensitive.

Modifying Opportunity Workflows

An administrator can modify the opportunity workflows. The administrator can make the following changes:

- Modify the text of the email.
- Change the notification time.
- Set the lead notification restrictions.
- Add other Siebel fields.

**NOTE:** The opportunity workflows are shipped as seed data. To modify a workflow, you should make a copy of the original workflow, and then modify the copy.

To modify the text of an opportunity workflow email

- In the Send Out Emails step, edit the value of the Message Body input argument.

  The text includes field placeholders for data from the opportunity record. These placeholders appear as "+[Placeholder field]+.”

To restrict conditions for delivery of emails

2. Select one of the email notification policies:
   - Email Notification of Assigned Oppty
Opportunity Workflows ■ Setting Up the Get Manager Email

- Email Notification of Inactive Oppty
- Email Notification of Lost Oppty
- Email Notification of Pending Oppty
- Email Notification of Won Oppty

3 In the Conditions applet, select a condition, or create a new condition.

4 Click on the Operation and Value fields and modify the condition.

For example, to send email notifications for leads that have a high lead quality, create the following condition:

Condition Field = Opportunity Lead Quality
Operation = “=”
Value = “1-excellent”

To stop sending email notifications to a sales representative’s manager
- Edit the workflow so that there is a single connector between Start and End. (Delete all other arrows.)

Setting Up the Get Manager Email

This process identifies the manager of the sales representative so that the manager can receive a copy of the five email notifications that are delivered. Because the Get Manager Email process is part of the five notification processes, the Get Manager Email process must be activated for the other processes to function correctly.

An email is sent to the sales representative and the appropriate manager for each of the notification workflows.
This chapter describes how end users use opportunities. It includes the following topics:

- "About Opportunities” on page 335
- “Scenario for Opportunities” on page 336
- "Opportunities Processes and Procedures” on page 337
- "About Opportunities Lead Assignment” on page 338
- “About Lead Response” on page 338
- "About Lead Qualification, Sales Methods, and Stages” on page 339
- “Creating an Opportunity” on page 340
- “Changing the Primary Sales Team Member” on page 344
- “Monitoring Significant Opportunity Transactions” on page 344
- “Assessing an Opportunity” on page 345
- “Viewing Decision Issues for an Opportunity” on page 345
- "Associating a Contact with an Opportunity” on page 345
- "Activities Associated with an Opportunity” on page 346
- "Associating a Product with an Opportunity” on page 346
- “Creating a Quote from an Opportunity” on page 347
- "Creating an Organization Analysis” on page 348
- “Opportunity Charts” on page 351
- “Generating Opportunity Reports” on page 353
- "Setting Up Lead Sources for Opportunities” on page 353

**About Opportunities**

An opportunity is defined as a potential revenue-generating event. Opportunity-related information is recorded and tracked in the views associated with the Opportunities screen. This chapter describes how sales professionals can use the Opportunities screen to perform the following tasks:

- Receive and respond to new leads that are assigned to you
- Create new opportunities and enter related information such as accounts, contacts, activities, and products
- View, qualify, and update opportunities assigned to you and your sales team (if you are a manager)
Opportunities (User)  ■ Scenario for Opportunities

- Track the status of an opportunity through the sales cycle from creation to closure
- Share information about the opportunity with sales team members
- Generate quotes, presentations, and other types of information needed to close the deal

Scenario for Opportunities

This scenario provides an example of how a sales representative works with leads and opportunities. Your company may follow a different process according to its business requirements.

Opportunity Lead Conversion

A company uses Siebel Marketing to develop a campaign as part of a new product introduction. During the campaign, a telemarketing agent uses Siebel Call Center to contact prospects associated with the campaign. During her conversations with prospects, the agent qualifies leads by determining whether each prospect is interested in the new product offering. When a prospect expresses interest in learning more about the new product, the agent creates a new lead.

Using Siebel Assignment Manager, the lead is automatically routed to the sales representative who is most qualified to work on the lead and whose schedule can accommodate the new assignment.

When the sales representative logs in to the Siebel Sales application, she sees the new lead in the Opportunities list on her home page. Drilling down on the lead takes the sales representative to the Opportunities screen. After reviewing details about the lead, such as the customer information, probability of closing, and the products that the customer is interested in purchasing, the sales representative decides to accept the lead by changing the Status field to Accept.

After the sales representative accepts the lead, she begins to work on the lead by assembling members of the sales team, conducting further research on the customer and its requirements, coordinating and recording activities, uploading agreements, and generating proposals and presentations for the customer. As the sales representative works through the sales cycle, she updates information about the sales stage and keeps private notes as well as notes that she shares with other members of the sales team. Eventually, the sales representative develops a quote from the Opportunities screen. When the customer accepts the quote, it is converted into an order.

NOTE: Siebel Marketing, Siebel Call Center, Siebel Sales, and Siebel Quotes are fully integrated, separately licensed product offerings. You need to license these products to access the views.

Opportunity Tracking

At a trade show, a sales representative meets a prospective customer who could be a lead for a new business opportunity. When the sales representative returns to the office, he discovers the company is listed in Siebel Sales as an account, but the person he met is not listed as a contact.

The sales representative proceeds to add the prospective customer as a contact, and then creates the opportunity. He then schedules meetings and creates associated activities, and enters other potential contacts associated with the opportunity.
As the sales process continues, the sales representative gathers and updates information about the account, its contacts, and the opportunity that he is pursuing. As the relationship grows, the sales representative can add, view, and share stored information and key knowledge with other members of the sales team.

**Opportunity Generated Quote**
A sales representative is assigned to the sales team for an opportunity. As the sales representative gathers product information about the customer requirements, she enters that information in the Siebel Sales application. After she presents to the customer, the customer indicates that the representative’s company is on the short list for the deal, and that the representative should submit a quote.

The sales representative creates a quote automatically based on the information she has already entered into the Siebel Sales application. After she generates the quote, she synchronizes the quote information with the revenues associated with the opportunity. By making sure these numbers are in sync, the sales representative establishes that the data associated with her opportunity is current and that her forecasts are accurate.

**Opportunities Processes and Procedures**
When you are working with opportunities, you perform the following key tasks:

- **Create an opportunity.** For more information, see “Creating an Opportunity” on page 340.
- **Change the primary team member.** For more information, see “Changing the Primary Sales Team Member” on page 344.
- **Monitor transactions.** For more information, see “Monitoring Significant Opportunity Transactions” on page 344.
- **Assess opportunities.** For more information, see “Assessing an Opportunity” on page 345.
- **Manage decisions.** For more information, see “Viewing Decision Issues for an Opportunity” on page 345.
- **Add contacts.** For more information, see “Associating a Contact with an Opportunity” on page 345.
- **Add activities.** For more information, see “Activities Associated with an Opportunity” on page 346.
- **Associate products.** For more information, see “Associating a Product with an Opportunity” on page 346.
- **Create quotes.** For more information, see “Creating a Quote from an Opportunity” on page 347.
- **Performing an organization analysis.** For more information, see “Creating an Organization Analysis” on page 348.
- **Adding attachments, and notes.** For more information, see *Siebel Fundamentals*.
- **Generate and viewing charts and reports.** For more information, see “Opportunity Charts” on page 351 and “Generating Opportunity Reports” on page 353.
About Opportunities Lead Assignment

As a sales representative, you can view new leads in the Opportunities list on your home page, or you can navigate to the Opportunities screen to view new leads that you did not create but were assigned to you. There are a number of ways in which a lead might be assigned to you:

- A lead is generated through a campaign and automatically routed using Siebel Assignment Manager and predefined rules.
- A lead is entered into the system by an administrator and automatically routed using Siebel Assignment Manager and predefined rules.
- An opportunity is created by a sales manager or sales representative who adds you to the sales team.

In each of these scenarios, you are able to view the lead or opportunity because you have been added to the sales team, either as the primary on the sales team or as a sales team member. If you are receiving a lead for the first time and you are the primary on the sales team, the Status field in the More Info view is set to Pending by default. You can accept, reject, or reroute the lead by changing the value in the Status field.

If the administrator has activated the email notifications, and has enabled predefined processes, these processes can send email messages to you, to alert you of the following events:

- You have received a new lead and should accept, reject, or reroute the lead within seven days.
- You received a new lead five days ago and should accept, reject, or reroute the lead within two days.
- You have accepted a lead but have not worked on the lead in 30 days.
- You have won the sales opportunity and should enter the reason in the system.
- You have lost the sales opportunity and should enter the reason in the system.

The wording of the emails and the wait periods can be modified. Opportunity Workflows only sends email if the opportunity has revenue greater than $50,000. For more information, see Chapter 28, "Opportunity Workflows."

About Lead Response

After you, as a sales representative, receive a lead, you can choose to accept, reject, or reroute the lead.

- **Rejecting the Lead.** You can reject a lead by changing the Status field to Reject in the More Info view. Enter the reason for rejecting the lead in the Reason field. The lead remains in your queue until it is reassigned by your manager.

- **Rerouting the Lead.** If you decide to reroute a lead by changing the Status field in the More Info form to Reroute, a Reroute activity automatically is created. Enter the reason for rerouting the lead in the Reason field. The lead remains in your queue until it is rerouted by your manager.

- **Accepting the Lead.** You can accept a lead by changing the Status field in the More Info form to Accept. Enter the reason for accepting the lead in the Reason field.
About Lead Qualification, Sales Methods, and Stages

When you, as a sales representative, accept a lead, you can begin to work on the lead in the Opportunities screen. The records in the Opportunities list include both leads and opportunities. Leads are defined as opportunities that have not yet been qualified.

Lead qualification status is indicated in the Sales Stage field. The list of values in the Sales Stage field varies depending on which sales method you are using.

A sales method is a formalized approach or methodology used during the sales process. A sales method can encompass all activities associated with the sales process, from prospecting to forecasting to closing deals. This approach allows sales representatives to use the method most appropriate for their opportunities.

The application administrator establishes values in your Siebel application that represent the sales methods and sales stages for your company. It is a recommended business practice to designate a default sales method in your Siebel application. This practice allows a sales method to be associated with each opportunity and aids in charting and reporting accuracy.

Sales methods can differ within a company. For instance, a sales method for managing a complex multimillion dollar opportunity can include 15 stages, while a sales method for a simple low-dollar opportunity may require only four stages.

Your application administrator creates and implements the sales stages that your company uses. For more information about creating or implementing sales methods, see “Defining a Sales Methodology” on page 181.
Table 85 shows sales methodologies (Accelerated, Default, Standard), and the associated sales stage for each methodology (for example, 01 - Prospecting). The table also shows if the record is a lead or is an opportunity at each sales stage.

Table 85. Sales Methods and Sales Stages

<table>
<thead>
<tr>
<th>Accelerated</th>
<th>Default and Standard</th>
<th>Lead or Opportunity</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 - Prospecting</td>
<td>01 - Prospecting</td>
<td>Lead</td>
</tr>
<tr>
<td></td>
<td>02 - Potential Lead</td>
<td>Lead</td>
</tr>
<tr>
<td>02 - Qualification</td>
<td>03 - Qualification</td>
<td>Opportunity</td>
</tr>
<tr>
<td></td>
<td>04 - Opportunity</td>
<td>Opportunity</td>
</tr>
<tr>
<td></td>
<td>05 - Building Vision</td>
<td>Opportunity</td>
</tr>
<tr>
<td></td>
<td>06 - Short List</td>
<td>Opportunity</td>
</tr>
<tr>
<td></td>
<td>07 - Selected</td>
<td>Opportunity</td>
</tr>
<tr>
<td>03 - Closing</td>
<td>08 - Negotiation</td>
<td>Opportunity</td>
</tr>
<tr>
<td></td>
<td>09 - Closed or Won</td>
<td>Opportunity</td>
</tr>
<tr>
<td>04 - Lost</td>
<td>09 - Closed or Lost</td>
<td>Opportunity</td>
</tr>
</tbody>
</table>

NOTE: The Portfolio Management Process sales methodology does not focus on opportunities and so is not present in Table 85.

Creating an Opportunity

Create a new record each time you identify an opportunity.

NOTE: Each time a new opportunity record is created, a primary Revenue record is automatically created for the opportunity.

To create an opportunity

1. Navigate to the Opportunities screen > Opportunities List view.
2. In the Opportunities List, create a new record, and complete the necessary fields.
3 Drill down on the record, and click the view tabs to complete more fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Best Case</td>
<td>Allows you to enter the amount the deal might generate in the best-case scenario. This amount is higher than the value in the Revenue field.</td>
</tr>
<tr>
<td>Channel</td>
<td>Select the sales channel from which the opportunity comes.</td>
</tr>
<tr>
<td>Close Date</td>
<td>Allows you to enter the expected date on which the opportunity closes. The default date is the same as the Created Date. It is important to modify the date, if the opportunity closes on a different date, because this date is used in revenue forecasting.</td>
</tr>
<tr>
<td>Committed</td>
<td>A check box which, when selected, indicates there is a high probability that the deal will close, and that the deal should be included in your revenue forecast.</td>
</tr>
<tr>
<td>Cost</td>
<td>Expense associated with the opportunity.</td>
</tr>
<tr>
<td>DUNS #</td>
<td>The Data Universal Numbering System (D-U-N-S) numeric serial number for a company. The D-U-N-S number is unique for each company.</td>
</tr>
<tr>
<td>Executive Priority</td>
<td>This check box can be used to flag a significant opportunity. Sales executives can query for high-priority opportunities for tracking purposes.</td>
</tr>
<tr>
<td>Expected value</td>
<td>Displays a currency value that is calculated based on the potential revenue field multiplied by the value in the probability field. A lower percentage in the probability field reduces the expected value that is included in your revenue forecast.</td>
</tr>
<tr>
<td>Lead Partner</td>
<td>The lead partner field is populated automatically when the source of the opportunity is a campaign with a lead partner. If you create an opportunity from a response, and the response had a campaign associated with it, the opportunity inherits the lead partner from the campaign. If you create a new opportunity and select a campaign as the source, the opportunity inherits the campaigns lead partner, if it has one.</td>
</tr>
<tr>
<td>Margin</td>
<td>A calculated field that displays the revenue figure minus the cost.</td>
</tr>
<tr>
<td>Opportunity Currency</td>
<td>A list of values established by your company that allows you to specify the currency type associated with the opportunity. The selected value does not affect forecasting.</td>
</tr>
<tr>
<td>Organization</td>
<td>A default value that displays the organization name associated with the person creating the opportunity. Your system administrator sets up organizations in your Siebel application. You can associate multiple organizations with an opportunity.</td>
</tr>
</tbody>
</table>
### Field | Comments
---|---
Partner Approval Status | A list of values established by your company that allows you to specify the approval status of the lead partner for the opportunity.
Primary | Displays the user ID of the primary sales team member. This value defaults to your user ID if you are creating a new opportunity.
Probability % | The Probability reflects the percentage of confidence you have that the deal will close with the specified revenue on the specified close date. By default, the probability adjusts automatically based on the sales stage of the opportunity. You can manually override the probability value.
Reason | A list of values established by your company that allows you to specify a reason that the opportunity was accepted, rejected, rerouted, won, or lost.
Revenue | Allows you to enter the currency amount of the opportunity. If you are using the Products, Quotes or Revenue view tabs, you can make sure your summary revenues are calculated and are in sync. The amount entered affects forecasting.
Revenue Class | A list of values established by your company that allows you to define the quality of the expected revenue. For more information, see "About Revenue Class and Revenue Type" on page 343.
Revenue Type | A list of values established by your company that allow you to define the kind and source of the expected revenue. For more information, see "About Revenue Class and Revenue Type" on page 343.
Sales Method | A list of values established by your company that includes the sales methodologies.
Sales Stage | A list of values established by your company that allows you to specify the sales stages associated with the selected sales method.
Sales Team | This list shows who is on the sales team for the opportunity. You can add employees to the sales team by selecting them from the employee list. Only the manager of the primary sales team member, or an administrator, can change or delete the sales team member identified in the Primary field.
You can set a Priority flag for individual members of the sales team. If an opportunity is a priority for all team members, the Priority Flag is set in the Opportunity List and Explorer views.
Source | A dialog box that allows you to associate the sources of the sales lead with the opportunity. Typical source values include specific events, campaigns, or conferences.
Source Type | A default value that displays the category of the primary source. For instance, a specific seminar that is the source of the opportunity is identified with a value of Seminar in this field.
Revenue Class and Revenue Type

Revenue Class and Revenue Type fields appear on both the Opportunity and the Revenue forms. These two fields are the same fields, which means changes made in the Opportunity form are reflected on the Revenue form and changes made in the Revenue form appear in the Opportunity form.

The Revenue Class and Revenue Type lists of values are based on the internal business process for each company. The standard values can be adapted to your business, or the lists of values changed by your application administrator to reflect the stages of your company’s sales process and the manner in which your company recognizes revenue.

- **Revenue Class Field.** Your company can define the quality of the revenue at a given time by setting the list of values in the Revenue Class field to reflect the sales stages you use. Sample values are Pipeline, Upside, Expected, Committed, and Closed.

- **Revenue Type Field.** Your company may want to differentiate between kinds of revenues and their sources. For instance, your company may classify revenue by Software, Consulting, and Hardware categories, or by Booked versus Billed revenue, which are defined in the list of values. Defining revenue types allows you to query revenues or view charts sorted by the category of the revenue.

  For more information about the Revenue Class and Revenue Type fields, see *Siebel Forecasting Guide*.

About Split Revenue

A revenue split allows you to forecast how revenue from an opportunity is split between multiple sales representatives. The Split Revenue field indicates that the revenue is split in the Revenues tab.

For more information about the Split Revenue field, see *Siebel Forecasting Guide*.

### Table: Field and Comments

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Split Revenue</td>
<td>A system-populated check box that indicates that the revenue for the opportunity is split in the Revenues tab. For more information, see “About Split Revenue” on page 343.</td>
</tr>
<tr>
<td>Territories</td>
<td>A default value based on the territories defined by your company. Your system administrator controls the territory assignment function set up by your sales manager.</td>
</tr>
<tr>
<td>Worst Case</td>
<td>Allows you to enter the currency amount the deal could generate in the worst-case scenario. This amount is lower than the value in the Revenue field.</td>
</tr>
</tbody>
</table>
Changing the Primary Sales Team Member

The administrator or manager of the primary sales representative can change the person assigned as the primary member of the sales team.

To change a primary team member

1. Navigate to the Opportunities screen > Opportunities List view.
2. From the Show drop-down list, choose My Team’s Opportunities.
3. In the Opportunities list, drill down on the opportunity.
4. Click the More Info view tab.
5. In the More Info form, click the select button in the Sales Team field.
6. In the Team Members dialog box, select the team member to assign and select the Primary check box.

NOTE: If you have access to the Data Administration screen, you can change a primary team member assignment there.

Monitoring Significant Opportunity Transactions

Sales executives can monitor significant opportunity transactions by querying for opportunities flagged as Executive Priority. These flagged opportunities can be tracked by the executive team regardless of the revenue or forecast commitment. Tracking high-priority opportunities helps the executive maintain the most accurate quarterly revenue forecast and plan involvement in the most promising opportunities.

To flag an opportunity as an executive priority

1. Navigate to the Opportunities screen > Opportunities List view.
2. In the Opportunities list, select the opportunity.
3. In the Opportunities list, click the menu button and choose Columns Displayed.
4. In the Columns Displayed dialog box, move the Executive Priority field from the list of Available Columns to the list of Selected Columns, and click Save.
   The field appears in the record for the selected opportunity.
5. In the opportunity record, click the check box in the Executive Priority field.
Assessing an Opportunity

You can use assessments to compare opportunities with one another, compare them with a model, or to determine what information is present or not for an opportunity. To perform the assessment, you enter values for the assessment attributes. The application calculates a composite assessment value for the opportunity. For information about how to perform an assessment, see “Performing an Assessment (User)” on page 192.

Viewing Decision Issues for an Opportunity

Decision issues are specific areas of interest that can influence a prospect’s buying decision during the sales cycle. These decision issues provide you with an opportunity to present the advantages of your solution to the customer.

You can track these decision issues using the Opportunity screen’s Decision Issues view, and use this information to develop your sales strategy and address customer concerns. For more information, see Chapter 36, “Decision Issues.”

Associating a Contact with an Opportunity

As you work with an opportunity, you want to maintain information about the contacts associated with the opportunity. For more information about contacts, see Chapter 22, “Contacts.”

You can use the Contacts view from the Opportunity screen to store and review contact-related information for an opportunity.

To associate a contact with an opportunity

1. Navigate to the Opportunities screen > Opportunities List view.
2. In the Opportunities list, drill down on the opportunity, and then click the Contacts view tab.
3. In the Contacts list, click Add.
4. In the Add Contacts dialog box, select the contact to add, and then click OK.

NOTE: To select a sequence of contact records, hold down the SHIFT key and click the contact records. To select multiple contacts that are not in sequence, hold down the CTRL key and click the contact records.
Activities Associated with an Opportunity

The Opportunities screen’s Activities view allows you to track activities at the opportunity level, maintain a calendar and to-do list for the opportunity, and delegate activities related to the opportunity to your sales team. For more information about Activity Plans and associated activities, see Chapter 13, “Activities.”

Associating a Product with an Opportunity

Specific products can be associated with an opportunity. For example, if a customer is interested in purchasing a new software suite, this information can be specified in the Products view.

After the product is associated with the opportunity, you can drill down on the product to review additional information such as product features and prices.

Later, this data can be used when you are building a presentation, quote, or proposal based on the opportunity.

To associate a product with an opportunity

1. Navigate to the Opportunities screen > Opportunities List view.
2. In the Opportunities list, drill down on the opportunity, and then click the Products view tab.
3. Create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Quote</td>
<td>Select the check box if you want to include the product in automatic quotes generated for the opportunity.</td>
</tr>
<tr>
<td>Covered Product</td>
<td>This field can be completed only if the product (specified in the Product field) is a service product.</td>
</tr>
<tr>
<td>Net Price</td>
<td>Enter the price of the item minus discounts.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Enter the number of product units that the customer wants to purchase.</td>
</tr>
</tbody>
</table>
Creating a Quote from an Opportunity

Using the Quotes view, you can automatically create and revise quotes for the opportunity. For more information on quotes and orders, see Siebel Order Management Guide.

To create a quote from an opportunity
1. Navigate to the Opportunities screen > Opportunities List view.
2. Drill down on the opportunity.
3. Click the Products view tab.
4. In the Products list click New, and then add a product.
   For more information, see “Associating a Product with an Opportunity” on page 346.
5. In the Product record, complete the fields.
   a. Enter the number of product units the customer wants to purchase.
   b. In the Auto Quote field, select the check box to display a check mark.
6. Click the Quotes view tab, and then in the Quotes list, click Auto Quote.
   A quote record is automatically created, with some fields completed and a status of In Progress.
7. If no price list is associated with the account, in the Price List field click the select button, and choose a price list.
   If a price list is associated with the account, the Price List field is automatically completed.
   For more information on price lists, see Siebel Pricing Administration Guide.
8. In the quote record, drill down on the hyperlink in the Name field.
   You can change the system-generated name for a name that is more meaningful in the quote details form.
In the quote’s Line Items list, add line items, and then click the menu button and choose Reprice. The Reprice function makes sure that the quote total reflects the prices from the price list, and multiplies those prices by the quantities that you enter in the products view.

9

In the Quote form, click the menu button, and choose Update Opportunity, and then return to the Opportunity form.

TIP: The Update Opportunity function verifies that the opportunity’s revenue line items are in sync with the quote line items.

TIP: Use the History icon or the thread bar to navigate back to the Opportunity form.

To update opportunity revenues

1 In the Opportunity list, drill down on the opportunity, and then click the Revenues view tab.

2 In the Revenues list choose List from the Revenues drop-down menu.

3 In the Revenues list, click the menu button and choose Update Opportunity.

After this process is completed, the revenue amounts that appear in the Products, Revenues, and Quotes views are synchronized and the Opportunity’s Revenue field displays a calculated sum of the individual revenue line items associated with the opportunity.

NOTE: Siebel Quotes is a separately licensed product offering. You cannot access the Quotes view tab if you have not licensed this product.

Creating an Organization Analysis

You can automatically create organization charts to help you analyze your key contacts and develop your relationship strategy to win the opportunity.

Siebel Sales automatically generates organization charts based on contacts associated with each opportunity. When you update contact information, your changes are reflected in the organization chart.

To add existing contacts to the organization analysis

1 Navigate to the Opportunities screen > Opportunities list > Organization Analysis view.

2 Use the form at the top of the page to query for the opportunity with which you want to work.

3 In the Organization Chart view, click New.

The Add Contacts dialog box appears.

4 Select one or more contacts to add, and then click OK.

NOTE: To select a sequence of contact records, hold down the SHIFT key, and click the contact records. To select multiple contacts that are not in sequence, hold down the CTRL key, and click the contact records.
To create new contacts for the organization analysis

1. Navigate to the Opportunities screen > List view.
2. Drill down on the opportunity.
3. Click the Organization Analysis view tab.
4. In either the default Organization Analysis chart view or in the Contacts list (toggle view), click New.
5. In the Add Contacts dialog box, click New.
6. In the new contact record enter the contact information in the fields, and then click Save.

**NOTE:** If you create a new contact directly from the Organization Analysis chart view, then an explicit Save is required to update the chart.

The Level of Influence value determines the degree of shading that appears in the Contact node in the Organization Analysis chart. The following table details values and shading.

<table>
<thead>
<tr>
<th>Value in Level of Influence Fields</th>
<th>Shading on Organization Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td>None</td>
</tr>
<tr>
<td>Political Structure (Medium)</td>
<td>Light gray</td>
</tr>
<tr>
<td>Inner Circle (High)</td>
<td>Dark gray</td>
</tr>
</tbody>
</table>

You can update contact information from either the Opportunities screen or from the Contacts screen.

Using Drag and Drop to Depict Organization Hierarchy

From the Organization Analysis chart view you can drag and drop contacts to indicate professional relationships within the organization.

To create the hierarchy

1. Navigate to the Opportunities screen > List view.
2. Drill down on the opportunity for the Organization Analysis.
3. Click the Organization Analysis view tab.
4. Add or create contacts, as described in "To add existing contacts to the organization analysis" on page 348 and "To create new contacts for the organization analysis" on page 349.

In the Organization Analysis chart area the nodes (boxes) appear for each of the contacts you have analyzed and associated with the opportunity.

5. Select the contact node and drag it beneath the contact node that depicts the contact’s manager.

When you drop the contact node on its manager’s node, a formal line between the nodes appears, reflecting the reporting relationship.
Repeat Step 5 for each contact until you have completed the organization chart.

**NOTE:** The reporting relationships are also stored in the Contacts list (toggle view). The Manager’s Last Name and Manager’s First name fields of the contact automatically populate based on the drag and drop actions. To expose this information in the contacts list, click the menu button, and then choose Columns Displayed.

### Drawing Lines of Influence

You can also map the politics in the customer organization by identifying informal lines of influence between contacts. Mapping informal lines of influence helps you identify contacts who are not highly ranked (and are easier to access) but who have significant influence on key decision makers. Lines of Influence information is automatically updated in the Contacts screen’s Relationships view. You can add Lines of Influence information in the Relationships view if you prefer.

**To draw lines of influence**

1. In the Organization Analysis chart area, select the contact node, and simultaneously hold down the CTRL key.

2. Drag and drop the selected contact on other contacts to draw the lines of influence.

   The CTRL key must be depressed throughout this process in order for the informal line of influence to appear.

**To delete lines of influence**

- In the Organization Analysis chart area, select the line and press the DELETE key.

   You may also right click the mouse in the Organization Chart area, and choose Edit > Delete from the menu.

### Viewing and Printing the Organization Analysis

After you associate contacts with an opportunity and enter values for the manager, reports, associates and the influence level for each, you can view an organization chart of all your contacts.

**To view the Organization Analysis chart**

1. Navigate to the Opportunities screen > List view.

2. Drill down on the opportunity.

3. Click the Organization Analysis view tab.

   The Organization Analysis list of contacts appears.
4 From the drop-down list, choose Organization Analysis.

An organization chart appears with the contact information you entered.

Each contact appears in a hierarchy based on the influence level or managerial structure assigned to the contact.

**NOTE:** Double-click the contact node to navigate to the Contacts screen’s Activities view to add follow-up activities for the contact.

**To print an Organization Analysis chart**

1 Navigate to the Opportunities screen > List view.
2 Drill down on the opportunity.
3 Click the Organization Analysis view tab.

The Organization Analysis list of contacts appears.
4 From the drop-down list, choose Organization Analysis.
5 Right click the mouse in the Organization Analysis chart workspace, and choose Print from the menu.

You can adjust the zoom level at which you want to print the Organization Chart. Large charts print across multiple pages.

**Opportunity Charts**

Several charts are available that support analysis of opportunities data. The data can be depicted in a variety of formats such as pie graph, bar graph, and so on.

**Table 86** describes each opportunity analysis chart.

<table>
<thead>
<tr>
<th>Chart</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity Analysis</td>
<td>Displays the number of activity types for the selected record.</td>
</tr>
<tr>
<td>Current Opportunity</td>
<td>Displays a scatter diagram of the selected opportunity by revenue and</td>
</tr>
<tr>
<td>Analysis</td>
<td>probability. The bottom chart displays sales stage.</td>
</tr>
<tr>
<td>Lead Analysis</td>
<td>Displays the number of opportunities or revenue by organization or</td>
</tr>
<tr>
<td></td>
<td>primary sales representative. The data is segmented by lead quality.</td>
</tr>
<tr>
<td>Lead Source Analysis</td>
<td>Displays the number of opportunities, revenue, or average revenue by time</td>
</tr>
<tr>
<td></td>
<td>period. The data is segmented by lead source.</td>
</tr>
<tr>
<td>Lead Source Pipeline</td>
<td>Displays the number of opportunities by sales stage and lead source.</td>
</tr>
<tr>
<td>Analysis</td>
<td></td>
</tr>
<tr>
<td>New Business Analysis</td>
<td>Displays the number of opportunities, revenue, or average revenue over a</td>
</tr>
<tr>
<td></td>
<td>time period.</td>
</tr>
</tbody>
</table>
Viewing the Opportunity Sales Pipeline Analysis Chart

The Sales Pipeline Analysis works by evaluating the total revenue and count of opportunities by a selected sales methodology and then evaluating the total against each applicable quota.

**NOTE:** The Sales Pipeline Analysis Chart considers only active Quota plans, regardless of duration.

**To display sales pipeline analysis information**

1. Navigate to the Opportunities screen > List view.
2. From the Show drop-down list, select an Opportunities list. For example, you might choose All Opportunities.
3. In the Opportunities list, click Query.
4. In the Opportunities form, query on a Sales Method, and then click Go.
5. Click the Charts view tab.
6. In the Charts list, select Sales Pipeline Analysis from the Show drop-down list.
7. From the secondary Show drop-down list, choose either % of Count Quota, or % of Revenue Quota, and then click Go.

**NOTE:** Pipeline charts cannot be copied by dragging (as pie and bar charts can).
Viewing the Sales Pipeline Phases Analysis Chart
The Sales Pipeline Phases chart provides an overall view of the revenue generated for opportunities in an organization. Sales phases are basic components used to group stages together into basic sales categories.

To view the sales pipeline phases analysis chart
1. Navigate to the Opportunities screen > List view.
2. From the Show drop-down list, select an Opportunities list.
3. In the Opportunities list, click Query.
4. In the opportunities form, query for a Sales Method, and then click Go.
5. Click the Charts view tab.
6. In the Charts list, select Sales Pipeline Phases Analysis from the Show drop-down list.
7. From the secondary Show drop-down list, choose either % of Count Quota, or % of Revenue Quota, and then click Go.

Generating Opportunity Reports
You also can generate reports of your opportunities data. Available reports include:
- Opportunities by Category
- Opportunities by Sales Rep
- Opportunity Summary
- Opportunity List
- Pipeline Report by Rep
- Smart Report - Opportunity Detail
- Opportunity Status
- Opportunity Marketing Events Summary
For information about how to run a report, see Siebel Fundamentals.

Setting Up Lead Sources for Opportunities
Lead sources for opportunities are created, modified, and deleted through the Lead Sources Administration view of the Opportunities screen.

The following procedure describes how to add lead sources so that they can be associated with opportunities.
In addition, campaigns automatically appear as lead sources of type Marketing Campaign. For more information about Campaigns, see *Siebel Marketing User Guide*.

**To create a lead source**

1. Navigate to Opportunities screen > Lead Sources Administration view.
2. Create a new record and complete the necessary fields.

Some of the fields are explained in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Date</td>
<td>Select the start date of the campaign.</td>
</tr>
<tr>
<td>End Date</td>
<td>Select the end date of the campaign.</td>
</tr>
<tr>
<td>Description</td>
<td>Type a brief description about the campaign.</td>
</tr>
<tr>
<td>Source</td>
<td>Type the source of the campaign. For example, a new product line, a marketing seminar, and so on.</td>
</tr>
<tr>
<td>Objective</td>
<td>Type the objective of the campaign.</td>
</tr>
<tr>
<td>Target</td>
<td>Type the target customer base for the campaign</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of the campaign. For example, marketing campaign, direct marketing, and so on.</td>
</tr>
</tbody>
</table>
Households

Household information is closely related to information about contacts, and is similar to information about accounts. Other chapters in this guide provide more detailed information about how to use the Contacts and Accounts screens.

This chapter describes how call center agents can use the Households screen to record information about groups of individual consumers who interact with the agents’ company. It includes the following topics:

- "Household Contact Tracking” on page 355
- "Scenario for Households” on page 356
- "End-User Procedures for Households” on page 356
- "Adding a Household Record” on page 356
- "Adding Contacts to a Household” on page 357
- "Adding Activities to Household Records” on page 360
- "Storing and Viewing Information About Households” on page 360
- "Synchronizing Household Information with External Systems” on page 361

Household Contact Tracking

A household is a collection of individual consumers who are economically affiliated and who share common purchasing or service interests. Individuals may or may not be related to one another and may belong to other households. Typically, a household shares the same residential address. Siebel Call Center allows an organization to address the complexity of dynamic households by tracking all household information through the appropriate household contact. If contacts leave a household to join another, their associated information moves with them.

The Households screen displays information about customer households. You can use the Households screen and its related views to work with the following kinds of information:

- Contacts (household members)
- Activities
- Attachments
- Service Requests
- Notes
- Assets
- Opportunities
- Agreements
The Household views summarize information that relates to all the individual contacts who are members of the household. For example, you might want to view a list of all the service requests from a particular household, regardless of which household member made the request.

The Household More Info view tab and the Household Contacts view tab allow editing, but other Household views are read-only.

If you want to add activities, service requests, notes, attachments, assets, opportunities, and agreements, you must navigate to the Household Contact list and click the appropriate contact hyperlink to reach a view where you can enter the necessary information.

**Scenario for Households**

Call center agents commonly use the Households screen in a business-to-consumer setting. Viewing household information allows for cross-selling, upselling, and sell-through opportunities. Combined with Siebel Marketing and Analytics, the Households screen provides the basis for consumer segmentation and analysis.

The Households screen displays market segment information on the household as a whole, as well as a summary of information about the individual contacts who are household members. Call center agents use the Households screen to identify and capture demographic information about a household, and also to review assets, products, activities, and contact information associated with the household. This information helps the agent assess the customer’s data and history to better meet the customer’s needs.

**End-User Procedures for Households**

This section describes the following end-user procedures for working with the Households screen:

- Adding a Household Record on page 356
- Adding Contacts to a Household on page 357
- Adding Activities to Household Records on page 360
- Storing and Viewing Information About Households on page 360
- Synchronizing Household Information with External Systems on page 361

**Adding a Household Record**

Use the following procedure to add a household record.

*To add a household*

1. Navigate to the Households screen > List view.
2 In the list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Automatically populated with the address of the primary household contact.</td>
</tr>
<tr>
<td>Category</td>
<td>Indicates the value of the household to your organization. Available values are Platinum, Gold, Silver, and Standard.</td>
</tr>
<tr>
<td>City</td>
<td>Automatically populated with the city where the primary household contact resides.</td>
</tr>
<tr>
<td>Head of Household</td>
<td>The main decision-maker for the household. Available values are all the contacts for the household.</td>
</tr>
<tr>
<td>Household #</td>
<td>Unique identifier for the household. Automatically populated.</td>
</tr>
<tr>
<td>Income</td>
<td>Total income from all members of the household.</td>
</tr>
<tr>
<td>Name</td>
<td>A name that identifies the household. Typically this is the last name of one or more contacts who are members of the household.</td>
</tr>
<tr>
<td>Organization</td>
<td>The organization that interacts with the household.</td>
</tr>
<tr>
<td>Revenue</td>
<td>Revenue your organization obtains from this household.</td>
</tr>
<tr>
<td>Segment</td>
<td>Indicates general economic class of the household, or home-ownership status. Typical values are White Collar, Blue Collar, Rural, Own Residence, and Renter.</td>
</tr>
<tr>
<td>Size</td>
<td>Total number of people in the household.</td>
</tr>
<tr>
<td>State</td>
<td>Automatically populated with the state where the primary household contact resides.</td>
</tr>
<tr>
<td>Status</td>
<td>The current stage in the customer interaction life cycle. Defaults to Active for a new household record.</td>
</tr>
<tr>
<td>Team</td>
<td>Employees assigned to work with this household. If a call center user is not a member of the household team, that user will not receive information about this household during Mobile Web Client synchronization.</td>
</tr>
<tr>
<td>Type</td>
<td>Types of people that make up the household. Typical values include Family - Children, Family - No children, Family - Senior Citizen, and Single.</td>
</tr>
<tr>
<td>Wealth</td>
<td>Estimated total wealth of the household.</td>
</tr>
<tr>
<td>Zip Code</td>
<td>Automatically populated with the zip code of the primary household contact.</td>
</tr>
</tbody>
</table>

**Adding Contacts to a Household**

Contacts are individuals associated with a household. Agents can specify one person in the household as the head of household and then identify the others as spouse, child, or dependent parent.
**To add contacts to a household**

1. Navigate to the Households screen > List view.
2. Drill down on the household to which the contacts will be added.
3. Click the Contacts view tab.
4. In the Contacts list, use one of the following methods to specify the contact you want to add:
   - To add an existing contact to the household, click Add, select the contact from the Add Contacts dialog box, and click OK.
   - To add a new contact to the household, click New.
5. Complete the fields for the record.

The following table describes some of the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alias</td>
<td>Contact's nickname.</td>
</tr>
<tr>
<td>Date Entered</td>
<td>Date that the contact became a member of the household.</td>
</tr>
<tr>
<td>Date Exited</td>
<td>Date that the contact left the household.</td>
</tr>
<tr>
<td>Employee Flag</td>
<td>Indicates that the contact is an employee of your company.</td>
</tr>
<tr>
<td>Income</td>
<td>Contact’s income.</td>
</tr>
<tr>
<td>Households</td>
<td>One or more households in which the contact is a member.</td>
</tr>
<tr>
<td>Primary</td>
<td>When selected, designates the current contact as the main decision-maker for the household.</td>
</tr>
<tr>
<td>Relationship</td>
<td>Indicates the role of the contact within the household.</td>
</tr>
</tbody>
</table>

**To specify an address for the household contact**

1. Navigate to the Contacts screen > Contacts List > Addresses view.
   This ensures that the Addresses view tab is visible in Step 6.
2. Navigate to the Households screen > List view.
3. Drill down on a household record.
4. Click the Contacts view tab.
5. In the Contacts list, select the contact and drill down on the hyperlink in the Last Name field.
6. Click the Addresses view tab, and in the Addresses list, create a new record, and complete the fields.
7. Click the thread bar to return to the Household Contacts view, and then scroll down to display the Household Contacts More Info form.
8 In the More Info form, click the select button in the Address field to display the Contact Addresses dialog box.

9 In the Contact Addresses dialog box, select the row and the Primary check box for the contact’s main address, and then click OK.

10 In the More Info form, complete additional fields.

The following table describes some of the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>Business or organization associated with the contact.</td>
</tr>
<tr>
<td>Address</td>
<td>Contact’s address or addresses. The procedure for entering addresses to be displayed in this field is described in Step 5.</td>
</tr>
<tr>
<td>Email</td>
<td>Contact’s email address.</td>
</tr>
<tr>
<td>Site</td>
<td>Site of the account associated with the contact.</td>
</tr>
</tbody>
</table>

**NOTE:** In the Households screen, a contact’s address is the residential or personal address. In the Contacts screen, the address displayed in the Contact form and the Contact More Info form is the address of the account associated with the contact. The Addresses view tab for the Contacts screen holds the list where a contact’s other addresses can be specified. Household addresses can only be selected from these individual contact addresses.
Adding Activities to Household Records

Add activity records to household records to track appointments, meetings, email messages, and other tasks related to households. The following procedure describes how to add an activity from the Household screen. For more information about Activities, see Chapter 13, “Activities.”

To add an activity for a household
1. Navigate to the Households screen > List view.
2. Drill down on the household for which the activity will be added.
3. Click the Contacts view tab.
4. In the Contacts list, select the contact, and then drill down on the Last Name hyperlink.
   The Activities view for the Contacts screen appears.
5. In the Activities list, create a new record, and complete the necessary fields.
   The fields are described in Chapter 13, “Activities.”

Storing and Viewing Information About Households

The following types of information can be indirectly related to a household by associating the information with the contact record for any member of the household:

- Attachments
- Notes
- Opportunities
- Service Requests
- Agreements
- Assets

The Household screen’s views that correspond to these types of information are read-only. The information must be stored and modified using Contact screen views.

To store additional information related to a household contact
1. Navigate to the Households screen > List view.
2. Drill down on a household record.
3. Click the Contacts view tab.
4. In the Contacts list, drill down on the Last Name hyperlink to display the Contacts screen.
5. Click the appropriate view tab for the type of information you want to add:
In the view tab list, create a new record, and complete the necessary fields.

If the contact who is associated with Attachments, Notes, Opportunities, Service Requests, Agreements, or Assets leaves the household, the information stays accessible through the Household screen if Siebel Call Center users register the contact’s departure by adding an exit date to the Household Contact record. If a user deletes the Household Contact record for the departing contact, the information associated with that contact is no longer associated with the contact’s former household.

To view additional information related to a household

1. Navigate to the Households screen > List view.
2. Drill down on a household record.
3. Click the view tab for the type of information you want to view:
   - Attachments
   - Notes
   - Opportunities
   - Service Requests
   - Agreements
   - Assets
   The corresponding list appears.

Synchronizing Household Information with External Systems

The Application Services Interface (ASI) feature allows you to synchronize the household data between a Siebel application and an external system in real time. This feature enables you to maintain consistent household information across your enterprise, and to eliminate manual entry of data in multiple systems.

If your Siebel administrator has set up real-time household integration between a Siebel application and another system, you can use the Update External System command to send new and modified household information from the application to the other system in real time. For more information about ASI, see Siebel Application Services Interface Reference and Chapter 24, “Integration Using ASIs.”
To synchronize household information with an external system

1. Navigate to Households > Household List.

2. In the Household list, select a household record.
   To create a new household record, see “Adding a Household Record” on page 356.

3. In the Household list, click the menu button, and then choose Update External System.
31 References

This chapter describes how sales professionals can use the References screen to access accounts that can be designated as references, and to associate contacts, activities, profiles, and notes with each reference. This chapter includes the following topics:

- "Scenario for References" on page 363
- "Managing Accounts and References" on page 364
- "Designating an Account as a Reference" on page 364
- "Associating an Activity with a Reference" on page 364
- "Associating a Contact with a Reference" on page 365
- "Associating an Attachment with a Reference" on page 365
- "Adding a Reference Activity to the Calendar" on page 366
- "Adding a Note to a Reference" on page 366
- "Adding Profile Information to a Reference" on page 367
- "Searching for References" on page 367
- "Viewing Reference Asset and Profile Charts" on page 367

Scenario for References

This scenario provides an example of the business process performed by a sales representative using references to compete for new business. Your company may follow a different process according to its business requirements.

A sales representative is attempting to win a 2,500-seat software sales opportunity for his company. In a series of meetings with the prospect, the sales representative demonstrates his product line and submits a quote. The sales representative receives a call from the prospective customer requesting a chance to speak with existing software customers as a point of reference before agreeing to the terms of the quote.

The sales representative searches the list of references, and performs a query to find accounts that meet specific criteria. The accounts must be designated as referenceable, in the same industry as the prospective customer, and listed as maintenance in the sales stage.

The sales representative finds companies that meet the criteria. She selects a company for the reference, and telephones the primary representative to get permission to use the customer as a reference. The representative agrees and sets up a conference call to discuss the opportunity with the prospect.
Managing Accounts and References

The References screen provides you with customer reference information that you can use as a sales tool when managing sales, marketing, and public relations initiatives. As a sales team member, providing potential customers with a list of referenceable accounts adds immediate legitimacy to any sales situation and gives you a competitive advantage. You also can use the References screen to determine the best reference for a current initiative.

You can use the References list to search for accounts that are referenceable. A calendar view of reference activities is also available.

The following procedures describe how to manage accounts references using the references screen:

- Designating an Account as a Reference on page 364
- Associating an Activity with a Reference on page 364
- Associating a Contact with a Reference on page 365
- Associating an Attachment with a Reference on page 365
- Adding a Reference Activity to the Calendar on page 366
- Adding a Note to a Reference on page 366
- Adding Profile Information to a Reference on page 367
- Searching for References on page 367
- Viewing Reference Asset and Profile Charts on page 367

Designating an Account as a Reference

You can mark an account as referenceable using the check box in the account record’s Reference field. During the reference process, you can set the reference stages.

To designate an account as a reference

1. Navigate to the Accounts screen > Accounts List view.
2. Drill down on an account record.
3. Click the More Info view tab.
4. In the Account details form, select the Reference check box.

Associating an Activity with a Reference

In the Activities view, you can see each activity associated with an account. Activities associated with a reference appear in the Calendar view. See Siebel Fundamentals for more information on using the Calendar. Reference record fields provide information on the primary representative, the corporate sponsor, and so on.
To associate an activity with a reference
1. Navigate to the References screen > Reference List view.
2. Drill down on a reference record.
3. Click the Activities view tab.
4. In the Activities list, create a new record, and complete the necessary fields.
   For more information, see Chapter 13, “Activities.”

Associating a Contact with a Reference
You can designate a specific contact within a referenceable account. This contact can provide you with reference information or the individual can be the point-of-contact for activities associated with the account.

To associate a contact with a reference
1. Navigate to the References screen > Reference List view.
2. Drill down on a reference record.
3. Click the Contacts view tab.
4. In the Contacts list, perform one of the following steps.
   a. Click Add Contact to open the Add Contacts dialog box, and then select the contact from the list.
   b. Click New to add a new row to the Contacts list, and then complete the necessary fields for the contact.

Associating an Attachment with a Reference
The Attachments view lists attachments associated with a reference account. You can add new attachments or view attachments associated with the account. Reference Attachments include account attachments as well as reference attachments.

To associate an attachment with a reference
1. Navigate to the References screen > Reference List view.
2. Drill down on a reference record.
3. Click the Attachments view tab.
4. In the Attachments list, create a new record.
5. In the Attachment Name field, click the select button, and in the Add Attachment dialog box, click Browse.
Adding a Reference Activity to the Calendar

The Calendar view details all reference activities associated with the account. In the calendar, you can view, by month, the number of reference activities associated with the account. This view allows you to manage the number of initiatives for the account and determine if the customer is being contacted too often.

To add a calendar item for a reference
1. Navigate to the References screen > Reference List view.
2. Drill down on a reference record.
3. Click the Calendar view tab.
   - The reference form appears with the calendar.
4. In the Calendar view, click New.
5. In the Calendar Detail form, complete the necessary fields, and then click Save This One.

Adding a Note to a Reference

The Reference screen’s Notes view allows you to add notes to the selected reference account. Notes can be shared with others, and notes can be designated as private. Reference notes are visible in both the Account screen and the Reference screen. If you create a note in either the Accounts screen or the Reference screen, it is accessible in both views.

To add a note to a reference
1. Navigate to the References screen > Reference List view.
2. Drill down on a reference record.
3. Click the Notes view tab.
4. In the lower link bar, click Private Notes or Shared Notes.
5. In the Notes list, create a new record, and complete the necessary fields.

6. In the Choose File dialog box, select the file, and then click Open.
7. In the Add Attachment dialog box, click Add.
Adding Profile Information to a Reference

The Profile view allows you to update the account with information about the assets owned by the account, and information about the service profile. The service profile is a list of all external products the account is using in its operating environment. For instance, if your company sells application software, you might add information about the server hardware and end-user operating system used in conjunction with your products.

To add profile information to a reference
1. Navigate to the References screen > Reference List view.
2. Drill down on a reference record.
3. Click the Profile view tab.
   The Profile list and the Service Profile subviews appear.
4. In the Profile list, create a new record, and complete the necessary fields.
5. In the Service Profile list, create a new record, and complete the necessary fields.

Searching for References

Use the All References Read Only and All References Across Organizations Read Only lists to search for references applicable to your accounts. These views are read-only; you cannot modify information, and a contacts list is not available. To use the reference contact information, contact the reference owner, whose User ID appears in the Primary Rep field.

To search for references
1. Navigate to the References screen > Reference Read Only List view.
2. In the References list, click Query, enter criteria in the query form, and then click Go.
3. In the reference record, drill down on the name hyperlink in the Primary Rep field to view reference owner information.

Viewing Reference Asset and Profile Charts

Reference charts provide a graphical analysis of referenced account assets and profiles. The Asset Analysis chart provides a graphical view of the assets. The Account External Product - Reference List chart provides a graphical representation of the profile information associated with all reference accounts. Both charts are read-only.
To view asset and profile analysis charts

1. Navigate to the References screen.

2. From the link bar, choose Asset Analysis or Account External Product - Reference List. The reference assets or reference profile list appears with the analysis chart.

3. In the chart, select the type (3D, 2D) from the drop-down list, and then click Go.
This chapter describes how marketing managers can use Siebel Real-Time Decisions (RTD), and how system administrators can configure RTD. This chapter includes the following topics:

- About Real-Time Decisions on page 370
- Scenario for Real-Time Decisions on page 370
- Process of Configuring Siebel Business Applications for Siebel RTD on page 370
- Checking Prerequisites on page 371
- Configuring Outbound Web Services on page 371
- Configuring RTD with Siebel Views on page 372
- Setting Siebel Enterprise Server Parameters on page 372
- Configuring Siebel Run-Time Events on page 373
- Importing Communication Configuration Seed Data on page 374
- Creating JDBC Data Sources on page 374
- Creating Views in the SIEBEL_OLTP Database on page 375
- Creating and Populating OLAP Tables with History Data on page 376
- Creating a Project for an Inline Service on page 377
- Deploying an Inline Service on page 378
- Customizing Call Reasons on page 379
- Process of Setting Up Real-Time Offers on page 380
- Defining the Campaign on page 380
- Creating and Modifying Offers on page 380
- Enabling Offers for RTD on page 380
- Opening Decision Center for Editing on page 381
- Specifying Eligibility for Offers on page 381
- Updating Offer Information on page 383
- Activating the Offers on page 383
- Viewing RTD Performance Reports on page 384
- Views for Call Center Agents on page 385
About Real-Time Decisions

The RTD service provides intelligent offer recommendation and retention management features to call center agents who receive inbound customer communications.

The RTD service combines predictive analytics technology with dynamic eligibility rules and scoring rules to maximize the value from inbound customer interactions. The criteria for rules can be based on a variety of attributes, for example, the age of a customer, the salary of a customer, recent life events, and so on. RTD can anticipate customer needs in real time and adapt each interaction to the needs of the customer. The decision logic of RTD and the integration points with Siebel Enterprise are implemented as an inline service. The inline service runs on a Siebel RTD server.

Scenario for Real-Time Decisions

This topic gives one example of how RTD might be used. You might use RTD differently, depending on your business model.

A marketing manager has been asked to use the call center to drive proactive retention management and increase revenues from cross- and up-sell offers. The manager decides to implement the RTD application for Siebel Call Center.

The marketing manager asks the marketing or system administrator to configure the RTD server. After the system administrator configures RTD, the marketing manager uses Siebel Marketing to create a marketing campaign specifically for inbound calls.

Then, the marketing manager creates offers within the campaign. Each offer can have one or more associated treatments. A treatment is a form of an offer that is specific to a particular channel. For example, you might have a phone treatment of an offer. After Siebel RTD is synchronized with Siebel Enterprise Server, choices in Siebel RTD correspond to treatments in Siebel Enterprise Server. After the marketing manager creates offers within the campaign, the manager can then change some settings for the treatments associated with the offer. For example, the manager can add a profit margin figure associated with an offer.

The marketing manager can then create rules, or groups of rules, which determine the eligibility of customers for an offer. For example, the manager might set up rules so that an offer is eligible only to customers over the age of 21 years, with a salary of more than $35,000.

The marketing manager can now add or update offer information, such as the profit margin associated with the offer. The marketing manager must then deploy the updates to an inline service to make the offers available to agents. Agents can then work with views in Siebel Call Center as they receive calls from customers.

Process of Configuring Siebel Business Applications for Siebel RTD

To configure Siebel RTD, perform the following tasks:

1. Checking Prerequisites on page 371
2. Configuring Outbound Web Services on page 371
Checking Prerequisites

Before you configure Siebel RTD, you must complete the following actions:

- Install the latest version of Siebel RTD platform.
- Deploy an inline service, for example SiebelB2B or SiebelB2C. You can integrate only one inline service with Siebel Enterprise Server at a time, so you must choose your inline service before you configure Siebel RTD.

This task is a step in Process of Configuring Siebel Business Applications for Siebel RTD on page 370.

Configuring Outbound Web Services

Siebel Enterprise Server uses Enterprise Application Integration (EAI) Outbound Web Services to communicate with Siebel RTD. Seed data for outbound Web services is provided with the product, but you must update the data to refer to the correct inline service.

This task is a step in Process of Configuring Siebel Business Applications for Siebel RTD on page 370.

To configure outbound Web services

1. Navigate to the Administration - Web Services screen > Outbound Web Services view.
2. Query the list for namespaces that contain the string sigma.
3. Select the ExternalChoiceService record.
4. In the Service Ports applet, type the address of your RTD server in the Address field. For example, you might use an address like http://services.corp.example.com:/soap/services/ExternalChoice.
   **NOTE:** Do not modify the DecisionService record.
5. Click on the Clear Cache button on the Outbound Web Services view.
Configuring RTD with Siebel Views

Siebel Portal Framework enables Siebel RTD to integrate effectively with Siebel views. Seed data for this integration is provided with the product, but you must make some updates to see RTD reports in Siebel views.

This task is a step in Process of Configuring Siebel Business Applications for Siebel RTD on page 370.

To configure RTD with Siebel views

1. Navigate to the Administration - Integration screen > WI Symbolic URL List view.
2. Select Host Administration from the visibility filter.
3. Query the list for a virtual name called RTD_SERVER.
4. In the record whose virtual name is RTD_SERVER, type the host name of the RTD server in the Name field. For example, you might use a hostname like services.corp.example.com:8080.
5. Select Symbolic URL Administration from the visibility filter.
6. Query the list for URLs that contain the string RTD.
7. For each record whose URL contains RTD, use the Symbolic URL Arguments applet to update the Argument Value of the argument to the appropriate inline service. For example, update the argument value of the DecisionCenter record to SiebelB2C or SiebelB2B.
8. If you plan to use RTD Platform Authentication instead of Siebel Object Manager Authentication, you must update the username and password arguments in the following table.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>username</td>
<td>Constant</td>
<td>sdsu</td>
</tr>
<tr>
<td>password</td>
<td>Constant</td>
<td>sdsu</td>
</tr>
</tbody>
</table>

Setting Siebel Enterprise Server Parameters

You must configure particular parameters in Siebel Enterprise Server so that offer synchronization, and Advisor or Informant functionality perform correctly.

This task is a step in Process of Configuring Siebel Business Applications for Siebel RTD on page 370.

To configure for Offer Sync and Advisor/Informant

1. Navigate to the Administration - Server Configuration screen > Servers list > Parameters view.
2. Query the list for parameters that begin with the string RTD.
Enter values for each of the RTD parameters, as described in the following table.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>RTD Application Name</td>
<td>Type the name of the RTD inline service. This parameter is used to provide the following functions between Siebel Enterprise Server and Siebel RTD: Offer synchronization and Real-time communication, for example, with integration points</td>
<td>SiebelB2B</td>
</tr>
<tr>
<td>RTD SOAP URL</td>
<td>Type the Simple Object Access Protocol (SOAP) URL for the RTD server. The RTD Integration Business service uses this to make Advisor and Informant SOAP calls.</td>
<td><a href="http://services.corp.example.com:8080/rtis/sdwp">http://services.corp.example.com:8080/rtis/sdwp</a></td>
</tr>
<tr>
<td>RTD Session Cookie Name</td>
<td>Type the name of the cookie for RTD Server to use to load balance calls for Web services from the Siebel Server. If you do not want to use any hardware- or software-based load balancing tools, use the default value JSESSIONID.</td>
<td>JSESSIONID</td>
</tr>
<tr>
<td>RTD WebService Timeout</td>
<td>Type the interval, in milliseconds, after which you want RTD Advisor or Informant Web service calls to time out.</td>
<td>3000</td>
</tr>
</tbody>
</table>

### Configuring Siebel Run-Time Events

Siebel Enterprise Server uses run-time events to communicate data changes from Siebel Object Manager to Siebel RTD. Seed data for run-time events is provided with the product, but the run-time events are not enabled by default. You must enable RTD-related events for RTD to function correctly.

This task is a step in Process of Configuring Siebel Business Applications for Siebel RTD on page 370.

**To enable RTD-related run-time event**

1. Navigate to the Administration - Runtime Events screen > Action Sets view.
2. Query the list for the parameters that begin with the string RTD.
3. Select the Active check box for all of the records that correspond with the inline service that you use. For example, if you use SiebelB2C inline service, select the Active check box only for the records that are labelled as B2C.
4. Choose Reload Runtime Events from the menu.
   This action clears and reloads the run-time events cache.
Importing Communication Configuration Seed Data

Siebel RTD requires seed data to function correctly. You must add seed data for communication configuration. To add seed data, you import the data from a configuration file. This task is a step in Process of Configuring Siebel Business Applications for Siebel RTD on page 370.

To import seed data to a communication configuration

1. Navigate to the Administration - Communications screen > All Configurations view.
2. Click New to create a new configuration, then type a name for the configuration.
3. Click Import Configuration, then click Next on the Import Configuration wizard.
4. In the Import Configuration wizard, select the following options:
   - Configuration Parameters
   - Commands
   - Events
   - Drivers and Profiles
5. Use the Browse button to select the configuration file. The configuration you must select depends on the type of application that you want to configure, as shown in the following table:

<table>
<thead>
<tr>
<th>Application Type</th>
<th>Configuration File</th>
</tr>
</thead>
<tbody>
<tr>
<td>B2B</td>
<td>B2B_Comm_Config.def</td>
</tr>
<tr>
<td>B2C</td>
<td>B2C_Comm_Config.def</td>
</tr>
</tbody>
</table>
7. Click the Agents tab, then use the Agents form to add all Siebel Call Center agents who need to use Siebel RTD.
8. Click the Profiles tab, then use the Profiles form to add the appropriate communication profiles to the communication configuration.

Creating JDBC Data Sources

Siebel RTD Server uses Java Database Connectivity (JDBC) to access contact and account profile information in the Siebel OLTP and OLAP databases. To run Siebel RTD for Siebel Call Center, you must use an Online Transaction Processing (OLTP) data source. You only need an Online Analytical Processing (OLAP) data source if you use Oracle Business Intelligence Server.
Table 87 lists the JDBC data sources that you can use.

### Table 87. JDBC Data Sources

<table>
<thead>
<tr>
<th>Data Source Name</th>
<th>Data Source Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDDS</td>
<td>System</td>
<td>Stores the deployed projects, run-time sessions, and model learnings. This data source is required. Typically, this data source is created when you install the Siebel RTD Server.</td>
</tr>
<tr>
<td>SIEBEL OLTP</td>
<td>Source</td>
<td>Populates the customer, account, and asset entities from the Siebel OLTP. This data source is required.</td>
</tr>
<tr>
<td>SIEBEL OLAP</td>
<td>Source</td>
<td>Uses a prepopulated OLAP table to populate the service request, order history, and financial account entities. For more information, see Creating and Populating OLAP Tables with History Data on page 376. This data source is required only if you use Oracle Business Intelligence Server.</td>
</tr>
</tbody>
</table>

For information about how to create the JDBC data sources, see Installation and Administration of Siebel RTD in Siebel Real-Time Decisions 2.1 Bookshelf.

This task is a step in Process of Configuring Siebel Business Applications for Siebel RTD on page 370.

## Creating Views in the SIEBEL OLTP Database

At run time, Siebel RTD Server accesses views defined in the SIEBEL OLTP database to populate the Siebel RTD Server entities. The login script that executes the Data Definition Language (DDL) statements to create the views must have CREATE VIEW privileges in the database. Only create the views for the inline service that you want to install. For example, if you want to install a B2B inline service, include only B2B views.

This task is a step in Process of Configuring Siebel Business Applications for Siebel RTD on page 370.
To create views in the SIEBEL_OLTP database

1. Open the text file that contains the statements which create views specific to your OLTP database type and Siebel Enterprise application type. The filenames of the text files are listed in the following table:

<table>
<thead>
<tr>
<th>Application Type</th>
<th>OLTP Database Type</th>
<th>Filename</th>
</tr>
</thead>
<tbody>
<tr>
<td>B2B</td>
<td>Siebel Business Applications</td>
<td>(\text{ALL}\textbackslash8.0\textbackslash B2B\textbackslash SQL_HOR_ORACLE.txt)</td>
</tr>
<tr>
<td>B2B</td>
<td>Siebel Industry Applications</td>
<td>(\text{ALL}\textbackslash8.0\textbackslash B2B\textbackslash SQL_SIA_ORACLE.txt)</td>
</tr>
<tr>
<td>B2C</td>
<td>Siebel Business Applications</td>
<td>(\text{ALL}\textbackslash8.0\textbackslash B2C\textbackslash SQL_HOR_ORACLE.txt)</td>
</tr>
<tr>
<td>B2C</td>
<td>Siebel Industry Applications</td>
<td>(\text{ALL}\textbackslash8.0\textbackslash B2C\textbackslash SQL_SIA_ORACLE.txt)</td>
</tr>
</tbody>
</table>

2. Find the CREATE VIEW statement in the text file for the view that you want to create.

3. Execute the CREATE VIEW statement on your database.

4. Test that the CREATE VIEW statement worked correctly. For example, execute a statement similar to the following:

   ```sql
   SELECT * FROM RTD_B2C_CONTACT
   ```

   Make sure that you replace RTD_B2C_CONTACT with the correct view name.

5. Repeat Step 2 to Step 4 for each view that you want to create.

Creating and Populating OLAP Tables with History Data

Oracle Business Intelligence Server provides customer behavioral and aggregate metrics. If you use Oracle Business Intelligence Server, Siebel RTD can use this historical data to enrich the customer profile. Oracle Business Intelligence Server needs to stage the data in a custom OLAP table so that Siebel RTD can use JDBC to access the data.

This task assumes the following:

- You have installed Oracle Business Intelligence Server.
- Oracle Business Intelligence Server is running a Siebel 7.5.x, 7.7.x, or 7.8.x Analytics repository against the Siebel Relationship Management Warehouse.

This task is an optional step in Process of Configuring Siebel Business Applications for Siebel RTD on page 370.

To create and populate OLAP tables with history data

1. Connect to the Oracle Business Intelligence Server, as follows:
   a. Open a command prompt window.
   b. Change to the `siebel-analytics/bin` directory.
c Execute the following command:
   nQCmd.exe

d Type the data source name, and press Return.
e Type the administrator username, and press Return.
f Type the password and press Return.
g Type Q and press Return.

2 Open Windows Explorer and navigate to the installed inline service. For example, for SiebelB2C, navigate to \All\8.0\B2C.

3 Open the file SQL_ANALYTICS_SERVER.txt.

4 Execute each POPULATE statement in the file in the command prompt window where nQCmd.exe is running.

   Each POPULATE statement retrieves the result set as specified in the logical SQL, and inserts the result set into the RTD_SRVREQ_HIST table through the Data Warehouse Connection Pool.

   The following table lists the tables that are created.

<table>
<thead>
<tr>
<th>Application Type</th>
<th>Entity</th>
<th>OLAP Table</th>
<th>Sample of Data Provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>B2B B2C</td>
<td>Service Request</td>
<td>RTD_SRVREQ_HIST</td>
<td>Average Service Quality, Number of Critical SRs, Average SR Duration, Number of Open SRs</td>
</tr>
<tr>
<td></td>
<td>Order</td>
<td>RTD_ORDER_HIST</td>
<td>Percentage Change of Closed Orders in Last Quarter, Total Order Revenue, Number of Orders</td>
</tr>
<tr>
<td></td>
<td>Financial Account</td>
<td>RTD_FIN_ACCT_HIST</td>
<td>Number of Open and Closed Assets, Average Balance, Contact Revenue Range, Contact Profitability Range, Contact Balance Range</td>
</tr>
</tbody>
</table>

5 Use any SQL tool to connect to the SIEBEL_OLAP data source name, then verify that the tables exist and contain data.

Creating a Project for an Inline Service

Before you can deploy an inline service, you must first create a project in Siebel Decision Studio with the default inline service metadata folder. The metadata folder comes in a packaged zip file, which contains XML and Java files organized in a directory structure.

This task is a step in Process of Configuring Siebel Business Applications for Siebel RTD on page 370.
To create a project for an inline service

1. Create a new folder under \RTD\apps\ on your installation directory, for example, \RTD\apps\SiebelB2C.

2. Locate the metadata zip file for the inline service, for example, \ALL\8.0\B2C\SiebelB2C.zip.

3. Copy the zip file into the new folder, then unzip the file into the folder.

4. Start Siebel Decision Studio; that is, choose Program Files > Siebel Analytics > Siebel RTD > Siebel Decision Studio.

5. Choose File > New, then select Inline Service Project.

6. Type either SiebelB2B or SiebelB2C for the project name.

7. Select Create project from existing source, then enter the name of the directory you created in Step 1.

8. Click Finish.

When the project is created, the inline service metadata is displayed in Siebel Decision Studio. The inline service metadata includes predefined decisions, data sources, and integration points.

Deploying an Inline Service

Before you deploy an inline service, you must import the customer data sources. After you deploy an inline service, the RTD application is ready for use.

This task is a step in Process of Configuring Siebel Business Applications for Siebel RTD on page 370.

To deploy an inline service

1. Start Siebel Decision Studio; that is, choose Program Files > Siebel Analytics > Siebel RTD > Siebel Decision Studio.

2. Choose File > Open, then select the inline service you want to work with.

3. Expand the Data Sources folder, double-click Customer, then click Import.

4. Select the J2EE server that is running, then click Next.
5 Depending on the system response, perform the appropriate step as described in the following table.

<table>
<thead>
<tr>
<th>If ...</th>
<th>Then Perform These Tasks ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Siebel Decision Studio displays a list of tables and views with the correct view highlighted for the current data source.</td>
<td>Click Finish. You configured the JDBC data source correctly.</td>
</tr>
<tr>
<td>An error message is displayed.</td>
<td>Click Cancel. Discontinue this task, and check that the JDBC data sources were created correctly. For more information about creating JDBC data sources, see Creating JDBC Data Sources on page 374.</td>
</tr>
</tbody>
</table>

The inline service is now ready to be deployed to the server.

6 Choose File > Deploy.

7 Select the correct SiebelB2C or SiebelB2B project from the Project drop-down list.

8 Select Development from the Deployment State drop-down list.

9 Click Deploy.

   If the inline service is successfully deployed, a success message box is displayed. The RTD server is now ready to test.

**Customizing Call Reasons**

When a customer calls your business, your agents can record the reason for the call. Your agents record the reasons in the Activities applet in the Contact Summary (RTD) and Account Summary (RTD) views.

By default, a number of call reasons are included with Siebel Business Applications. You can customize the list of call reasons. You can deactivate the default call reasons, and add call reasons that are relevant to your business.

This task is a step in Process of Configuring Siebel Business Applications for Siebel RTD on page 370.

**To customize call reasons**

1 Navigate to the Administration - Data view > List of Values screen.

2 Query the list for the list-of-value types whose Type is TODO_TYPE and whose Parent LIC is Call - Inbound.

3 Deselect the Active check box for any of the call reasons that are not relevant to your business.

4 Add any list-of-value types that are specific to your business.
**Process of Setting Up Real-Time Offers**

To set up real-time offer generation and retention management, perform the following tasks:

1. **Defining the Campaign** on page 380
2. **Creating and Modifying Offers** on page 380
3. **Enabling Offers for RTD** on page 380
4. **Opening Decision Center for Editing** on page 381
5. **Specifying Eligibility for Offers** on page 381
6. **Updating Offer Information** on page 383
7. **Activating the Offers** on page 383

**Defining the Campaign**

In the Siebel Marketing application, offers are presented to customers in the context of marketing campaigns. Before you can implement RTD offers, you must create a campaign in Siebel Marketing. For information about how to create a campaign, see the *Siebel Marketing User Guide*.

This task is a step in **Process of Setting Up Real-Time Offers** on page 380.

**Creating and Modifying Offers**

Offers are a way to present incentives on products and services to current and potential customers as part of a campaign. Offers are presented to customers in the context of marketing campaigns.

Before you can implement RTD offers, you must create offers within a campaign in Siebel Marketing. Add the treatments that you require to the offers. For more information about offers and treatments, see the *Siebel Marketing User Guide*.

This task is a step in **Process of Setting Up Real-Time Offers** on page 380.

**Enabling Offers for RTD**

Before you can use an RTD offer, you must change some settings for the treatments associated with the offer.

This task is a step in **Process of Setting Up Real-Time Offers** on page 380.

*To enable an offer for RTD*

1. Navigate to the Offers screen > Phone Treatments list, or Offers screen > Web Treatments list.
2. Select the offer that you want to work with.
In the Treatments view, drill down on the treatment you want to work with. Alternatively, create a new treatment, then drill down on the new treatment.

On the treatment screen, click the Real-Time Details tab.

Select Enabled from the Stage drop-down list.

Select the group with which you want to associate the offer from the Offer Group drop-down list.

Select a campaign with which to associate the offer from the Campaign field, and click the Sync button.

### Opening Decision Center for Editing

Before you use Siebel RTD, you can update offer-related information. For example, you can specify offer eligibility rules. You make these changes in the Decision Center, but before you make the changes you must open the Decision Center for edit operations.

This task is a step in Process of Setting Up Real-Time Offers on page 380.

**To open Decision Center for edit operations**

1. Navigate to the Administration - Marketing screen > Decision Center view.
2. Click the Open button in the Decision Center view.
3. Select the inline service with which you want to work, and click OK.
4. Click the Perspective button, select the Design perspective, and then click OK.

### Specifying Eligibility for Offers

By default, all offers are eligible for all customers. You can set up rules, or groups of rules, to determine the eligibility of customers for an offer.

An **eligibility rule** is a relational expression which, when evaluated, determines the eligibility of a customer for an offer. For example, you can set up rules so that an offer is eligible only to customers over the age of 21 years, with a salary of more than $35,000. A **rule set** is a group of eligibility rules that you can apply as a unit.

This task is a step in Process of Setting Up Real-Time Offers on page 380.

**To specify eligibility rules for an offer**

1. Navigate to the Administration - Marketing screen > Decision Center view.
2. Open the Decision Center view for edit operations.
   - For information about how to open decision center for edit operations, see Opening Decision Center for Editing on page 381.
In the tree structure in the left pane, select the offer that you want to work with in Decision Process > Marketing Messages.

In the right pane, click the Definition tab, then click the Eligibility tab.

To add a rule, click the Add Rule toolbar button in the Eligibility tab view.

For more information about how to add a rule, see Adding Eligibility Rules on page 382.

To add a rule set, click the Add Rule Set toolbar button in the Eligibility tab view.

For more information about how to add a rule set, see Adding Eligibility Rules on page 382.

Click the Save toolbar button in the Eligibility tab view.

Adding Eligibility Rules

You can add rules, or groups of rules, to determine the eligibility of customers for an offer.

To add an eligibility rule

1. Click the Add Rule toolbar button in the Eligibility tab view.
   A blank rule is displayed.

2. Click the field on the left side of the blank rule, then click the selection button at the right side of the field.

3. Use the Edit value dialog box to select the attribute on which you want to base the rule.
   For example, to base the rule on the age of the customer, select Attribute in the Edit value dialog box, then use the tree structure to locate the customer age attribute in the session attributes tree.

4. Click the equal sign, then click the selection button at the right side of the field. Select an operator from the drop-down menu.
   For example, if the offer applies to customers over the age of 21, select the IS GREATER THAN OR EQUAL TO (>=) operator.

5. Click the field on the right side of the blank rule, then click the selection button at the right side of the field.

6. Use the Edit value dialog box to select the value against which you want to evaluate the attribute.
   For example, if the offer applies to customers over the age of 21, select the Constant option, then select Integer from the Data Type drop-down list. Type 21 in the Value text field.

   For more information about how to work with rules, see the Siebel Real-Time Decisions 2.1 Bookshelf.

To add a set of eligibility rules

1. Click the Add Rule Set toolbar button in the Eligibility tab view.
2. Click the field on the left side of the blank rule, then click the selection button at the right side of the field.

3. Use the Edit value dialog box to select the attribute on which you want to base the rule.

4. Click the equal sign, then click the selection button at the right side of the field. Select an operator from the drop-down menu.

5. Click the field on the right side of the blank rule, then click the selection button at the right side of the field.

6. Use the Edit value dialog box to select the value against which you want to evaluate the attribute. For more information about how to work with rule sets, see the Siebel Real-Time Decisions 2.1 Bookshelf.

**Updating Offer Information**

You can add and update information about each offer. For example, you can add and update a profit margin figure associated with an offer.

This task is a step in **Process of Setting Up Real-Time Offers on page 380**.

**To update offer information**

1. Navigate to the Administration - Marketing screen > Decision Center view.

2. Open the Decision Center view for edit operations. For information about how to open decision center for edit operations, see **Opening Decision Center for Editing on page 381**.

3. In the tree structure in the left pane, select the offer you want to work with in Decision Process > Marketing Messages > Intelligent Offers.

4. In the right pane, click the Configuration tab, then click the Attributes tab.

5. Enter the value for the offer attribute in the Value column in the Attributes tab view.

6. Click the Save button at the end of the table of attributes.

**Activating the Offers**

To make your changes to offers available, you must deploy the changes on an inline service. You can deploy the changes in either of the following ways:

- **Redeploy** the changes, that is, apply the changes to an existing service.

- **Promote** the changes, that is, deploy the changed inline service to a higher deployment state.

This task is a step in **Process of Setting Up Real-Time Offers on page 380**.

**To redeploy changes to offers**

1. Navigate to the Administration - Marketing screen > Decision Center view.
2 Open the Decision Center view in edit mode. For information about how to open decision center in edit mode, see Opening Decision Center for Editing on page 381.

3 Make changes to the required offers, as described in Process of Setting Up Real-Time Offers on page 380.

4 Click the Redeploy button.

5 If you want to continue to work with the current inline service, select the Keep the current inline service opened for editing check box.

6 Click OK.

To promote changes to offers

1 Navigate to the Administration - Marketing screen > Decision Center view.

2 Open the Decision Center view in edit mode. For information about how to open decision center in edit mode, see Opening Decision Center for Editing on page 381.

3 Make changes to the required offers, as described in Process of Setting Up Real-Time Offers on page 380.

4 Click the Promote button.

5 Select the deployment state to which you want to promote the inline service from the To deployment state drop-down list.

6 If you want to continue to work with the current inline service, select the Keep the current inline service opened for editing check box.

7 Click OK.

Viewing RTD Performance Reports

Siebel RTD includes reports that you can use to monitor the performance of RTD. Table 88 lists the reports that you can use.

Table 88. RTD Performance Reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
<th>To access, navigate to ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attrite Profile</td>
<td>Displays the combination of attribute values which are most likely to indicate a future churn event.</td>
<td>Administration - Marketing &gt; Attrite Profile</td>
</tr>
<tr>
<td>Cross Sell Offers</td>
<td>Displays an overview of how many customers express interest in offers, and make purchases based on offers.</td>
<td>Administration - Marketing &gt; Cross Sell Offers</td>
</tr>
</tbody>
</table>
Views for Call Center Agents

RTD for Siebel Call Center provides views that expose offer recommendations by RTD for use by call center agents. The content of these views varies, depending on your business model.

Table 89 lists the views that call center agents can use.

Table 89. Views for Call Center Agents

<table>
<thead>
<tr>
<th>View</th>
<th>To access, navigate to ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Summary (RTD)</td>
<td>Accounts &gt; Accounts List &gt; Account Summary (RTD)</td>
</tr>
<tr>
<td>Contact Summary (RTD)</td>
<td>Contacts &gt; Contacts List &gt; Contact Summary (RTD)</td>
</tr>
</tbody>
</table>
Sales professionals can track information about accounts, opportunities, and contacts using the Categories screen and associated views. This chapter describes how to use predefined categories to sort and search for specific criteria, and enter information that defines a personal sales approach and style. The information can be shared with other members of the sales team or kept private.

**NOTE:** The categories discussed in this chapter are not the same as the categories associated with Catalog administration which are used primarily for access control. For information about this other kind of category, see the *Siebel Order Management Guide*.

This chapter includes the following topics:

- “Scenario for Categories” on page 387
- “Adding a Category” on page 388
- “Searching by Category” on page 388

### Scenario for Categories

This scenario provides an example of a business process performed by a sales representative using the Categories screen and views. Your company may follow a different process according to its business requirements.

A sales representative wants to track information to help manage relationships with current and potential customers. Categories, which can be designated as private or shared with the sales team, provide the sales representative with a way to organize information about an account, opportunity, or contact.

The sales representative can track the most active accounts by creating a category called Hot Accounts, and then select that category for each account that she wants to add to her active list.

The sales representative also can view a list of all the opportunities she has closed over a period of time. If she sets up a Closed category, she can see which opportunities she has closed during the previous year.

Sales professionals also can use categories to track personal information about contacts. For instance, a sales representative can record hobbies, such as golf or tennis, and designate that category for contacts she plans to invite to her company-sponsored sporting events. In addition, she can track family names or add contacts to a category called Holiday List that allows her to create a seasonal mailing list.
Adding a Category

You can add categories to accounts, contacts, and opportunities. The procedure that follows explains how to add a category for accounts. You can add a category for contacts or opportunities by navigating to the appropriate screen.

To add an account category

1. Navigate to the Accounts screen > Accounts List > Categories view.
2. Query the list for the account to which you want to add a category.
3. In the Categories list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Choose an existing category or create a new one.</td>
</tr>
<tr>
<td>Category Rank</td>
<td>A value that defines the category. The rank can be any numeric value.</td>
</tr>
<tr>
<td>Private</td>
<td>A check box which, when selected, restricts sales team members from seeing how you have categorized the account. When the check box is selected, the category is private. Clear the check box to designate the category as Public allowing access by team members.</td>
</tr>
<tr>
<td>Value</td>
<td>The value assigned to the category. Create new values as required.</td>
</tr>
</tbody>
</table>

Searching by Category

You can use the categories you and your team have defined to search for specific accounts, opportunities, and contacts.

To search by category

1. Navigate to the Category screen, then select the view that relates to the information that you require from the link bar.

   For example, if you want to find the accounts associated with a particular category, select the Account Categories view.

2. Use the categories list to select the category on which you want to search.

3. In the categories list, click Go.

   The accounts, opportunities, or contacts associated with the category are listed in the categories list.
In competitive sales situations, it is imperative for the sales representative to have information about competitors to strengthen his sales strategy and differentiate his company’s image and offerings.

This chapter describes how to use the Competitors screen to examine comparisons of your company and competitors, view comparative literature of your products and those of your competitors, and associate a competitor with an opportunity.

This chapter includes the following topics:

- “Scenario for Competitors” on page 389
- “Associating a Competitor with an Opportunity” on page 389
- “Viewing Competitor Comparisons” on page 390

**Scenario for Competitors**

This scenario provides an example of a business process performed by a sales representative using the competitors view. Your company may follow a different process according to its business requirements.

A sales representative logs into the Siebel Sales application and discovers a newly qualified opportunity. He navigates to the Competitors view to review the competition for the opportunity. One competitor is listed for the deal. The sales representative is not familiar with the company and drills down on the competitor name hyperlink to learn more.

In the Company Comparisons view, the representative can view a side-by-side comparison of his company and the competitor’s company as well as comparison of products. He can access competitive intelligence documents compiled by his company about this competitor, and the literature items that the competitor has published.

A colleague in Telesales calls the sales representative and indicates that there is a new competitor trying to win the deal. The sales representative adds the new competitor to the opportunity to allow the sales team to research the new competition.

**Associating a Competitor with an Opportunity**

Associating a competitor with an opportunity notifies the sales team about the competition for the deal and provides the team with a link to the information it needs to deliver a consistent, winning sales strategy.
To associate a competitor with an opportunity

1. Navigate to the Opportunities screen > List view > Competitors view.
2. Select the opportunity record to which you want to add a competitor.
3. In the Competitors list, create a new record, and complete the necessary fields.

   **TIP:** Drill down on the hyperlink in the competitor Name field to navigate to the Competitors screen to obtain more information.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comments</td>
<td>A text field that allows you to record additional information about the competitor.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the competitor’s company name as a hyperlink.</td>
</tr>
<tr>
<td>Primary</td>
<td>A check box which, when selected, indicates that the competitor is the primary rival for the deal.</td>
</tr>
<tr>
<td>Status</td>
<td>A list of values established by your company that allows you to specify the prospect’s interest level in the competitor’s offerings. Default values include Some Interest, Evaluation in Progress, Existing Relationship, and Not Satisfied.</td>
</tr>
<tr>
<td>Threat</td>
<td>A list of values established by your company that allows you to specify the value of the competitor’s threat. Default values include 1-Low, 2-Medium, 3-High, 4-Very High.</td>
</tr>
</tbody>
</table>

Viewing Competitor Comparisons

In many sales situations it is necessary to discuss competitive information with a prospect. Using the Competitors screen, you can view comparisons about companies, products, and services, and also find literature to prepare for sales calls.

To view competitor comparisons

1. Navigate to the Competitors screen > Competitor List view.
2. Drill down on a competitor record.
3. Click the Company Comparisons view tab.

   The Company Comparisons, Competitor’s Literature, and Comparative Literature lists appear.
4. In the Competitor’s Literature list, select the literature item you want to view, and then drill down on the hyperlink in the Name field.
5. In the Comparative Literature list, select the literature item you want to view, and then drill down on the hyperlink in the Name field.
This chapter is about the Siebel Signature Capture control feature. It includes the following topics:

- About Siebel Signature Capture Controls on page 391
- Scenario for Signature Capture on page 392
- Roadmap for Implementing Signature Capture on page 392
- Extending the Database for a Signature Capture Control on page 392
- Registering the OCX File on page 393
- Creating the Object and Class for Signature Capture on page 394
- Process of Creating the Applet for Signature Capture on page 395
- Compiling the SRF on page 403
- Testing the Signature Capture Applet on page 403
- Generating Reports That Contain Signatures on page 404

**About Siebel Signature Capture Controls**

You can configure custom views that allow your Siebel Business Applications to capture signatures. The Siebel Signature Capture control provides properties and methods that you can use in Siebel Tools or Siebel Scripting to do the following:

- Allow users to write signatures on a suitable device.
- Save signatures into Siebel tables.
- Retrieve and view previously captured signatures.
- Clear a signature from the signature control.

This chapter provides guidelines and illustrated examples of how to use the Signature Capture control object in Siebel Business Applications. The example configuration and scripts provided in this chapter are examples only. Do not consider the examples to be complete code, or an implementation strategy.

Siebel Life Sciences includes a prebuilt Signature Capture for Samples Management feature. No configuration is required for this feature. For more information about this feature, see the *Siebel Life Sciences Guide*.

For more information about how to configure and develop Siebel Business applications, see *Configuring Siebel Business Applications* and *Siebel Developer’s Reference*. 
Scenario for Signature Capture

This topic gives one example of how you might use the signature capture control. You might use the signature capture control differently, depending on your business model.

A sales manager decides to require electronic signatures from customers for new orders. The sales manager requests the Siebel administrator to implement this new functionality.

The Siebel administrator begins to plan to implement the new functionality, and considers the following:

- All usage scenarios and business processes where signature capture is required.
- Any legal and privacy issues that arise from capturing the signatures of users.
- Any issues that arise from the storage of signature data, and the security and encryption of the signature data.

The Siebel administrator contacts the Siebel product representative to make the appropriate license arrangements to use Siebel Signature Capture control. The Siebel administrator also makes sure that the appropriate hardware to capture signatures is available, for example, touch screens.

The Siebel administrator decides to create applets that can save and display signatures, and to implement a function that allows users to clear a signature from the signature capture control. The Siebel administrator then develops the applets and integrates them with views in the Siebel application. The customers for the business can now use touch screens to sign for an order when they make the order.

Roadmap for Implementing Signature Capture

To implement a signature capture control in your application, perform the following processes and tasks:

1. Extending the Database for a Signature Capture Control on page 392
2. Registering the OCX File on page 393
3. Creating the Object and Class for Signature Capture on page 394
4. Process of Creating the Applet for Signature Capture on page 395
5. Compiling the SRF on page 403
6. Testing the Signature Capture Applet on page 403

Extending the Database for a Signature Capture Control

Before you can implement a signature capture control, you must extend the database to create a field in which to store the signature data.
This task is a step in Roadmap for Implementing Signature Capture on page 392.

**To extend the database**

1. In Siebel Tools, open the project in which you want to implement the signature capture control.
2. Select the table that supports the business component to which you want to add the signature capture control.
3. Add an extension column of type LONG to the table.
   
   For more information about how to add a LONG column, see Configuring Siebel Business Applications.
4. To apply the new column, click the Apply/DDL button in the Object List Editor.
5. To activate the new column, click the Activate button.
   
   For more information about how to apply and activate database extensions, see Configuring Siebel Business Applications.
6. Create a new field in the business component that is supported by the table that you selected in Step 2.
   
   For example, create a field called AA Signature.
7. Map the field to the column that you added in Step 3.

**Registering the OCX File**

The file cicink.ocx contains the Ink Capture and Display ActiveX control. You must extract the file cicink.ocx from the file iTools.cab, then register the file on the system that hosts Siebel Tools.

This task is a step in Roadmap for Implementing Signature Capture on page 392.

**To register the OCX file**

1. Check that the file iTools.cab is present on the system that hosts Siebel Tools.
2. If iTools.cab is not present, copy the file to the system from one of the following locations:
   
   - `drive_letter:\SWEApp\PUBLIC\language\build_number\applets`. For example, D:\SWEApp\PUBLIC\enu\19213\applets.
   - `drive_letter:\siebsrvr\WEBMASTER\build_number\applets`. For example, D:\siebsrvr\WEBMASTER\19213\applets.
   - `drive_letter:\client\PUBLIC\language\build_number\APPLETS`. For example, D:\client\PUBLIC\enu\19213\APPLETS.
3. Decompress the iTools.cab file, then extract the cicink.ocx file from the file.
4. In a Windows command prompt, change directory to the directory where the cicink.ocx file is located.
5. To register the file, run the following command:
Creating the Object and Class for Signature Capture

Use Siebel Tools to create a DLL object, then create a class that refers to the DLL object. Controls on the signature control applet can refer to this class. Before you create these items, you must find particular information from the file iToolsMFC.inf.

This task is a step in Roadmap for Implementing Signature Capture on page 392.

To create a DLL object and class for signature capture

1. Extract the file iToolsMFC.inf from the file iTools.cab.
2. In a text editor, search the file iToolsMFC.inf for the section [cicink.ocx].
3. Note the following information from the section [cicink.ocx], in the iToolsMFC.inf file.

<table>
<thead>
<tr>
<th>Property Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class ID</td>
<td>This value is contained in the clsid entry. The following is a sample clsid entry: clsid={EFB7D763-97A3-11CF-AE19-00608CEADE00}</td>
</tr>
<tr>
<td>Filename and version number</td>
<td>This value is contained in the File Version entry. The following is a sample File Version entry: FileVersion=2,60,0,1331</td>
</tr>
</tbody>
</table>

4. In Siebel Tools, create a new DLL object.
5. Enter the Code or Class Id property value for the DLL object, based on the Class ID from the iToolsMFC.inf file.

Use the following syntax to enter the class ID string as the Code or Class Id property value:

```
classid: number_from_clsid_section
```

The following is a sample Code or Class Id property value:

```
classid: EFB7D763-97A3-11CF-AE19-00608CEADE00
```

**NOTE:** Omit the curly braces ({} ) that are present in the clsid entry in the iToolsMFC.inf file from the string that you enter as the Code or Class Id property value.

6. Enter the File Name property for the DLL object, based on the filename and version number from the iToolsMFC.inf file.

Use the following syntax to enter the filename and version number string as the File Name property value as follows:
Process of Creating the Applet for Signature Capture

To create an applet that can capture a signature, you must perform the following tasks:

1. Creating a Form Applet on page 395
2. Creating a Control on the Applet on page 396
3. Creating a Hidden Control on the Applet on page 396
4. Creating Buttons for Saving and Clearing Signatures on page 397
5. Adding Server Script to the Applet on page 397
6. Adding Browser Script to the Applet on page 398
7. Adding the Applet to an Object on page 402

This process is a step in Roadmap for Implementing Signature Capture on page 392.

Creating a Form Applet

You must create a form applet into which you can insert the controls to handle the capture and storage of the signature.

This task is a step in Process of Creating the Applet for Signature Capture on page 395.

To create a new form applet

1. In Siebel Tools, select File > New Object menu item, then select Form Applet.

   For more information about how to create applets and form applets, see Using Siebel Tools and Configuring Siebel Business Applications.

2. In the wizard, select the project, name, and business component for the applet.
3. Select the Use Grid Layout check box.
4. Select Edit Mode for the applet.
Choose the fields and controls that you want on the applet.

**NOTE:** Do not select the AASignature control at this point.

Click Finish to create the applet.

**Creating a Control on the Applet**

You must create an ActiveX control on the applet, and assign a class to the control.

This task is a step in *Process of Creating the Applet for Signature Capture on page 395.*

*To create a control on an applet*

1. In Siebel Tools, right-click the applet object you created in *Creating a Form Applet on page 395,* then choose Edit Web Layout.
2. Drag the ActiveX control from the Palettes window to the applet canvas.
3. Select the CIC Ink control from the Insert ActiveX Control dialog box, then click OK.
   **TIP:** If the CIC Ink ActiveX control does not appear in the list on the dialog box, make sure that you have registered the cicink.ocx file on the system that hosts Siebel Tools. For more information about how to register the cicink.ocx file, see *Registering the OCX File on page 393.*
4. Enter a value in the Name property of the control.
   For example, enter the name CICInk.
5. Set the Class property of the control to the class that you created in *Creating the Object and Class for Signature Capture on page 394.*

**Creating a Hidden Control on the Applet**

You must create a hidden control on the applet, and set the Field property for the control.

This task is a step in *Process of Creating the Applet for Signature Capture on page 395.*

*To create a hidden control*

1. In Siebel Tools, right-click the applet object you created in *Creating a Form Applet on page 395,* then choose Edit Web Layout.
2. Drag the Hidden control from the Palettes window to the applet canvas.
3 Set the Field property of the control to the name of the field that you created in Extending the Database for a Signature Capture Control on page 392.

For example, set the Field property of the control to AA Signature.

**NOTE:** This setting enables the browser script to access the field when the script sets and clears the controls.

4 Choose File > Save.

### Creating Buttons for Saving and Clearing Signatures

You must add buttons to the applet, add labels to the buttons, and associate methods with the buttons.

This task is a step in Process of Creating the Applet for Signature Capture on page 395.

To create buttons for saving and clearing signatures

1 In Siebel Tools, drag the Button control from the Palettes window to the applet canvas.

2 Enter a value in the Caption - String Override property of the control.

   For example, change the name to Store Signature.

3 Set the Method Invoked property of the control.

   Set this property to the custom method that you implement in the browser script to save the signature to the business component. For example, set the Method Invoked property to StoreSignature.

   For more information about how to implement browser script for signature capture, see "Adding Browser Script to the Applet" on page 398.

4 Drag the Button control from the Palettes window to the applet canvas.

5 Enter a value in the Caption - String Override property of the control.

   For example, set the property to Clear Signature.

6 Set the Method Invoked property of the control.

   Set this property to the custom method that you implement in the browser script to delete the signature from the business component. For example, set the Method Invoked property to ClearInk.

7 Choose File > Save.

### Adding Server Script to the Applet

In Creating Buttons for Saving and Clearing Signatures on page 397, you specified methods for the buttons you created. You must add server script to the applet to allow the methods to be called; that is, the server script enables the buttons to function.
This task is a step in Process of Creating the Applet for Signature Capture on page 395.

**To add server script to the applet**

1. In Siebel Tools, right-click the applet object, then choose Edit Server Scripts.
2. Select the WebApplet_PreCanInvokeMethod event.
3. Write the script to enable the custom methods that are called from the buttons created in Creating Buttons for Saving and Clearing Signatures on page 397.

   For example, you might write server script similar to the following example:

   ```javascript
   function WebApplet_PreCanInvokeMethod (MethodName, &CanInvoke)
   {
     if (MethodName=="StoreSignature" || MethodName=="ClearInk")
     {
       CanInvoke="TRUE";
       return (CancelOperation);
     }
     else
     {
       return (ContinueOperation);
     }
   } 
   ```


**Adding Browser Script to the Applet**

To access the ActiveX control, and to execute methods as required, you must add browser script to the applet.

This task is a step in Process of Creating the Applet for Signature Capture on page 395.

**To add browser script to the applet**

1. In Siebel Tools, right-click the applet object, then choose Edit Browser Scripts.
2. Write the script to perform the following functions:
   - Populate the signature capture control with the data already stored in the business component.
Enable the custom methods that are called from the buttons created in Creating Buttons for Saving and Clearing Signatures on page 397.

For examples of scripts for events to perform these functions, see the following:

- Example Applet_Load Event on page 399
- Example Applet_ChangeRecord Event on page 399
- Example Applet_PreInvokeMethod Event on page 400

Choose File > Save.

Example Applet_Load Event

The following example code retrieves the data for the current record, and displays the data in the signature control applet when the applet is loaded.

```javascript
function Applet_Load ()
{
    //when the applet loads check the BC field value
    //and use it to set the signature control value
    //control is clear by default so no call to clear here
    var inPS;
    var iResult;
    var sigVal;
    inPS = TheApplication().NewPropertySet();
    sigVal = this.BusComp().GetFieldValue("AA Signature");
    if (sigVal.length >1)
    {
        inPS.SetProperty("InkVal", sigVal);
        iResult = this.InvokeMethod("SetInk", inPS);
    }
}
```

Example Applet_ChangeRecord Event

The following example code updates the data in the signature capture control when that data changes, for example, when a new record is selected.

```javascript
function Applet_ChangeRecord ()
```
Signature Capture ■ Process of Creating the Applet for Signature Capture

```javascript
{
  // when the BC record changes then check the BC field value
  // and use it to set the signature control value
  // or clear the signature control value
  var inPS;
  var iResult;
  var sigVal;
  inPS = TheApplication().NewPropertySet();
  sigVal = this.BusComp().GetFieldValue("AA Signature");
  if (sigVal.length > 1)
  {
    inPS.SetProperty("InkVal", sigVal);
    iResult = this.InvokeMethod("SetInk", inPS);
  }
  else
  {
    iResult = this.InvokeMethod("ClearInk", inPS);
  }
  inPS = null;
}
```

**Example Applet_PreInvokeMethod Event**
The following example code manages the logic for the buttons and for the other scripts.

```javascript
function Applet_PreInvokeMethod (name, inputPropSet)
{
  if (name == "StoreSignature")
  {
    // code to store signature value
    var myOcx;
    // get the signature aX control
    ```
try {
    myOcx = this.FindActiveXControl("CICInk");
}
catch (e) {
    alert ("the error is "+ e.toString());
    alert ("the message is "+e.message);
}
// code to get the value in the control
// and then write it in the BC field
var lnInk;
var objBC;
lnInk = myOcx.Ink();
objBC = this.BusComp();
objBC.SetFieldValue("AA Signature", lnInk.toString());
objBC.WriteRecord();
return ("Cancel Operation");
}
else
if (name == "ClearInk")
{
    // code to clear the signature control value
    var axCntl;
    axCntl = this.FindActiveXControl("CICInk");
    axCntl.ClearInk();
    return ("Cancel Operation");
}
else
if (name == "SetInk")
{
    // code to set the signature control value
// InkVal comes from applet_load and applet_changerecord

var strInk;
var axCntl2;
strInk = inputPropSet.GetProperty("InkVal");
axCntl2 = this.FindActiveXControl("CICInk");
try {
    axCntl2.Ink(strInk);
}
catch (e) {
    alert("the error is "+e.toString());
    alert("the message is "+e.message);
}
return("CancelOperation");
} else {
    return("ContinueOperation");
}

Adding the Applet to an Object

You must add the applet that you have developed to an object to which you want to add the signature capture control. You can add an applet with a signature capture control to the following objects:

- Views
- Form applets

This task is a step in Process of Creating the Applet for Signature Capture on page 395.

To add the applet to an object

1. In Siebel Tools, select the appropriate object in the object explorer, then find the required view or form applet.
2. Lock the project for the object.
3 Right-click the object, then select Edit Web Layout.
4 In the Applets window, select the applet you created in Creating a Form Applet on page 395.
5 Drag the applet to the required area in the Web layout.
   For example, drag the applet to the Child Applet or Grandchild Applet section of the view Web layout.
6 Choose File > Save.
7 Select the view Web layout window, then choose File > Close.

Compiling the SRF
You must compile the changes you have made into the SRF.
This task is a step in Roadmap for Implementing Signature Capture on page 392.

To compile the SRF
1 In Siebel Tools, select the locked projects that contain the table, class, DLL, business component, applet, and view.
2 Compile the selected items into the SRF that is used by the application.
3 Make sure that you generate browser script as part of the compile process.
   For more information about how to generate browser script as part of the compilation process, see Configuring Siebel Business Applications.

Testing the Signature Capture Applet
After you develop and compile the applet with a signature capture control, you must test the feature.
This task is a step in Roadmap for Implementing Signature Capture on page 392.

To test the Signature Capture applet
1 Open an application that exposes the view to which you added the applet in Adding the Applet to an Object on page 402.
2 Navigate to the view that contains the applet.
3 Perform the following tests:
   a Use a touch screen or a mouse to sign in the signature capture control.
   b Click the Store Signature button to save the signature in the appropriate record.
   c Click the Clear Signature button to clear the signature in the control.
Generating Reports That Contain Signatures

An ActiveX control is used to capture and display the signature of the user. The ActiveX control converts the signature to a long string of numbers, and the string is stored in the database. If you want to display a signature in a report, you must use a Java object.

To display signatures in reports

1. Make sure that the report server is configured correctly, as follows:
   - Check that the server has the correct version of Sun Java Runtime. For more information about which is the correct version, see Siebel System Requirements and Supported Platforms on Oracle Technology Network.
   - Copy the files InkToolsLib.jar and iSignBmp.jar to `drive_letter:\Program Files\Java\version_number\lib\ext`. For example, if the report server uses Sun Java Runtime 1.4.2, you might copy the files to `C:\Program Files\Java\j2re1.4.2_04`.
   - Add both of the files InkToolsLib.jar and iSignBmp.jar to the CLASSPATH environment variable. Include the full path to both files, for example, `C:\Program Files\Java\j2re1.4.2_04\InkToolsLib.jar`.

2. Restart the report server.

3. Locate the source files for the Siebel Life Sciences Signature Capture Audit Report, which is supplied with your Siebel application.

   The names of the source files are as follows:
   - LS_SIGNAD.rox
   - LS_SIGNAD.rod

   The report references a Java object to convert the signature into an image file. This image file is saved into a temporary file path that the report creates, and then the image is added to the report at run time.

   This Java object is supported by a Java class which is supplied with your Siebel application. The file that contains the class is iSignBmp.jar. You can find this file in the same location as the file LS_SIGNAD.rox.

4. Review the techniques used in the Siebel Life Sciences Signature Capture Audit Report, and apply the techniques to your signature report.
36 Decision Issues

Decision issues are specific areas of interest that can influence a prospect’s buying decision. Customers and prospective customers may ask questions and express concerns about the solutions you propose, and your company in general, during the sales cycle. Decision issues provide you with an opportunity to develop a sales strategy and address customer concerns.

This chapter describes how to use the Decision Issues view to associate customer questions and concerns with an opportunity. Decision issues are the criteria a prospective customer uses to evaluate a potential supplier and product before making a decision to buy. It includes the following topics:

- “Scenario for Decision Issues” on page 405
- “Creating Decision Issues” on page 405
- “ Associating Decision Issues with an Opportunity (End User)” on page 406
- “Adding Decision Issues Details (End User)” on page 406

Scenario for Decision Issues

This scenario provides an example of a business process performed by a sales representative using decision issues. Your company may follow a different process according to its business requirements.

A sales representative logs into the Siebel Sales application and discovers a new opportunity for a software module his company sells. The 2,500-seat opportunity has been qualified by a colleague in the Telesales department, and the sales representative wants to move forward with the opportunity. The sales representative reviews the list of contacts, and then calls the main prospect to introduce himself and gather some initial requirements. Based on this conversation, the sales representative adds two new decision issues which are important to this prospect—customer references and search engines in the software.

Creating Decision Issues

Typically the administrator sets up the list of decision issues. End users associate these decision issues with other records, but cannot edit the decision issue text.

To create a decision issue record

1. Navigate to the Administration - Data screen > Decision Issues view.
2. Create a new record, and complete the necessary fields.
Associating Decision Issues with an Opportunity (End User)

After you qualify an opportunity, you can associate the related decision issues with the opportunity and rank the decision issues in order of importance to the prospect.

To associate a decision issue with an opportunity
1. Navigate to the Opportunities screen > List view.
2. Drill down on an opportunity record associated with the decision issue.
3. Click the Decision Issues view tab.
4. In the Decision Issues list, create a new record, and complete the necessary fields.

NOTE: Your application administrator enters decision issue data that has been defined in your company. For more information, see your application administrator.

Adding Decision Issues Details (End User)

After associating a decision issue with an opportunity, drill down on the decision issue name hyperlink to access associated views. These views, shown in Figure 16, allow you to enter details that help you position your company’s offerings around the selected issue. By clicking a view tab you can specify related issues, associate literature, and attach files to the decision issue.

Figure 16. Decision Issues Details View
To add decision issue details
1. Create a Decision Issue associated with an opportunity as detailed in "To associate a decision issue with an opportunity" on page 406.
2. In the Decision Issues list, drill down on the hyperlink in the Decision Issue field.
   The selected decision issue read-only form appears with subview tabs, Related Issues, Literature, and Attachments, as shown in Figure 16.

To add related issues
1. Click the Related Issues view tab, and then click Query.
2. In the Related Issues query form, enter the query information, and then click Go.

To associate literature with the decision issue
1. Click the Literature view tab, and then click Query.
2. In the Literature query form enter the query information, and then click Go.
   Select the Auto Update check box if you want to update associated literature when source literature files are updated.

To associate attachments with the decision issue
1. Click the Attachments view tab, and then click Query.
2. In the query form, click the select button in the Attachment Name field.
3. In the Add Attachment dialog box, specify a file name or URL, and then click Add.
   In the Add Attachment dialog box, click Browse to navigate to the file you want to attach.
Decision Issues ■ Adding Decision Issues Details (End User)
This chapter describes how a sales professional can use Siebel Enterprise Selling Process (ESP) methodology from Siebel MultiChannel Services to penetrate, cover, and grow large strategic accounts—especially global accounts.

This chapter includes the following topics:

- “About Enterprise Selling Process” on page 409
- “Using ESP Methodology to Manage Accounts” on page 410
- “Scenario for Enterprise Selling Process” on page 410
- “Process of Enterprise Selling” on page 411
- “Adding ESP Business Unit and Service Unit Information” on page 412
- “Adding ESP Business and Service Unit Offerings” on page 413
- “Conducting an ESP Organizational Analysis” on page 415
- “Charting the Organization’s Reporting Structure” on page 416
- “Adding Partners for ESP Analysis” on page 418
- “Viewing the BU/SU Offering Summary” on page 419
- “Adding ESP Objectives” on page 419
- “Adding ESP Account Plan Highlights” on page 420
- “Viewing an ESP Manager’s Review” on page 421
- “Generating ESP Account Plan and Account Map Reports” on page 421

About Enterprise Selling Process

Enterprise Selling Process is a separately licensed module that integrates with the Siebel Sales application.

The ESP module helps sales professionals identify the customer’s business drivers and initiatives, uncover opportunities in key business and service units, develop global account strategies, manage key executive and partner relationships, and coordinate team activities.

The ESP module is designed to support users who are already familiar with the ESP methodology, based on the learning programs offered by Siebel MultiChannel Services. Users should first complete an initial account analysis to select the units, opportunities, and partners, using the tools provided in the ESP workshop. After the analysis, the business units, opportunities, and partners are entered and tracked using the Siebel ESP module.
Using ESP Methodology to Manage Accounts

Siebel Enterprise Selling Process (ESP) software provides support for the Enterprise Selling Process methodology from Siebel MultiChannel Services. The software module allows account teams to better make use of the ESP account management methodology to penetrate, cover, and grow large strategic accounts—especially global accounts. Using the software, sales professionals can be more effective at identifying the customer's business drivers and initiatives, uncovering opportunities in key business and service units, developing global account strategies, managing key executive and partner relationships, and coordinating team activities.

The Siebel Enterprise Selling Process software module provides the following features:

- Support for the Enterprise Selling Process methodology
- An overview of Account Plan Highlights, such as the goal, the value proposition, and the critical success factors for driving business in the account
- A set of objectives for driving business in the account and an action plan for achieving each objective
- Analysis of the offerings that address each business and service unit's needs, along with the associated revenue from Installed Base, Current, and Potential Opportunities
- Automatic creation of an organization chart that visually shows an analysis of key players and their relationships
- Automatic creation of ESP reports including the Account Map and Account Plan

Scenario for Enterprise Selling Process

This scenario provides an example of the business process performed by a sales manager using the ESP methodology. Your company may follow a different process according to its business requirements.

An account manager has completed the ESP methodology workshop. At the end of the workshop, she develops a plan for her account. She plans to use the ESP software module to enter her account plan information to share with her team, and to track performance over the next several quarters against the plan.

The account manager begins by launching Siebel Sales and navigating to the Accounts screen. She selects the targeted account from the list of accounts, and then moves to the Enterprise Selling Process view to begin her account analysis.

First, the account manager enters the account's business and service units and key information about each unit such as the unit's culture, her company's level of relationship with the unit, and the strategy she plans to apply to the unit. This provides her team with important sales information about each unit that sales team members plan to contact.
Then, the account manager enters information about the potential, current, and installed base opportunities by offering for each unit. This information helps the team understand where they have coverage and penetration in each unit and with which offerings. After the account's units and opportunities are mapped, the account manager analyzes the organizational structure within the account. The account manager defines both the formal and informal organizational structures and determines who is important within the account and whom the team needs to spend more time with to close the identified opportunities.

The account manager continues by analyzing the partners involved with this account so she can identify and use partnership capabilities within the key business and service units. The manager enters her value proposition, goal, critical success factors and objectives for the account based on her analysis. She then enters activities that are necessary to meet each objective, and assigns objectives to the appropriate team member. This allows the account manager to coordinate with her team in a goal-oriented fashion.

When the account manager is ready to share her Account Plan, she runs the report and emails it to her team and manager. Her manager can also review the report online and enter her comments in the Manager’s Review form.

Process of Enterprise Selling

The Enterprise Selling Process (ESP) module consists of eight views. Information provided in these views comprises the overall account plan. The ESP Account Plan and the ESP Account Map reports can be automatically generated from the ESP module.

The procedures associated with the eight ESP views describe how to use the Enterprise Selling Process module.

1. "Adding ESP Business Unit and Service Unit Information" on page 412
2. "Adding ESP Business and Service Unit Offerings" on page 413
3. "Conducting an ESP Organizational Analysis” on page 415 and “Charting the Organization’s Reporting Structure” on page 416 (Organizational Analysis)
4. "Adding Partners for ESP Analysis” on page 418
5. "Viewing the BU/SU Offering Summary” on page 419
6. "Adding ESP Objectives” on page 419
7. "Adding ESP Account Plan Highlights” on page 420
8. "Viewing an ESP Manager’s Review” on page 421
9. "Generating ESP Account Plan and Account Map Reports” on page 421
Adding ESP Business Unit and Service Unit Information

The Business Unit and Service Unit (BU/SU) Overview helps you segment the account into more manageable business and service units. Each business or service unit in your account has different characteristics that affect your ability to sell into the unit. This view helps you profile each unit to determine these characteristics. It also helps you to make decisions about where to apply your resources and how to successfully integrate into the organization.

To add BU/SU overview information

1. Navigate to the Accounts screen > Accounts List view.
2. Drill down on an account record.
3. Click the Enterprise Selling Process view tab.
4. In the lower link bar, click BU/SU Overview.
5. In the list, create a new record, enter a name for the business or service unit, and then complete the fields.

The following table describes the fields in the BU/SU Overview record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Culture</td>
<td>A list of values that defines the culture (sales environment and sales approach) favored by the business or service unit. Examples are Entrepreneurial, Individualistic, Bureaucratic, and Collaborative.</td>
</tr>
<tr>
<td>Strategy Type</td>
<td>A list of values that defines your strategy to penetrate, cover and grow the relationship with the business or service unit. The values are Create, Exit, Expand, Protect, and Pursue.</td>
</tr>
<tr>
<td>Initiatives</td>
<td>A text field that allows you describe the initiatives on which you plan to focus for the business or service unit. Example are improve ROI by 10% and increase customer satisfaction.</td>
</tr>
<tr>
<td>Level of Relationship</td>
<td>Your company’s perception of its relationship with the business or service unit. Examples are Problem Solver, Trusted Advisor, and Credible Source.</td>
</tr>
<tr>
<td>Marketing</td>
<td>Enter information in this text field about an existing marketing campaign or new marketing campaign that you want to apply or develop for this business or service unit.</td>
</tr>
</tbody>
</table>

6. Repeat Step 5 for each Business or Service Unit in the account.

NOTE: If you are using ESP to analyze an account that has associated child accounts, the child accounts automatically appear in the BU/SU Overview list.
Adding ESP Business and Service Unit Offerings

The Offerings view helps sales professionals to identify opportunities to sell their offerings (products and services) into key business or service units in the account. The sales professional can use this view to maintain a balance of current and future revenue in the account. It also helps to identify opportunities for greater account penetration.

To add offerings
1. Navigate to the Accounts screen > Accounts List view.
2. Drill down on an account record.
3. Click the Enterprise Selling Process view tab.
4. In the lower link bar, click BU/SU Overview.
5. In the Business/Service Unit field, drill down on the hyperlink of the unit to which you want to add offerings.

The name of the unit you drilled down on appears in the Account form at the top of the screen. The Offerings view is displayed. To add offerings, the Account Type must be ESP BSU. When the Account Type is set to ESP BSU, the New button is inactive in the BU/SU Overview view and in the Objectives view. This behavior is controlled by the business component user property Parent Read Only Field.
In the Offerings list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Potential Oppty Name</td>
<td>A Potential Opportunity has long-term revenue implications and ties to the customer's business initiative. The opportunity may or may not occur and may be classified as unqualified. Click the select button in this field to add existing opportunities, or to create new opportunities.</td>
</tr>
<tr>
<td>Potential Oppty Revenue</td>
<td>The revenue classified as Potential that is associated with the opportunity.</td>
</tr>
<tr>
<td>Current Oppty Name</td>
<td>A Current Opportunity is in the sales cycle and has a significant associated revenue or market value. The opportunity can be the result of a new or installed business. Click the select button in this field to add existing opportunities, or to create new opportunities.</td>
</tr>
<tr>
<td>Current Oppty Revenue</td>
<td>The revenue classified as Current that is associated with the opportunity.</td>
</tr>
<tr>
<td>Install Base Name</td>
<td>An Installed Base opportunity can be categorized in one or more of the following groups.</td>
</tr>
<tr>
<td></td>
<td>■ Servicing and maintaining</td>
</tr>
<tr>
<td></td>
<td>■ Upgrades, add-ons</td>
</tr>
<tr>
<td></td>
<td>■ Contract extensions</td>
</tr>
<tr>
<td></td>
<td>■ Non-competitive</td>
</tr>
<tr>
<td></td>
<td>Click the select button in this field to add existing opportunities or to create new opportunities.</td>
</tr>
<tr>
<td>Install Base Revenue</td>
<td>The revenue classified as Install Base that is associated with the opportunity.</td>
</tr>
<tr>
<td>Value to Customer</td>
<td>Choose a numeric value to indicate your assessment of how critical the initiative is to the enterprise's overall strategy.</td>
</tr>
<tr>
<td>Value to Us</td>
<td>Choose a numeric value after evaluating the following factors.</td>
</tr>
<tr>
<td></td>
<td>■ Short-term revenue potential</td>
</tr>
<tr>
<td></td>
<td>■ Future revenue potential</td>
</tr>
<tr>
<td></td>
<td>■ Profitability</td>
</tr>
<tr>
<td></td>
<td>■ Degree of risk</td>
</tr>
<tr>
<td></td>
<td>■ Strategic value</td>
</tr>
</tbody>
</table>

**NOTE:** You can enter the revenue associated with potential opportunities without creating a new opportunity in the database.
When you have finished identifying opportunities in the unit for your offerings, navigate back to the BU/SU Overview view, select a new unit, and repeat Step 5 and Step 6.

**Conducting an ESP Organizational Analysis**

Using the Organizational Analysis view, sales professionals can map the structure and politics of the customer's organization to build and expand the relationship with the customer. After completing additional assessments to identify the most influential people and how to use these relationships, sales professionals can automatically create formal and informal organizational charts that visually summarize their contact analyses.

**To conduct an organizational analysis**

1. Navigate to the Accounts screen > Accounts List view.
2. Drill down on an account record.
3. Click the Enterprise Selling Process view tab.
   - You can conduct an organizational analysis at the Account level or at the Business/Service Unit level.
4. Perform the following steps to conduct an Account-level Organizational Analysis.
   a. In the lower link bar, click Organizational Analysis.
      - The Organization Chart view appears, showing all contacts associated with the account.
   b. Proceed to Step 6 of this procedure.
5. Perform the following steps to conduct a Business/Service Unit Organizational Analysis.
   a. In the BU/SU Overview list, drill down on the name hyperlink of the unit for which you are conducting an organizational analysis.
      - The name of the unit appears in the Account form at the top of the screen. The Offerings view is automatically displayed.
   b. In the lower link bar, click Organizational Analysis.
      - The Organization Chart view appears, showing all contacts associated with the unit.
   c. Proceed to Step 6 of this procedure.

   **NOTE:** In the Organizational Analysis view, you can toggle between the Organization Chart view and the Contacts list view. Contacts previously associated with the account or unit automatically appear in both views. The contacts shown in the Contacts list appear in the Organization Chart view.

6. From the drop-down list in the Organizational Analysis view, choose Contacts.
   - All the contacts that have been created for the account or business unit or service unit are displayed.
In the Contacts list, create a new record, and complete the necessary fields to associate an existing contact with the account or unit.

To create a new contact record, click New in the Add Contacts dialog box.

NOTE: You can also create contacts by clicking New on the Organization Chart. If you create a new contact from the Organization Chart, an explicit Save is required to return to the Organization Chart view.

In the Contacts list, analyze each contact based on the criteria taught in the ESP methodology training program.

The criteria includes Role, Your Status, Level of Influence, Adaptability to Change, and Coverage.

The Level of Influence value for the contact determines the degree of shading that appears in the Contact node in the Organization Chart. The following table describes the shading associated with the Level of Influence value.

<table>
<thead>
<tr>
<th>Value in Level of Influence Field</th>
<th>Shading on Organization Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td>None</td>
</tr>
<tr>
<td>Political Structure (Medium)</td>
<td>Light gray</td>
</tr>
<tr>
<td>Inner Circle (High)</td>
<td>Dark gray</td>
</tr>
</tbody>
</table>

In the Contacts list, use the drop-down list to toggle to the Organization Chart view. For more information, see “Charting the Organization’s Reporting Structure” on page 416.

**Charting the Organization’s Reporting Structure**

The Organization Chart displays nodes (boxes) that contain information for each of the contacts you have analyzed and associated with the account or contact. Figure 17 shows a contact node with associated information.

You can visually represent the formal hierarchy in the organization by creating the Organization Chart for the account or unit.
To represent a reporting structure

1. In the Organization Chart view, select the contact node and drag it beneath the node that represents the manager of the contact.

   After you drop the contact node on the manager node, a line between the nodes appears, reflecting the reporting relationship.

2. Repeat this process for each contact until you have completed the organization chart.

   **NOTE:** The reporting relationships are also stored in the Contacts list (toggle view). Information about the manager of the contact appears in the fields Manager Last Name, and Manager First Name. To expose this information in the list, click the menu button, and then select Columns Displayed.

To delete contacts from the organization chart

1. In the Organization Chart view, select the contact node, right click, and choose Edit > Delete from the menu.

   You can also delete a contact by selecting the contact node, and then pressing the DELETE key.

2. To confirm the deletion, click OK.

   When you delete a contact, the contact is removed from the contacts list as well as the organization chart.

Using the Organization Chart to Draw Lines of Influence

You can also map the political structure in the account or unit organization by identifying informal lines of influence for contacts. This feature helps you identify contacts who are not highly ranked (and are easier to access) but who have significant influence on key decision makers.

Lines of Influence information is automatically updated in the Relationships view of the Contacts screen. You can add lines of influence in the Relationships view if you prefer.

To draw a line of influence

1. In the Organization Chart view, select the contact, and then simultaneously hold down the CTRL key on your keyboard.

2. Select the contact node, and then drag and drop the contact node onto other contacts to draw the lines of influence.

   The CTRL key must be depressed throughout this process for the informal line of influence to appear.

To delete lines of influence

- Select the line, and then press the DELETE key.

   You can also select the line, right click the mouse, and then choose Edit > Delete from the menu.
Printing the Organization Chart
You can print the Organization chart for distribution to your sales team.

**NOTE:** The Organization Chart does not print in the Account Plan Report or Account Map Report. You must print it from the Organization Chart view using the right-click menu.

To print an organization chart
1. In the Organization Chart view, right-click your mouse.
2. From the menu, choose the Zoom level at which you want to print the chart.

Adding Partners for ESP Analysis
The Partners view helps you to analyze and execute key partnership strategies while identifying and using partnership capabilities across the enterprise. This view also helps you develop initiatives used to engage key partners.

To add a partner
1. Navigate to the Accounts screen > Accounts List view.
2. Drill down on an account record.
3. Click the Enterprise Selling Process view tab.
4. In the lower link bar, click BU/SU Overview.
5. In the list, drill down on the name hyperlink for the unit to which partners will be added.
   - The name of the unit appears in the Account form at the top of the screen. The Account Type must be ESP BSU to add partners to the unit.
   - The Offerings list appears below the Account form.
6. In the lower link bar, click Partners.
7. In the Partners view, create a new record, and complete the necessary fields.
   - **NOTE:** Partners are stored as Accounts in the database. The Partner flag is checked in the Add Accounts dialog box.
8. Navigate back to the BU/SU Overview to add partners to another unit.
9. Select a new business or service unit, and repeat Step 7.

To add a contact
1. In the Partners list, select the partner, and drill down on the hyperlink in the Name field.
   - The Accounts screen, Contacts view appears.
2 In the Contacts list, click Add to select an existing contact. Click New to add and enter information on a new contact.

3 In the Add Contacts dialog box, select a contact, and then click OK.

**NOTE:** You can select multiple contacts by holding down the SHIFT key and selecting multiple contacts.

### To add activities

1 In the Contacts list, drill down on the hyperlink in the Last Name field. The Contacts detail form and Activities view appears.

2 In the Activities list, create a new record, and complete the necessary fields.

   - If you select Calendar and Activities in the Display In field, you must specify a Start date and time for the record to appear in the Calendar.
   - To delegate the activity, click the select button in the Owner field, and from the Pick Assigned To dialog box, select the owner of the activity. For more information, see Chapter 13, "Activities."

### Viewing the BU/SU Offering Summary

The BU/SU Offering Summary is a read-only view that allows you to see all the offerings (and associated opportunities) you have added to each business and service unit in the account.

**NOTE:** Verify that the account name in the Account form does not show one of your units. You must select the main account for which you are conducting the ESP analysis to see all the offerings by unit.

### To view BU/SU offerings

1 Navigate to the Accounts screen > Accounts List view.

2 Drill down on an account record.

3 Click the Enterprise Selling Process view tab.

4 In the lower link bar, click BU/SU Offering Summary.

   - The offerings associated with each unit in the account appear. You can also see the potential, current, and installed base opportunities for each offering associated with each unit.

### Adding ESP Objectives

The Objectives view helps the sales professional to develop an initial plan for the account. Sales professionals can create specific types of objectives (for example, Business Development, Revenue, and Cross-Account) for each unit or resource to improve strategic planning and account team coordination.
The defined objectives link to an Action Plan form that sales professionals can use to develop action plans to achieve each objective they set. Moreover, the sales professional can verify that the action plan is implemented, because the activities assigned in the Action Plan form automatically appear in the assignee’s activities list.

**To add objectives**

1. Navigate to the Accounts screen > Accounts List view.
2. Drill down on an account record.
3. Click the Enterprise Selling Process view tab.
4. In the lower link bar, click Objectives.
5. In the list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit or Resource</td>
<td>The Unit or Resource for which you are creating the objective. Units can be a business or service unit, opportunities, offerings, or groups of units. Examples of Resource names are Marketing, Customer Satisfaction, or Partners.</td>
</tr>
<tr>
<td>Objective Type</td>
<td>The type of objective being defined. Choose from the three primary objective types, Cross Account, Revenue, and Business Development.</td>
</tr>
<tr>
<td>Objective</td>
<td>The objective for the unit or resource.</td>
</tr>
<tr>
<td>Strategy</td>
<td>A text entry field. Enter a statement that explains how the objective will be achieved.</td>
</tr>
</tbody>
</table>

6. Drill down on the Unit or Resource hyperlink.
   The Objective details form appears with the Action Plan list.

7. In the Action Plan list, create a new record, and complete the necessary fields.

   The Actions you create in the Action Plan list appear in your Activities, Calendar, and To Do List, based on the Display In value you selected. To appear in the Calendar, the start date for the action must be entered.

### Adding ESP Account Plan Highlights

The Account Plan Highlights view allows the sales professional to enter the achievement goals for the account. The sales professional can communicate the strategic plans for the account to the sales team and to sales management, using the Account Goal, Value Proposition, and Critical Success Factor fields.
Goal. The account goal is a statement that describes the level of business you desire with the customer within the next few years. Express the goal, if possible, in terms of relationship and revenue.

Value Proposition. The value proposition is a statement that describes your value to the customer. The value proposition should be written from the perspective of the customer.

Critical Success Factor. Specific to the ESP Account Plan, critical success factors are the events or resources necessary to the success of your plan.

**To add account plan highlights**
1. Navigate to the Accounts screen > Accounts List view.
2. Drill down on an account record.
3. Click the Enterprise Selling Process view tab.
4. In the lower link bar, click Account Plan Highlights.
   - The Overview form and the Critical Success Factors form appear.
5. In the Overview form, enter statements in the Goal and Value Proposition fields.

**Viewing an ESP Manager’s Review**

The sales manager uses the Manager’s Review view to enter an assessment of the sales professional’s ESP account plan. The manager can add comments in the Manager’s Review, which includes the date of each review.

The sales representative and other nonmanagers have read-only access to this view.

**To view a manager’s review**
1. Navigate to the Accounts screen > Accounts List view.
2. Drill down on an account record.
3. Click the Enterprise Selling Process view tab.
4. In the lower link bar, click Manager’s Review.

**Generating ESP Account Plan and Account Map Reports**

You can automatically generate an Account Plan report and an Account Map report for your selected account. The reports can be printed or emailed.
To create a report

1. Navigate to the Accounts screen > Accounts List view.
2. Drill down on the account associated with the report.
3. Click the Enterprise Selling Process view tab.
4. Click the Reports button and select ESP Account Plan or ESP Account Map.

For more information on reports see *Siebel Fundamentals* and *Siebel Reports Administration Guide*. 
This chapter describes how the Target Account Selling (TAS) module integrates with Siebel Sales to help sales professionals win deals. The TAS module provides automated support and coaching to help sales professionals in the following ways:

- Assess opportunities, relationships with key customer contacts, and their competitive position
- Develop competitive and relationship strategies to win the deal
- Execute the strategy and track progress against the action plan

The TAS opportunity management methodology is a separately licensed offering developed by Siebel MultiChannel Services.

This chapter includes the following topics:

- “Using Target Account Selling to Manage Opportunities” on page 423
- “Scenario for Target Account Selling” on page 424
- “Process of Target Account Selling” on page 425
- “Completing a TAS Overview” on page 426
- “Assessing an Opportunity” on page 428
- “Developing Strategy with TAS Competitive Analysis” on page 431
- “Conducting an Organizational Analysis” on page 432
- “Developing a Relationship Strategy” on page 435
- “Adding Customer Milestones” on page 436
- “Viewing PRIME Activities” on page 437
- “Adding Notes” on page 438
- “Creating TAS Opportunity Plan and Initial Plan Reports” on page 439

### Using Target Account Selling to Manage Opportunities

The Target Account Selling module provides full support for the Target Account Selling (TAS) sales methodology from Siebel MultiChannel Services. Using the Target Account Selling methodology and the Target Account Selling module, sales professionals can assess opportunities, conduct organizational and competitive analysis, and develop and execute effective sales strategies.

The Siebel Target Account Selling software module provides the following features:

- Full support for the Target Account Selling methodology
Scenario for Target Account Selling

This scenario provides an example of the business process performed by a sales manager using the Target Account Selling (TAS) methodology. Your company may follow a different process according to its business requirements.

A sales representative meets with a customer and discovers a new opportunity. The sales representative plans to use the Target Account Selling (TAS) methodology from Siebel MultiChannel Services (MCS) to develop a sales strategy for this new deal. TAS is supported by her Siebel Sales application, allowing the sales representative to analyze the opportunity and its multiple decision makers.

Opportunity Assessment

The sales representative selects the opportunity within Siebel Sales, and navigates to the Target Account Selling views to begin the process. She sees several views that she can use to profile and assess the opportunity, develop her value proposition and competitive strategy, and create a detailed action plan to achieve her goals.

She begins by developing an overview of the opportunity. She enters some high-level information, including a profile of the account and the opportunity. This information provides strategic insight that her sales team can use and helps her to connect the project to the customer’s business drivers. The sales representative also enters details about her goal for the opportunity, the solution she is offering, and the business value this solution provides. She continues by entering a description of the compelling event that is causing the customer to act. This helps her to determine the customer’s sense of urgency to close the deal. She concludes by summarizing her high-level strengths and weaknesses for the deal.
Now that she has a general overview of the opportunity, she begins to assess her position using the TAS criteria that Siebel MCS has developed from analyzing the best practices of top sales professionals. She also rates the position of her key competitors using these criteria. She uses the TAS Coach on the Assessments screen to help her complete the assessment. The assessment helps her qualify the opportunity and understand her company’s position in the deal.

**Competitive and Relationship Strategy Development**

Next, the sales representative begins to analyze her competitors for the opportunity and to determine what strategy she should use to win the deal. She uses the TAS Coach, available from the Competitive Analysis screen, for competitive strategy recommendations.

She continues by analyzing the prospect’s organization. She maps both the formal and informal structures so that she can be sure she is spending time with the right contacts. When she completes the analysis, she views the organizational chart that summarizes her assessment and identifies key players and relationships she can use to close the deal.

Now that she knows who to talk to, the sales representative begins to develop a relationship strategy. She enters the business and personal agenda, as well as key decision issues, for each contact. This preparation helps her to determine what message to deliver to each contact.

**Strategy Execution**

The sales representative is now prepared to develop her action plan to win the opportunity. First, she navigates to the Customer Milestones view to document key events or milestones in the customer’s buying process. This view helps her plan the activities that she and her sales team should take to address the customer’s requirements at each milestone. Then, she enters key action steps and resources needed and assigns the actions to members of her sales team. She can choose to have the activities appear in her calendar, activities, or to-do list, or in those of another assignee. She navigates to the PRIME Activities view where she can see all the activities she created to meet customer milestones, as well as add action items required to win the deal. She also makes some additional notes about the opportunity and makes the notes available for the entire team to view.

The sales representative’s manager requests a copy of the TAS Opportunity Plan. The sales representative configures the report to display relevant sections of the Opportunity Plan, generates the report, and then emails it to her manager.

**Process of Target Account Selling**

Siebel Target Account Selling (TAS) consists of eight views that automate the steps in the TAS methodology. The TAS Initial Plan report and the TAS Opportunity Plan report can be generated from the TAS module.

The TAS Opportunity Plan template is available with Siebel Proposal Generator (a separately licensed module), which automatically creates the Opportunity Plan using Microsoft Word.

The procedures associated with the Target Account Selling views describe how to use the Target Account Selling module.
For more information on reports, see "Creating TAS Opportunity Plan and Initial Plan Reports" on page 439.

1. “Completing a TAS Overview” on page 426
2. “Assessing an Opportunity” on page 428
3. “Developing Strategy with TAS Competitive Analysis” on page 431
4. “Conducting an Organizational Analysis” on page 432.
5. “Viewing PRIME Activities” on page 437 (for relationship strategy)
6. “Adding Customer Milestones” on page 436
7. “Viewing PRIME Activities” on page 437 (for PRIME activities)
8. “Adding Notes” on page 438

**Completing a TAS Overview**

The Overview view provides a starting point that sales professionals can use to consolidate their observations about the account and opportunity and share strategic insights with their sales teams.

Using this view, sales professionals can profile their customers’ important business initiatives and requirements. In addition, sales professionals can summarize the strategic goal, value proposition, and overall position.

**To complete a TAS overview**

1. Navigate to the Opportunities screen > List view.
2. Drill down on an opportunity record.
3. Click the Target Account Selling view tab.
In the first form, complete the necessary fields.

The following table describes the fields.

**TIP:** Position the pointer on the information icon to see information on the view.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer’s Business Profile</td>
<td>Describes the customer’s business conditions. Identify the customer’s major lines of business, affiliations, products, and markets. Include information about recent mergers and acquisitions.</td>
</tr>
<tr>
<td>Customer’s Revenue</td>
<td>The customer's annual revenues or sales.</td>
</tr>
<tr>
<td>Fiscal Year End</td>
<td>The month and day in which the customer’s 12-month accounting period ends.</td>
</tr>
<tr>
<td>Customer’s Profit</td>
<td>The customer's annual profit.</td>
</tr>
</tbody>
</table>
5 In the Overview form, complete the necessary fields.

The following table describes the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opportunity Profile</td>
<td>Describes the customer's project or application. Identify the customer's business objectives for the project, the total cost and budget for the project, and how the project affects the customer's overall business.</td>
</tr>
<tr>
<td>Customer's Compelling Event</td>
<td>Describes what is driving the customer to make a decision or change the current situation. Identify the payback if the customer makes a change, or the consequences if they do not act. Note the specific date associated with the consequences or payback.</td>
</tr>
<tr>
<td>Critical Success Factors</td>
<td>Identifies actions you, the competition, and your customer must do for you to win this opportunity.</td>
</tr>
<tr>
<td>Our Strengths</td>
<td>Identifies business, organizational, and political issues that give your sales team an advantage in the deal.</td>
</tr>
<tr>
<td>Goal</td>
<td>Describes your desired, long-term position with the customer. Identify how a closer relationship with you advances the attainment of their business goals. Include the long-term gain for your business such as future or strategic value.</td>
</tr>
<tr>
<td>Our Solution</td>
<td>Describes the solution you plan to offer to the customer. Address how the solution works in the customer's environment and how it meets their compelling event. Include any alliances or business partner solutions required to make it operational for the customer.</td>
</tr>
<tr>
<td>Our Weaknesses</td>
<td>Identifies business, organizational, and political issues that could put your sales team at risk in the deal.</td>
</tr>
<tr>
<td>Our Unique Business Value</td>
<td>Describes your value proposition. Make sure it is specific to this customer, defines a measurable business result, and creates credibility by proving your ability to deliver. The value proposition should be confirmed with the customer, and differentiate you from your competitors.</td>
</tr>
</tbody>
</table>

**NOTE:** If this is a new opportunity, you must create a new record and associate it with an account before you can enter text in the Customer's Business Profile field. For more information, see Chapter 28, “Opportunity Workflows.”

**Assessing an Opportunity**

Sales professionals can use the Assessments view to evaluate the opportunity using criteria developed by Siebel MultiChannel Services. Assessments must be completed before determining the best strategy. An assessment focuses on the following four key questions:

1. Is there an opportunity?
2  Can we compete?
3  Can we win?
4  Is it worth winning?

Sales professionals assess their organization’s position and the position of their top competitors against these criteria. As the sales campaign progresses, sales professionals repeat this assessment and then compare the results to past assessments to evaluate and monitor their position at each sales stage.

The first few times an assessment is performed, use the TAS Coach to help evaluate and answer each set of assessment questions. After a number of assessments are performed and you are familiar with the criteria and methodology, use the Assessment form to rate the criteria.

To begin an assessment

1  Navigate to the Opportunities screen > List view.
2  Drill down on an opportunity record.
3  Click the Target Account Selling view tab.
4  In the lower link bar, click Assessments.
   The Assessments list includes all the assessments you and your sales team have performed to date. Use the Assessments list to compare opportunity assessments for your company and your competitors.
5  In the Assessments form, create a new record.
6  In the new record, the Assessment For field defaults to Our Company for self assessments. If you are assessing a competitor’s position, specify the competitor.
7  In the Assessment form, click TAS Coach and complete the assessment criteria questions.
Using the TAS Coach

The Assessment TAS Coach, shown in Figure 18, uses Siebel SmartScripts technology to help sales professionals evaluate opportunities. The explorer pane expands to show the individual questions in each question set, and the form at right provides information on assessment considerations and rating selection.

To perform an assessment using TAS Coach

1. Assess the position of each of the criteria in the Assessments list by selecting a plus (+), a minus (-), or a question mark (?) from the drop-down list.

2. Click Next to advance to the next set of criteria questions.
   - Click Previous to return to criteria you have already assessed.
   - Click Cancel to return to the Assessments view without saving the assessment.
   - If you want to pause in the middle of a TAS Coach assessment, and then return to the assessment at a later time, click Finish Later. The assessment does not appear in the Assessments list until it is completed.

Your assessment is saved in the SmartScripts screen’s My Saved Session view. Use Site Map to navigate to the SmartScripts screen.

If you do not have enough information to answer the question, select the question mark (?).

3. When you have rated all criteria, click Finish to return to the Assessments list.

   **NOTE:** You must click Finish to save the criteria ratings.
Developing Strategy with TAS Competitive Analysis

The Competitive Analysis view helps sales professionals to develop competitive strategy. For each competitor, the sales team can evaluate strengths and weaknesses and anticipate the competitor’s strategy. The view also help the sales team to assess its own position against the competitor and to refine its strategy to win the deal.

Use the TAS Coach to help you establish your sales strategy. TAS Coach provides recommendations based on the information you enter.

NOTE: If you use the TAS Coach to refine your strategy, enter information in the Our Competitive Strategy field. If you are analyzing a competitor’s strategy, enter the information in the Competitors list.

When you determine what your strategy will be, enter a summary in the Our Competitive Strategy text field in the Competitive Analysis view.

To add competitive analysis information
1. Navigate to the Opportunities screen > List view.
2. Drill down on an opportunity record.
3. Click the Target Account Selling view tab.
4. In the lower link bar, click Competitive Analysis.
5. In the Competitors list, create a new record, and complete the necessary fields.
   - After you have analyzed your competitors, you determine the strategy you will take in the deal. Enter your strategy, based on what you think the competitor will do, in the Our Competitive Strategy field.

Using the TAS Coach for Competitive Analysis

The TAS Coach can help you develop a competitive strategy after you have completed the TAS Assessment for your company and competitors. You can also answer TAS Coach questions from your competitors’ perspective to help you anticipate the strategy that competitors are likely to take. You may need to refer to your assessment criteria ratings during a TAS Coach session, and may want to review or print the assessments before starting. See “Creating TAS Opportunity Plan and Initial Plan Reports” on page 439.

To use the TAS Coach for competitive analysis
1. Navigate to the Opportunities screen > List view.
2. Drill down on an opportunity record.
3. Click the Target Account Selling view tab.
4. In the lower link bar, click Competitive Analysis.
5 In the Competitive Strategy form, click TAS Coach.

The TAS Coach screen appears, as shown in the following figure, detailing strategy types such as Fragment, Frontal, and Disengage, and includes a description of how to use the TAS coach.

6 During the TAS Coach session, answer each question presented, and then click the Continue hyperlink to proceed to the next question.

During the session, an interim evaluation of each answer is provided, outlining the relevant issues that you must consider.

Click the Back hyperlink to return to a previous question.

At the conclusion of the session, TAS Coach recommends the type of strategy to take.

7 At the TAS Coach Recommends screen, drill down on the Click here for variations hyperlink for additional strategy options.

8 When you complete the TAS Coach session and review the TAS Coach recommendation, click the Back arrow to return to the Competitive Analysis view.

9 Enter the strategy you will take in the Our Competitive Strategy field.

Conducting an Organizational Analysis

Sales professionals can use the Organizational Analysis view to create formal and informal organizational charts that visually summarize their contact analyses.

The Organizational Analysis view toggles between a Contacts list and an Organization Map. Contacts previously associated with the opportunity automatically appear in both views. The contacts shown in the Contacts list appear in the Organization Map view.
The toggle control list is shown in Figure 19. You can click New in either the Contacts list view or the Organization Map to create contact records. Position the pointer on the information icon to display information on the view.

![Organizational Analysis View, Contacts List, and Organization Map Toggle](image)

Figure 19. Organizational Analysis View, Contacts List, and Organization Map Toggle

Regardless of which view you use to create or select contacts, analyze each contact based on the criteria taught in the Target Account Selling methodology training program. This criteria includes Buying Role, Your Status, Level of Influence, Adaptability to Change, and Coverage.

The Level of Influence that you assign to each contact determines the degree of shading that appears in the contact node in the Organization Map. Table 90 explains the contact node shading for each value in the Level of Influence field.

<table>
<thead>
<tr>
<th>Value in Level of Influence Field</th>
<th>Shading on Organization Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td>None</td>
</tr>
<tr>
<td>Political Structure (Medium)</td>
<td>Light gray</td>
</tr>
<tr>
<td>Inner Circle (High)</td>
<td>Dark gray</td>
</tr>
</tbody>
</table>

You can also map the politics in the customer organization by identifying formal and informal lines of influence between contacts. Mapping informal lines of influence helps you identify contacts who may not be ranked highly (and are easier to access) but have significant influence on key decision makers.

**To begin an organizational analysis**

1. Navigate to the Opportunities screen > List view.
2. Drill down on an opportunity record.
3. Click the Target Account Selling view tab.
4. In the lower link bar, click Organizational Analysis.
   The Organization Map view appears.
5. Add new contacts.
   You can also add new contacts by choosing Contacts from the drop-down list and entering the contacts in the list.
To create the Organization Map

1. In the view drop-down list toggle, select Organization Map.

   The organizational chart displays the nodes (boxes) containing information for each of the contacts you have analyzed and associated with the opportunity.

   The following figure shows an example of a contact node (box) with the Level of Influence shading of dark gray. The node includes information about the contact, such as the contact’s title and other contact analysis information (Decision Maker, Mentor).

   ![Organization Map Example](image)

   You can visually represent the formal hierarchy in the organization by creating the Organization Map of key contacts in the deal.

2. Select the contact node and drop it on top of the contact node that represents the contact’s manager.

   When you drop the contact node on the manager node, a line appears between the nodes, reflecting the reporting relationship.

3. Repeat this procedure for each contact until you have completed the organization chart.

   **NOTE:** The reporting relationships are also stored in the Contacts list (toggle view). The Manager Last Name and Manager First Name fields in the contact record are automatically populated. To expose this information in the contacts list, click the menu button, and then choose Columns Displayed.

To delete contacts on the Organization Map

- Right-click on the contact node and choose Edit > Delete from the menu.

   **NOTE:** Contacts deleted from the organization map are no longer associated with the opportunity. However, the contact record still exists in your Contacts screen list.

To draw lines of influence

1. In the Organization Map, press the CTRL key and simultaneously select the contact.

2. Drag and drop the selected contact node on other contacts to draw the lines of influence.

   The CTRL key must be depressed throughout this process for the informal line of influence to appear.

   **NOTE:** This information is automatically updated in the Relationships view of the Contacts screen. You can indicate lines of influence in the Relationships view if you prefer.
Target Account Selling ■ Developing a Relationship Strategy

To delete lines of influence on the Organization Map
- Right-click on the line and choose Edit > Delete from the menu.

To print the Organization Map
1 Right-click on the Organization Map and select Zoom from the menu.
2 Choose the Zoom level at which you want to print the chart.
3 Right-click the Organization Map again and choose Print from the menu.
   The Organization Map prints at the selected zoom level. Large charts print across multiple pages.
   **NOTE:** The Organization Map does not print in the Initial Plan Report or Opportunity Plan Report. You must print it from the Organization Map view using the right-click menu.

Developing a Relationship Strategy

Information captured in the Relationship Strategy view helps sales professionals develop a relationship strategy for each of the key players for an opportunity. The view allows sales teams to share their understanding of the business and personal decision issues for each contact.

To add relationship strategy information
1 Navigate to the Opportunities screen > List view.
2 Drill down on an opportunity record.
3 Click the Target Account Selling view tab.
4 In the lower link bar, click Relationship Strategy.
5 In the list, create a new record.
6 From the Add Contacts dialog box, select the contact or contacts you want to add, and then click OK.
   **NOTE:** All contacts added in the Organization Map automatically appear in the Contacts list, and all contacts added in the Contacts list appear in the Organization Map.
7 In the Relationship Strategy list, complete the Business Agenda, Personal Agenda and Relationship Strategy fields for each contact.
   You only need to complete this information for key players in the organization, based on their role, level of influence, and rank.
8 Add decision criteria:
   a In the Relationship Strategy list, select a contact.
   b In the Decision Criteria list, create a new record, and complete the necessary fields.
   **NOTE:** The administrator may want to create a record called Custom that users can select from the list of decision criteria. This record can be used to track issues that are unique to the contact and do not already exist in the database.
Adding Customer Milestones

Milestones are formal steps in the customer’s buying process. The Customer Milestones view helps sales professionals identify and track customer requirements that must be met as the sales cycle progresses. After the milestones are set, use the Our Activities list to target specific activities that need to be accomplished to meet each milestone. These activities might include formal presentations, product demonstrations, benchmarks, proposals, and other activities required to make the sale. Figure 20 shows the Customer Milestones list, and the activities associated with the selected milestone in the Our Activities subview list.

1. Navigate to the Opportunities screen > List view.
2. Drill down on an opportunity record.
3. Click the Target Account Selling view tab.
4. In the lower link bar, click Customer Milestones.
5 In the Customer Milestones list, create a new record.
The current date appears in the Date field.

6 In the Event field, select the type of event from the list.
A set of suggested activities appears in the Our Activities list. You must save the type of event for the activities to appear.

7 In the Description field, enter a description of the milestone event.

8 In the Customer Responsibility field, choose the customer contact who is the key contact and owner of the milestone event.

Repeat the procedure until you have entered all key milestone events. Review the recommended activities for each milestone before adding new milestones.

**To add associated activities to each milestone**

1 Follow the procedure “To add a milestone” on page 436 to create a customer milestone.

2 In the Our Activities list, add a new activity record and complete the fields.
   a In the Type field, choose the activity type from the list.
   b In the Display In field, choose where you want the activity to appear.
      If you choose Calendar and Activity as the display method, you must enter a start date for the activity for it to appear in the calendar.
   c In the Resources text field, describe the resources required to support the activity.
   d If the activity will be delegated, for example, from a manager to a member of the sales team, click the hyperlink in the Owner field, and query for the new owner in the Employees list.
      The default owner is the User ID of the activity creator.

**Viewing PRIME Activities**

The PRIME Activities view helps sales professionals develop the necessary action steps to execute the strategy and win the opportunity. The PRIME acronym underscores the initiatives that are used:

- Prove your value
- Retrieve missing information
- Insulate against competition
- Minimize your weaknesses
- Emphasize your strengths

These activities can be assigned with due dates to members of the sales team and automatically appear in individual calendars and activity lists. Use this view to update the entire sales team, and to measure progress while implementing the sales strategy.
Target Account Selling ■ Adding Notes

All the activities created in the PRIME Activities view automatically appear in the Activities view associated with the opportunity. Your sales organization may wish to standardize on one of these views.

Activities created in the Our Activities list in the Milestones view also appear in the PRIME Activities list, providing a method for tracking. (In the Customer Milestones list, you must select the milestone to see the associated activities.)

Using this view, you can create activities that are not specific to milestones, such as follow-up actions associated with assessments and the organizational analysis.

To add PRIME activities
1. Navigate to the Opportunities screen > List view.
2. Drill down on an opportunity record.
3. Click the Target Account Selling view tab.
4. In the lower link bar, click PRIME Activities.
5. In the list, create a new record, and complete the necessary fields.
   - Identify the actions and resources required to implement your strategy, and then select a member of your sales team who is responsible for the activity.

Adding Notes

The Notes view consolidates comments (for example, notes and directions) created by various members of the sales team. These can be marked for general viewing or can be kept private. The Notes view allows the sales team to aggregate and track observations about the opportunity throughout the sales process.

To add a note
1. Navigate to the Opportunities screen > List view.
2. Drill down on an opportunity record.
3. Click the Notes view tab.
4. Select Public Notes or Private Notes from the link bar in the Notes view.
5. In the Notes view, create a new record.
   - The Created field is completed automatically.
6. Complete the Description field.
Creating TAS Opportunity Plan and Initial Plan Reports

You can automatically create reports to make it easier to review your TAS plans. These can be printed or emailed to share with your sales team. Available reports include the TAS Opportunity Plan and TAS Initial Plan reports. You can configure the Opportunity Plan report to print specific sections.

The TAS Opportunity Plan Report prints all the assessments completed for Our Company and all competitors on the three most recent dates. The TAS Initial Plan Report prints all the assessments completed for Our Company and all competitors on the one most recent date.

Using the separately licensed Proposals module, you can apply the TAS Proposal Template to generate an editable Microsoft Word document of the TAS Opportunity Plan Report.

To create a report
1. Navigate to the Opportunities screen > List view.
2. Drill down on an opportunity record.
3. Click the Target Account Selling view tab.
4. Click the Reports button and select TAS Initial Plan or TAS Opportunity Plan.
   - To print specific sections of the Opportunity Plan report, click the check boxes associated with the sections in the Configure Opportunity Plan dialog box and click Finish.
39 Managing Portfolios

This chapter describes how a portfolio manager can use the Portfolio Management Process (PMP) methodology in Siebel applications to manage accounts and complex relationships with customers and partners. It includes the following topics:

- About the Portfolio Management Process on page 441
- Scenario for Managing a Portfolio on page 442
- Roadmap for Managing Portfolios on page 443
- Creating a Portfolio Plan on page 443
- Process of Segmenting Accounts on page 445
- Process of Analyzing the A Accounts on page 447
- Process of Analyzing B, C, and D Accounts on page 448
- Performing a Manager Review of a Portfolio Plan on page 455
- Printing a Portfolio Report on page 456

About the Portfolio Management Process

PMP is an account-based, structured methodology for sales professionals who manage a portfolio of accounts, and who must be responsible for, penetrate, retain, and grow those accounts. A portfolio contains a set of accounts organized by industry application, geographic location, and so on. Typically, a portfolio contains strategically important accounts that represent high-potential business for the sales organization.

PMP is designed to help portfolio managers perform the following activities:

- Analyze accounts in their portfolio to reveal the accounts with highest revenue potential.
- Engage the high-potential accounts in their portfolio.
- Direct and manage resources to close as much business as possible.
- Manage complex relationships with customers and partners.

PMP separates a group of accounts into four segments, as shown in Table 91.

Table 91. Segmentation Groups in Portfolio Management Process

<table>
<thead>
<tr>
<th>Group</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Accounts that offer significant sales potential and deserve significant sales effort.</td>
</tr>
<tr>
<td>B</td>
<td>Accounts that make a significant current revenue contribution and are meeting targets.</td>
</tr>
</tbody>
</table>
Scenario for Managing a Portfolio

This topic gives one example of how portfolio managers might use the Portfolio Management Process. You might use the Portfolio Management Process differently, depending on your business model.

A portfolio manager has ten accounts and must analyze the accounts, and decide how best to focus the resources.

The portfolio manager logs in to Siebel Sales and navigates to the Portfolio Management Process view. The manager creates a new portfolio plan. A portfolio plan is the means by which portfolio managers capture their intentions about how to drive revenue from a portfolio.

The manager adds ten accounts to the plan, and then performs the following tasks to segment the accounts:

1. **Assesses current revenue.** The portfolio manager enters the period for which they want to assess the revenue for the account. The revenue for this period is displayed in the application, separated into closed and committed revenue.

   The portfolio manager then selects a current revenue breakpoint. This breakpoint determines which accounts are considered to be more significant from a revenue point of view. This breakpoint also determines which accounts appear in the left and right halves of the segmentation map.

2. **Assesses future potential.** For each account, the portfolio manager enters a score against a set of criteria. The application then calculates a future potential score for each account, based on the scores entered by the portfolio manager.

   The portfolio manager then selects a future potential breakpoint. This breakpoint determines which accounts are considered to be more significant from a future potential point of view. This breakpoint also determines which accounts appear in the top and bottom halves of the segmentation map.

For each account, the application takes the current revenue value and the future potential score and plots the account on the portfolio segmentation map. The breakpoints segment the accounts into A, B, C, and D accounts.

<table>
<thead>
<tr>
<th>Group</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Accounts that are valued, but do not make a significant contribution and offer limited future potential.</td>
</tr>
<tr>
<td>D</td>
<td>Accounts that have little or no revenue potential today. Insufficient data exists to accurately assess potential.</td>
</tr>
</tbody>
</table>
Next, the portfolio managers analyze each of the A accounts. They review the business units and service units (BU/SU) for each account to make sure that all of the units are included. They then segment the units. To segment the units, they assign each unit scores to reflect the importance of the unit to the portfolio managers, and to the customers. The application uses these scores to plot a BU/SU segmentation map.

The portfolio managers then review the BU/SU segmentation map and select the units where they want to identify the potential opportunities. For each selected unit, they analyze the business drivers, related initiatives, and critical success factors.

Next, the portfolio managers review and update more information to complete the A account analysis. They also review and update the equivalent information for the B, C, and D accounts to complete the analysis of the B, C, and D accounts.

The information that the portfolio managers review and update for all the account groups is as follows:

- Current and installed base opportunities
- Organizational structure
- Marketing plan information
- Partner information
- Objective strategy and action plan information

The portfolio manager can view the portfolio segmentation map and print the BU/SU segmentation map. The manager of the portfolio manager can now review the portfolio plan and approve the plan.

**Roadmap for Managing Portfolios**

To manage portfolios, perform the following processes and tasks:

1. **Creating a Portfolio Plan on page 443**
2. **Process of Segmenting Accounts on page 445**
3. **Process of Analyzing the A Accounts on page 447**
5. **Performing a Manager Review of a Portfolio Plan on page 455**

**Creating a Portfolio Plan**

You can create a portfolio plan to group your accounts together.

This task is a step in **Roadmap for Managing Portfolios on page 443**.

**To create a portfolio plan**

2. In the portfolio plan list, create a new record, and complete the necessary fields. Drill down on the portfolio plan to see more fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Account Breakpoint</td>
<td>Select the future potential score. This score determines which accounts are considered to be more significant and less significant. It also determines which accounts appear on the top half of the segmentation map and the bottom half of the segmentation map.</td>
</tr>
<tr>
<td>Completion Date</td>
<td>Select the date by which the portfolio plan is due to be completed.</td>
</tr>
<tr>
<td>Critical Success Factor</td>
<td>Type the factors that are important for the success of the portfolio plan.</td>
</tr>
<tr>
<td>Currency Code</td>
<td>Select the currency to use for revenue amounts for the portfolio plan.</td>
</tr>
<tr>
<td>Last Revenue Calculation</td>
<td>Displays the date of the most recent revenue calculation.</td>
</tr>
<tr>
<td>Next Review Date</td>
<td>Select the date of the next management review between the portfolio manager and their manager.</td>
</tr>
<tr>
<td>Owner</td>
<td>Select the owner of the portfolio plan.</td>
</tr>
<tr>
<td>Period From</td>
<td>Select the start date of the period for which the plan is active.</td>
</tr>
<tr>
<td>Period To</td>
<td>Select the end date of the period for which the plan is active.</td>
</tr>
<tr>
<td>Portfolio Name</td>
<td>Type a unique name for the portfolio plan.</td>
</tr>
<tr>
<td>Portfolio Plan Goal</td>
<td>Type the goals for the portfolio plan.</td>
</tr>
<tr>
<td>Revenue Assessment From</td>
<td>Select the start date of the period for which you want to analyze revenue.</td>
</tr>
<tr>
<td>Revenue Assessment To</td>
<td>Select the end date of the period for which you want to analyze revenue.</td>
</tr>
<tr>
<td>Revenue Benchmark</td>
<td>Select the amount of the total current revenue. This value determines which accounts are considered to be more significant and less significant. It also determines which accounts appear on the left side of the segmentation map and the right side of the segmentation map.</td>
</tr>
<tr>
<td>Status</td>
<td>Select the status of the portfolio plan from the drop-down list.</td>
</tr>
</tbody>
</table>

3. To add accounts to the portfolio plan, perform the following steps:
   a. Drill down on the portfolio plan.
   b. Click the Segmentation tab.
   c. Click the Revenue Assessment link.
d Click New, then click the Select button in the Account field to select accounts.
The other fields are populated automatically.
For information about how to view and print a Portfolio Map report from this screen, see Printing a Portfolio Report on page 456.

Process of Segmenting Accounts
To segment accounts, perform the following tasks:

1 Assessing Current Revenues on page 445
2 Assessing the Future Potential of Accounts on page 446
3 Viewing the Portfolio Segmentation Map on page 447

Assessing Current Revenues
To assess the current revenue of your accounts, you must review the current closed and committed revenue, then choose a benchmark that determines which accounts are more significant from a revenue perspective.

This task is a step in Process of Segmenting Accounts on page 445.

To assess the current revenue of an account
1 Navigate to the Accounts screen > Accounts List > Portfolio Management Process view.
2 Drill down on the portfolio plan with which you want to work.
3 Enter the period for which you want to analyze the revenue in the Revenue Assessment From and Revenue Assessment To fields.
4 Click the Segmentation tab, then click the Revenue Assessment link.
5 Click the Calculate Revenues button.

The revenues for each account are displayed in the Segmentation subview.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed Revenue</td>
<td>Displays the aggregate revenue from opportunities whose Sales Stage value is 09 - Closed/Won, for the time period specified in Step 3.</td>
</tr>
<tr>
<td>Committed Revenue</td>
<td>Displays the revenue from the opportunities where the Sales Stage value is not 09 - Closed/Won or 09 - Closed/Lost, and where the PMP Revenue Type is set to Installed Base or Current, for the period specified in Step 3.</td>
</tr>
<tr>
<td>Total Current Revenue</td>
<td>This is the sum of the Closed Revenue and Committed Revenue fields.</td>
</tr>
</tbody>
</table>

You can add more accounts to the portfolio. For information about how to add accounts to a portfolio, see Creating a Portfolio Plan on page 443.

6 Select a current revenue value that separates high-revenue accounts from low-revenue accounts in the Revenue Benchmark field.

For information about how to view and print a Portfolio Map report from this screen, see Printing a Portfolio Report on page 456.

Assessing the Future Potential of Accounts

To assess the future potential of your accounts, you must assign scores for a number of criteria for the account. The future potential score for the account is calculated from the scores for the criteria.

This task is a step in Process of Segmenting Accounts on page 445.

To assess the future potential of an account

1 Navigate to the Accounts screen > Accounts List > Portfolio Management Process view.
2 Drill down on the portfolio plan with which you want to work.
3 Click the Segmentation tab, then click the Account Assessment link.
4 Select the account that you want to assess.
Managing Portfolios ■ Process of Analyzing the A Accounts

5 In the Criteria subview, use the drop-down lists to assign a value to each of the criteria. Assign values as follows:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>High</td>
</tr>
<tr>
<td>0</td>
<td>Low</td>
</tr>
<tr>
<td>?</td>
<td>Unknown</td>
</tr>
</tbody>
</table>

The future potential score for the account is calculated automatically and is displayed in the list of accounts.

6 Repeat Step 4 and Step 5 for all the other accounts whose future potential you want to assess.

7 In the A Account Breakpoint field, select a score that separates accounts with a high-future potential score from accounts with a low-future potential score.

For information about how to view and print a Portfolio Map report from this screen, see Printing a Portfolio Report on page 456.

Viewing the Portfolio Segmentation Map

After you assess the current revenue and future potential of your accounts, the application plots the results on a segmentation map. Use the segmentation map to decide how to allocate your sales resources.

This task is a step in Process of Segmenting Accounts on page 445.

To view the segmentation map of a portfolio

2. Drill down on the portfolio plan with which you want to work.
3. Click the Segmentation tab, then click the Map link.

Process of Analyzing the A Accounts

To analyze the A accounts, perform the following tasks:

1. Entering Details of the Account on page 448
2. Assessing Business Units and Service Units on page 449
3. Analyzing Selected Units on page 450
4. Reviewing Opportunities on page 451
5. Reviewing Organizational Analysis on page 451
6. Reviewing Marketing Events on page 452
Managing Portfolios ▶ Process of Analyzing B, C, and D Accounts

7 Reviewing Partners on page 453
8 Reviewing Objectives and Action Plans on page 454

This process is a step in Roadmap for Managing Portfolios on page 443.

Process of Analyzing B, C, and D Accounts

To analyze B, C, and D accounts, perform the following tasks:

1 Entering Details of the Account on page 448
2 Reviewing Opportunities on page 451
3 Reviewing Organizational Analysis on page 451
4 Reviewing Marketing Events on page 452
5 Reviewing Partners on page 453
6 Reviewing Objectives and Action Plans on page 454

This process is a step in Roadmap for Managing Portfolios on page 443.

Entering Details of the Account

You must enter details for each of your A, B, C, and D accounts.

This task is a step in Process of Analyzing the A Accounts on page 447 and Process of Analyzing B, C, and D Accounts on page 448.

To enter details of a portfolio account

1 Navigate to the Accounts screen > Accounts List > Portfolio Management Process view.
2 Drill down on the portfolio plan with which you want to work.
3 Click the appropriate account planning tab.
Managing Portfolios ■ Process of Analyzing B, C, and D Accounts

4 Complete the necessary fields in the account planning view. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>Displays the name of the account.</td>
</tr>
<tr>
<td>Account Team</td>
<td>Displays the team responsible for the account.</td>
</tr>
<tr>
<td>Actual Account Type</td>
<td>Select the type of account.</td>
</tr>
<tr>
<td>Importance To Customer Breakpoint</td>
<td>(A Account only) Displays the value that distinguishes the accounts on the left side of the segmentation map and the right side of the segmentation map.</td>
</tr>
<tr>
<td>Importance To You Breakpoint</td>
<td>(A Account only) Displays the value that distinguishes the accounts on the top side of the segmentation map and the bottom side of the segmentation map.</td>
</tr>
</tbody>
</table>

For information about how to view and print a Portfolio Map report or a Portfolio Plan from this screen, see Printing a Portfolio Report on page 456.

Assessing Business Units and Service Units

To assess the business units and service units of an account, you must assign a value that indicates the value of the unit to you and to the customer. After you assess the units, you can view a BU/SU segmentation map. You can use the segmentation map to identify the units that you want to include in your analysis. To include a business or service unit on the map, select the Pursue field for the unit.

This task is a step in Process of Analyzing the A Accounts on page 447.

To assess the business units and service units of an account

1 Navigate to the Accounts screen > Accounts List > Portfolio Management Process view.
2 Drill down on the portfolio plan with which you want to work.
3 Click the A Account Planning tab, then click the BU/SU Segmentation subview tab.
4 Select Assessment from the drop-down list at the top of the BU/SU Segmentation subview. The subview displays the business and service units for the account.
5 Complete the necessary fields in the BU/SU Segmentation subview. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business/Service Unit</td>
<td>Select a subaccount of the selected account. Alternatively, to create a new business unit or service unit, type the name of the unit.</td>
</tr>
<tr>
<td>Importance To Customer</td>
<td>Select the value that indicates the importance of the unit to the customer.</td>
</tr>
<tr>
<td>Importance To You</td>
<td>Select the value that indicates the importance of the unit to you.</td>
</tr>
<tr>
<td>Pursue?</td>
<td>Select this option if you want to include the business unit or service unit in your analysis. If you select this option, the unit is included in the Selected Unit Analysis subview. For more information about how to analyze units, see Analyzing Selected Units on page 450.</td>
</tr>
<tr>
<td>Unit Type</td>
<td>Select whether the unit is a business unit or a service unit.</td>
</tr>
</tbody>
</table>

To view the segmentation map of business units and service units
1 Navigate to the Accounts screen > Accounts List > Portfolio Management Process view.
2 Drill down on the portfolio plan with which you want to work.
3 Click the A Account Planning tab, then click the BU/SU Segmentation subview tab.
4 Select Map from the drop-down list at the top of the BU/SU Segmentation subview.

The subview displays the BU/SU segmentation map for the account. A diamond shape on the map represents a business unit. A square shape represents a service unit.

Analyzing Selected Units
After you select the business units and service units that you want to work with, you must analyze these units, and add the business driver, initiative, and critical success factor information.

This task is a step in Process of Analyzing the A Accounts on page 447.

To analyze selected business units and service units
1 Navigate to the Accounts screen > Accounts List > Portfolio Management Process view.
2 Drill down on the portfolio plan with which you want to work.
3 Click the A Account Planning tab, then click the Selected Unit Analysis subview tab.

You can review the fields in the Selected Unit Analysis subview. For more information about the fields, see Assessing Business Units and Service Units on page 449.

4 To add information about the business drivers for the BU/SU, click New in the Drivers subview. Type the driver information in the Driver field.
To add information about the business initiatives for a driver, select the driver, then click New in the Business Initiatives subview. Complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Initiatives</td>
<td>Type the business initiative associated with the business unit or service unit.</td>
</tr>
<tr>
<td>Critical Success Factor</td>
<td>Type the critical success factor associated with the business initiative.</td>
</tr>
</tbody>
</table>

**Reviewing Opportunities**

You can review the opportunities associated with your accounts, and new opportunities if required. This task is a step in Process of Analyzing the A Accounts on page 447 and Process of Analyzing B, C, and D Accounts on page 448.

**To review opportunities for selected units**

2. Drill down on the portfolio plan with which you want to work.
3. Click the appropriate account planning tab, then click the Opportunities subview tab. The current opportunities for the selected units are displayed.
4. To add an opportunity, click New and complete the necessary fields. For information about the fields, see “Opportunities (User)” on page 335.

**Reviewing Organizational Analysis**

You can review the contacts associated with an account or unit. You can add contacts, and you can create an organizational chart to reflect the structure of contacts in an account or unit.

This task is a step in Process of Analyzing the A Accounts on page 447 and Process of Analyzing B, C, and D Accounts on page 448.

**To review organizational analysis**

2. Drill down on the portfolio plan with which you want to work.
3. Click the appropriate account planning tab, then click the Organizational Analysis subview tab.
4. Select Contacts from the drop-down list at the top of the Organizational Analysis subview. The current contacts for the selected accounts or units are displayed.
5. To add a contact, click Add, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adaptability to Change</td>
<td>Select the value that best describes how receptive the contact is to change.</td>
</tr>
<tr>
<td>Business Agenda</td>
<td>Type your understanding of the business agenda of the contact.</td>
</tr>
<tr>
<td>Coverage</td>
<td>Select the value that best describes how much communication you have had with the contact.</td>
</tr>
<tr>
<td>Decision Orientation</td>
<td>Select the orientation of the contact when the contact makes a decision.</td>
</tr>
<tr>
<td>Level of Influence</td>
<td>Select the value that best describes the level of influence that the contact has within the organization.</td>
</tr>
<tr>
<td>Personal Agenda</td>
<td>Type your understanding of the personal agenda of the contact.</td>
</tr>
<tr>
<td>Relationship Strategy</td>
<td>Select the strategy to follow for the contact.</td>
</tr>
<tr>
<td>Your Status</td>
<td>Select the value that best describes your relationship with the contact.</td>
</tr>
</tbody>
</table>

6. To view or draw an organization chart of the business unit or service unit, select Organization Chart from the drop-down list at the top of the Organizational Analysis subview. For more information about how to create an organization analysis, see Creating an Organization Analysis on page 348.

**Reviewing Marketing Events**

You can review and update the marketing events associated with an account or unit. You can view the marketing events for a particular account or unit, or you can view marketing events for all units.

This task is a step in Process of Analyzing the A Accounts on page 447 and Process of Analyzing B, C, and D Accounts on page 448.

**To review marketing events for selected accounts or units**

2. Drill down on the portfolio plan with which you want to work.
3. Click the appropriate account planning tab, then click the Marketing Events subview tab.
   The current marketing events for the selected accounts or units are displayed.
To add a marketing event, click New, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created Date</td>
<td>Displays the date on which you created the marketing event record. The date distinguishes the marketing event from other marketing events.</td>
</tr>
<tr>
<td>Event</td>
<td>Select the type of event.</td>
</tr>
<tr>
<td>Expected Results</td>
<td>Type information about the expected results.</td>
</tr>
<tr>
<td>Target</td>
<td>Type information about the target audience.</td>
</tr>
</tbody>
</table>

To view marketing events for a portfolio plan
2. Drill down on the portfolio plan with which you want to work.
3. Click the All Marketing Events tab.
   All marketing events that are associated with accounts in the portfolio plan are displayed.
   For information about the fields in this screen, see Reviewing Partners on page 453.

Reviewing Partners
You can review and update the partners associated with an account or unit. You can view the partners for a particular account or unit, or you can view partners for all units.
This task is a step in Process of Analyzing the A Accounts on page 447 and Process of Analyzing B, C, and D Accounts on page 448.

To review partners for selected units
2. Drill down on the portfolio plan with which you want to work.
3. Click the appropriate account planning tab, then click the Partners subview tab.
   The current partners for the selected units are displayed.
To add a partner, click New, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Competitors</td>
<td>Select your competitors for the customer account.</td>
</tr>
<tr>
<td>Partner</td>
<td>Select a partner. Click the Select button to display a list of all accounts that have the Partner field selected.</td>
</tr>
<tr>
<td>Partner Alignment with Competitors</td>
<td>Select the value that best describes the relationship of the partner with your competitors.</td>
</tr>
<tr>
<td>Partner Relationship with Account</td>
<td>Select the value that best describes the relationship of the partner to the customer.</td>
</tr>
<tr>
<td>Partner Type</td>
<td>Select the partner type.</td>
</tr>
<tr>
<td>Relationship Owner</td>
<td>Displays the owner of the customer account.</td>
</tr>
<tr>
<td>Relationship with Partner</td>
<td>Select the value that best describes your relationship with the partner.</td>
</tr>
</tbody>
</table>

To view partners for a portfolio plan

2. Drill down on the portfolio plan with which you want to work.
3. Click the All Partners tab.
   - All partners that are associated with accounts in the portfolio plan are displayed.
   - For information about the fields in this screen, see Reviewing Partners on page 453.

Reviewing Objectives and Action Plans

You can review the objective strategy and actions (OSA) associated with an account. You can add objective strategy information and action plans to the account.

This task is a step in Process of Analyzing the A Accounts on page 447 and Process of Analyzing B, C, and D Accounts on page 448.

To review objective strategy and action plans

2. Drill down on the portfolio plan with which you want to work.
3. Click the appropriate account planning tab, then select the account on which you want to work.
4. Click the OSA subview tab.
   - The current objective strategy and action plans for the selected account are displayed.
To add objective strategy information, use the fields at the top of the OSA subview. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Objective</td>
<td>Type the objective of the action plan.</td>
</tr>
<tr>
<td>Strategy</td>
<td>Type information about how to achieve the objective.</td>
</tr>
<tr>
<td>Unit or Resource</td>
<td>Type the unit or resource to which the objective applies. For example, the objective might be for business units, service units, opportunities, offerings, or groups of units. Alternatively, the objective might be for resources such as marketing, customer satisfaction, or partners.</td>
</tr>
</tbody>
</table>

To add an action plan, click New and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Type details of the action.</td>
</tr>
<tr>
<td>Activity Type</td>
<td>Select the type of activity which is planned.</td>
</tr>
<tr>
<td>Due</td>
<td>Select a date by which the action plan is due to be completed.</td>
</tr>
<tr>
<td>Owner</td>
<td>Select the owner of the action plan from the list of employees.</td>
</tr>
<tr>
<td>Planned Outcome</td>
<td>Type details of the expected outcome of the action.</td>
</tr>
<tr>
<td>Resources</td>
<td>Type details of the resources required to implement the action plan.</td>
</tr>
<tr>
<td>Start</td>
<td>Select the date when the action plan starts.</td>
</tr>
<tr>
<td>Status</td>
<td>Select the status of the action plan.</td>
</tr>
<tr>
<td>Strategy Component</td>
<td>Select the strategy element of which the action plan is a part.</td>
</tr>
</tbody>
</table>

**Performing a Manager Review of a Portfolio Plan**

When portfolio managers complete a portfolio plan, they can then request their manager to review and approve the plan.

**NOTE:** After you perform a manager review, you might want to update the Next Review Date field for the portfolio plan.

This task is a step in Roadmap for Managing Portfolios on page 443.

**To perform a manager review of a portfolio plan**

Managing Portfolios ■ Adding Solutions to Portfolio Plans

2 Drill down on the portfolio plan with which you want to work.
3 Click the Manager’s Review tab.
4 To add a review record, click New, then complete the necessary fields.
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Review Date</td>
<td>Select a date on which the review occurs.</td>
</tr>
<tr>
<td>Reviewer</td>
<td>Select the contact who performs the review.</td>
</tr>
<tr>
<td>Status</td>
<td>Select the status for the portfolio plan. For example, to approve a</td>
</tr>
<tr>
<td></td>
<td>portfolio plan, select Approved from the Status drop-down list.</td>
</tr>
</tbody>
</table>

Adding Solutions to Portfolio Plans

You can associate solutions with your portfolio plans, and specify whether or not to include the solution in the segmentation map.

To add a solution to a portfolio plan
1 Navigate to the Accounts screen > Accounts List > Portfolio Management Process view.
2 Drill down on the portfolio plan with which you want to work.
3 Click the Solutions tab.
4 To add a solution, click New, then complete the necessary fields.
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solution</td>
<td>Select the solution to associate with the portfolio plan.</td>
</tr>
<tr>
<td>Show in Report</td>
<td>Select this option to include this solution in the segmentation map.</td>
</tr>
</tbody>
</table>

Printing a Portfolio Report

You can print the following reports for your portfolio plans:

- Portfolio Map
- Portfolio Plan
- Selected Unit Analysis

To print a portfolio report
1 Navigate to the screen you require.
2 On the Siebel application toolbar, click the Reports button, then select the report you require from the pop-up menu.

3 Click the Print button in the report window to print the report.

**NOTE:** To print any of the portfolio reports, navigate to the Accounts screen > Accounts List > Portfolio Management Process view. You can also print reports from particular subviews within the Portfolio Management Process view.
Table 92 lists the system preferences provided throughout your Siebel applications. For information about how to change system preferences, see "Setting System Preferences" on page 46.

Table 92. System Preferences

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ActivationLoadBalancerConfig</td>
<td>For use with the Assignment Manager’s load splitter. Set this preference to the Configuration ID for the load splitter configuration that you want to use for activating territory alignments. For more information about load splitter, see Siebel Assignment Manager Administration Guide. For more information about activating territory alignments, see Siebel Territory Management Guide.</td>
</tr>
<tr>
<td>Activity Hierarchy: Max Levels</td>
<td>The maximum number of levels for the Activity Hierarchy.</td>
</tr>
<tr>
<td>Alarm Manager Load Frequency</td>
<td>Number of minutes the system waits before rechecking for alarms. Default: 60</td>
</tr>
<tr>
<td>AllowOver Receipts</td>
<td>If set to TRUE, the received quantity can be greater than the shipped quantity. Also, for an internal order, when the Process Receipt command is invoked, the pick ticket can be closed only when the received quantity is equal to or greater than the shipped quantity. For more information about shipping and receiving, see Siebel Field Service Guide</td>
</tr>
<tr>
<td>Always Show Message Bar Alerts</td>
<td>Obsolete.</td>
</tr>
<tr>
<td>Asgn: Inherit Org Candidates</td>
<td>If set to TRUE, the organization candidates on an assignment rule can be copied to rules that inherit from the assignment rule. After the rule is inherited, any change to the organization candidate of the original rule has no effect on the inherited rule.</td>
</tr>
<tr>
<td>Auto Mgr Calendar Access</td>
<td>Allow employee’s manager access to the employee’s calendar, even if the employee does not explicitly give the manager access. <strong>NOTE:</strong> If multiple employees share a position, only the calendar of the primary employee is accessible. Default: True</td>
</tr>
</tbody>
</table>
### System Preferences

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSM Logging</td>
<td>Enables logging of merge transactions. Merge transactions are created when connected users combine or merge two or more business components such as accounts or opportunities into one. Information from this log can be used to re-link orphaned records created when the merge process is crossed with an update process during a synchronization. This is only applicable if the installation uses Siebel Remote or Replication Manager. Default: False</td>
</tr>
<tr>
<td>DB2: Default Opt Level</td>
<td>Default optimization level which defines the optimizing algorithm that DB2 will use to execute SQL statements.</td>
</tr>
<tr>
<td>DBX: Vis Rules per Statement 1</td>
<td>Number of visibility or routing rules checked per SQL statement processed by the Database Extract component for the first SQL statement with header information.</td>
</tr>
<tr>
<td>DBX: Vis Rules per Statement N</td>
<td>Number of visibility or routing rules checked per SQL statement processed by the Database Extract component for other SQL statements.</td>
</tr>
<tr>
<td>Default Campaign Source Code</td>
<td>Default campaign for Web offers used in Siebel Marketing. All offers that are a part of the default campaign will appear in the Featured Offers applet in Siebel Marketing.</td>
</tr>
<tr>
<td>Default EC Procedure</td>
<td>Obsolete.</td>
</tr>
<tr>
<td>Default Offer Code</td>
<td>Code to track the click path of a customer on the Marketing Web site who does not select a specific offer.</td>
</tr>
<tr>
<td>Default Pricing Procedure</td>
<td>Obsolete.</td>
</tr>
<tr>
<td>Default Time Zone</td>
<td>Default time zone for all users of that database. When a user logs in, the Time Zone field of the User business component is checked. If it is empty, the Default Time Zone system preference is checked. Default: UTC</td>
</tr>
<tr>
<td>Entitlement: Pricing Dates</td>
<td>If False or NULL, date verification is skipped when entitlement pricing terms are checked in the Verify Entitlement process. (Similar to the Entitlement: Verify Dates system preference except that one applies to entitlement pricing terms and the other to entitlement service terms.)</td>
</tr>
</tbody>
</table>
Enable ST Script Engine
Siebel eScript is a scripting language that application developers use to write simple scripts to extend Siebel applications. The Strong Typing (ST) eScript engine provides improved performance, scalability, and enhanced functionality when running scripts. To enable the ST eScript engine, enter TRUE for this preference.
For more information about the ST eScript engine, see *Using Siebel Tools*.

Enable Auditing
See *Chapter 6, “Audit Trail”*.  
Enable EimAuditing
See *Chapter 6, “Audit Trail”*.  
Entitlement: Verify Consumer
See *Siebel Field Service Guide*.  
Entitlement: Verify Dates
See *Siebel Field Service Guide*.  
Entitlement: Verify Product
See *Siebel Field Service Guide*.  
ETL Analysis End 
ETL Analysis Start 
ETL Date Format
- ETL Date format indicates the way dates need to be interpreted. The other two parameters mention the date range for which the Exchange Rates will be adjusted. This does not indicate that only the data created within this range will be extracted. Select the earliest date for the Analysis Start Date—that is, when the transactions may have begun. In addition to considering the created and modified dates, consider other relevant dates such as order date. Setting this to an early value such as 19700101 (January 1, 1970) does not affect the processing time. A similar logic applies for choosing Analysis End Date. Note that the values need to be entered in the format defined by ETL Date Format.
  - Default Analysis End: 20101231
  - Default Analysis Start: 19940101
  - Default Date Format: YYYYMMDD

ETL Base Exchange Currency
Currency in which all the financial data will be converted. While the OLTP supports transactions in many different currencies, the data in the OLAP is converted to a single currency for analysis purposes. The Exchange rates are derived from the Exchange Rates table in the OLTP.
- Default: USD

ETL Default Continent
Value for any address that does not have Continent defined. Set this to a value, which will be used if the value of Continent is not defined in the OLTP.
- Default: North America

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable ST Script Engine</td>
<td>Siebel eScript is a scripting language that application developers use to write simple scripts to extend Siebel applications. The Strong Typing (ST) eScript engine provides improved performance, scalability, and enhanced functionality when running scripts. To enable the ST eScript engine, enter TRUE for this preference. For more information about the ST eScript engine, see <em>Using Siebel Tools</em>.</td>
</tr>
<tr>
<td>Enable Auditing</td>
<td>See <em>Chapter 6, “Audit Trail”</em>.</td>
</tr>
<tr>
<td>Enable EimAuditing</td>
<td>See <em>Chapter 6, “Audit Trail”</em>.</td>
</tr>
<tr>
<td>Entitlement: Verify Consumer</td>
<td>See <em>Siebel Field Service Guide</em>.</td>
</tr>
<tr>
<td>Entitlement: Verify Dates</td>
<td>See <em>Siebel Field Service Guide</em>.</td>
</tr>
<tr>
<td>Entitlement: Verify Product</td>
<td>See <em>Siebel Field Service Guide</em>.</td>
</tr>
<tr>
<td>ETL Analysis End</td>
<td></td>
</tr>
<tr>
<td>ETL Analysis Start</td>
<td></td>
</tr>
<tr>
<td>ETL Date Format</td>
<td>ETL Date format indicates the way dates need to be interpreted. The other two parameters mention the date range for which the Exchange Rates will be adjusted. This does not indicate that only the data created within this range will be extracted. Select the earliest date for the Analysis Start Date—that is, when the transactions may have begun. In addition to considering the created and modified dates, consider other relevant dates such as order date. Setting this to an early value such as 19700101 (January 1, 1970) does not affect the processing time. A similar logic applies for choosing Analysis End Date. Note that the values need to be entered in the format defined by ETL Date Format. Default Analysis End: 20101231 Default Analysis Start: 19940101 Default Date Format: YYYYMMDD</td>
</tr>
<tr>
<td>ETL Base Exchange Currency</td>
<td>Currency in which all the financial data will be converted. While the OLTP supports transactions in many different currencies, the data in the OLAP is converted to a single currency for analysis purposes. The Exchange rates are derived from the Exchange Rates table in the OLTP. Default: USD</td>
</tr>
<tr>
<td>ETL Default Continent</td>
<td>Value for any address that does not have Continent defined. Set this to a value, which will be used if the value of Continent is not defined in the OLTP. Default: North America</td>
</tr>
</tbody>
</table>
Table 92. System Preferences

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ETL Default Country</td>
<td>Value for any address that does not have the Country defined. Set this to a value, which will be used if the value of Country is not defined in the OLTP. Default: USA</td>
</tr>
<tr>
<td>ETL Default Currency</td>
<td>Value for currency code that will be used if the currency code for a specific financial transaction is not set. Default: USA</td>
</tr>
<tr>
<td>ETL Default Language</td>
<td>Language code used when language translation occurs when looking up the List of Values table. Default: ENU</td>
</tr>
<tr>
<td>ETL LOV Maximum Value</td>
<td>In some fields, bucketing of values happens. Instead of saying the number of employees at an account is 45, 96, the values can be bucketed to 0-50, 50-100 and so on. In the List of Values, if the minimum and maximum values are not specified, the values of these parameters will be used. Defaults: 9999999999 and 0</td>
</tr>
<tr>
<td>ETL LOV Minimum Value</td>
<td></td>
</tr>
<tr>
<td>ETL Unknown Exchange Rate</td>
<td>Value used when an exchange rate for a currency to the Datamart Default Currency is undefined in the OLTP. Default: 1</td>
</tr>
<tr>
<td>Forecast: Auto-Forecast</td>
<td>Creates subordinates’ forecasts to be used in a rollup forecast, if the subordinates have not created forecasts themselves.</td>
</tr>
<tr>
<td>Forecast: Use Server Task</td>
<td>Send forecast processing requests to the Siebel Server for batch processing. If the value is False, requests are processed locally.</td>
</tr>
<tr>
<td>FSAssetSwap SubComponents</td>
<td>If set to TRUE, the subcomponent assets of the source asset are shifted to the target asset when an activity part tracker transaction is committed.</td>
</tr>
<tr>
<td>FSDB:Override Service Region</td>
<td>Maximum monetary value accepted in Auction Item, Bid, and Fee currency fields.</td>
</tr>
<tr>
<td>Internal DUNS Number</td>
<td>Your company’s DUNS number.</td>
</tr>
<tr>
<td>LOGMGR:Vis Rules per Statement</td>
<td>Set to 50 by default. For implementations that use any database other than Oracle, you should change this value to 20.</td>
</tr>
<tr>
<td>MRG:Docking Timestamp Source</td>
<td>See Siebel Remote and Replication Manager Administration Guide.</td>
</tr>
<tr>
<td>MRG:Inter Table Conflict Res</td>
<td>See Siebel Remote and Replication Manager Administration Guide.</td>
</tr>
</tbody>
</table>
### System Preferences

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MRG:Inter Table Merge Rule</td>
<td>See Siebel Remote and Replication Manager Administration Guide.</td>
</tr>
<tr>
<td>MRG:System Conflict Resolution</td>
<td>See Siebel Remote and Replication Manager Administration Guide.</td>
</tr>
<tr>
<td>MRG:Txns per Commit</td>
<td>See Siebel Remote and Replication Manager Administration Guide.</td>
</tr>
<tr>
<td>PSP Pricing Var Map - Context</td>
<td>See Siebel Pricing Administration Guide.</td>
</tr>
<tr>
<td>PSP Pricing Var Map - Row Set</td>
<td>See Siebel Pricing Administration Guide.</td>
</tr>
<tr>
<td>PSP Pricing Var Map - XA</td>
<td>See Siebel Pricing Administration Guide.</td>
</tr>
<tr>
<td>Quick Print Application</td>
<td>This preference determines which application is used by quick print. Allowed values are: HTML and EXCEL. This system preference can be overridden by the Quick Print Application user preference.</td>
</tr>
<tr>
<td>Quick Print Output Format</td>
<td>Set to HTML, CSV, or Tab, as appropriate for the quick print application that you are using.</td>
</tr>
<tr>
<td>RunAlignmentLoadBalancerConfig</td>
<td>For use with the Assignment Manager’s load splitter. Set this preference to the Configuration ID for the load splitter configuration that you want to use for running territory alignments. For more information about load splitter, see Siebel Assignment Manager Administration Guide. For more information about running territory alignments, see Siebel Territory Management Guide.</td>
</tr>
<tr>
<td>SalesHierarchy:UseServerTask</td>
<td>If set to TRUE, the Sales Hierarchy operation runs as a server task.</td>
</tr>
<tr>
<td>Satmetrix Key Value</td>
<td>A string provided by Satmetrix to customers of Siebel Satmetrix Surveys. Required for generating encrypted tokens that are part of URLs for displaying survey reports.</td>
</tr>
<tr>
<td>Sch:Break Time Id</td>
<td>Specifies the Row ID of the work type to be used when calculating the schedule cost where activities contain breaks. The default value is -1. To find the Row ID, navigate to the Application Administration screen &gt; Work Type Administration view, select the record, choose About Record from the Help menu, and note the Row # value.</td>
</tr>
<tr>
<td>Preference</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sch:Default Constraint Set</td>
<td>Specifies the Row ID of the constraint set to be used where no constraint set is associated with the service region loaded. The default value is -1.</td>
</tr>
<tr>
<td></td>
<td>To find the Row ID, navigate to the Scheduling Administration screen &gt; Constraint Sets view, select the record, select About Record from the Help menu and note the Row # value.</td>
</tr>
<tr>
<td>Sch:Default Cost Function</td>
<td>Specifies the Row ID of the cost function to be used where no cost function is associated with the service region loaded. The default value is -1.</td>
</tr>
<tr>
<td></td>
<td>To find the Row ID, navigate to the Scheduling Administration screen &gt; Cost Functions view, select the record, select About Record from the Help menu and note the Row # value.</td>
</tr>
<tr>
<td>Sch:Default Parameter Set</td>
<td>Specifies the Row ID of the parameter set to be used where no cost function is associated with the service region loaded. The default value is -1.</td>
</tr>
<tr>
<td></td>
<td>To find the Row ID, navigate to the Scheduling Administration screen &gt; Parameter Sets view, select the record, select About Record from the Help menu and note the Row # value.</td>
</tr>
<tr>
<td>Sch:Default Time Window</td>
<td>Specifies the Row ID of the time window to be used where no cost function is associated with the service region loaded. The default value is -1.</td>
</tr>
<tr>
<td></td>
<td>To find the Row ID, navigate to the Scheduling Administration screen &gt; Time Window view, select the record, select About Record from the Help menu and note the Row # value.</td>
</tr>
<tr>
<td>SecThickClientExtAuthent</td>
<td>See Siebel Security Guide.</td>
</tr>
<tr>
<td>SM WebIntelligence Server</td>
<td>The URL that points to the Web Intelligence server that serves up reports for Oracle Business Intelligence.</td>
</tr>
<tr>
<td>SqlStyle</td>
<td>Indicate which SQL statements are to be used with this implementation—Oracle, Microsoft SQL Server, Informix, or Sybase. Case-sensitive.</td>
</tr>
<tr>
<td>SSASqlErrRsltsDiscarded</td>
<td>This message is displayed to the user when there are more rows than can be returned. For more information, see Implementing Siebel Business Applications on DB2 UDB for z/OS.</td>
</tr>
<tr>
<td>Strict Date Format</td>
<td>When you implement a strict date format, users can enter dates only in a format you specify, and all dates are displayed in this format. To implement a strict date format, enter the date format you require in this field. For example, to implement DD/MMM/YYYY date format, enter DD/ MMM/ YYYY.</td>
</tr>
</tbody>
</table>
Table 92. System Preferences

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SubSqlStyle</td>
<td>An SQLStyle that falls within a family of similar database products.</td>
</tr>
<tr>
<td>Technical Support (Alt. 1)</td>
<td>Specifies the telephone numbers to display in the Siebel Technical Support dialog box. Update this number to match your internal help desk number. The alternate numbers (Alt. 1 and Alt. 2) provide expansion for pager numbers and email addresses. Set a value to None to leave it blank in the dialog box.</td>
</tr>
<tr>
<td>Technical Support (Alt. 2)</td>
<td>Specifies the telephone numbers to display in the Siebel Technical Support dialog box. Update this number to match your internal help desk number. The alternate numbers (Alt. 1 and Alt. 2) provide expansion for pager numbers and email addresses. Set a value to None to leave it blank in the dialog box.</td>
</tr>
<tr>
<td>Technical Support (FAX)</td>
<td>Specifies the fax number to display in the Siebel Technical Support dialog box. Update this number to match your internal help desk fax number. Set a value to None to leave it blank in the dialog box.</td>
</tr>
<tr>
<td>Technical Support (URL)</td>
<td>Specifies the support URL to display in the Siebel Technical Support dialog box. Update this URL to match your internal help desk Web address. Set a value to None to leave it blank in the dialog box.</td>
</tr>
<tr>
<td>Technical Support (Voice)</td>
<td>Specifies the voice number to display in the Siebel Technical Support dialog box. Update this number to match your internal help desk number. Set a value to None to leave it blank in the dialog box.</td>
</tr>
<tr>
<td>Training: Customer Calendar</td>
<td>See Siebel Training Guide.</td>
</tr>
<tr>
<td>Training: Employee Calendar</td>
<td>See Siebel Training Guide.</td>
</tr>
<tr>
<td>Training: Partner Calendar</td>
<td>See Siebel Training Guide.</td>
</tr>
<tr>
<td>Training: SCORM Import Path</td>
<td>See Siebel Training Guide.</td>
</tr>
<tr>
<td>Training: SCORM Import URL</td>
<td>See Siebel Training Guide.</td>
</tr>
<tr>
<td>Training: EAI HTTP Password</td>
<td>See Siebel Training Guide.</td>
</tr>
<tr>
<td>Training: EAI HTTP Server</td>
<td>See Siebel Training Guide.</td>
</tr>
<tr>
<td>Training: EAI HTTP User Name</td>
<td>See Siebel Training Guide.</td>
</tr>
</tbody>
</table>
### System Preferences

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Training: Lesson Adapter URL</td>
<td>See Siebel Training Guide.</td>
</tr>
<tr>
<td>Universal Time Coordinated</td>
<td>Turns on global time zone support for the entire system. Set this preference to TRUE to enable global time zone support. The default setting is TRUE. <strong>NOTE:</strong> This is a one-time setting. Once you have turned on global time zone support in a production environment, you should not turn it off. If you intend to operate your deployment with the Global Time Zone feature enabled, you must also set the operating system of your database servers to UTC time, or its equivalent. Failure to set the OS to UTC when the UTC parameter is set to TRUE will result in asynchronous server request errors. For more information on enabling Global Time Zone, see Siebel Global Deployment Guide. Although enabling this feature is optional, it is strongly recommended that you operate your production environment with Global Time Zone enabled.</td>
</tr>
<tr>
<td>UsageTracking Enabled</td>
<td>See Siebel Content Publishing Guide.</td>
</tr>
<tr>
<td>UsageTracking Log Time Period</td>
<td>See Siebel Content Publishing Guide.</td>
</tr>
<tr>
<td>UsageTracking LogFile Dir</td>
<td>See Siebel Content Publishing Guide.</td>
</tr>
<tr>
<td>UsageTracking LogFile Encoding</td>
<td>See Siebel Content Publishing Guide.</td>
</tr>
<tr>
<td>UsageTracking LogFile Format</td>
<td>See Siebel Content Publishing Guide.</td>
</tr>
<tr>
<td>UsageTracking Sess Cache Size</td>
<td>See Siebel Content Publishing Guide.</td>
</tr>
<tr>
<td>User Group</td>
<td>The User Group grantee for database access privileges. It is used in the DDL Sync step in Oracle’s Siebel Tools where the schema for the application is defined.</td>
</tr>
</tbody>
</table>
Numerics

8.0
new features  19, 20

A
account assessments, performing  318
account category
adding  388
searching by category  388
account credit profiles, viewing  319
account plan
highlights, adding  420
reports, generating and account map reports  421
accounts
designating as reference  364
manager approval, viewing  421
offerings, adding to Business and Service Units  413
partners, adding for Enterprise Selling Process  418
accounts map reports
generating and account plan reports  421
accounts, global
custom hierarchy, assigning to an organization  325
custom hierarchy, creating  324
custom hierarchy, restoring  326
custom hierarchy, updating  325
default hierarchy, adding accounts with no parent  324
default hierarchy, generating  323
hierarchies, types of  321
process flow for using and administering accounts  323
scenario  322
viewing global accounts  327
accounts, using
account information, synchronizing with external systems  319
accounts, using in Siebel Sales
about  313
account assessments, performing  318
account credit profiles, viewing  319
account, associating with an activity  317
account, associating with an opportunity  318
contact, associating, with an existing account  317
creating an account  314
scenario  313
action buttons
background colors, configuring  137
high interactivity, configuring  136
Inbox views, configuring for  136
standard interactivity, configuring  136
ActivationLoadBalancerConfig system preference  459
ActiveX, browser support of
activities
about  171
account, associating with  317
activity plans, creating  188
activity, delegating  177
another user's activities, working with  176
assigning using Assignment Manager  177
assignment methods  172
business objects, associated with  172
create activities asynchronously, configuring  241
Enterprise Selling Process, adding  419
households, adding activity to  360
new activity, creating  173
note, about changing Category value  184
opportunity reroute activity, setting up  333
opportunity, associating with  346
Owner and Employee fields, configuring  178
ownership of an activity, reassigning or removing  177
references, adding to activities  364
service requests, viewing existing activities for  178
target lists, creating from  239
activity assignment, about  183
Activity Hierarchy: Max Levels system preference  459
activity plans
about and activity templates  179
activities, creating associated with activity plan  188
activity assignment, about  183
activity template, creating without grandchild records  184
activity template, deleting  187
process for administering and using 181
sales methodology, defining 181
sales methods, about 180
scenarios 180
TAS Customer Milestone template, creating in a localized application 186

activity templates
about and activity plans 179
activity assignment, about using to create 183
activity plans, using to create 188
creating without grandchild records 184
target lists, setting up for 240

adding
activities to household records 360
associated activities to milestones 437
browser capabilities, adding additional 67
Business and Service Unit information 412
Business and Service Unit offerings 413
calendar access and modifying 199
category 388
child Web browser 69
competitive analysis information 431
contact to a synchronization list 282
Contact Us account 63
contacts 280
contacts to a household 357
customer milestones 436
decision issues details 406
default view link to home page 70
default view link to home page 70
default view link to home page 70
default view link to home page 70
default view link to home page 70
default view link to home page 70
default view link to home page 70
default view link to home page 70
Enterprise Selling Account plan highlights 420
Enterprise Selling Process activities 419
Enterprise Selling Process contacts 418
Enterprise Selling Process objectives 419
household 356
Inbox translations 123
industries 64
JumpTab capability for Internet Explorer 68
languages 64
list of values, adding new value to 72
new D&B accounts 275
note to a reference 366
notes 438
parent Web browser 69
partners for Enterprise Selling Process 418
PRIME activities 438
profile information to a reference 367
reference activity to the calendar 366
related decision issues 407
relationship strategy information 435
Web browser capabilities 66
Web browser, adding additional 67
ZIP codes 61
addresses
displaying Households and Contacts screen 359
administration tasks
browser, adding additional Web Browsers 67
cancel query, enabling 48
case sensitivity, about and Siebel applications 65
Contact Us account, adding 63
currencies, setting up 48
currency conversions, setting up 50
date formats, about 61
e-mail address and subjects, about adding 63
expense types, setting up 53
global time zone support, administering 61
industry, adding 64
language, adding 64
language, deleting and Mobile Web client synchronization 65
pager companies, setting up 60
payment terms, setting up 54
periods, setting up 55
phone formats, working with 56
predefined queries, creating by saving a query 47
Predefined Query view, setting up predefined query in 47
predefined query, about setting up 46
quick fill template, editing 70
quick fill template, making public 69
screen home pages, setting up default view links 70
system preferences, setting 46
Web browser capabilities, adding 66
ZIP Codes, adding 61
Adobe Designer
Adobe forms integration 285
XML schema, mapping to 292
Adobe Forms Integration
applets, enabling using Siebel Tools 290
business scenarios 286
form for multiple records, generating 294
form, generating 294
forms integration, about 285
integration object, creating an 290
PDF file, referencing 292
preconfigured on applets 288
process of setting up 287
schema, generating 291
schema, mapping to a PDF form 292
software requirements 288
Adobe Forms Server 6.0
forms integration with Public Sector 285
Adobe plug-in software 288
Adobe Reader forms 288
Adobe Web service
  Adobe Designer, and 288
  configuring 289
  creating 288
Alarm Manager Load Frequency system preference 459
alarms
  Alarm Manager Load Frequency, about 201
  retroactive alarms, about and changing days displayed 201
alerts
  about and example 113
  creating and sending 114
  email and screen alerts, about 165
  recurring message alert, setting up 167
  scenario, using alerts 113
  single message alert, sending 167
AllowOverReceipts system preference 459
Always Show Message Bar Alerts system preference 459
applets
  list applets, enabling target lists on 242
  list applets, saving of target lists in 244
ASIs, integrating using
  accounts, contacts, and household, using for 297, 301
  accounts, contacts, and households ASIs, setting up 297
  Get Account ASI 300
  Synchronize Account ASI 299
  Synchronize Contact ASI 300
  Synchronize Household ASI 300
  Web service, setting up an inbound service 299
  Web service, setting up an outbound service 298
  workflow, activating 299
assessment templates
  about 189
  creating 190
assessments
  assessment scores, about calculating 192
  assessment templates, about 189
  assessment templates, creating 190
  opportunity, assessing 192
  process of administering and using 190
  scenario 189
  Target Account Selling, assessing an opportunity for 193
  TAS coach, using to perform assessment 194
assessments, performing for contacts 283
Assignment Manager
  using to assign activities 177
attachments
  decision issue, associating with 407
  reference attachments, viewing 365
audit scope, about 82
Audit Trail
  about 81
  audit scope, about 82
  audit trail records and record details, viewing 88
  business component and fields, configuring to be audited 84
  business component, disabling 86
  business component, linking to 91
  content of 82
  disabling 84
  enabling 84
  parent-child business components, configuring to be audited 86
  process flow diagram 84
  querying audit trail information 88
  records, verifying 88
  restrictions, list of 83
  Siebel Remote and Siebel Replication users, about using 83
  user, restricting by 87
Auto Mgr Calendar Access system preference 459
B
bcp utility
  about loading D&B data on Microsoft SQL server 253
Broadcast Message business component fields 110
BU/SU offering summary, viewing 419
bulk copy process (bcp) utility 253
Business and Service Unit, adding 412
business components
  audit trail, disabling for individual business component 86
  audit trail, linking to 91
  audited, configuring for 84
  calendar, based on multiple business components 210
  child modifications, disabling 222
  child modifications, enabling 222
  state models, about configuring for 217
  state models, enabling in Siebel Tools 217
business service
  CreateInbox method 140
  CreateInboxEx method 139
  CreateInboxItem method 142
CreateInboxOwner method 143
DeactivateInboxItem method 150
DeactivateInboxOwner method 152
DeleteInboxItem method 153
GetInboxItem method 145
GetInboxItemInfo method 145
GetInboxOwnerInfo method 148
GetInboxOwnerInfoEx method 147
GetInboxParamInfo method 146
Initialize method 154
IsInboxItemExisted method 145
RouteInboxItem method 154
SetInboxParamInfo method 149
Universal Inbox definitions 137
Universal Inbox, about 119
UpdateInboxItemInfo method 150
UpdateInboxOwnerInfo method 152
Web Engine User Agent 67

C

caching
  clearing 73
  message broadcast caching, configuring 111
calendar
  Alarm Manager Load Frequency, about system preference 201
  calendar access administration scenarios 197
  calendar access, about 197
  calendar activities, administering resources 199
  calendar activity display, starting and ending times 202
  calendar administration, process of setting up 198
  Calendar Detail view, changing controls 213
  calendar records, displaying fields for 202
  calendars to which an employee has access, viewing 199
  data display format, changing 207
  Day Summary ToolTip 203
  display field drilldown 202
  drag-and-drop, about and user properties 210
  editing, enabling and disabling 209
  employee’s Calendar Owner drop-down list, removing all employees from 200
  employee’s calendar, giving another employee access to 199
  employees’ Calendar Access List views, removing an employee from 200
  field color, displaying 202
  first day of the week, changing 208
  Life Sciences calendar, hiding side 213
  multiple business components, based on reference activity, adding to 210
  resource administration scenarios, about 197
  retroactive alarms, about and changing days displayed 201
  special date markers 209
  ToolTip text, displaying 203
  user interface components, showing/hiding 205
  user interface strings, changing 206
  user preferences, overriding 209
Calendar Access List views
  removing an employee from 200
Calendar Detail view
  changing controls 213
Calendar Owner drop-down list
  removing all employees from 200
call reasons, customizing for RTD 379
canceling queries, enabling 48
case sensitivity
  about and Siebel applications 65
Catalog Administration screen
  associating literature with a category 233
categories
  about 387
  account category, adding 388
  scenario 387
  searching for a category 388
Category icon, configuring 135
charts
  currency conversion, supporting 53
  opportunity charts 351
  sales pipeline analysis chart, viewing 352
  sales pipeline phases analysis chart, viewing 353
child records
  child modification, disabling for business components 222
  child modification, enabling for business components 222
  state models, changing behavior 221
child Web browser, adding 69
Clear Cache button
  using to clear cache 74
color
  displaying calendar field color 202
competitive analysis
  company comparisons, viewing 390
  competitive analysis information, adding 431
  TAS coach, using for 431
competitors
competitor comparisons, viewing 390
opportunity, associating with 389
scenario 389
Competitors screen
sharing literature through 230
constrained list of values
See list of values, constrained
constrained pick lists
See list of values, constrained
contact category
searching by category 388
Contact Us account, adding 63
contacts
adding a contact 280
assessments, performing 283
associating with opportunities 345
defined 279
existing account used in Siebel Sales,
associating with 317
household address, specifying for a household
contact 358
household contact, storing information related
to 360
household, adding contacts to 357
new account used in Siebel Sales, associating
with 317
organization analysis, adding existing
contacts to 348
organization analysis, creating new contacts
for 349
organization chart, deleting from 417
organization map, deleting contacts on 434
partners, adding for Enterprise Selling
Process 418
personal contact, promoting to a contact
profile, creating for a contact 282
reference, associating with 365
scenario 279
synchronization list, adding a contact to
synchronization list, removing a contact
from 283
contacts, using
contact information, synchronizing with
external systems 283
CookiesAllowed
additional browser capabilities 67
Correspondence screen
sharing literature through 232
Create Activities for List command
using 241
Create Rerouted Oppty Activity workflow
setting up 333
CreateInbox method 140
CreateInboxEx method 139
CreateInboxItem method 142
CreateInboxOwner method 143
CSM Logging system preference 460
currencies, setting up
active, making 49
active, making currencies active 48
currencies, defining 49
currency conversion, setting up
Euro Triangulation method, about 51
exchange rates, setting up 50
Siebel applications, conversion occurs in
triangulation conversion, process of 52
current locale
editing 41
custom hierarchy
about 321
creating 324
default hierarchy, creating based on 324
organization, assigning to 325
restoring 326
updating 325
customer milestones
about 436
adding a milestone 436
associated activities, adding to
milestones 437
customized views, adding 35
D
D&B Global Integration search
See global integration
D&B integration
account promotion and prospect list creation
configuration 264
account promotion and prospect lists, field
mappings for 271
aggregate data, viewing 273
company data and report, accessing 273
configuration guidelines 263
D&B account, promoting 274
D&B real-time search and update, setting up
symbolic URL for 262
D&B real-time updates, field mapping
for 269
D&B report ordering, setting up symbolic URL
for 262
D&B report, viewing 275
data, about 247
DB2, loading D&B data on 252
D-U-N-S number, understanding 249
files and format, required 250
global integration, using to add new
accounts 275
loading D&B data  250
loading or reloading data  251
Microsoft SQL Server, loading D&B data on  253
multiple D&B update manager processes  257
multiple D&B update manager processes, with first time data loading  257
multiple processes and D-U-N-S number processing  257
Oracle, loading D&B data on  252
process of integrating data  249
prospect list, creating from D&B data  274
sample scripts, caution before running  252
scenarios  248
server components, about updating  254
server components, multiple D&B update manager processes  256
server components, multiple task Siebel update  256
server components, single task Siebel update  255
server components, updating process  254
Siebel update server component, running  258
symbolic URL, setting up  262
update server process configuration  264

D&B Update Manager
account promotion and prospect lists, field mappings for  271
D&B real-time updates, field mapping for  269
D&B server component field mappings  267
D&B server component, running as multiple task process  260
D&B server component, running as single task process  259
D&B server component, running from a command line  261
D&B Siebel server component, running from a command line  261
D&B, running without updating or deleting data  265
Siebel server component field mappings  267
Siebel server component, running as multiple task process  260
Siebel server component, running as single task process  260
Siebel, running without updating account name or location  266
tip, about running  259

data
import, list of values, considerations  80
seed data, about  30

Data Universal Numbering System number
See D-U-N-S number
databases
sample database, about  29
selecting  29
date
and timestamps, about  63
calendar date display format, changing  207
formats, about  61
special date markers  209
Day Summary ToolTip  203
DB2, loading D&B data on  252
DB2: Default Opt Level system preference  460
DBX: Vis Rules per Statement 1 system preference  460
DBX: Vis Rules per Statement N system preference  460
DeactivateInboxItem method  150
DeactivateInboxOwner method  152
decision issues
attachments, associating with decision issue  407
decision issue record, creating  405
decision issues details, adding  406
literature, associating with the decision issue  407
opportunity, associating with  406
opportunity, viewing for  345
related issues, adding  407
scenario  405
Decision Issues screen
sharing literature through  231
dedicated Web clients
 databases, selecting  29
error message, first time logging in  26
license key, entering  26
message broadcasting, enabling or disabling  106
Siebel application, starting from  24
Default Campaign Source Code system preference  460
Default EC Procedure system preference  460
default hierarchy
about  321
adding accounts with no parent  324
generating  323
Default Offer Code system preference  460
Default Pricing Procedure system preference  460
Default Time Zone system preference  460
DeleteInboxItem method  153
deleting
activity template 187
contacts from organization chart 417
contacts on organization map 434
employee from all employee's Calendar Access List views 200
employees from Calendar Owner drop-down list 200
Inbox items 121
languages, about and mobile Web client synchronization 65
lines of influence 350
lines of influence from organization chart 417
lines of influence on the organization map 435
demo user
logging on 29
Designer
See Adobe Designer
Display Value field
about modifying and updating records 76
dnbinitial.sql file
using to load D&B data 257
dragging and dropping records
into the calendar 210
drilldown
display field 202
D-U-N-S number
about 249
warning about multiple processes 257
dynamic pick lists
constraining, about 80
using, about 71
E
EAI Adapter
updating phone formats with 60
eBriefings
sharing literature through 232
editing
quick fill template 70
EIM (Siebel Enterprise Integration Manager)
importing phone information 60
email
address, about adding 63
alerts, about 165
message, using to send 168
opportunity assigned notification process 331
Employee field
configuring for activities 178
employee setup
completing 36
information, additional 35
employees
about activity assignment methods 172
Enterprise Selling Process
account plan and account map reports, generating 421
account plan highlights, adding 420
activities, adding 419
BU/SU offering summary, viewing 419
Business and Service Unit, adding 412
contact, adding 418
manager approval, viewing 421
objectives, adding 419
offerings, adding to Business and Service Units 413
organization chart, printing 418
organization's reporting structure, charting 416
organization's reporting structure, deleting contacts 417
organization's reporting structure, deleting line of influence 417
organization's reporting structure, drawing lines of influence 417
organization's reporting structure, representing 417
organizational analysis 415
overview 410
partners, adding 418
process of 411
scenario 410
Entitlement: Pricing Dates system preference 460
Entitlement: Verify Consumer system preference 461
Entitlement: Verify Dates system preference 461
Entitlement: Verify Product system preference 461
ESP
See Enterprise Selling Process
ETL Analysis End system preference 461
ETL Analysis Start system preference 461
ETL Base Exchange Currency system preference 461
ETL Date Format system preference 461
ETL Default Continent system preference 461
ETL Default Country system preference 462
ETL Default Currency system preference 462
ETL Default Language system preference 462
ETL LOV Maximum Value system
preference 462
ETL LOV Minimum Value system preference 462
ETL Unknown Exchange Rate system preference 462
Euro Triangulation method about 51
triangulation conversion, process of 52
Excel Web service about 302
configuring 303
connecting template to Siebel EAI 304
downloading template 304
seed data 303
using 305
exchange rates multiple currencies, about setting up for 48
setting up 50
expense reports about currency conversion 52
expense types, setting up about and pretasks 53
exporting iHelp item as HTML file 102
features, new version 8.0 19, 20
Forecast: Auto-Forecast system preference 462
Forecast: Use Server Task system preference 462
forecasting about currency conversion 52
Forms Integration See Adobe Forms Integration
FrameSupport additional browser capabilities 67
FSAssetSwap SubComponents system preference 462
FSDB:Override Service Region system preference 462
adding accounts with no parent 324
custom hierarchy, assigning to an organization 325
custom hierarchy, creating 324
custom hierarchy, creating based on default hierarchy 324
custom hierarchy, restoring 326
custom hierarchy, updating 325
default hierarchy, generating 323
global accounts, viewing 327
process flow for using and administering accounts 323
scenario 322
global integration search, initiating 275
using to add D&B accounts 275
Global Target List Management about 235
activity templates, setting up for target lists 240
create activities asynchronously, configuring 241
default hierarchy, generating 323
global accounts, viewing 327
global integration search, initiating 275
using to add D&B accounts 275
Global Target List Management about 235
activity templates, setting up for target lists 240
create activities asynchronously, configuring 241
default hierarchy, generating 323
inglobal accounts, viewing 327
list applets, enabling target lists on 242
target lists, kinds of 236
scenario 236
target lists, applying 239
target lists, creating activities from 239
target lists, creating by combining lists 239
target lists, creating by querying 237
target lists, editing 238
workflows, about 241
target lists, saving for a list applet 244
target lists, applying 239
target lists, creating activities from 239
target lists, creating by combining lists 239
target lists, creating by querying 237
target lists, editing 238
workflows, about 241
target lists, saving for a list applet 244
H
help See iHelp
hierarchy custom hierarchy, assigning to an organization 325
custom hierarchy, creating 324
custom hierarchy, creating based on the default hierarchy 324
custom hierarchy, restoring 326
custom hierarchy, updating 325
default hierarchy, adding accounts with no parent 324
default hierarchy, generating 323
high message, severity level 107
HighInteract additional browser capabilities 67
home pages
setting up default view links 70

**households**
- activity, adding to 360
- adding a household 356
- address, specifying for a household contact 358
- contact, storing information related to 360
- contacts, adding to a household 357
- defined 355
- information, types that can be related to household 360
- information, viewing additional information related to 361
- note, displaying addresses in Households and Contacts screens 359
- scenario 356

**households, using**
- household information, synchronizing with external systems 361

**HTML**
- exporting iHelp item as 102
- importing iHelp item as 102

**I**

**iHelp**
- about 93
- active iHelp item, revising 100
- administering iHelp scenario 93
- buttons, about activating, revising, and deactivating 100
- designing iHelp 97
- example process workflow 94
- iHelp Designer, accessing 97
- iHelp item records, creating 95
- iHelp item, activating 100
- iHelp item, deactivating 101
- iHelp items, exporting as HTML file 102
- iHelp items, importing as HTML file 102
- iHelp items, translating 101
- iHelp list cache, clearing 99
- iHelp step, creating 98
- steps, connecting with branches 99
- terminology 93

**importing**
- iHelp item as HTML file 102

**Inbox**
- deleting Inbox items 121
- destination view, changing for Inbox type 122
- expiration dates and due dates, setting 122
- feature objects, interaction with 118
- Inbox item, approving or rejecting 124
- Inbox items, reviewing all 121
- interaction between feature objects figure 118
- previously approved items, reviewing 124
- process of administering and using 121
- remote database, changing downloading to 122
- scenario for approving personnel action forms 120
- scenario for service request management 120
- submitted items, reviewing 124
- terminology 117
- translations, adding 123
- Universal Inbox business service, about 119

**Inbox approval translations**
- setting up 133

**Inbox type**
- about 127
- action type 127
- category 127
- creating 128

**Inbox views**
- action buttons for high interactivity, configuring 136
- action buttons for standard interactivity, configuring 136
- action buttons, configuring background colors 137
- action buttons, configuring for 136
- toggle applets, configuring 134
- toggle applets, types supported 134

**Inbox, configuring**
- action buttons for high interactivity, configuring 136
- action buttons for standard interactivity, configuring 136
- action buttons, configuring background colors 137
- action buttons, configuring for Inbox views 136
- actions, about 129
- actions, setting up 130
- Category icon, configuring 135
- Inbox action type 127
- Inbox approval translations, setting up 133
- Inbox category 127
- Inbox item, deactivating 130
- Inbox items, configuring the application to create 126
- Inbox trigger used in ESS 160
- Inbox trigger used in Server Script 161
- Inbox type, creating 128
- Inbox types 127
- planning an Inbox configuration 126
process of setting up and configuring 125
remote databases, configuring using 132
setting level for troubleshooting 137
toggle applets, configuring for Inbox views 134
Universal Inbox business service methods 137
views and SmartScripts, setting up Inbox links 128
industries
  adding an industry 64
Infocenter screen
  sharing literature through 233
Initial Plan report 439
Initialize method 154
installing
  software required 23
integration object
  creating for Forms Integration 290
intelligent offer recommendation
  See RTD
Internal DUNS Number system
  preference 462
international phone
  formats, about entering and format logic 56
  numbers, calculating maximum length 57
Internet Explorer 5.0
  adding JumpTab capability 68
intervals
  sorting messages by 168
IsInboxItemExisted method 145
J
JumpTab capability
  adding for Internet Explorer 5.0 68
L
Language Independent Code
  list of values, about changing 76
  list-of-values type, about within the 73
language independent values (LIV)
  about changing list of values 76
languages
  adding 64
  deleting, about and mobile Web client synchronization 65
lead sources
  setting up for opportunities 353
leads, rerouting 333
license keys
  about 25
  additional license key, entering using a Siebel application 27
additional license key, entering using Siebel Tools 27
cautions, about entering option-module license key 26
correcting errors 26
fields, table of 28
first license key, entering 26
hiding access to 28
option module license key 26
lines of influence
  organization chart, deleting lines of influence 417
  organization chart, using to draw 417
  organization map, deleting 435
  organization map, drawing 434
list applets
  target list, saving in an applet 244
  target lists, enabling on an applet 242
list of values (LOV)
  about 71
  cache, clearing 73
  caution, modifying seed data 76
  inactivating a value, about and procedure 77
  items, modifying 76
  Language Independent Code values (LIC) 76
  list-of-values type, identifying for a display value 72
  LOV data, viewing 71
  LOV record, fields in 74
  new value, adding to an existing list 72
  WI_ARG_TYPE, extending for 42
list of values, constrained
  about 78
  Parent LIC attribute, about changing parent Area 79
  Parent LIC attribute, about making values hierarchically dependent 78
Siebel EIM considerations 80
literature
  See Siebel Literature
Literature Administration screen
  associating literature with a category 233
literature files
  See Siebel Literature
literature item kits
  creating 228
literature records
  creating 225
local database, about 29
locales
  creating 38
  editing current locale 41
  setting up, about 37
  translation, creating for 41
Index  M

log files
setting level for troubleshooting  137

logging
demo user, on as  29
LOGMGR:Vis Rules per Statement system preference  462
LOV
See list of values (LOV)

M
Management Responsibility Code
about  250
manager approval, viewing  421
Marketing Data file, about  250
marketing resources, balancing tool  412
message broadcasting
Broadcast Message business component fields, table of  110
caching, configuring  111
message broadcast script, sample of  111
message text, about automatically updating  110
messages, creating and sending  108
mobile and dedicated Web clients, enabling or disabling  106
overview  103
process flow example  105
scenario  104
server level, enabling/disabling message broadcasting  105
severity levels  107
standard interactivity application clients, enabling or disabling  107
messages
e-mail and screen alerts, about  165
e-mail, using to send a message  168
messages created by you, viewing  167
new message, creating  165
recurring message alert, setting up  167
setting up and using, process of  164
setting up scenario  163
single interval, sorting messages by  168
single message alert, sending  167
using, about  164
workflows for Messages screen and views, setting up  164
your messages, viewing  167
Microsoft SQL Server
loading D&B data on  253
milestones
adding a milestone  436
associated activities, adding to milestones  437
customer milestones, about  436
mobile users
about activating state models  220
mobile Web clients
enabling or disabling message broadcasting  106
MRC file, about  250
MRG:Docking Timestamp Source system preference  462
MRG:Inter Table Conflict Res system preference  462
MRG:Inter Table Merge Rule system preference  463
MRG:System Conflict Resolution system preference  463
MRG:Txns per Commit system preference  463
MRG:User Friendly Notification system preference  463
multiple currencies
about setting up exchange rates for  48
multiple processes
and D-U-N-S number processing  257
My To Do filter
using to view activity  174

N
new features
version 8.0  19, 20
non-North American phone formats
specifying  57
[N] normal message
severity level  107
North American phone formats
default format for  56
notes
reference, adding a note to  366
target account selling, adding a note  438
notification workflows
delivery of emails, restricting conditions for  333
e-mail notifications, stop sending  334
Get Manager Email process, setting up  334
opportunities lost notification process, about  332
opportunity assigned notification process, about  331
opportunity inactive notification process  331
opportunity won notification process  332
opportunity workflow email, modifying the language of  333
opportunity workflows, setting up  331
setup steps  330
time lapse between lead assignment and email delivery, modifying 332

objectives
adding Enterprise Selling Process objective 419

offerings
BU/SU offering summary, viewing 419
Business and Service Units, adding to 413

opportunities
about and predefined opportunities, list of 329
account, associating with 318
activities, associated with an opportunity 346
assessing an opportunity 345
assessment, beginning 429
associating a contact with 345
competitors, associating with 389
creating an opportunity 340
decision issue, associating with an opportunity 406
decision issues, viewing for an opportunity 345
defined and examples 335
delivery of emails, restricting conditions for 333
depicting organization hierarchy, using drag and drop 349
e-mail notifications, stop sending 334
Get Manager Email process, setting up 334
lead qualification, sales methods, and stages 339
lead response, about 338
lead sources, setting up for opportunities 353
lines of influence, deleting 350
lines of influence, drawing 350
notification workflows, setup steps 330
opportunities lead assignment, about 338
opportunity assigned notification process, about 331
opportunity charts 351
opportunity inactive notification process, about 331
opportunity lost notification process, about 332
opportunity reports, generating 353
opportunity reroute activity, setting up 333
opportunity revenues, updating 348
opportunity won notification process, about 332
opportunity workflow email, modifying the language of 333
opportunity workflows, setting up 331
organization analysis, adding existing contact 348
organization analysis, creating new contacts 349
organization analysis, viewing and printing 350
primary team member, changing 344
processes and procedures 337
products, associating to an opportunity 346
quote, creating from an opportunity 347
revenue class and revenue type, about 343
sales pipeline analysis chart, viewing 352
sales pipeline phases analysis chart, viewing 353
scenario 336
significant opportunity transactions, monitoring 344
split revenue, about 343
Target Account Selling, assessing an opportunity for 193
Target Account Selling, sales professionals accessing an opportunity 428
TAS Coach, using 430
TAS coach, using to perform assessment 194
TAS, assessing an opportunity 192
time lapse between lead assignment and email delivery, modifying 332

opportunity category
searching by category 388

Oracle
loading data D&B data 252

organization
custom hierarchy, assigning to 325
organization chart, printing 418
reporting structure, charting 416
reporting structure, deleting contacts 417
reporting structure, deleting lines of influence 417
reporting structure, drawing lines of influence 417
reporting structure, representing 417

organization analysis
contacts, adding existing to 348
contacts, creating new 349
depicting organization hierarchy, using drag and drop 349
lines of influence, deleting 350
lines of influence, drawing 350
printing and viewing 350

organization hierarchy
using drag and drop to depict 349
organization map
- contacts, deleting 434
- creating 434
- lines of influence, deleting 435
- lines of influence, drawing 434
- printing 435

organizational analysis
- about 415
- about conducting 432
- beginning an analysis 433
- creating 415

Owner field
- configuring for activities 178

P

pager company
- setting up 60

Parent LIC attribute
- list of values, about making values hierarchically dependent 78
- parent Area, about changing 79

parent Web browser
- adding 69

parent-child business associations for audit
- specifying 86

partners
- adding for Enterprise Selling Process 418

password and default user ID 24

payment terms
- setting up 54

PDF
- form record, referencing the PDF 292
- XML schema, mapping to using Adobe Designer 292

periods
- period units, associating with a period 55
- setting up 55

personal contact
- promoting to a contact 282

phone formats
- about 56
- calculating maximum length of international phone numbers 57
- EAI Adapter 60
- EIM, about importing information with 60
- entering letters in place of digits 58
- format examples (table) 59
- international, about entering and format logic 56
- querying for phone numbers 59
- sorting phone numbers 59
- specifying North American phone formats, default 56

specifying non-North American phone formats 57
- unformatted phone numbers 58

pick lists
See dynamic pick lists

PMP
- about 441
- analyzing A accounts 447
- analyzing B, C, and D accounts 448
- analyzing select details 450
- assessing BUs and SUs 449
- assessing current revenues 445
- assessing future potential of accounts 446
- creating portfolios 443
- entering account details 448
- managing portfolios 443
- performing a manager review 455
- printing portfolio reports 456
- reviewing marketing events 452
- reviewing objectives and action plans 454
- reviewing opportunities 451
- reviewing organizational analysis 451
- reviewing partners 453
- scenario 442
- segmenting accounts 445
- viewing segmentation map 447

Portfolio Management Process
See PMP

predefined queries, setting up
- about 46
- creating by saving a query 47
- Predefined Query view, setting up predefined query in 47

preferences
- overriding user preferences 209

preferences, system 459

price lists
- currency conversion 52

primary team member
- changing 344

PRIME activities
- adding 438
- viewing 437

printing
- organization analysis 350
- organization chart 418
- organization map 435

Priority input argument, about 154

products
- opportunity, associating to 346

profile
- contact, creating for 282
profile information, adding to a reference 367
profiles charts, viewing 367
projects, currency conversion 52
prospects
creating list from D&B data 274
queries
audit trail information 88
canceling 48
phone number, examples 59
predefined query, about setting up 46
predefined query, creating by saving a query 47
predefined query, setting up in Predefined Query view 47
target list, creating by querying 237
quick fill template
editing 70
making public 69
Quick Print Application system preference 463
Quick Print Output Format system preference 463
quotes
currency code, about changing 52
opportunity revenues, updating 348
opportunity, creating from 347
rate lists
about currency conversion 52
Real-Time Decisions
See RTD
records
form, generating using a record 294
multiple records, generating forms for 294
recurring message alert
setting up 167
reference assets
viewing 367
references
accounts, designating as reference 364
accounts, managing and references 364
activities, adding 364
attachments, viewing 365
calendar, adding reference activity to 366
contact, associating with 365
note, adding to 366
profile information, adding to a reference 367
reference assets and profiles charts, viewing 367
scenario 363
searching for references 367
relationship strategy
developing 435
remote databases
configuring Inboxes for use with 132
replication (Siebel Replication)
about using audit trail 83
reports
account plan and account map reports, generating 421
currency conversion supported in 52
Initial Plan report 439
opportunity reports, generating 353
Satmetrix survey reports, setting up 41
TAS Opportunity Plan report 439
resources
about 197
calendar activities, administering
resources 199
calendars to which an employee has access, viewing 199
employee’s calendar, giving another employee access to 199
Reserves list applet
tip, adding fields 199
retention management
See RTD
retroactive alarms
about and changing days displayed 201
revenues
updating opportunity revenues 348
RouteInboxItem method 154
RTD
about 370
adding eligibility rules 382
creating a campaign for offers 380
Decision Center, opening for editing 381
offers, activating 383
offers, creating 380
offers, enabling for RTD 380
offers, specifying eligibility for 381
offers, updating information 383
scenario 370
setting up real-time offers 380
viewing performance reports 384
views for call center agents 385
RTD, configuring 370
checking prerequisites 371
customizing call reasons 379
outbound web services 371
runtime events 373
setting Enterprise Server parameters 372
with Siebel views 372

**RTI configuration file**
- account locations, edit so not updated 266
- caution if modified 258

**S**

**SADMIN ID**
- about modifying responsibility 24

**sales methods**
- about 180
- sales methodology, defining 181

**sales pipeline analysis chart**
- viewing 352

**sales pipeline phases analysis chart**
- viewing 353

**SalesHierarchy:UseServerTask system preference** 463

**sample database**
- about and logging in 29

**Satmetrix Key Value system preference** 463

**Satmetrix survey reports**
- setting up, about 41
- symbolic URL, setting up for access 42
- WI_ARG_TYPE, extending list of values for 42

**saving**
- enabling saving target lists for a list applet 244

**Sch:Break Time Id system preference** 463

**Sch:Default Constraint Set system preference** 464

**Sch:Default Cost Function system preference** 464

**Sch:Default Parameter Set system preference** 464

**Sch:Default Time Window system preference** 464

**screen alerts**
- about 165

**screen home pages**
- setting up default view links 70

**script**
- sample message broadcasting script 111

**searching**
- category, searching for 388
- for references 367
- initiating D&B’s Global Integration search 275

**SecThickClientExtAuthent system preference** 464

**seed data**
- about 30
- list of values, modifying 76

**server database, about** 29

**service requests**
- viewing activities associated with 178

**SetInboxParamInfo method** 149

**setup tasks**
- summary of application administration tasks 30

**setup, initial**
- about 33
- employee setup, additional information 35
- employee setup, completing 36
- locale name, creating translation for 41
- locale, editing current locale 41
- locales, about setting up 37
- locales, creating 38
- Satmetrix survey reports, setting up 41
- skills, assigning 37
- tasks, summary of 34
- views, adding to the application 35

**severity levels**
- about using for message broadcasting 107

**SIC (Standard Industrial Classification code) file**
- about and D&B data 250

**Siebel application**
- license keys, hiding access to 28
- Siebel Developer Web Client, starting from 24
- Siebel Web Client, starting from 24

**Siebel eBriefings**
- about ordering D&B reports 263
- sharing literature through 232

**Siebel Enterprise Integration Manager**
- importing phone information 60

**Siebel Enterprise Selling Process (ESP)**
- See Enterprise Selling Process

**Siebel Industry Applications**
- See Global Target List Management

**Siebel Literature**
- Competitors screen, sharing literature through 230
- Correspondence screen, sharing literature through 232
- Decision screen, sharing literature through 231
eBriefings, sharing literature through 232
- literature files, about setting up 224
- literature files, creating 224
- literature files, modifying 224
- literature item kits, creating 228
- literature kits, about 223
- literature or Infocenter, sharing literature through 233
- literature records, creating 225
literature, associating with the decision issue 407
literature, making visible to users 229
Products screen, sharing literature through 230
software supported 224
translation records, associating with a literature record 227
Siebel objects
association with activity objects 172
Siebel OLE Automation, about 110
Siebel Remote
audit trail, about using 83
Siebel Replication
about using audit trail 83
Siebel Sales
account, associating a contact 317
account, associating with an activity 317
account, associating with an opportunity 318
accounts assessments, performing 318
accounts credit profiles, viewing 319
accounts, about using 313
accounts, associating contact with 317
accounts, creating 314
scenario for accounts 313
Siebel Tools
business component, enabling for state models 217
enabling Forms Integration for applets 290
license keys, entering additional using Tools 27
license keys, hiding access to 28
Siebel Web Client
Siebel application, starting from 24
signature capture controls
about 391
adding applet to an object 402
adding browser script to an applet 398
adding server script to an applet 397
compiling the SRF 403
creating applet control for 396
creating buttons for saving and clearing 397
creating form applet for 395
creating hidden control for 396
creating object and class for 394
extending database for 392
generating reports with signatures 404
implementing 392
registering OCX file 393
scenario 392
testing applets 403
skills, assigning 37
SM WebIntelligence Server system preference 464
SmartScripts
setting up Inbox links 128
software required, table 23
SQL (dnbinitial.sql)
using to load D&B data 257
SqlStyle system preference 464
SSASqlErrRsltsDiscarded system preference 464
Standard Industrial Classification code
about and D&B data 250
standard interactivity application clients
enabling or disabling message broadcasting 107
starting
Siebel application, starting from Siebel Developer Web Client 24
Siebel application, starting from Siebel Web Client 24
State Machine, defined 215
state models
activating 220
business component, about configuring 217
business component, enabling in Siebel Tools 217
business component, is it already enabled? 217
child modification, disabling 222
child modification, enabling 222
child records, about changing behavior 221
enforcing state models, about 220
functionality 215
mobile users, about activating 220
new state model, creating 218
scenario 216
setting up state model, process of 216
state model objects, about reading 220
state transitions
defined 215
new state model, creating 218
static pick lists
about 71
constraining, about 78
Strict Date Format system preference 464
SubSqlStyle system preference 465
Suppress Side Applets Calendar Types user property 213
symbolic URL
setting up for access to D&B database 262
setting up for Satmetrix reports 42
synchronization list
adding a contact to 282
removing a contact from 283
Synchronize Account ASI 299
Synchronize Contact ASI 300
Synchronize Household ASI 300
system preferences
setting 46
      table of 459

T

Target Account Selling
assessment, beginning 429
associated activities, adding to
milestones 437
competitive analysis information,
adding 431
competitive analysis, using TAS coach
for 431
customer milestones, about 436
customer milestones, adding a
milestone 436
notes, adding 438
opportunities, using to manage 423
opportunity, assessing 193
opportunity, sales professionals
assessing 428
organization map, creating 434
organization map, deleting contacts 434
organization map, deleting lines of
influence 435
organization map, drawing lines of
influence 434
organization map, printing 435
organizational analysis, about
conducting 432
organizational analysis, beginning 433
PRIME activities, adding 438
PRIME activities, viewing 437
process of 425
relationship strategy, developing 435
reports 439
scenario 424
TAS Coach, using 430
TAS coach, using to perform assessment 194
TAS overview, completing 426

target lists
activities, creating asynchronously 241
activities, creating from 239
activity templates, setting up 240
applying 239
creating by combining lists 239
creating by querying 237
editing 238
list applets, enabling on an applet 242
list applets, saving target lists in an
applet 244

competitive analysis, using for 431
using 430
TAS Customer Milestone template
creating in a localized application 186
TAS Opportunity Plan report 439
TAS tools
creating organizational analysis 415
Technical Support (Alt. 1) system
preference 465
Technical Support (Alt. 2) system
preference 465
Technical Support (FAX) system
preference 465
Technical Support (URL) system
preference 465
Technical Support (Voice) system
preference 465
Telocator Alphanumeric Protocol (TAP)
pager support of 60
templates
activities, creating target lists from 239
activity template, deleting 187
activity templates, about activities created
using 183
activity templates, about and activity
plans 179
activity templates, creating without
grandchild records 184
activity templates, using to create activity
plans 188
assessment templates, about 189
assessment templates, creating 190
quick fill template, editing 70
quick fill template, making public 69
TAS Customer Milestone template,
creating 186
time zone support, administering
about 61
date and timestamps, about 63
time zone settings, modifying 62
translations of time zones, maintaining 62
timestamps
about and dates 63
toggle applets
Inbox view, types of views supported 134
Inbox views, configuring 134
Tools
enabling Forms Integration for applets 290
ToolTip
Day Summary ToolTip 203
text, displaying 203
Training: EAI HTTP Password system
preference 465
Training: EAI HTTP Server system
preference 465
Training: EAI HTTP User Name system preference 465
Training: Lesson Adapter URL system preference 466
Training: Lesson Security system preference 466
translation records
associating with a literature record 227
triggers
Inbox trigger used in ESS 160
Inbox trigger used in Server Script 161
troubleshooting
setting Inbox log file level for troubleshooting 137

U
unformatted phone numbers 58
Universal Inbox business service
about 119
CreateInbox method 140
CreateInboxEx method 139
CreateInboxItem method 142
CreateInboxOwner method 143
DeactivateInboxItem method 150
DeactivateInboxOwner method 152
definitions 137
DeleteInboxItem method 153
GetInboxItemInfo method 145
GetInboxOwnerInfo method 148
GetInboxOwnerInfoEx method 147
GetInboxParamInfo method 146
Initialize method 154
IsInboxItemExisted method 145
RouteInboxItem method 154
SetInboxParamInfo method 149
UpdateInboxItemInfo method 150
UpdateInboxOwnerInfo method 152
Universal Time Coordinated system preference 466
UpdateInboxItemInfo method 150
UpdateInboxOwnerInfo method 152
[U] urgent message
severity level 107
UsageTracking Enables system preference 466
UsageTracking Log Time Period system preference 466
UsageTracking LogFile Dir system preference 466
UsageTracking LogFile Encoding system preference 466
UsageTracking LogFile Format system preference 466
UsageTracking Sess Cache Size system preference 466
user
restricting audit trail by user 87
User Group system preference 466
user ID and password, default 24
user interface components
showing/hiding 205
user interface strings
changing 206
user preferences, overriding 209

V
version
8.0, new features 19, 20
views
customized views, adding 35
Inbox links, setting up 128

W
Web browser
additional, adding Web browsers 67
capabilities, adding 66
capability, adding JumpTab 68
child Web browser, adding 69
extended capabilities, list of 67
parent Web browser, adding 69
required browser capabilities 68
Web Engine User Agent business service 67
Web services
See Adobe Web service
See Excel Web service
See RTD, configuring
See Word Web service
WI_ARG_TYPE
extending list of values for 42
Word Web service
about 302
configuring 306
connecting template to Siebel EAI 306
downloading template 306
mail merge, getting Siebel data 308
mail merge, log as Siebel activity 310
mail merge, previewing message 309
mail merge, printing and sending messages 310
mail merge, process of 307
mail merge, refining message 309
mail merge, refining recipients 308
seed data 303
workflows
Create Rerouted Oppty Activity, setting
up 333
delivery of emails, restricting conditions for 333
e-mail notifications, stop sending 334
Get Manager Email process, setting up 334
Global Target List Management workflows 241
opportunity assigned notification process, about 331
opportunity inactive notification process, about 331
opportunity lost notification process, about 332
opportunity notification workflow, setup steps 330
opportunity won notification process 332
opportunity workflow email, modifying the language of 333
opportunity workflows, setting up 331
time lapse between lead assignment and email delivery, modifying 332

X
XML schema
  generating for Form Integration 291
  mapping to the PDF 292

Z
ZIP Codes, adding 61